
1

序章　この本の成り立ちと読み方

序_1 本書の成り立ち

　この本は，力学モデルによるシミュレーション実験と，必要に応じ新たな力学モデルの創造を通

して，基礎力学の理解を深めることを目的としている。主な読者として，大学基礎教育課程におけ

る力学の初学者を選んだが，対象とする読者については，あまり狭く絞り込んでいない。それは，

近年の高等学校での理科教育の現状から，高校時代に学習する力学の内容・程度に大きな多様性が

生じていることと関係している。また，当然のことながら，ここで採用するシミュレーション・ソ

フトウェアの運用にも，いろいろなレベルがありうる。

　そこで本書の内容は，高等学校から大学の理系基礎教育課程までの多様な読者のレベルに沿った

ものとなるように配慮した。例えば，まだ高等学校などで力学の初歩を学んでいる人が，シミュレ

ーション実験を通して更に上級の力学に直接触れてみる，などということがいとも容易にできるよ

うになっている。また，力学シミュレーションを純粋に面白いと感じる人は，学習の過程にかかわ

らず，これを単にエンターテインメントの手段として楽しむことも可能である。

　本書はこのように自由度の高い教材であるが，その教科・コースとしてのレベルを分類・仕分け

すると，次のようになる。

レベル A：高等学校の復習，

　　　　　あるいは高等専門学校および文系大学における基礎教育課程の初歩

レベル B：高等専門学校および文系大学における基礎教育課程，

　　　　　あるいは理系大学における基礎教育課程の初歩

レベル C：理系大学における基礎教育課程の応用

本書では，これらのレベルに従い，各節あるいはひとまとまりの解説の標題に A，B，C のマーク

を振った。

　読者は教科の目的や，自分のレベルに応じ，A，B，C 各レベルをそれぞれ独立に学ぶことができ

る。あるいは，レベル A および B，レベル B および C，更にはすべてのレベルを一括して選択し，

学習を進めることもできる。
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　本書の章立てであるが，第１章では，後の章（第２章～第６章）の力学モデルを運用するための

基礎知識について説明する。主に力学モデルの運用法を解説しているが，例題として，初歩の力学

に必要とされる数学的知識を復習する力学モデルを採用したので，Working Model 2D の運用につ

いて既に知っている人も一読されることをお勧めする。

　次に，第２章から第６章では，理系大学の基礎教育課程までに学ぶ力学を，力学モデルの運用に

よって解説する。読者はレベルに応じ，内容を取捨選択して読み進めることができる。これらの章

で用いられている力学モデルは，単にそれらを運用することで，各テーマの理解を促進するように

作られている。

　これに対し第７章は，基礎的な力学モデル（第 1 章と深い関わりを持つ）をはじめから組み立て

る方法について示す。力学シミュレーションの手法を学びたい方や，モデリングに興味を持った方

は，ぜひこの章を一読し，自らの力学ワールドを構築していただきたい。それにより，更に力学に

対する深い理解が得られるものと思われる。

序_2　インターネットからの力学モデルのダウンロード

　本書の例題力学モデルは，全てインターネット上の指定サイトから入手可能である。従ってまず

これらの力学モデルを，フロッピーディスク，あるいは使用しているコンピュータにダウンロード

する必要がある。そのためには，インターネットに接続されているコンピュータでインターネット

エクスプローラなどのブラウザを動作させ，以下のアドレスを指定して，力学モデルが格納されて

いるサイトに接続し，目的のアイコンをクリックすればよい。

　あるいは，そのようにインターネットに接続されているコンピュータにおいてダウンロードした

力学モデルを，フロッピーディスクなどにコピーして他のコンピュータにコピーしてもよい。

　これらの力学モデルは，本書の学習に利用する場合に限って，著作権フリーとしてあるので，商

用に使用する以外は，一度インターネットからダウンロードした後にフロッピーディスクなどで再

配布していただいて構わない。

ダウンロードサイト： http://133.67.99.140/sato/wm2d_model/
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第１章　力学シミュレーションの基礎

1.1　力学シミュレーションについて (A)

　コンピュータサイエンスの輝かしい成果の一つであるシミュレーション（simulation）技術は，

我々の身近に起こる力学現象を創出・再現するための有力な手段となっている。シミュレーション

とは，現実の世の中に起こり得る事象を，仮想的（数値的）に実現することを言う。

　　　　　図 1.1　自動車の衝突シミュレーション（Working Model 2D サンプルより）

　例えば自動車メーカーでは安全性の高い車体を設計するために，実際の自動車を用いた衝突実験

を行なうことがある。しかしこのような実験には，多大の費用と時間を必要とする。従って，開発

の過程では，コンピュータによるシミュレーション（図 1.1）を通し，基礎的な安全設計を補助す

ることが得策である。このように，シミュレーションを繰り返しながら，ある製品の設計を完成さ

せて行く技法を CAE（Computer Aided Engineering）と呼び，現代の先端技術となっている。

　本書はこのシミュレーション技術を用い，物理学の基礎である力学学習の補助をしようとするも

のである。本書で用いるソフトウェアは，日本 MSC ㈱ の Working　Model 2D という，２次元

力学シミュレーションソフトウェアである。実は，今ではアメリカ産業界で盛んに使用されている

Working　Model 2D も，元はといえば，アメリカの中学・高校生の力学の学力レベルアップを目

的としたものであった。そのような努力が功を奏し，宇宙・航空あるいは自動車産業など，現在の

アメリカ基幹産業は，３次元 CAD と３次元シミュレーションソフトウェア（日本 MSC㈱からも

Working Model NASTRAN が出ている）を連携させた高度な CAE 技術によって強力にバックアッ
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プされている。

　Working Model 2D は，２次元に限定されるが，グラフィックを用いて容易にシミュレーション

の世界を造り上げることができる。慣れるとゲーム感覚で自分の世界を構築することができるよう

になる。いわば，我々が『仮想力学世界』の創造主となるのである。このように，

シミュレーションソフトウェアのために造られた個々の『仮想力学世界』を，本書では『力学モデ

ル』と呼ぶ。

　従来力学の学習は，教科書の学習と，それとは独立の力学実験から成り立っていた。扱う事象が

比較的身近な現象であっても，それを教科書の学習と並行して実験してみることは意外に難しいか

らである。本書はコンピュータシミュレーションの特性を生かし，既に読者が所有している教科書

の学習に並行して，小さな，しかし多くの実験を即座に行なうことによって，教科書各段階の理解

を促進しようとするものである。

　　　　　　　　　　　　図 1.2　Working Model 2D 初期画面（例）
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1.2　力学モデルの動作基盤：World（ワールド）(A)

本書では，力学モデルが動作するスペースと，その環境をWorld（ワールド）と呼ぶことにする。

これは読んで字のごとく，今考えている「仮想力学世界」のことである。これを実体験するには，

Working Model 2D を実行してみればよい。初期画面は図 1.2 のようになるはずである。このうち，

タイトルバー，メニューバー，ツールバーは，それぞれ Windowsに共通の概念である。

　画面の「ウィンドウの内側」が World（ワールド）であり，初期画面には何も表示されていない。

それはこの世界にはまだ何も無いことを示している。しかしこの状態でも，この World（ワールド）

は何らかの性質を持っている。それを調べるためには，図 1.2 のメニューバーにあるWorld を，更

にその中で Gravity（重力）をクリックしてみればよい。本書では今後このように

メニューバーからマウスクリックによりメニューウィンドウを開いていく場合，World > Gravity

などと『>』を用いて表記することにする。

　　　　　図1.4  World（ワールド）のxy軸とその設定

　　図1.3　World > Gravity

y 座標値

x 座標値

xy 軸表示
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　図 1.3 に，World > Gravity によって開かれるウィンドウの様子を示す。ここではこのWorld（ワ

ールド）において重力をどのように扱うかを設定・表示する。選択項目としてPlanetary（惑星），

Vertical（鉛直方向），None（無重力）を選べるが，デフォルトは重力が「鉛直方向（画面の上か

ら下）に作用する重力場」すなわちVertical（鉛直方向）となっている。Planetary（惑星）は「物

体間の万有引力のみ」を考慮する力場となっており，None（無重力）はいずれの重力も考えない。

　メニューバーの Worldではそのほか、デフォルトでAir Resistant（空気抵抗），Electrostatics

（静電場）および重力以外の Force Field（力場）が Off となっているのが確認できる。第 1 章で

扱う力学モデルのWorld（ワールド）では，Gravity（重力）と Air Resistant（空気抵抗）以外の

力場は考えない。

「2 次元」ということは，画面に垂直な方向の物の大きさや動きなどは一切考えないことを意味し

ている。従って座標系も水平右方向を正とするx軸と，鉛直上方向を正とする y 軸のみを考える。

　 xy座標を確認するためには，メニューバーの View で，Workspace をクリックし，その中の

Navigation の XY Axes をチェックすると，World（ワールド）上に横軸と縦軸が現れる（図 1.4）。

これらがx軸と y 軸であり，後述のオブジェクトやカーソルの位置が，これを基にするxy座標系で

表されている。同じメニューバーの View > Workspace > Navigation で Coordinates（座標）がチ

ェックされていると，図 1.4 のようにウィンドウの下部にxy座標値が表示される。試しにマウスで

カーソルを移動させ，World（ワールド）のxy軸が交わっている点（座標系の原点）の上でxy座標

値が(0,0)（デフォルトでは単位はｍ）となることが確認できる。

　このようにメニューバーの View > Workspace（作業空間）では，文字通りユーザーの「作業空

間」の使い勝手を設定できる。例えば同じ Navigation の中の Grid Lines（グリッド線）は，モデ

リング作業中にオブジェクトの大きさや長さの目安を得るのに便利である。

1.3　力学モデルの『物と規則』：Object（オブジェクト）(A)

World（ワールド）の中に存在しうる，あらゆる『物と規則』を，Object（オブジェクト）と呼ぶ。

図 1.5 に，オブジェクト・ツールバー（オブジェクトに関するツールバー）を示す。ウィンドウ外

周の左側にある，Joint／Sprit 以外の合計４組のツールバーが，上から順に Body（物体），Points

（点要素），Joints（接続），Constraints（拘束）各ツールバーである。Working Model 2D ではそ

の他計測ウィンドウなども Object（オブジェクト）に分類されている。このうち，Body（物体）の

みが実体のある『物』であり，Points（点要素），Joints（接続），Constraints（拘束）は，Body

（物体）と Background（バックグラウンド），あるいはBody（物体）1 とBody（物体）2 の力学的

関係を決める『規則』である。ここで Background（バックグラウンド）とは，World（ワールド）

の絶対座標系（今後これをワールド座標系と呼ぶ）に固定された静止空間と考えることができる。

　なお，具体的な個々のObject（オブジェクト）については，それが力学モデルに出現したときに

解説する。Working Model 2D では，これらツールバー上の Object（オブジェクト）のアイコンを

マウスで選択し，World（ワールド）の中へドラッグすることによって，容易に力学モデルを組み

立てることができる。その過程，すなわちモデリングの詳細は，第７章で解説する。モデリングに

のみ興味のある読者は，本章の次に，直接第７章へ進んでもよい。
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　　　　　　　　　　　　図 1.5　オブジェクト・ツールバー

1.4　簡単な力学モデルのロードと実行（等速直線運動）(A)

　m1_4_1 は，無重力空間における等速直線運動をシミュレートする簡単な力学モデルである。

力学モデルをロードし，実行するためには，File>Open…をクリックし，力学モデルを記述したフ

ァイルをロードする。

このモデルのワールドの特性は無重力である。またワールド時間（シミュレートされているワール

ドの中での経過時間）が 10 秒間で力学モデルの実行を停止させるので，このような条件を明記す

るために，今後は各モデルごとに表 1.1 のような「ワールド初期設定」を明示することにする。

　ここでは，Gravity（重力）は None（無重力），Stop when（終了条件）はワールド時間でtime>=

10.0（10 秒以上）としている。また見易さのために，XY Axes（XY 座標軸）と Grid Line（グリッ

ド線）が表示されるように設定されている。グリッド線の間隔はデフォルトで１[m]である。上記

の力学モデルがロードされた直後の様子を，図 1.6 に示す。

　注意を要するのは，xy 座標軸はワールド座標系における座標軸であるが，グリッド線は後述する

Reference frame（基準フレーム）に伴って動く。しかし初期状態では『基準フレーム』はワール

ド座標系に一致しているので，今はこの相違を意識する必要はない。
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表 1.1　力学モデル m1_4_1 のワールド初期設定

力学モデル・ファイル名 m1_4_1.wm
目的・機能 等速直線運動のシミュレーション

Gravity（重力） None（無重力）

Stop when（終了条件） Time >= 10.0
XY Axes（XY 座標軸） On
Grid Lines（グリッド線）On

　以下の解説では，紙数を節約するために，ここまでに述べた程度の「ワールド初期設定」の解説

については特に記述しないので，表を参考に，読者自ら理解していただきたい。

　さてこのモデルには，無重力空間上に，上下２つのCircle（円形）（いずれも半径１[m]）が置か

れている。ここに円形と書いたが，

Working Model 2D では，通常 World（ワールド）に表示される Body（物体）は，厚さが１[mm]

の板の形状をしていると想定する。ただし，板状であることをことさら意識する必要はない。

上の円形は初速度１[m/s]で x軸の正方向に放たれる。また下の円形は，Actuator（アクチュエータ）

により，強制的にx軸正方向に１[m/s]の等速で動かされる。Actuator（アクチュエータ）とは，一

般に長さや角度などを任意に設定できるような装置を言うが，Working Model 2D では，長さを設

定するものだけをアクチュエータと呼んでいる。（これに対し回転を制御するものを Motor（モー

タ）と呼ぶ。）現実の世界のアクチュエータは，空気圧や油圧などで筒を伸ばしたり縮めたりする

ものが多いので，描かれる絵もそのようになっている。ただし Working Model 2D の Actuator（ア

クチュエータ）は，「元の長さを無視することのできない現実のアクチュエータ」に比べて理想的

であり，長さが０から無限大までの正の値を取りうる。

　ツールバーの Run ボタンを押すとシミュレーションが開始し，ワールド時間の 10 秒間で停止す

る。結果的に上の円形は下の円形と全く同じ動きをするので，初速１[m/s]で放たれた物体は，その

速度で等速直線運動を続けることがシミュレートされたことになる。

　このように，

シミュレーションを開始するには一般にツールバーの Run ボタンを押せばよい。

本書で用意した力学モデルの多くは，設定した時間が経過すると停止したり一時停止するように作

られている。しかし Working Model 2D では必ずしも全ての力学モデルが自動的に停止したり一時

停止したりする設定とはならない。そのようなとき，

途中で停止させる場合にはツールバーの Stop ボタンを押す。

停止したモデルを再び始めから動作させるためには，ツールバーの Reset ボタンを押し，元に戻す。

一時停止の場合は，Reset の代りに Run ボタンを押して次のステップへ進むことができる。

　力学モデルの中に表示されたグラフは，上の円形の位置 )(tx ・速度 )(tvx ・加速度 )(tax  を計測

して表示したものである。これらを式で表すと，

                                 ttx =)(  [ m ]                                       ( 1 . 1 )

                                1)( =tv x  [ m / s ]                                      ( 1 . 2 )

                                0)( =tax [m/s2]                                     ( 1 . 3 )
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　　　　　　　　　　　　　図 1.6　等速直線運動に関する実験

となっていることが分かる。これは等速直線運動の一例である。

Working Model 2D の画面では，変数に大文字が使われることが多いが，本書の解説ではこれを小

文字に直して使用する。また，位置を示すために Position の頭文字“ p ”が用いられている。しか

し物理学の教科書では，通常 p は運動量に用いられるので，本書ではその意味に応じ，x  や y  ，

あるいはφを用いる。

　なお，Run の後に Reset してから力学モデルを閉じない場合，『変更を保存するか？』問い合わ

せがあるが，これを保存してしまうと，次回同じ力学モデルをロードしたときに，初期状態が変化

してしまうので，注意を要する。特に変更を要しない場合はいいえボタンをクリックして終了する。

1.5　位置・速度・加速度間の数学的な関係（等加速度直線運動）(A)

　力学モデル m1_5_1 は，Body（物体）の等加速度直線運動をシミュレートする。この力学モデル

の「ワールド初期設定」を表 1.2 に，このモデルをロードした直後の状態を図 1.7 に示す。
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　この力学モデルには，前のモデルと同様に，無重力空間上に，上下２つの円形（いずれも半径１

[m]）が置かれている。これらの円形は，やはり厚さが１[mm]の板となっており，密度は1000 [kg/m3]

表 1.2　力学モデル m1_5_1 のワールド初期設定

力学モデル・ファイル名 m1_5_1.wm
目的・機能 等加速度直線運動のシミュレーション

Gravity（重力） None（無重力）

Stop when（終了条件） Time >= 10.0
XY Axes（XY 座標軸） On
Grid Lines（グリッド線）On

（2 次元なので，1[kg/m2]と考える）なので，いずれも質量は 3.142[kg]である。その事実は，各円

形をマウスでダブルクリックすると現れるProperties（属性）ウィンドウ（図 1.8）のmass（質量）

の大きさによって知ることができる。

　以後，ワールド時間を表す変数 time は，数学式ではｔと書く。上の円形は初速度 0[m/s]である

が，Actuator（アクチュエータ）により強制的に x軸の正方向に ttv x 2.0)( =  [m/s] の速度で動か

される。これも Actuator（アクチュエータ）をダブルクリックして現れる Properties（属性）ウ

ィンドウによって確認することができる。

　またモデル中のグラフは，上の円形の位置 )(tx ，速度 )(tv x および加速度 )(ta x を計測して表示し

たものである。これらを式で表すと，

                                21.0)( ttx =  [ m ]                                     ( 1 . 4 )

                                ttvx 2.0)( =  [ m / s ]                               　  (1.5)

                                2.0)( =tax  [m/s2]                                   ( 1 . 6 )

となっていることが分かる。これは等加速度直線運動の一例である。

　これに対し下の円形は，やはり初速度 0[m/s]であるがその中心には 0.628[N]の力を作用させてお

り，結果的に右に動く。その動作は，アクチュエータによるものとまったく同じ，加速度が 0.2[m/s2]

の等加速度直線運動であることが分かる。これは，第２章で学習する，『物体に作用する力と加速度

は比例する』ことを確認する現象である。

注意　　　Working Model 2Dのようなシミュレーションプログラムは，その動作原理の中で既にニュートンの運動

法則などを自明の理論として用いているので，このようなソフトウェアを用いた実験結果からそのような法則が正

しいという結論を導くことはできない。あくまでもヴィジュアルな確認実験と考えていただきたい。

　なお，各円形の中心には，参考のため，その円形に作用する力（FT）と各円形中心の加速度（A）

を示す矢印が描かれている。さてここでは，これらのシミュレーション実験から，１次元の位置，

速度，加速度の間になりたつ基本的な数学を復習しておこう。今，時間ｔをパラメータとすると，

一般に，運動する物体の位置 )(tx [m]，速度 )(tvx [m/s]，加速度 )(ta x [m/s2]の間には，微分を用いて，

　　　　　　　　　　　　 )()(
d
d

tvtx
t x= 　　　　　　　　　　　　　　　　　　　　　　（1.7）
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　　および　　　　　　　 )()(
d
d

tatv
t xx = 　　　　　　　　　　　　　　　　　　　　　　（1.8）

の関係がある。あるいはこれを積分を使って書き直し，

　　　　　　　　　　　 ∫ +=
t

x xvtx
0

)0(d)()( ττ  　　　　　　　　　　　　　　　　　　 （1.9）

　　および　　　　　　 ∫ +=
t

xxx vatv
0

)0(d)()( ττ 　　　　　　　　　　　　　　　　　　（1.10）

の関係がある。

式（1.9）および式（1.10）で用いたτは，積分式の中だけで有効な積分変数である。

　　　　　　　　　　　　図 1.7　等加速度直線運動に関する実験

　これらの関係を，図 1.6 および図 1.7 のグラフから確認してみよう。各グラフでは，青い線が位

置 )(tx （グラフの下端が-1，上端が 11[m]），赤い線が速度 )(tvx （グラフの下端が-1，上端が 11[m/s]），

緑の線が加速度 )(tax （グラフの下端が-1，上端が 11[m/s2]）を表す。グラフのｔ（ワールド時間）

方向の範囲は-1~11[s]であるが，実際にデータ（線）が描かれているのは 0～10[s]の範囲である。

　図 1.6 の前モデルでは，無重力状態で物体に速度の初期値 1)0( =xv  [m/s]を与えたのであるから，
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図 1.8　Properties（属性）ウィンドウ

その後の速度は 1)( =tvx  [m/s]で一定である。従って，式（1.8）より 0)( =ta x  [m/s2]，また式（1.9）

より ttx =)(  [m]となり，これらの式は図が表している状態と一致している。最終的な位置，速度，

加速度の正確な値を知りたければ，この状態でモデル中のグラフ左上の矢印をあと２回クリックす

ると，グラフが値表示モードとなり，現在のワールド時間における値が表示される。もう一度矢印

をクリックすると，再びグラフ表示モードとなる。

　同様に，図 1.7 のモデルでは，無重力状態で物体に一定の加速度 0.2)( =ta x [m/s2]を継続して与

えるので，その後の速度は式（1.10）より ttv x 2.0)( =  [m/s]，位置は式（1.9）より 21.0)( ttx =  [m]

となり，これらの式は，やはり図が表している状態と一致している。

演習　　　力学モデル m1_5_tikaradego.wmをロードし，X-Force（x方向の力）とKinetic Friction

（動摩擦）の２つのスライダーを操作して電車を制御し，椅子に座っているお客を落とさないよう

に，錨マークと終点の間に安全に止めよ。時間制限は 10 秒（グラフの t軸の範囲内）とする。グラ

フの最終時刻において，速度と加速度がともに 0 となっていることを確認すること。

　ただし，Start，Stop，Reset/Start Here（リセット後，再び始めから計算をスタートする：図や

軌跡も書き直す）などはWorld（ワールド）中のボタンを使用すること。

1.6　回転運動のシミュレーション（等速円運動）(A)

　m1_6_1 は，Body（物体）の等速円運動をシミュレートする。この力学モデルの「ワールド初期
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設定」を表 1.3 に，またこのモデルを Run により実行し，停止した直後の状態を図 1.9 に示す。

　この力学モデルはMotor（モータ）を用い，Background（バックグラウンド）をベースとしてCircle

（円形）と Rectangle（矩形）の接続よりなる Body（物体）を等速回転させる。

表 1.3　力学モデル m1_6_1 のワールド初期設定

力学モデル・ファイル名 m1_6_1.wm
目的・機能 Body（物体）の等速円運動

Gravity（重力） None（無重力）

Stop when（終了条件） time >= 10.0
XY Axes（XY 座標軸） On

　この例では，Circle（円形）の中心点も等速円運動をするが，その速度（図では Vで表されてい

る）は軌跡円の半径方向に垂直，すなわち軌跡円の接線（円周）方向で一定，加速度（図ではAで

表されている）は軌跡円の中心方向で一定であることが分かる。

　図より分かるように，Circle（円形）の中心は，座標(0, 0)[m]を中心に，半径 3=r [ｍ]の円周上

　　　　　　　　　　　　　　図 1.9　等速円運動に関する実験
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を一定の角速度 1=ω [rad/s]で左方向（正）に回転する。更に，図 1.9 の左上のグラフより，回転

の角度（振動の問題ではこれを位相と呼ぶ）φ  [rad]に関し，

　　　　　　　　　　　      角度　 tt ωφ =)(  [ r a d ]                                 （1.11）

　　　　　　　　　　　　　角速度　 ωφ =)(tv  [ r a d / s ]                                 （1.12）

　　　　　　　　　　　　角加速度　 0)( =taφ  [rad/s2]                                 （1.13）

の関係があり，回転角度についても 1.5 節の式（1.7）~（1.10）の )(tx , )(tvx , )(tax と同様の関係

が成り立つことが確認できる。なお，式（1.11）では 0=t のときの初期角度は 0[rad]である。

　次に図 1.9 の左下のグラフにより確認できるように，Circle（円形）の中心位置 ),( yx に関し，

半径 r ，角速度ω が一定の等速円運動（初期角度 0）において，円周上の一点 ),( yx の座標値は，
　　　　　　　　　　            trx ωcos=                                       （1.14）

　　　　　　　　　　            try ωsin=                                       （1.15）

と表せる。さらに，図 1.9 の右上，および右下のグラフより，Circle（円形）の中心位置に関して，

半径 r ，角速度ω が一定の等速円運動（初期角度 0）において，円周上の一点 ),( yx の速度

),( yx vv および加速度 ),( yx aa は，

  　 　　　　　　　            trvx ωω sin−=                                    （1.16）

  　 　　　　　　　            trv y ωω cos=                                     （1.17）

  　 　　　　　　　            trax ωω cos2−=                                  （1.18）

  　 　　　　　　　            tra y ωω sin2−=                                   （1.19）

となることが確認できる。ここで，式（1.14）,（1.16）および（1.18），あるいは式（1.15）,（1.17）

および（1.19）はそれぞれ，1.5 節の式（1.7）~（1.10）の )(tx , )(tvx , )(tax と同様の関係にある。

　また，グラフには次のような速度と加速度の絶対値も表示されている。

半径 r ，角速度ω の等速円運動において，円周上の一点 ),( yx の速度および加速度の絶対値は

                              ωrvvv yx =+= 22||                                （1.20）

                              222|| ωraaa yx =+=                               （1.21）

これらは一定の値である。なお，速度も加速度もベクトルであるが，その方向に関しても図1.9の

中のベクトルで確認できる。次の節ではより一般的な現象から，再び等速円運動に戻って説明する。

1.7　Reference frame（基準フレーム）の変更（等速でない円運動）(B)

　m1_7_1 は，「等速でない」円運動をシミュレートする力学モデルである。この力学モデルの「ワ

ールド初期設定」を表 1.4 に，またこの力学モデルを実行し，停止した直後の状態を図 1.10 に示す。

　　　　　　　　　　　表 1.4　力学モデル m1_7_1 のワールド初期設定

力学モデル・ファイル名 m1_7_1.wm
目的・機能 Body（物体）の不等速円運動

Gravity（重力） None（無重力）

Stop when（終了条件） Time >= 10.0
XY Axes（XY 座標軸） On
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　　　　　　　　　　　　図 1.10　等速でない円運動に関する実験

　この力学モデルは前節の m1_6_1と同様に Motor（モータ）を用い，Background（バックグラウン

ド）をベースとしてCircle（円形）と Rectangle（矩形）の接続よりなる Body（物体）を回転させ

るが，角速度は t12.0=ω [rad/s]と，時間に比例して大きくなるように設定されている。

　なお，この力学モデル（m1_7_1）が前の力学モデル（m1_6_1）と大きく異なるのは，Reference

frame（基準フレーム）のとり方である。Working Model 2Dでは，

シミュレーションの過程を表示するためのReference frame（基準フレーム）（＝基準となる座標系）

を，移動する物体の質量中心に変更することができる。

前の力学モデル（m1_6_1）では Reference frame（基準フレーム）が Background（バックグラン

ド）（＝Home）となっているが，この力学モデル（m1_7_1）では，それがCircle（円形）の中心に

設定されている。その位置に目の形が表示されていることが分かる（表示させないこともできる）。

　この場合，Reference frame（基準フレーム）が設定されている物体はシミュレーション実行中

動かず，相対的に周りの景色（具体的にはｘｙ座標軸）が動く（この場合は回転する）。結果的に，

Circle（円形）の中心位置における速度（v）と加速度（a ）のベクトルが実行中どのように増大
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するか，注意して観察することができる。

　図 1.10 の左上のグラフより，回転角度に関し，

　　　　　　      角度　   206.0)( ttt == ωφ   　　   [ rad]   　　　 　　　　　     （1.22）

　　　　　　     角速度   t
dt
d

tv 12.0)( === ωφφ     [ rad /s ]      　　　　　        （1.23）

　　　　　     角加速度 　  12.0)( == φφ v
dt
d

ta  　　　 [rad/s2]                       （1.24）

となることが確認できる（初期角度 0）。これらについても当然 1.5 節の式（1.7）~（1.10）の

)(tx , )(tvx , )(tax と同様の関係が成り立つ。

　実行結果で重要なのは，Circle（円形）の質量中心の速度（図では V で表されている）は半径方

向に垂直で軌跡円の接線方向（円周方向）となり，その方向が等速円運動のときと同じであるが，

加速度（図では A で表されている）は軌跡円の中心方向ではないことである。

一般に，ある経路上を運動する物体の速度ベクトルv [m/s]は

　　　　　　　　　　　　　　　         τrr
vv =                                     （1.25）

となり，その経路の接線方向（単位ベクトルをτr とする）を向き，大きさvは経路の基準点からの

距離 sの時間による微分，すなわち

　　　　　　　　　　　　　　　        
t
s

v
d
d

=                                      （1.26）

に等しい。またその物体の加速度ベクトルa
r

[m/s2]は，接線方向加速度 τa [m/s2]と法線方向（単位ベ

クトルをn
r
とする）加速度 na [m/s2]の和，

　　　　　　　　　　　　　           naaa n
rrr += ττ                                （1.27）

で表すことができ，それぞれの方向の加速度は，

　　　　　　　　　　　　　　          
t
v

a
d
d

=τ               　                    （1.28）

　　　　　　　　　　　　　　          
ρ
12van =                                   （1.29）

で表される 1)。ただし，ρ[m]は経路のその位置における曲率半径（経路が円の場合は半径そのもの）

である。

　これらの式を，今までのモデルに当てはめてみよう。前節の等速円運動（m1_6_1）では，

　　　　　　　　　　　　　　　 rttrrs =×== 1φ   [ m ]                             （1.30）
となり，

　　　　　　　　　　　　　　　   3
d
d

=== r
t
s

v   [ m / s ]                            （1.31）

　　　　　　　　　　　　　　　  0
d
d

==
t
v

aτ      [m/s2]                           （1.32）

　　　　　　　　　　　　　　    3
12 ==
ρ

van     [m/s2]                            （1.33）

                                                
1) 大沼　甫 他：基礎から学ぶ物理学（培風間）,第２章
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　したがって，

　　　　　　　　　　　　　　　　　 τ
rr 3=v   [ m / s ]                                 （1.34）

　　　　　　　　　　　　　　　　　 na rr 3=   [m/s2]                                （1.35）

となり，速度は軌跡円の接線方向，加速度は軌跡円の法線方向（円の中心方向）を向いている。

　次に本節の不等速円運動（m1_7_1）では，

　　                2

0
06.0d12.0 rtttrrs

t
=×== ∫φ   [ m ]                          （1.36）

となり，

　　　　　　　　　　　 trt
t
s

v 36.012.0
d
d

===   [ m / s ]                              （1.37）

　　　　　　　　　　　　　 36.0
d
d

==
t
v

aτ   [m/s2]                                  （1.38）

　　　　　　　　　　　  22 0432.0
1

tvan ==
ρ

  [m/s2]                               （1.39）

　したがって，

　　　　　　　　　　　　　　 τ
rr tv 36.0=   [ m / s ]                                     （1.40）

　　　　　　　　　　    nta rrr 20432.036.0 += τ   [m/s2]                             （1.41）

となり，速度（1.40）は接線方向であるが，その絶対値は tに比例して大きくなる。図 1.10 の状態

において，右上のグラフの矢印を２回クリックして数値を確かめると， 6.3|| =vr [m/s]となり，式

（1.40）に 10=t  [s]を代入したときの絶対値と一致する。

　加速度（1.41）については接線方向成分は一定値，法線方向成分は 2t に比例する式となり，等速

円運動とは異なり接線方向成分も存在することが分かる。図 1.10 の右下のグラフの矢印を２回クリ

ックして数値を確かめると， 335.4|| =ar [m/s2]となり，式（1.41）に 10=t  [s]を代入したときの絶

対値と一致することが確認できる。

1.8　ベクトルのつり合い（力のつり合い）(A)

　m1_8_1 は，力ベクトルのつり合いをシミュレートする。この力学モデルの「ワールド初期設定」

を表 1.5 に，またこのモデルを実行開始した直後の状態を図 1.11 に示す。

　この力学モデルは，透明な Rectangle（矩形）に重なって摺動する（すべる）Circle（円形）（質

量3.142[kg]）の動きを，摺動する方向に作用させる Force（力）（最大 40[N]）により制御しよう

とするものである。Circle（円形）が Rectangle（矩形）と重なっているにもかかわらず，その上

を摺動（しゅうどう：滑らせること）できるのは，Rectangle（矩形）には Slot joint（溝型摺動

ジョイント）が設置されており，Circle（円形）がその上を摺動できるように接続されているから

である。

　なお Rectangle（矩形）は，Reset 後の初期状態において，透明な部分をマウスによりドラッグ

することにより，点（0, 0）を中心に回転させることができる。また Force（力）は，実行中に画
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面下のスライダーにより制御することができる。

　また今までの力学モデルとは異なり，Gravity（重力）を Vertical（鉛直方向）としたため，と

くに制御しなければ Circle（円形）が Slot joint（溝型摺動ジョイント）に沿って斜め下へ落ち

てしまう。また摩擦力など，何らかの抵抗がなければ動きがいつまでも収束しないので，ここでは

Standard（標準）のAir Resistance（空気抵抗）を導入し，その粘性抵抗によってその問題を解決

している。

表 1.5　力学モデル m1_8_1 のワールド初期設定

力学モデル・ファイル名 m1_8_1.wm
目的・機能 力ベクトルのつり合い

Gravity（重力） Vertical（鉛直方向）

Air Resistance（空気抵抗）Standard（標準）

Stop when（終了条件） Time >= 100.0
XY Axes（XY 座標軸） On
Grid Lines（グリッド線） On

　　　　　　　　　　　　図 1.11　ベクトルのつり合いに関する実験
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　読者は実行中，Circle（円形）を静止させておくようにスライダーを調整すること。その際，図

中右上の Circle（円形）の速さの絶対値 || v が参考になる。空気抵抗は粘性なので速さに比例する。

スライダーの分解能は最大 100で，この例では40[N]までの力を0.4[N]の精度で制御しているが，

若干の不つり合いは残ってしまう。従って図のように || v の値が0.02[m/s]程度に小さくなれば，つ

り合い実験成功ということにしよう。

　この力学モデルで表示される力のベクトルは，簡潔に表現すると，Circle（円形）の中心に作用

する重力
GF

r
（鉛直下向きの赤い FG），斜面抗力

NF
r
（右上向きの赤い FT），および動きを制御する

力
CF
r
（左上向きの赤い FT）の３力である。このうち，

GF
r
は鉛直下向きに作用する重力で，この例

の場合 30.779.83.142 =×  [N]で固定している。この力学モデルでは，作用する３つの力がつり合

って Circle（円形）が動かないとき，

　　　　　　　　　　　　　　　 0=++ CNG FFF
rrr

                                    （1.42）

となり，それぞれのベクトルのx軸方向成分の和，あるいは y 軸方向成分の和は，

　　　　　　　　　　　　　　　 0=++ xCxNxG FFF                                    （1.43）

　　　　　　　　　　　　　　　 0=++ yCyNyG FFF                                    （1.44）

となる。このことは図 1.11 のように，つり合っている状態のベクトルの図により確認することがで

きる。このような性質はベクトルの基本性質といえるが，2 章の 2.1 でまとめて整理する。

詳細　　　『Circle（円形）の中心に作用する斜面抗力
NF

r
』と書いたが，実はこれは Keyed Slot joint（回転不能

溝型摺動ジョイント）が他に作用する力である。Working Model 2Dの現在の版では，ある物体が Keyed Slot joint

（回転不能溝型摺動ジョイント）や Slot joint（溝型摺動ジョイント）から受ける力をベクトルで表示することは

できない。しかし逆に，この例のようにこれらの Slot joint（溝型摺動ジョイント）系の規則が他の物体に及ぼす

力を表示することができるので，それに替えることができる。ただし，その副産物として，透明な Rectangle（矩形）

の上端から左下に出ている赤いベクトル FT も表示されているが，これは，この Keyed Slot joint（回転不能溝型

摺動ジョイント）が他（具体的に，その溝型摺動ジョイントの裏に存在し，その点でその溝型摺動ジョイントに接

続する透明な Rectangle（矩形））に与えるもう一方の力なのである。

　この力学モデルではまた，これらの力のつり合いがとれずに摺動速度が大きくなると，その動き

の反対向きに空気抵抗
AF

r
（赤い FAir）が出現する。その場合の運動方程式は，

　　　　　　　　　　　　　　 α
rrrrr

mFFFF ACNG =+++                                  （1.45）

となる。ただしm は Circle（円形）の質量，α
r
は Circle（円形）の加速度ベクトルである。

演習　　　Reset 後に，透明な Rectangle（矩形）の適当な場所を上下にドラッグすることにより，

（0, 0）を中心としてその透明な Rectangle（矩形）に適当な角度を付けることができるので，角度

を変更した新たな状態で再びつり合い実験を試みよ。

1.9　ベクトルのスカラー積（力のなす仕事）(A)

　m1_9_1 は，『着力点が直線運動をする力』がなす仕事をシミュレートする力学モデルである。こ

の力学モデルでは，力がなす仕事をDamper（ダンパー）に消費させるが，逆に Damper（ダンパー）
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のなす仕事を計測することによって力のなす仕事を計測する。この力学モデルの「ワールド初期設

定」を表 1.6 に，またこの力学モデルを実行し７秒後に一時停止したときの状態を図 1.12 に示す。

　この例では，質量が 0.1=m  [kg]の Circle（円形）が，Damper（ダンパー）によって抗力を受け

つつ，Slot Joint（溝型摺動ジョイント）により，水平方向へ摺動できるようになっている。この

Circle（円形）の中心に，任意の力ベクトル f
r
（力学モデルでは赤色 FT）を作用させ，その力が

なす仕事を Damper（ダンパー）が消費する。ここで使用した Damper（ダンパー）の特性は，Damper

（ダンパー）に作用する力を f [N]，Damper（ダンパー）が伸縮する速さを v [m/s]とすると，

vvDf 10== [N]で表せる。係数Dをダンパー係数と呼ぶが、この場合、 10=D  [Ns/m]である。

表 1.6　力学モデル m1_9_1 のワールド初期設定

力学モデル・ファイル名 m1_9_1.wm
目的・機能 エネルギーの消費，およびベク

トルのスカラー積の実験

Gravity（重力） None（無重力）
Pause when（一時停止条件） time >= 7.0
Stop when（終了条件） time >= 8.0
XY Axes（XY 座標軸） On
Grid Lines（グリッド線） On

　図1.13には，Circle（円形）の速度v
r

[m/s]（力学モデルでは青色 V）と 1 秒間に Damper（ダン

パー）のなす仕事（すなわちダンパーの仕事率）w [W]がグラフに表示される。速度v
r
は x軸方向

が正であるが，仕事率wは，Damper（ダンパー）が他に仕事をなすとき正の値をとる。従って，逆

に Damper（ダンパー）が他から与えられるエネルギー（仕事）を消費するとき、グラフには負の値

が示される。

　図 1.13 には力ベクトル f
r
と速度ベクトルv

r
が表示されているが，動作開始 7 秒後のこの時点では

v
r
の大きさは十分一定となっているので，ベクトルv

r
は，次の 1 秒間に Circle（円形）が進む変位

ベクトルと考えることもできる。

　従ってここで，

　　　　　　　　　　　　　　　　 vfw
rr

･=                                     （1.46）

に示す f
r
とv

r
のスカラー積 wは，その 1 秒間に力がなす仕事w [J]を表す。ここに単位をジュール[J]

としたが，1 秒間当たりの仕事であることからワット[J/s] =[W]と考えることもできる。仕事率であ

れば，図中の下のグラフPower of Damper（ダンパーの仕事率）[W] により，力がなす 1 秒間当た

りの仕事を調べ，比較することができる。

詳細(B)　　　右図に模式的なダンパーの構造を示す。流体が詰まった筒の中を，穴の

空いたシリンダー（固体）が進もうとし，流体の粘性抵抗（乾性摩擦ではない）を受

ける。その結果，伸縮の速度に比例する抗力を発生する。ただし伸縮速度や個々のダ

ンパーの性質によっては，その他の特性を示すこともある。一般に制振器として振動

のエネルギーを吸収するために用いられる。この節では，一定の力で物体を等速に運

動させるための（調速用の）抵抗として用いている。

　第 2 章の 2.3.2 に流体の抵抗について詳しい記述がある。

図 1.12　ダンパー
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　　　　　　　　　　　図 1.13　ベクトルのスカラー積に関する実験

　実際に，図 1.13 の状態で，力ベクトルの絶対値は，スライダーに始めから設定されている値より，

　　　　　　　　　　　　　　 88.10|| =f
r

　[N]

であり，さらに力ベクトルの向きはx軸からの方向が θ=45°である。また上のグラフの矢印を 2

回クリックすると，速度ベクトルの最終的な絶対値は，

　　　　　　　　　　　　　　 769.0|| =vr [m/s]

であることが分かり，力ベクトルと速度ベクトルのスカラー積は，

　　　　　　　　　　　　　　 917.545cos|||| =°= vfw
rr

 [W]

と計算できる。

一般に，２つのベクトル f
r
およびv

r
のスカラー積（内積）はスカラー量で，

　　　　　　　　　　　　 θcos|||| vfvfw rrrr
== ･                                     （1.47）

の値を持つ。θ は f
r
からv

r
への角度である。

　図 1_13 の下のグラフの矢印を 2 回クリックして現れる，Damper（ダンパー）が 1 秒間に消費し

た仕事（仕事率）は，

　　　　　　　　　　　　　　 917.5|| =w 　[W]

であり，先程の計算値と同じであることが確認できる。

詳細(B)　　　Circle（円形）の最終的な速度が一定値になることは次のようにして示される。

　まず Damper（ダンパー）の伸縮速さと作用する力は比例するので，この系のx 軸方向の運動方程式は，
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　　　　　　　　　　　　　 xmxDf &&&
r

=−θcos||                                       （1.48）

　　　　　　すなわち　　　 vmDvf &
r

=−θcos||                                       （1.49）

となる。今， 2/2/ πθπ <<− の範囲では，

　　　　　　　　　　　　　 0cos|| >θf
r

                                            （1.50）

となり，式は，

　　　　　　　　　　　　　 0)/( =+=−+=−+ aVVabvavbavv &&&                     （1.51）

となる。ただし， mDa /=  および mfb /)cos|(| θ
r

=  はいずれも正であり，

　　　　　　　　　　　　　 abvV /−=                                             （1.52）

と置いた。(1.51) の最後の方程式を積分して

　　　　　　　　　　　　　 catV +−=||ln                                         （1.53）

したがって，

　　　　　　　　　　　　　
tacta CeeV −+− =±=     　                               （1.54）

つまり，

　　　　　　　 aebabCev tata /)1(/ −− −=+= 　（t = 0 のとき 0=v より）          （1.55）

これはｔが十分大きいとき，

　　　　　　　　　　　　 Dfabv /)cos|(|/ θ
r

=≈                                     （1.56）

となり，図 1.13 の状況では 769.0≈v  [m/s] となるので，Circle（円形）の最終的な速さを理論的にも確認する

ことができた。

演習　　　上記の力ベクトル f
r
に関し，力学モデル左側の２つのスライダーによって，その

Magnitude（大きさ）とDirection（方向）を変化させることができるので，いろいろな状況で実験

してみること。

1.10　ベクトル積（力のモーメント）(B)

　m1_10_1 は，『着力点が円運動をする力』がなす仕事をシミュレートする力学モデルである。こ

の力学モデルでは，力がなす仕事を Rotational Damper（回転ダンパー）に消費させるが，逆に

Rotational Damper（回転ダンパー）のなす仕事を計測することによって力のなす仕事を計測する。

この力学モデルの「ワールド初期設定」を表 1.7 に，またこのモデルを実行し 20 秒後に停止した

ときの状態を図 1.14 に示す。

　この例では，質量 0.1=m [kg]（慣性モーメントは 667.1=F [kgm2]）の Rectangle（矩形）が，

Background（バックグラウンド）と接続されたRotational Damper（回転ダンパー）によって回転

表 1.7　力学モデル m1_10_1 のワールド初期設定

力学モデル・ファイル名 m1_10_1.wm
目的・機能 回転エネルギーの消費，および

ベクトル積の実験

Gravity（重力） None（無重力）

Stop when（終了条件） time >= 20.0
XY Axes（XY 座標軸） On
Grid Lines（グリッド線）On
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　　　　　　　　　　　　　　図 1.14　ベクトル積に関する実験

の抵抗を受けつつ，点 O（0, 0）の回りを回転できるようになっている。この Rectangle（矩形）上

の点 Q（1,  0）に，着力点とともに回転する力ベクトル f
r
（力学モデルでは赤色）を作用させ，そ

の力がなす仕事を Rotational Damper（回転ダンパー）が消費する。ここで使用した Rotational

Damper（回転ダンパー）の特性は，作用する力のモーメントをn [Nm]，回転の角速度をω [rad/s]

とすると， ωω 10' == Dn で表せる。係数 'D を回転ダンパー係数と呼ぶが、この場合、

10'=D [Nms/rad]である。

　図 1.14 の右側には，Rectangle（矩形）の角速度ω ，Rotational Damper（回転ダンパー）が伝

達する Torque（モーメント）n
r
（左回り正），およびRotational Damper（回転ダンパー）のなす仕

事率 wが上から順にグラフ表示されている。角速度ω は左回りが正であるが，仕事率wは回転の方

向にかかわらず，Rotational Damper（回転ダンパー）が 1 秒間になす仕事が正の量で示される。

従って，逆に Rotational Damper（回転ダンパー）が 1 秒間に消費したエネルギー（仕事）はマイ

ナスの値で示される。

O

Q
θ

f     r
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　図 1.14 には力ベクトル f
r
（赤色）と，補助的に位置ベクトル OQr =

r
（実験後に記入：黒色）が

表示されているが，このとき，

　　　　　　　　　　　　　　　　　　 frn
rrr

×=                                     （1.57）

のようにr
r
と f

r
のベクトル積が Torque（モーメント）n

r
を表し，

　　　　　　　　　　　　　　  　  θsin|||| frn
rrr

=                                 （1.58）

で表せる。

一般に，２つのベクトルr
r
および f

r
のベクトル積（外積） frn

rrr
×= はベクトル量で，

　　　　　　　　　　　　　　　 θsin|||| frn
rrr

=                                     （1.59）

と表せる。ここでθ は r
r
から f

r
への角度であり，ベクトル積の向きはr

r
と f

r
を含む面に垂直であり，

その方向は，r
r
の方向から f

r
の方向に右ねじを回したときにその右ねじが進む方向である。

　図 1.14 の例では， 1|| =rr [m]， 879.10|| =f
r

[N] および °= 45θ  なので， 69.7=n
r

[Nm] となり，

Body（物体）から回転ダンパーは正のトルクが作用している。図の真中のグラフは回転ダンパーが

Body(物体）に作用するトルクとして負の値が記録されている。その最終的な値は、図の中央のグ

ラフの矢印を 2 回クリックして表示される数値の絶対値と同じ値となり，式を理論的に確認するこ

とができる。

　次に，Rotational Damper（回転ダンパー）が 1 秒間に消費するエネルギー（仕事）は，

　　　　　　　　　　　　　　　　 ||nw r
ω=  [ W ]                                     （1.60）

であり，この例では，上のグラフの矢印を 2 回クリックして表示される数値 769.0=ω [rad/s]を

代入して 917.5=w [W] となるが，これは，図の下のグラフの矢印を 2 回クリックして表示され

る数値の絶対値と同じ値となり，式を理論的に確認することができる。

詳細　　　この力学モデルも，前の m1_9_1 と同様に，図の上のグラフのように定常回転角速度になることは次の

ようにして確認できる。まず Rotational Damper（回転ダンパー）の回転角速度 φω &=  と作用するトルクn
r
は比

例するので，この系の左回りの回転の運動方程式は，

　　　　　　　　　　　　　　　　 φφθ &&&
rr

FDfr =− 'sin||||                                     　　（1.61）

　　　　　　　　すなわち　　　　 ωωθ &
rr

FDfr =− 'sin||||                                     　　（1.62）

となる。ただし， 667.1=F [Nms2/rad]（あるいは[kgm2]） は Rectangle（矩形）の慣性モーメントである。

　今， πθ <<0  の範囲では，

　　　　　　　　　　　　 0sin|||| >θfr
rr

                                    （1.63）

となり， FDa /'' =  および Ffrb /)sin|||(|' θ
rr

=  とすれば式（1.53）～（1.56）と全く同じようにして，ｔが

十分大きいとき，

　　　　　　　　　　　　 '/)sin|||(|'/' Dfrab θω
rr

=≈                                 （1.64）

となり，図 1.14 の状況では 769.0≈ω  [rad/s] となるので，Rectangle（矩形）の最終的な角速度を理論的にも

確認することができた。なお，角度の単位 [rad] は無次元であり，上記の単位標記において[1]（1は数字のイチ）

と置き換えてもよい。

演習　　　上記の力ベクトル f
r
は，Reset 時にそれをダブルクリックして表れる Properties（属性）

ウィンドウによって，その Magnitude（大きさ）とDirection（方向）を直接キー入力して（座標系

ラジオボタンが Polar（極座標）になっている必要がある）変化させることができるので，いろい

ろな状況を作り，実験してみること。
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　「力学って？」　　　　　　　　　　

Coffee Break 1

いろいろと勉強してきたところで，ちょっと一服。この Coffee Break では，力学の中で当たり前のように思

われていることをもう一度見直してみようと思います。勉強に疲れたところで，ちょっと寄り道し

てシミュレーションをやりながら気楽に眺めてみてください。数学に没頭する余り，時々何のため

にやっているのかわからなくなっていませんか？原点に立ち返って頭の中を整理してみようとい

うのが Coffee Break のねらいです。

さて最初は「力学って？」一体どんなものなのかを簡単にまとめてみましょう。力学とは，一言

で言うと「力によって物体の位置が，時間と共にどのように変化していくかを理解するための学問」

ということになろうかと思います。したがって，力学において考える要素としては，

1) 物体：質量 mをもちます。力学では一般に以下の３種類を考えます。

　　　　　質点（質量をもつが大きさ，形がないもの；現実的ではないけれど取り扱いが簡単）

　　　　　質点系（多くの質点が集まったもの；現実の物体を扱うための前段階）

　　　　　剛体（無数の質点が集まったもので変形しないもの；現実の物体に近い）

2) 力  
r 
F （物体に働く力）

3) 位置  
r 
r （物体の位置）

4) 時間 t

の４つが考えられます。

　これら物体の質量 m，力  
r 
F ，位置  

r 
r ，時間 tを用いて，「力によって物体の位置が，時間と共にど

のように変化していくかを理解する」ために運動方程式を解くというのが力学の流れです。ただそ

れだけのことです。力学が苦手なあなた，力学ってそんなに難しく考えなくても良いんですよ。力

学モデル mc 1 rikigakutte1.wmでは力 F=0，mc 1 rikigakutte2.wmでは力 F=F0（一定），mc 1

rikigakutte3.wmでは力 F=mg の場合について「力によって物体の位置が，時間と共にどのように

変化していくか」を示しています。気分転換にやってみてください。
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第2章 質点の力学

　物体の運動は一般に，並進・回転・変形の３つの運動が合わさったものである。特に，物体の並

進運動を考える場合には，物体の大きさや形を無視して１つの点で代表させて，物体の運動をその

点の運動に置き換えて考えることができる。そのような点を質点という。この章では，ガリレイや

ニュートンにより基礎が築かれ，その後多くの物理学者や数学者によって発展させられた力学の基

本である運動の３法則を示し，１つの質点の様々な運動やつりあいの状態を取り上げ，それらを運

動の３法則に基づいて考える。

2.1 運動の法則

2.1.1 運動の３法則 (A)

運動の第１法則（慣性の法則）

　すべての物体は，外力によりその状態を変えられない限り，その静止の状態あるいは一直線上の
一様な運動の状態を，そのまま続ける。

　外から何の力も受けていない物体は，それが持つ速度をそのまま保持しようとする性質を持つ。

この性質を慣性という。また，このような条件にかなう座標系を慣性系という。すなわち，「外力

を受けていない質点の運動が静止もしくは等速直線運動になるように座標系を設定せよ」といって

いるとも解釈できる。

　また，逆に運動の状態に何らかの変化があったとすれば，外力が必ず働いていなければならない。

そして，外力が加えられると運動がどのように変化するかが次の第２法則で述べられている。

運動の第２法則（運動の法則）

　運動の変化は，およぼされる力に比例し，その力がおよぼされる直線の方向に行われる。

　時間をt (単位は[s]，以下，単位を[  ]で示す)，物体の質量をm [kg]，位置ベクトルをrr [m]，力を

F
r

[N=kg･m/s2]とすると，運動の第２法則は次のような式で表すことができる。

2

2

d
d

r
F m

t
mr

=

=

rr

r&&
(2.1)

ここで 2 2d da r t r= =
r r r&& [m/s2]は加速度であり，また， d dv r t r= =

r r r& [m/s]は速度である。この式(2.1)を

ニュートンの運動方程式という。
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　上記の位置，速度，力などはベクトルで表記されているが，座標系を決めることにより，その成

分で表すことができる。座標系には，直交座標系，円筒座標系，極座標系などがある。

　直交座標( , ,x y z )を用いると，速度vr ，加速度ar および運動方程式の各成分は次のように表される。

, ,

, ,

, ,

x y z

x y z

x y z

v x v y v z

a x a y a z

F mx F my F mz

= = =

= = =

= = =

& & &

&& && &&

&& && &&

(2.2)

図 2.1(a)　円筒座標系　　　　　　　　　　図 2.1(b)　極座標系

図 2.1(a)に示す円筒座標( , ,r zθ )は，直交座標( , ,x y z )と次の関係

cos , sin ,x r y r z zθ θ= = = (2.3)

がり，円筒座標での速度vr および加速度ar の各成分は次のように表される。

2 2

, ,

1 d
, 2 ( ),

d

r z

r z

v r v r v z

a r r a r r r a z
r t

θ

θ

θ

θ θ θ θ

= = =

= − = + = =

&& &

& && & &&& & &&
(2.4)

平面極座標( ,r θ )は，円筒座標で z =一定とすればよい。

図 2.1(b)に示す極座標( , ,r θ φ )は，直交座標( , ,x y z )と次の関係

cos cos , cos sin , sinx r y r zφ θ φ θ φ= = = (2.5)

があり，極座標での速度vr および加速度ar の各成分は次のように表される。

2 2 2 2

, cos ,

cos , cos 2 cos 2 sin , cos sin 2

r

r

v r v r v r

a r r r a r r r a r r r

θ φ

θ φ

θ φ φ

θ φ φ θ φ θ φ θφ φ φ θ φ φ φ

= = =

= − − = + − = + +

& &&

& & && & & & && & &&& & &
(2.6)

運動の第３法則（作用反作用の法則）

　質点１が質点２に力 12F
r
をおよぼしているときには，必ず同時に質点２は質点１に力をおよぼして

いる。その力を 21F
r
とすると，次式が成り立つ。

12 21F F= −
r r

(2.7)

y

z

x

O

θ
r

y

z

O

θ

r

φ
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2.1.2 運動量と角運動量 (A)

　質量m と速度vr との積を運動量[kg･m/s]とよぶ。

p mv=r r
(2.8)

この運動量を用いると，運動方程式(2.1)は次のように表すことができる。

d
d
pF
t

=
rr

(2.9)

　時刻 1t と 2t における運動量をそれぞれ 1pr ， 2pr とし，式(2.9)をt に関して， 1t から 2t まで積分する

と次式が得られる。

2

1
2 1d

t

t
F t p p= −∫
r r r

(2.10)

この式の左辺を力F
r
の 1t から 2t まで間の力積という。

式(2.10)は，「質点の運動量の変化はその間にした力の力積に等しい」ということを表している。

　位置 rr と力F
r
のベクトルの外積

N r F= ×
r rr

(2.11)

を力のモーメント[N･m]という。

また，運動量のモーメント

l r p= ×
r r r

(2.12)

を角運動量という。

この式を時間で微分すると

d d d
d d d
l r p

p r
t t t

= × + ×
r r r

r r
(2.13)

となるが，速度v dr dt=r r は運動量 pr に平行なので，左辺第１項はd d 0r t p× =r r となる。したがって，

式(2.13)は，式(2.9)，式(2.11)より，次式となる。

d d
d d
l p

r r F N
t t

= × = × =
r r r rr r

(2.14)

これは，「質点の角運動量の時間変化は，それに働いている力のモーメントに等しい」ということを

表している。

　質点に力が働いていないときや，働いていても位置rr と力 F
r
が平行であるときには，モーメント

N
r
は 0 になり，式(2.14)より，l =

r
一定となり，角運動量が保存されることがわかる。

2.2 力のつり合い (A)

　質点に２つ以上の力 ( )1,2,iF i =
r

L が働いているとき，これらの力を１つの力 i iF F= ∑
r r

で置き換え

ても，質点の運動は変わらない。

１つの質点に２つ以上の力が働いていて，それらの和が 0 であるとき，すなわち

0i
i

F F= =∑
r r

(2.15)
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のとき，質点の加速度は 0 であり，質点は静止しているか等速直線運動をする。このとき力はつり

合っているという。

演習　　　図 2.2のように，質量１[kg]の質点に２本の質量のない糸を取り付けて天井からつるす。

スライダーで質点の位置( , )x y を変化させ，２本の糸の張力がどのように変化するかを調べよう。な

お，この力学モデルでは，糸は Rod（棒）で作成してある。

表 2.1　力学モデル m2_2_turiai.wm のワールド初期設定

力学モデル・ファイル名 m2_2_turiai.wm
目的・機能 力のつり合い

Pause when（中断条件） Time > 1
XY Axes（XY 座標） On
Grid Lines（グリッド線）On

図 2.2　重力と張力のつり合い

　図 2.2のように鉛直方向と糸とのなす角をそれぞれ 1θ ， 2θ とし，糸の張力を 1T ， 2T として，水平

1θ 2θ
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方向および鉛直方向の力のつり合いを考えると次の式が得られる。

1 1 2 2

1 1 2 2

sin sin 0

cos cos

T T

T T m
θ θ

θ θ

− =

+ = g
(2.16)

この式を連立して解けば，張力 1T と 2T は，次のように求められる。

1 2 1 2 1 2

2 1 1 2 1 2

sin (sin cos cos sin )

sin (sin cos cos sin )

T m

T m
θ θ θ θ θ

θ θ θ θ θ

= +

= +

g

g
(2.17)

2.3 質点の運動

　この節では，運動の３法則に基づき，質点の様々な運動を見ていく。

2.3.1 等速直線運動 (A)

　まず，外力が全く働かない場合，すなわち， 0F =
r

の場合の１次元運動を考える。ニュートンの

運動方程式(2.1)は以下のようになる。

0mx =&& (2.18)

初期条件として， 0t = での位置と速度をそれぞれ 0x ， 0v として，式(2.18)を解くと，速度v と位置

x は以下のように求まる。

0v x v= =& (2.19)

0 0x x v t= + (2.20)

したがって，外力が全く働かない場合には，初速度 0 0v ≠ ならば，質点の速度は一定で，位置は時

間の１次関数となり，等速直線運動を行う。また 0 0v = ならば， 0v = で 0x x= となり，質点は静止

の状態である。このことは，運動の第１法則に符合している。

2.3.2 落体の運動 (A)

a.　ガリレイの考えたこと

　アリストテレス（及びその流派）によると物体の運動には自然的運動と強制的運動がある。前者

では物体が本来納まるべき低いところに帰っていくとの考えである。詳しい観察の結果重いものは

早く，軽いものは遅く一定の速度で落下すると主張する。この考えは古代から中世を通じての規範

であったが，これに異論を唱えひっくり返したのがガリレイである。落体の運動は観察するにはス

ローモーションビデオのない時代であるので早すぎる。ガリレイは本質を失うことなくスローモー

ションが実現される装置として斜面上での運動を考えた。なお，強制運動については落下以外の運

動において速度は力に比例するとするもので，不合理な点からインペートス（勢い）の概念を産み

最終的に運動量に収斂していく。

　さて，モデル m2_3_gal.wm を実行してみよう。モデルの初期設定は表 2.2 に示されている。そ

のままでは空気の抵抗を無視したものになっている。物体に働く力は

2 mgF −= (2.21)

である。軌跡は一定時間間隔の位置を表示しているが，位置の間隔は最初の間隔 1 に対して 3，5，

7，9，11，...，原点からは 1，4，9，16，25，36，...を記録していることが分かる。ガリレイは斜
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面上の 1，4，9，16，25，36 の位置に鈴を置きそれに羽根をつけ物体が通ったときに羽根を擦り鈴

がなるように工夫した（図 2.3 参照）。鈴は等間隔に「リン，リン，リン，...」と鳴るのである。観

衆は等しい時間間隔のうちに物体はそれぞれ 1，3，5，7，9，11，...の距離を移動することを見て

とり唸ることになる。「どうだ，俺の方が正しい，アリストテレスは間違いだ」と叫んだかどうか。

ガリレイは賑やかなことが好きだったようで，ピサの斜塔の上から物体を落とすという逸話を産ん

だのであるが，逸話であるからには信憑性に乏しい。左上には速度の時間依存性が示されている。

原点を通る直線であり，速度が時間に伴って大きくなっていることがわかる。もう１度ガリレイの

運動のシミュレーション実験をやってみて確認しておこう。

表 2.2

モデル名 m2_3_gal.wm
目的・機能 落体の運動
Gravity (重力) Vertical
Stop when (停止条件) time > 99
XY Axes (XY 座標) On
Grid Line (グリッド線) On

図 2.3

　b.　空気の抵抗を考慮すると

　地球表面近くには空気があり，物体の運動はその抵抗を受ける。2001 年 3 月に宇宙ステーション

「ミール」が地表に落下するというので大騒ぎであったが，この空気の抵抗による摩擦熱でかなり

の部分が燃焼消滅し一部が南太平洋上に落下した。空気の抵抗がなければあのでかい「ミール」が

そのまま「ドーン」と落ちてくることを想像するだに恐ろしい。

　実体に合うように空気の抵抗力を考慮しよう。Air Resistance のボタンをクリックし，Type の中
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から Standard（摩擦あり）を選択しよう（最後に OK をクリック）。この場合物体に働く力は

CvmgF −−= (2.22)

である。この場合運動はどうなるであろうか，シミュレーションを実行しよう。

　左上の速度変化は最初はだんだん早くなるのであるがそのうち摩擦力の効果が顕著に効いてきて

ついには速度一定になることを示している。そのときには重力と摩擦力が釣り合って一定速度とな

っている。この速度 ∞v は終端速度（または終速度）と呼ばれ，式  (2.22)から次のように得られる。

C
mgv −=∞ (2.23)

今のシミュレーションで終端速度をメモしておこう。次に物質の質量を変えてみよう。スライダー

を用いて先のものの２倍にしてみる。そうすると終端速度はどうなるであろうか。式(2.23)に示す

とおり，先のものの２倍になることを確かめられたことと思う。やや，これはアリストテレスの結

果ではないか。アリストテレスの方がやっぱり正しいのではないか！終端速度についていうとアリ

ストテレスの方が正しいと言えるかも知れない。なにしろ観測という事実に基づいているのである

から。しかし，アリストテレスでは今の問題で落下しはじめた初期の加速される部分は説明できな

い。図 2.4 に速度の模試図をしめす。初期過程はガリレイ（G）が合っており，最終過程はアリス

トテレス（A）が正しいように見える。しかし，落体の運動の本質は初期の加速される過程にある

のであって，空気の抵抗は次に考えるべき二義的なものなのである。理想化することによって問題

を鮮明にしておき基本法則を見いだす。そしてその後に現実に近づくように複雑な効果を考慮して

いく。これが物理学のやり方であるが，空気の抵抗を含む運動の全容解明にはニュートンを待たね

ばならない。

図 2.4

　c.　速度の２乗に比例する空気抵抗がある場合（終端速度）
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　空気の抵抗を考慮した先のシミュレーションは終端速度がそれほど速くない場合に対応する。そ

こでは式(2.22)に示されているように抵抗力は速度に比例している。しかし速度が大きくなると物

体の後方に渦を作るようになり，この場合には抵抗力は速度の２乗に比例することが知られている。

極めて遅い物体の運動においてもこの形の力が重要であるともいわれている。次におまけとしてこ

の問題をも取り扱ってみよう。Air Resistance のボタンをクリックし，High（抵抗が大きい場合）

を選択する。物体に働く力は次式で与えられる。
2vCmgF ’+−= (2.24)

シミュレーション結果では終端速度などの違いはあるが，質的に先の場合とそれほど違いはないの

ではなかろうか。なお ∞v は式 (2.24)より次のように得られる。

2
1









−=∞ ’C

mg
v (2.25)

演習（月面上での落下運動）　　　落体の運動の本質がガリレイにあることを理解するために月面

上での落下運動を考えてみる。力は式(2.1)と同じ形であるが，重力加速度 ’g が地球上のものg に

比べ，およそ 1/6 になっている。

’mgF −= (2.26)

モデル m2_3_tuki.wmを起動させ，スライダーでg の値を変えてシミュレーションを実行してみよ

う。重力加速度が小さいので運動は緩慢であるが，時間と共に早くなる点は地球上でのガリレイの

問題と同じであって，ここにガリレイが落体の運動の本質を捕らえたという点が確認できた。

2.3.3 放物運動 (A)

　a.　投げ上げ

　再びモデル m2_3_gal.wmを起動し Air Resistance のボタンをクリックし None（空気の抵抗が

ない場合）を選択してガリレイの運動を再度確認してみよう。次にモデル m2_3_nageage.wmでシ

ミュレーションを実行しよう(初期設定は表 2.3)。力は式(2.21)で与えられる。運動は，一旦上昇し

た物体は頂点に達しそこから落下を始める。頂点から後の落下する運動に注目すると，これはまさ

にガリレイの運動と同じであることに気付く。図 2.5 の左上挿入の速度図において矢印は vy = 0 を

示しており，頂点の位置に対応している。この時点以降からの速度の変化は 2.3.2a 節のものに一致

する。また頂点までの運動と頂点からの運動は時間の向きが逆であること以外は同じである。ガリ

レイの運動は投げ上げの問題に含まれることが分かる。

表 2.3

モデル名 m2_3_nageage.wm
目的・機能 投げ上げ運動
Gravity (重力) Vertical
Stop when (停止条件) Body[1].p.y < 0
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XY Axes (XY 座標) On
Grid Line (グリッド線) On

図 2.5

演習　　　スライダーでさまざまな初速度を選択してシミュレーションを実行してみよう。

b.　放物運動

　ガリレイが太陽中心説を主張したとき，そうだとすると地球はとんでもない早さで動いているの

だから，我々を含めあらゆる地球上の物体は振り落とされるという反論にあった。ガリレイは次の

ような例で答えた。大きな船のメインマストの上から物体を落とすとマストの真下に落ちる。あた

かも地上で落ちるごとくである。しかしこの運動を陸地から見ると，物体の運動はまっすぐ鉛直線

に添って運動するのでなく放物線を描く（図 2.6 参照）。落下に要する時間の間に船は少し前に進ん

でいるのである。この実験を船室の中でやったとしたら（窓のカーテンは締めておこう），運動は地

球上での如くであり船が動いていることすら気付かないであろう。この船の中にいる人間のように，

動いている地球上の人々は動いていることに気付かず，また運動も（運動法則も）動いていること

の影響を受けない（詳しくは 2.4.1 節参照）。
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図 2.6

表 2.4

モデル名 m2_3_houbutu.wm
目的・機能 放物運動
Gravity (重力) Vertical
Stop when (停止条件) Body[1].p.y < 0
XY Axes (XY 座標) On
Grid Line (グリッド線) On

　この船上での運動は陸地から見ると船の速度で物体を横方向に投げ出した問題と同じである。高

い位置から落とすのと投げ上げるのとでは同じであるので，これらの運動はすべて同類である。次

に地球上から角度θで投げ出す問題をシミュレートしてみよう。まず，モデル m2_3_houbutu.wm

の初期設定(表 2.4)どおり ? を 60 度（?1）にとって実行する。先に放物線と述べたが，そうなって

いるだろうか。着地点の座標をメモしておこう。次に 30 度（?2）で実行してみる。先の軌跡に比べ，

低空を飛ぶ放物線になっている。ところで着地点の座標 Lを先のものと比べてみよ。同じではない

か！では，65 度と 25 度ではどうか，55 度と 35 度ではどうか。このシミュレーションから ? 1+? 2 =

90 度の場合に飛行距離が等しいことが分かる。角度を 10 度，20 度，30 度，40 度，45 度，50 度，

60 度，70 度，80 度ととってシミュレーションを実行し，着地点を読取り，図 2.7 に書きこんでみ

よう。なおこのモデルでは角度として弧度法が用いられているので度(degree)との対応を表 2.5 に

示しておく。45 度(弧度法で 0.785)で最大であることが分かる。どの教科書にも到達距離として，

θ2cos

2
0

g
v

L = (2.27)

の式が書かれており，この式のθ依存性をシミュレーションで確認したことになる。



36

図 2.7

表 2.5

degree 10° 20° 30° 40° 45° 50° 60° 70° 80°
radian 0.1745 0.3491 0.5236 0.6981 0.7854 0.8727 1.0472 1.2217 1.3963

演習　　　ここで放物運動は落下運動の１種に過ぎないということを自覚させるモンキーハンティ

ング（猿の射撃）と呼ばれる有名な問題のシミュレーションをやってみよう。図 2.8 に示すように

猿がぶら下がっており，これを射撃する問題である。もし重力がなければ猿が手を放しても落ちな

いのだから，銃を猿に向けて(図の直線の方向)打てば当たることは間違いない。しかし，重力中で

も同じ狙いで猿が手を放すと同時に銃を発射すれば必ず当たる。シミュレーションで確認しよう

(m2_3_monkey.wm)。この間の時間を tとすると，落下距離は

2

2tg
x = (2.28)

であって，銃弾にも猿にも共通だから当たるのである。もちろんこの事情は g の値が違う環境にも

あてはまるのは言うまでもない。
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図 2.8

c.弾道学 (空気の抵抗)

　2.3.2 節で地球上では空気の抵抗があることを述べた。その意味で，前節の放物運動は理想的な場

合，または速度がそんなに大きくない場合に対応する。速度が大きくなると空気の抵抗の効果が顕

著になってきて，最大到達距離を得る角度は 45 度ではなくなる。現代の大型爆弾は地図を内蔵さ

せた自動操縦のようなものであるが，昔はそうはいかない。「戦争と平和」など，ナポレオン時代の

戦争シーンは大砲の嵐である。最大到達距離を得るにはどう打ち出せばいいか，遠距離になればさ

らに地球の自転なども考慮する必要が出てくる複雑な問題であって(2.4.2 節参照)，弾道学の名で知

られた重要な兵術であった。

　さて，ここでのシミュレーションでは再びモデル m2_3_houbutu.wm にもどり，AirResistance

で standard(摩擦あり)を選択する。速度（Circle 1 Speed）を一定にして，角度θを変えてみて L

のθ依存性を図 2.9 に書き込み，最大到達距離を求めてみよう。
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図 2.9

2.3.4 単振動と減衰振動

a.　単振動 (A)

　図 2.10(a)に示すように，物体に Spring（バネ）を付けて往復運動させる振動を取り扱う。バネ

の長さを自然長から変化させると，バネはその長さの変化に比例した復元力を出す。バネの変位を

x とすると，バネの復元力F は

F kx= − (2.29)

と表される。これをフックの法則といい，比例係数 0k > [N/m]はバネ定数と呼ばれる。

　物体の質量をm とし，摩擦が無いとすれば，物体の運動方程式は

mx kx= −&& (2.30)

となる。ここで

0 k mω = (2.31)

とおくと，運動方程式は次にように整理される。
2

0 0x xω+ =&& (2.32)

この微分方程式の一般解は，

0cos( )x a tω φ= + (2.33)

あるいは

1 0 2 0cos sinx C t C tω ω= + (2.34)

で与えられる。ここにa とφ または 1C と 2C は初期条件から決まる定数である。

　このような運動は単振動あるいは調和振動と呼ばれ，a は振幅，φ は初期位相と呼ばれる。また，

角振動数(または角周波数) 0ω [rad/s]は，初期条件とは無関係に質量m とバネ定数 k のみから一意的
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に決まるので，固有振動数と呼ばれる。このような固有振動で振動する運動，すなわち式(2.32)の

解となる運動を自由振動という。角振動数 0ω と１往復に要する時間である周期T [s]および１秒間の

往復回数である振動数(または周波数) f [Hz]との関係は以下のようになっている。

0

1 2
T

f
π

ω
= = (2.35)

　なお，バネを天井からつるすなどして上下に振動させる場合には，物体に働く重力を考えなけれ

ばならない。しかし，物体のつり合いの位置から変位をとれば，重力の影響が消えて式(2.30)と同

じ運動方程式になる。

演習　　　図 2.10(a)に単振動の力学モデルを示す。ワールド初期設定は表 2.6 の通りである。

BODY（物体）は，Keyed Slot Joint（回転不能溝型摺動ジョイント）で１次元運動に拘束してあ

る。スライダーでSpring（バネ）のバネ定数を変化させ，適当な初期値で離したときの振動の様子

や図 2.10(a)の右上にある位置・速度・加速度の時間変化のグラフを観察しなさい。

表 2.6　力学モデル m2_3_4_tansindo.wmのワールド初期設定

力学モデル・ファイル名 m2_3_4_tansindo.wm
目的・機能 単振動

Gravity（重力） None（無重力）

Pause when（中断条件） Time > 10
XY Axes（XY 座標） On
Grid Lines（グリッド線）On
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(a)　力学モデル

(b)　直列バネ　　　　　　　(c)　並列バネ１　　　　　　(d)　並列バネ２

図 2.10　単振動

　次に，バネ定数がそれぞれ 1k ， 2k である２つのバネが１つの質点に作用する場合を考える。図

2.10(b)のように片側で直列に配置したときのバネを直列バネ，図 2.10(c)のように片側で並列に配

置したときや，図 2.10(d)のように両側に配置したときのバネを並列バネと呼ぶ。系全体を１つの

等価バネ定数k で表すと，

直列バネでは，２つのバネに作用する力が等しいので，
1 2

1 1 1
k k k

= + 　となり，

並列バネでは，２つのバネの変位が等しいので，　　　 1 2k k k= +  　となる。

このことは各自確かめてみなさい。なお，Working Model 2D では，２つの Spring（バネ）を直接

接続することはできず，Body（物体）が間に必要となる。

1k 2k

2k

2k
1k

1k
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　これまでは，運動の様子や，位置・速度・加速度の時間変化のグラフを見てきたが，ここでは，

横軸に位置を，縦軸に速度をとった図で，位置と速度の関係を陽に観測してみる。これは位相平面

と呼ばれる。運動方程式(2.30)の解は，１つの初期条件が指定されると唯一に決まるので，時間t を

パラメータにして 0 から∞まで変化させると，位相平面上に１つの軌道ができる。そして，様々な

初期条件に対する軌道を描くことにより，運動の様子や特徴を調べることができる。図 2.10(a)の

右下のグラフに示すように，単振動の場合の軌道は初期条件を通り，原点を中心とする楕円となり，

いつまでも振動を続けることがよくわかる。なお，原点（ 0x x= =& ）に初期値をとると，解はいつ

までも原点に止まる。このような点を平衡点という。

b.　減衰振動 (B)

　実際のバネの振動は永遠に振動しているのではなく，必ず何らかの抵抗があって，振幅が徐々に

小さくなり，やがて振動しなくなってしまう。このような現象を減衰という。

　図 2.11 のようにバネと Damper（ダンパー，減衰器）を取り付けた物体の運動を考える。この

ダンパーは速度に比例する抵抗力R を発生するとする。すなわち，次の式で表されるとする。

R cx= − & (2.36)

比例係数 0c > [Ns/m]をダンパー係数と呼ぶ。運動方程式は

0mx cx kx+ + =&& & (2.37)

となる。ここで

0 ,
2

k c
m m

ω γ= = (2.38)

とおくと（ 0ς γ ω= を減衰係数と呼ぶことがある），次にように整理される。
2

02 0x x xγ ω+ + =&& & (2.39)

この微分方程式おいて，解の形を ptx e= とおいて式(2.39)に代入し， pte で割ると
22

02 0p pγ ω+ + = (2.40)

という特性方程式が得られる。

この p に関する２次方程式を解くと

22
0p γ γ ω= − ± − (2.41)

となる。上式の根号内の値により，一般解は次の３種類に分けられる。

(1) 0γ ω< の場合

　２根は共役複素根となり，実数の一般解は
22 2

0ω ω γ′ = − (2.42)

とおくと，次のようになる。

cos( )tx ae tγ ω φ− ′= + (2.43)

これは時間t が増すと，振幅が指数関数的に減少する減衰振動である。なお，式(2.42)よりわかるよ

うに，角振動数ω ′ も減衰のない単振動の場合の 0 k mω = より小さくなっている。
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(2) 0γ ω= の場合

　この場合の一般解は次のようになる。

1 2( ) tx C C t e γ−= + (2.44)

このような運動を臨界減衰といい，振動することなく滑らかに振幅が減衰する。

(3) 0γ ω> の場合

　式(2.41)の２根はどちらも負の実数であり，それらを 1p ， 2p とすると，一般解は

1 2
1 2

p t p tx C e C e− −= + (2.45)

で与えられる。この場合も振動することなく減衰していき，過減衰であるという。

演習　　　図 2.11 に減衰振動の力学モデルを示す。ワールド初期設定は表 2.7 の通りである。こ

のモデルは，単振動のモデルのSpring（バネ）が Spring Damper（バネ・ダンパー）に置き換わ

っただけである。スライダーでバネ定数やダンパー係数を変化させ，適当な初期値で離したときの

振動の様子や位置・速度・加速度の時間変化および位相平面図を観察しなさい。

表 2.7　力学モデル m2_3_4_gensuisindo.wmのワールド初期設定

力学モデル・ファイル名 m2_3_4_gensuisindo.wm
目的・機能 減衰振動

Gravity（重力） None（無重力）

Pause when（中断条件） Time > 10
XY Axes（XY 座標） On
Grid Lines（グリッド線）On
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図 2.11　減衰振動

　このような減衰振動では，速度・加速度の大きさは時間とともに小さくなり，定常位置に漸近す

る。また位相平面図をみると，様々な初期値から出発した軌道は原点に向かって収束していく様子

がわかる。ダンパーによりエネルギーを消耗し，運動が衰えていくからである。

　ところで，負のバネ定数を持つ場合や負のダンパー係数を持つ場合の運動はどのようになるであ

ろうか。それら負の係数を持つ実際の機械要素は無いが，シミュレータではそのような状況を簡単

に作り出すことができる。

演習　　　バネ定数やダンパー係数に負の値を設定し，シミュレーションしてみなさい。

　シミュレーション実験を行うと，位相平面の原点以外に初期条件をとると，振動の振幅が増し，

位相平面図では原点から遠ざかっていく結果が得られる。どんどんエネルギーが増え，発散してし

まう。ただし，この場合にも原点は平衡点であるが，この平衡点は不安定な平衡点といわれる。な

お，減衰振動の場合の原点は，安定な平衡点である。

2.3.5 強制振動 (B)

　振動する系に外部から周期的に変動する力が加わった場合の運動を考える。この外力を強制力，

強制外力などと呼ぶ。このような強制外力は様々な原因によって発生する。自動車が凹凸のある路

面上を走れば，路面の凹凸が強制外力の原因となるし，内燃機関で往復するピストンの慣性力も強
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制外力となる。偏心のある電動機が回転すれば，この偏心により生じる遠心力は強制外力となる。

また，地震も建築物に対する強制外力となる。

　今，強制外力F を次のように仮定する。

0 cosF F tω= (2.46)

減衰振動する系にこの強制外力が作用すれば，運動方程式は次のようになる。

0 cosmx cx kx F tω+ + =&& & (2.47)

ここで

0 ,
2

k c
m m

ω γ= = (2.48)

とおくと，次にように整理される。

2 0
02 cos

F
x x x t

m
γ ω ω+ + =&& & (2.49)

このような非同次（非斉次）線形微分方程式の解は，右辺=0 とおいた同次（斉次）方程式の一般解

と特解との和になる。このうち，一般解は前項で述べたように時間とともに減衰してしまい，特解

だけが残る。この強制外力に起因する特解は次式のように得られる。

cos( )x a tω φ= − (2.50)

ただし，

0
2 22 2 2 2 2

00

2
, tan

( ) 4

F m
a γω

φ
ω ωω ω γ ω

= =
−− +

(2.51)

このように特解は外力と同じ角振動数ω で振動する。この振動を強制振動という。変動しない一定

の力 0F が作用したときの振幅を 0 0a F k= とすると，振幅の拡大率は

2 42 2 2 2
0 0 0

1

(1 ) 4
f

a
M

a ω ω γ ω ω
= =

− +
(2.52)

と表すことができる。

　特に，減衰がないとき，すなわち 0γ = のときは，強制外力と同じ角振動数，同じ位相で振動し，

拡大率は次のようになる。

22
0

1
1fM

ω ω
=

−
(2.53)

角振動数 0ω = のとき拡大率 1fM = で，ω を 0 から増加するにつれて拡大率は徐々に大きくなり，

固有振動数 0ω に一致する（ 0ω ω= ）と，拡大率は±∞ になる。この状態を共振または共鳴という。

一般に大きな強制振動が発生することはトラブルの原因となるため，望ましくない。さらに，

0ω ω> では拡大率が負，すなわち強制外力と物体の運動が逆向きになり，ω の増加とともに拡大率

の絶対値は小さくなり，ω → ∞ で 0 になる。

　減衰がある（ 0γ > ）場合，式(2.51)よりわかるように，強制振動の位相は強制外力よりφ だけ位

相が遅れるが，ω が小さければφ は小さく， 0ω ω= で 2φ π= ， 0ω ω> では 2φ π> となり，ω → ∞

でφ π→ (逆相)となる。また，減衰が無い場合と異なり，共振状態のときでも振幅が∞となること

はない。振幅が最大となるのは，式 (2.51)をω で微分してみればすぐわかるように， 22 2
0 2ω ω γ= − の

ときであり，このとき，
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0

2 2
02

F m
a

γ ω γ
=

−

となる。

　図 2.12 に強制振動のモデルを表 2.8にワールド初期設定を示す。図中の右上のグラフが位置・

速度・加速度の時間変化である。また，右下のグラフは横軸に強制外力の角振動数，縦軸に振幅の

絶対値をとって，最大値が残るようにしてある。ただし，停止条件による計算の打ち切りや計算精

度により，最大振幅は正確には表示されない。

演習　　　スライダーでバネ定数やダンパー係数を設定し，強制外力の角振動数ω を種々に変え

て，質点の振動の様子を観察すると同時に，角振動数に対する振幅の変化を図にプロットしなさい。

なお，ω の変更はシミュレーション中ではなく，中断後に変更するようにして，共振振動数の近く

では長めに計算させると綺麗にグラフが描ける。また，共振状態の近くでは振幅が増加し，Spring

Damper（バネ・ダンパー）の Length（長さ）が負になると計算結果がおかしくなるので注意する

こと。

表 2.8　力学モデル m2_3_5_kyouseisindo.wmのワールド初期設定

力学モデル・ファイル名 m2_3_5_kyouseisindo.wm
目的・機能 強制振動

Gravity（重力） None（無重力）

AutoErase Track チェックをはずす

Pause when（中断条件） Time > 20
XY Axes（XY 座標） On
Grid Lines（グリッド線）On
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図 2.12　強制振動

2.3.6 振子の運動(A)

a.　単振り子

　一定時間の後に初期の状態に戻り，同じ運動を繰り返すものを周期運動と呼ぶ。そのような繰返

しの起こる最小の時間を周期と呼ぶ。前節の単振動や定常になった後の強制運動はこれに属する。

ここでは振り子の運動についてシミュレートしてみる(モデル m2_3_furiko1.wm,図 2.13)。
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図 2.13

　まず，初期設定の位置からシミュレーションを実行する(x の値を読みとってメモしよう)。左上挿

入図のふるまいを参考に 10 回振動させたところで運動をストップさせ(マウス左クリック)経過時

間 tを読み取りそれを 10 で割ると周期 Tが得られる。これを図 2.14 にプロットする。次に x の値

を変えて周期を求め図にプロットする。この作業の繰返しから周期の振れの幅依存性T (x)が得られ

る。振れの幅は最大振れ角θ0で表現した方がよさそうだが，このシミュレーション模型ではθは求

めにくい。もし T(? 0)依存性を求めようとするなら次の関係を用いればよい。
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図 2.14







= −

l
x1

0 sinθ (2.54)

ただし l は紐の長さである。振れ幅の小さい領域では T は一定であることを確認したであろうか。

この運動の運動方程式は次式で与えられる。

θ
θ sin
2

2

l
g

dt
d

−= (2.55)

ところで，θ<<1 の場合，sinθはθで近似できるので式(2.55)は次式に帰着される。

θ
θ

l
g

dt
d

−=2

2

(2.56)

これは式(2.30)の形をしているので T = 2π(l/g)1/2の単振動を表わしている。即ち，θが小さい範囲

で周期はθの値に関係しない。これは等時性と呼ばれ，ガリレイがランプの揺れを見て気付いたと

の逸話がある。今シミュレーションで観察したことに対応している。

　ところで，θ（または x）が大きい場合には周期はどうなるであろうか，x の値として，θが 90

度に近い値を２，３選んでシミュレーションを行い図 2.14 にプロットしてみよう。x(即ち ? 0)が増

大すると共に周期が大きくなることが確認できたであろうか。この時点ではもはや式(2.56)は成立

せず，式 (2.55)をまともに解く必要がある。その点に関連して後述するが，ここでは専らシミュレ

ーションを進める。

　今度は初期条件を変えて最下点から初速を適当に与える初期条件から始める。モデル

m2_3_furiko2.wm を立ち上げ，まずシミュレーションを実行すしよう。次に初速度（Circle 1 X-

Velocity，vx0）を少しずつ増大させてシミュレーションを実行し運動の変化を観察する。初速度が

或る価を越え，最大振れ角θがπ/2 を越えると，途中で糸の張力が消失し，円周上の運動から放物

運動に移る(vx0 < 9)。しかし vx0 > 15 の場合ひもは縮むことなく回転運動になる。
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表 2.9

モデル名 m2_3_furiko3.wm
目的・機能 単振り子

Gravity (重力) Vertical
Stop when (停止条件) None
XY Axes (XY 座標) On
Grid Line (グリッド線) On

　

b.　複振り子

　ここではもっと大きな振れ角θに対する運動を見るために糸に変えて剛体（ピアノ線）で支えら

れた物体の振り子運動を見よう（モデル m2_3_furiko3.wm）。初期設定は表 2.9 に示されている。

紐のようにたるむことなく変形しないようにしただけであるが，第4章で扱う剛体のある決った軸

の廻りの運動にも共通する運動を調べることになる。剛体のようなひろがりのある物体が振子運動

するものを複振り子（物理振り子，実体振り子とも）という。

図 2.15

　先ほどの単振り子の場合同様いろいろな初速度でシミュレーションを実行し図 2.15 の T-vx0関係

を作成しよう。vx0がある値を越えると運動は振動から回転に変わる。いずれも周期運動に違いはな

いが，運動の様子が歴然と違う。その境での vx0 を今ここで臨界速度と呼ぶことにする。その境と

なるのはどんな運動であろうか。vx0 を臨界速度に近い値になるよう上手に選んでみよう。vx0 が臨

界速度に近ければ近いほど周期は長くなることが分かる。vx0がちょうど臨界速度に選べたとすると，

周期は発散する。即ち，物体は無限の時間をかけて真上にまで届き，その無限の未来に真上で静止

に至るのである。このような運動は式(2.54)を解くことによって得られるが，Jacobi の楕円関数の

知識が要求される。力学の演習書などに詳記されているので，さらに進んで勉強したい人は参照せ

よ*)。
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　vx0が臨界速度を越えると円運動になるが，その周期は vx0の値と共に小さくなることもシミュレ

ーションで確かめられる。回転運動をする側から初速度を小さくすることによって臨界速度の値に

近づけながら運動の変化を見るのもおもしろいであろう。

　質的に異なる形の２つの運動の境にソリトンに相当する運動が現われることに興味がもたれる。

これは両方の運動の極限形になっており，この運動を通して異なる運動が繋がることになる。

*)例えば山内恭彦・末岡清一編：大学演習 力学（裳華房）第 4章

［付録］　　　臨界速度の場合とソリトン

　ソリトンとは非線型波動方程式の孤立解のうちで，衝突によっても分散することなく衝突後には元の形を保つも

のである。サイン・ゴルドン方程式と呼ばれる次の方程式もソリトン系である。

φφφ
sin2

2

2

2
−=−

dt
d

dx
d (2.57)

速度 c で並進する座標 u

ctxu −= , (| c | < 1) (2.58)

を導入すると式(2.57)は次式に帰着される。

φ
φ

sin
1

1
22

2

cdu

d

−

−= (2.59)

これは式(2.55)と同じ形であって，そこで臨界速度の条件で得られた解が式(2.57)（または(2.59)）の速度 c で運動す

るソリトン解に相当する。このように，見かけ上異なる体系でも数理的に共通する問題，即ち物理的にも類似な概

念で理解できる問題がある。

2.3.7 惑星の運動と万有引力 -ニュートンの解析をたどって- (A)

　a.　惑星の運動

　球面上にはりついた恒星天の一様な運動に対して月，金星，水星，太陽，火星，木星，土星の運

動の理解が古来から天文学の課題であった。これらの天体は逆行も含む複雑な運動をするので

planet の訳語にいみじくも惑星（また遊星）を当てている。コペルニクスによって地球は宇宙の中

心の位置を太陽に奪われたのであるが，それでも惑星の運動の複雑さは解消しなかった。古来から

の叡智ともいえる周転円，離心円，エカントなどという考えはなお必要であったのである。ケプラ

ーはティコ＝ブラエの観測データを譲り受け，それを解析することにより一挙に惑星の運動を見事

に記述することができた*)。曰く，

［ケプラーの法則］

第１法則：惑星の軌道は太陽を焦点とする楕円である。

第２法則：太陽と惑星を結ぶ直線が一定時間に描く面積は一定である（面積速度一定）。

第３法則：(周期)2/(長半径)3は全ての惑星に対し共通の値（一定）である。

　ここでモデル m2_3_kep.wmを実行してみよう。軌道は楕円になっていることを確認できる。初

速度 vy（Circle 2 Y-Velocity）を変えることによって様々な潰れ具合（離心率）の楕円軌道を得るこ

とが確かめられる（第１法則）。惑星の楕円軌道は様々で，地球の場合離心率は 0.017 と小さく円

に近い（太陽は季節によらずほぼ同じ大きさに見える）。火星では 0.093 とやや潰れており，当時
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まだ未知の冥王星では 0.247 とかなり大きい。実際，冥王星は極めて円軌道に近い海王星（0.009）

の軌道の内側にも入る軌道を描いている。面積速度一定の第２法則は，端的に言えば，太陽から遠

くにあれば遅く，近ければ速いということであって，この法則も一定時間間隔に描く軌跡の観察か

ら定性的には確認できたと思う。

*)朝永振一郎：物理学とは何だろう 上（岩波新書）

　さてこのシミュレーションでは，天体に働く力は万有引力であり次式で与えられる。

2
0

r

mm
GF −= (2.60)

G は万有引力定数， 0m は中心にある天体(太陽)の質量，m はこの天体の質量，r は太陽とこの天体

間の距離である。力は中心を向いており，今のようにその方向が動径に平行な力を中心力という。

万有引力の法則はニュートンによって発見されたのだが，それはどのようになされたのであろうか。

　一般に中心力の場合，

0=× Fr
rr

(2.61)

である。運動方程式， Fdtvmd
rr

=/ ，の両辺とr
r
とのベクトル積をとり，上式(2.61)と 0/ =×vdtrd rr

を

考慮すると次式の角運動量保存が得られる。

0=
d
d

t
L
r

(2.62)

vrmL
rrr

×= ( =一定) (2.63)

図 2.16

表 2.10

モデル名 m2_3_newton1.wm
目的・機能 惑星の運動
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Gravity (重力) None
Stop when (停止条件) None
XY Axes (XY 座標) On
Grid Line (グリッド線) On

面積速度は 2/×=d/d vrtS
rr

であるので，式(2.63)より一定であることが分かる。すなわち，ケプ

ラーの第２法則は力が中心力であることを示している。力が二つの天体の質量の積に比例すること

は図 2.16 のような思考実験によって確かめられる。（力全体は部分に働く力の総和になるというこ

とが暗暗裏に仮定されているので，質量の積で表わされるという結果は当然事実に合うか実験で確

認されねばならない。）

距離依存性については，一般に比例定数 K を用いて

aKrF = (2.64)
と表わされる。次に式(2.60)のように a = -2 となることをシミュレーションで導いてみる。

　b.　F = -Kr の場合の運動

　モデル m2_3_newton1.wmを開いてシミュレーションを実行しよう。初期設定(表 2.10)では力は

a＝1，ベクトルを用いて書くと力は次式になる。

rKF
rr

= (2.65)
シミュレーションでこの場合も軌道は楕円になり，第１法則に合致することが分かる。では周期と

軌道長半径との関係はどうであろうか。異なる初期条件でシミュレーションを実行しよう(初速度 vy

を変える)。この結果から周期は長半径にかかわらず一定であることが分かる。式(2.65)を x-および

y-成分で表わすと，

KxFx = (2.66)

KyFy = (2.67)

であるが，これらはともにフックの法則を表わしており，運動はそれぞれ 2.3.4 節で扱った単振動

であって，周期は振幅に依存しない。運動は 5.6 節のリサージュ波形でみるように，二つの単振動

を重ね合わせたものになっている。このようにシミュレーションでも確かめたように長半径（振幅）

にかかわらず周期は一定であるので，これは第３法則に合わない。したがって a＝1 は惑星の運動

には適用できない。

　c.　F = -Kra の運動

　では他の a の値では運動はどうなるであろうか。モデル m2_3_newton1.wmは a＝1 の近くの値

で，モデル m2_3_newton2.wm では a＝-1 の近くの値，モデル m2_3_newton3.wm では a＝-1.5

の近くの値，モデル m2_3_newton4.wmでは a＝-2 の近くの値でそれぞれシミュレーションが実行

できるように設定されている。a の値を変化させてシミュレーションを実行し，さまざまな軌跡の

図形が実現されることを味わってみよう。いずれにしても a＝-2 と 1 を除くと軌道は楕円にならな

い。

　３つのケプラーの法則は天体の運動を記述したものであって，事実である。以上のことから事実

に合うものは式(2.15)の場合（a＝-2）に限られることが分かった。ここではシミュレーションで万

有引力の法則を確認したのであるが，ニュートンは数理的演繹によってこれを導いた。なお，第３
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法則についてケプラーは科学的精神というよりは神秘主義的な情熱にかられて法則の発見に至った

という。このことは２０世紀はじめに水素原子の構造を解明したボーアの理論におけるバルマー系

列の役割を思い起こさせる。バルマーは神の意図を読み取る目的で水素原子の出す光のスペクトル

を分析しそこに潜む法則性を見いだしたのであった。ケプラーの第３法則にせよ，バルマー系列に

せよ，発見の動機にかかわらず，事実は事実として歴史の中で大きな役割を果たした。

2.3.8 その他の運動 (C)

a.　ロケットの運動

　ここでは，ロケットの運動をとりあげてみる。これまでは，質量が一定の場合の運動を取り扱っ

てきたが，ロケットの場合は，燃料の燃焼により，質量が時間的に変化する。時刻t から t t+ ∆ のあ

いだに燃料を噴出し，ロケットの質量がm からm m+ ∆ に変化したとする。 0m∆ < であり，この間

に m−∆ だけの燃料を相対速度u で後方へ噴出し，それによりロケットの速度がv から v v+ ∆ に増加

したとする。噴出された燃料の速度は平均して，速度が v u− と v v u+ ∆ − の間の値

v u vα− + ∆ ( 0 1α< < )であるから，その運動量は ( )v u v mα− − + ∆ ∆ である。したがって，ロケットと

噴出された燃料の持つ運動量は，

時刻 t では， p mv=

時刻 t t+ ∆ には， ( )( ) ( )p p m m v v v u v mα+ ∆ = + ∆ + ∆ − − + ∆ ∆

である。微小量の２次以上を無視すると，

p m v u m∆ = ∆ + ∆

となる。これだけの運動量の変化は，その間に外から働いた外力の力積に等しいので，外力の総和

を F とすると，式(2.9)より，次式が得られる。

d d d dp m v u m F t= + = (2.68)

したがって，

d d
d d
v mm F u
t t

= − (2.69)

となる。このロケットでは，上式の右辺第２項は正であり，速度を増加させる働きを持つ。すなわ

ち，この項はロケットの推力である。

　地表から鉛直上方に打ち上げられるロケットの場合には，空気抵抗を無視し，重力を一定の平均

値とすると，F m= − g であるので，式(2.69)は次のようになる。

d d
d d
v mm m u
t t

= − −g (2.70)

燃料の燃焼速度が一定であるとすれば

0 (1 )m m Ct= − (2.71)

として，式(2.60)は次のように簡単化される。

d
d 1
v Cu
t Ct

= −
−

g (2.72)

初期条件として， 0t = で 0v = とすると，式(2.72)の解は次のように得られる。

log(1 )v u Ct t= − − − g (2.73)
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　発射時の全質量を 0m ，衛星などのペイロードおよび構造体などの燃料以外の質量を fm とすると，

燃料を全て消費しつくすまでの燃焼時間 ft は，式(2.71)より

0

1
1 f

f

m
t

C m
 

= − 
 

(2.74)

となる。このときの速度 fv は，

0

0

log 1 f
f

f

mm
v u

m C m

 
= − − 

 

g
(2.75)

このように，ロケットの到達できる最大速度は，発射時の全質量と燃料以外の質量の比で決まる。

また，重力の影響による速度損失を考えると，最大速度を上げるためには，燃焼時間が短いほど有

利になるが，実際には低空で高速になると空気抵抗が大きくなってしまう。

　ロケットの性能を示す重要な指標として，燃料の噴出速度u を重力加速度g で割った比推力 I が

ある。比推力は燃料によって異なるが，200～500 [s]程度である。例えば，比推力 / 400I u= =g [s]，

燃焼時間 100ft = [s]とすると，人工衛星に必要な速度約 8 [km/s]以上を出すためには，式(2.74)より，

質量比 0 fm m を約 10 以上とする必要がある。

　次に，２段ロケットの場合を考える。ペイロードの質量 pm ，各段( 1,2i = )の質量を im ，そのうち

の idm を燃料以外の構造体の質量とし，比推力を iI とする。１段目の燃焼終了後，１段目は切り離

されるので，達成できる速度は，次のようになる。

1 2 2
1 2

1 2 2

log logp p
f

p d p d

m m m m m
v t I I

m m m m m
+ + +

= − + +
+ + +

g g g (2.76)

上式の対数の中を iQ と表せば，

1 1 2 2log logfv t I Q I Q= − + +g g g (2.77)

となる。 iQ は各段において，自分自身およびそれ以上の段の全質量と燃焼後の質量の比である。

　図 2.17 にロケットの力学モデルを，表 2.11 にワールド初期設定を示す。このモデルでは View >

Numbers and Units（数値と単位）で Distance（距離）を kilometers（キロメートル）に，Mass

（質量）を Metric tones（トン）にしてある。また，View > View size（画面のサイズ）の Window

width（ウィンドウの幅）を変更し 5.0e4 ぐらいに大きくすると地球全体を表示することができる。

地球の概略値には半径 6400[km]，質量 6.0e21[t]を用いた。

　実際のロケットでは燃料節約のため，地球の自転による速度を可能な限り利用しているが，このモデ

ルではロケットは地球の自転の影響を受けないように北極の地表から発射することとした。また，

空気抵抗は無視している。スライダーにより，比推力，燃焼時間，ロケットの初期（全）質量，重

量比，鉛直上方から測った発射角，制御開始時間が設定できる。発射角を０とすると真上に発射す

ることになり，燃焼終了後のロケット運動は燃焼終了時の速度を初期値とする落下運動となるので，

時間が経つと地球に落下してしまう。人工衛星として地球の周りを回るためには，燃焼終了時の速

度がほぼ接線方向を向いていることが望ましい。制御開始時間までは発射角の方向にガイドで誘導

し，その後，ロケットの速度方向と推力の方向を合わせるように制御する。すると重力の影響によ

り，速度の方向が変化しロケットの機首下げが起こる。これが重力ターンである。ただし，この力

学モデルではロケットは質点とみなせる，小さな Circle（円）で作成してある。なお，制御開始時
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間を燃焼時間以上とすることにより，ロケットの進行方向をあまり変化させなくすることも可能で

ある。

演習　　　スライダーにより条件を変えて，うまく地表から数百キロの上空を通過する人工衛星に

することができるだろうか，挑戦してみよう。なお，シミュレーションを開始すると，燃焼終了時

に一旦停止するので，そのときの速度も確認しておくとよい。

表 2.11　力学モデル m2_3_8_rocket.wm のワールド初期設定

力学モデル・ファイル名 m2_3_8_rocket.wm
目的・機能 ロケット

Gravity（重力） Planetary（惑星）

Pause when（中断条件） time > Input[7] 　(燃焼終了時)
|Body[2].p|<6400　(落下時)

Tracking（軌跡） Every 32 frames
XY Axes（XY 座標） On
Grid Lines（グリッド線）On

図 2.17　ロケットの運動
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b.　係数励振振動

　ブランコはどのようにこぐと大きく揺らすことができるであろうか。ここではブランコに関連し

た振動について見てみる。

　ブランコをこぐときの運動は，単振子の重心の位置が一定でなく周期的に変化させた運動と考え

ることができる。振子の長さを小振幅a で， cosl a tω+ のように周期的に変動させると，振れ角θ

が微少のときの運動方程式は次のようになる。

( cos ) 0l a tθ θ ω+ + =g&& (2.78)

　また，長さ一定の振子の支点を cosa tω のように上下振動させたとした場合には，

2( cos ) 0a t lθ ω ω θ+ + =g&& (2.79)

と表すことができる。

　式(2.78)や式(2.79)のように，バネ力の項の大きさが角振動数ω で周期的に変動する場合，この角

振動数ω がある特定の値をとると，系が不安定となり，振動が発生する。このような不安定振動を

係数励振振動という。式を用いた議論は基礎物理の範囲を越えるため，ここでは省略するが，変動

の角振動数ω が系の固有振動数 0ω のほぼ２倍に等しくなると， 02ω ω≈ の角振動数の係数励振振動

が発生する（不安定となる振動数領域は他にもある）。なお，長さ一定の振子の支点を左右に微小振

動させた場合は，強制振動となる。

　ここでは，後の2.5節で述べるエネルギーを用いて，振子の長さが変化する場合の運動を簡単に説

明する。振子の重心が，図 2.18 のような軌跡を描くとする，すなわち鉛直真下の点付近で重心が

上昇し，折り返し点付近で重心が降下するものとする。図からわかるように振子の振動数の約２倍

の振動数で重心が振動している。重心を上げるときには系の位置エネルギーが増し，重心が下がる

ときは系の位置エネルギーは減少する。鉛直真下の点で重心を引き上げるには重力と遠心力に逆ら

って大きな力 1F を必要とするが，重心が下がる折り返し点では重力 2F のみが作用する。明らかに

1 2F F> であるから鉛直真下の点で受け取るエネルギー 1E は折り返し点で失うエネルギー 2E より大

きい。したがって１周期あたり 1 2 0E E− > のエネルギーが系に入り，振幅は大きくなる。なお，ブ

ランコをこぐときはこのエネルギーは人が供給しているわけである。

演習　　　図 2.18 は力学モデル m2_3_8_keisureisin_A.wm で，振子の長さが変化する場合であ

る。単振子における振子の長さを数式で与えることもできるが，このモデルでは Pulley（プーリ）

を用い，その端を Actuator（アクチュエータ）で上下に振動させている。スライダーで，振子の固

有振動数 0ω に対する上下振動の振動数ω の倍率を設定することができる。このスライダーにより上

下振動の振動数を変化させて，振幅がどのような振動数のとき増加するか確かめなさい。

　m2_3_8_keisureisin_B.wm は長さ一定の振子の支点を上下に振動させる場合である。この場合

にも 02ω ω≈ で係数励振振動が発生することを確かめなさい。

　m2_3_8_keisureisin_C.wm は長さ一定の振子の支点を左右に振動させる場合である。この場合

は強制振動となるので 02ω ω≈ では振幅が増加せず， 0ω ω≈ で振幅が増加することを確かめなさい。

表 2.12　力学モデル m2_3_8_keisureisin.wmのワールド初期設定
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力学モデル・ファイル名 m2_3_8_keisureisin_A.wm ～
m2_3_8_keisureisin_C.wm

目的・機能 係数励振振動

Pause when（中断条件） Time > 20
Tracking（軌跡） Every frame
XY Axes（XY 座標） On
Grid Lines（グリッド線）On

図 2.18　係数励振振動

c.　リミットサイクル

　2.3.4項の減衰振動でみたように，バネの復元力のほかに正の減衰力が作用したときには振動が減

衰し，逆に負の減衰力が作用するときの運動

0 ( 0, 0)mx cx kx c k+ + = < >&& & (2.80)

の振幅は無限に増大する。実際の振動では，ある程度振動が大きくなれば，振幅の増加は頭打ちに

なり，振幅一定の定常状態になる。このような現象を説明するためには，振動が小さいうちは負の

減衰力として作用するが，ある程度以上の大きな振動に対しては正の減衰力として働く減衰を考え

る必要がある。

　そこで，次式のような非線形減衰項を持つ運動を考える。
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2(1 ) 0 ( 0)mx x x xε ε− − + = >&& & (2.81)

この式は，ファン・デル・ポール(van der Pol)の方程式と呼ばれる。ダンパー係数 2(1 )xε− − は，振

幅に依存しており， 1x < ならばダンパー係数は負であるので振幅は増大し， 1x > ならばダンパー

係数は正であるので振幅は減少する。位相平面の原点は平衡点であり，原点近くの点の軌道は原点

から離れようとし，原点から遠くにある点の軌道は原点に近づこうとする。結局，原点は不安定な

平衡点であり，原点からある距離のところに安定な孤立した閉軌道が存在することがわかる。この

孤立した閉軌道をリミットサイクルと呼ぶ。単振動のところで見られたような線形系の純虚根に起

因して生じる閉軌道とは本質的に異なるものである。リミットサイクルの形状はパラメータε に依

存しており， 0ε → で円に近づき単振動となる。また， 0ε < とすると，原点は安定な平衡点となり，

リミットサイクルは不安定なリミットサイクルとなる。

　一般に摩擦などの減衰のある散逸系では，過渡運動の後，ある状態に落ち込んでいく。この状態

の軌道の集合をアトラクターという。前節で示した減衰振動における位相平面の原点や，この例の

リミットサイクルはアトラクターである。

演習　　　図 2.19 にリミットサイクルを示す。Spring Damper（バネ・ダンパー）のダンパー係

数を非線形の式で与えてある。初期値を変えて位相平面上の軌道がリミットサイクルに漸近する事

を確認しなさい。また，スライダーによりパラメータε を変えると，リミットサイクルの形が変わ

ることを確かめなさい。

表 2.13　力学モデル m2_3_8_limitcycle.wm のワールド初期設定

力学モデル・ファイル名 m2_3_8_limitcycle.wm
目的・機能 リミットサイクル

Gravity（重力） None（無重力）

Pause when（中断条件） Time > 30
XY Axes（XY 座標） On
Grid Lines（グリッド線）On
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図 2.19　リミットサイクル

d.　カオス

　1960 年代初め，気象学者ローレンツ(Lorenz)は天候のシミュレーションを行っていた時，ほんの

わずかなの初期条件の違いで，予測される数日後の天候が全く異なるものになってしまう現象に遭

遇した。彼は，温度勾配のある流体について最小限の成分だけを取り出して次のような３変数の微

分方程式でモデル化した。

x x y
y xz rx y
z xy bz

σ σ= − +
= − + −
= −

&
&
&

(2.82)

ここでσ ，r ，b は系のパラメータである。ローレンツはこの方程式を解き，その解が不規則解を

持つ場合があることを示した。３次元の位相空間での軌道は二度と同じ点に戻ることは無く，いか

なる周期性も持たず，ある奇妙な形の空間図形に引き込まれていく。このローレンツ・アトラクタ

ーと呼ばれる集合の中に吸収された軌道はそれ以降二度とそこから飛び出すことはない。また，あ

る初期値に対して一定の時間が経過した後の点の位置と，わずかに異なる初期値で同じ時間が経過

した後の点の位置は，全く異なっている。

　ローレンツの研究はしばらく埋もれたままであったが，それから 10 年ほど経って，リー(Li)とヨ

ーク(Yorke)が論文のタイトルにカオスという言葉を使い，初期条件に敏感に依存する非周期現象が
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カオスと呼ばれるようになった。こうしてローレンツの研究は発掘され，後世に名を残すこととな

った。ローレンツ・アトラクターのようなカオス軌道から生まれるアトラクターは複雑な構造を持

ち，ストレンジ・アトラクターと呼ばれる。

　カオスが他の運動とどのように異なるかを理解するために，運動を大きく３つに分類する。

(1)規則的運動：前節までで見てきた単振子や惑星の公転（ケプラーの法則）などのように，周期的

または準周期的であり，初期条件が決まれば未来の状態が一意的に決まるニュートンの運動の法則

のような決定論的法則に支配されている運動。

(2)確率的運動：電気回路に生じる熱雑音やブラウン運動のように，偶然に左右され，乱雑で不規則

であり，未来の状態を一意的に予測できない運動。

(3)カオス運動：２重倒立振子や木星の小惑星のような公転などのように，規則運動と同様に決定論

的法則に支配されているが，非周期的で，軌道不安定性を持ち，初期条件が正確に与えられれば短

期予測は可能であるが，初期条件に鋭敏に依存するので長期予測は実際上不可能な性質を持つ。

　この本で扱っている時間が連続に変化する連続力学系では，変数が３個以上ないとカオスは生じ

ないことが知られている。（時間が整数で計られる離散力学系では，法則が可逆な時は２変数以上で，

不可逆な時は１変数系でもカオスが生じる）

　カオスの詳しい話は，他書に譲るとして，ここでは摩擦によりエネルギーが散逸される散逸系で

の例として，上田により研究され，ジャパニーズ・アトラクターとして有名なカオスを見てみよう。

扱う方程式は，ダフィン(Duffing)方程式と呼ばれる次の非線形微分方程式である。

3 cosx cx x B t= − − +&& & (2.83)

これは，速度に比例する摩擦 cx− & ，変位の３乗に比例する復元力 3x− および周期的な強制外力

cosB t が働く非線形弾性振動の運動方程式である。ここで， x y=& ， t z= とおくと，式 (2.83)は３

元１階連立微分方程式とすることができる。なお，c ， B はパラメータである。

　変位の時間応答や位相平面での複雑な軌道を観測する他に，強制外力は周期2π であるので，時

刻2π 毎に位相平面に点をプロットしてみよう。すると，墨流しのような美しい模様が浮かび上が

ってくる。この方法はポアンカレ写像と呼ばれ，連続系の解の性質を調べる重要な手法の１つであ

る。連続系の解の性質は，軌道上である変数が最大値をとる時とか，軌道がある切断面を繰り返し

よぎる時とか，周期的な外力が働く場合にその周期毎に解がとる値とか，軌道が描かれる位相空間

において離散的に繰り返される写像がどのような点の集合になるか，あるいはどのような性質を持

っているかを調べることにより，明らかにすることができる。

演習　　　図 2.20 にダフィン方程式の解とポアンカレ写像を示す。Spring Damper（バネ・ダン

パー）のバネ定数を非線形の式で与えてある。位置などの時間変化および位相平面上の軌跡は複雑

な振動となることを観察しなさい。図中の左下のグラフがポアンカレ写像で，時刻約2π 毎に位相

平面に点をプロットしている。なお，ポアンカレ写像を綺麗に描くためには長時間の計算時間が必

要である。

表 2.14　力学モデル m2_3_8_chaos.wmのワールド初期設定

力学モデル・ファイル名 m2_3_8_chaos.wm
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目的・機能 カオス（ダフィン方程式の解と
ポアンカレ写像）

Gravity（重力） None（無重力）

Pause when（中断条件） Time > 30
XY Axes（XY 座標） On
Grid Lines（グリッド線）On

図 2.20　ダフィン方程式の解とポアンカレ写像

演習　　　前に述べたように，摩擦のない２重振子や惑星の３体問題などの保存系でもカオス運動

を観察することができるので力学モデルを作成しシミュレーションしてみなさい。

なお，ストレンジ・アトラクターは散逸系には存在するが，保存系では存在しない。

2.4 座標変換

2.4.1 並進座標系 (A)

　2.1節で述べた運動の第１法則により，運動の記述に使用される座標系は，慣性系とするべきであ

る。今，そのような慣性系O xyz− があったとして，O xyz− 系に対し並進運動する座標系O x y z′ ′ ′ ′−

で見た質点 Pの運動を考える。O xyz− 系から見た原点O ′ の位置および質点 Pの位置をそれぞれ 0r
r ，



62

rr とすると，質点 Pの位置，速度，加速度には次の関係がある。

0 0 0, , ,r r r r r r r r r′ ′ ′= + = + = +
r r r r r r r r r& & & && && && (2.84)

　質点 Pに力 F
r
が働いているとき，O xyz− 系は慣性系であるから，運動の法則

mr F=
rr&& (2.85)

が成り立つ。一方，質量m と力F
r
は並進座標系O x y z′ ′ ′ ′− で見ても変わらないので，式(2.84)より

0mr F mr′ = −
rr r&& && (2.86)

となる。これは 0mr−
r&& を力と見なせば，並進座標系でも慣性系の場合と同じ形の運動方程式が成り立

つことを表している。このような見かけの力を慣性力という。

O x y z′ ′ ′ ′− 系に静止している観測者にとっては，本当の力F
r
の他に見かけの力 0mr−

r&& が存在するよう

に感じられる。例えば，乗り物が発車するときに乗客が後ろ向きの力を受けたように感じたり，急

停車するときに前につんのめりそうになるのはこのためである。

　なお， 0 0r =
r&& の場合，すなわち，座標系間の相対速度 0r

r& が時間によらず一定値ならば，式(2.86)は，

mr F′ =
rr&& (2.87)

となり，O x y z′ ′ ′ ′− 系も慣性系となる。つまり，１つの慣性系に対して等速度で並進運動する座標系

は慣性系である。一定の速度で揺れずに走っている乗り物の中では，外を見ないと走っているかど

うかわからない。このように，全ての慣性系は資格が同等であり，どれが静止系であるかを力学的

手段で決定することはできない。

演習　　　図 2.21(a)に示すようにボタンによりReference frame（基準フレーム）を静止座標系と

並進座標系に切り替えることができる。このシミュレーションでは表 2.15 のように軌跡を残す設

定になっており，静止座標系および並進座標系で見た質点の位置の時間変化もグラフに表示される。

地上で放物運動をしている質点を，水平に加速度a で動いている乗り物から見るとどのように見え

るかをスライダーで加速度や初速度を設定し調べなさい。

　また，図 2.21(b)に示すように，長さl の単振子を，加速度a で水平に動いている乗り物の中や，

加速度a で上昇するエレベータの中で小さく振らせた場合の振動がどのようになるかを調べなさ

い。なお，比較のため静止座標系で同じ長さの単振子を振らせたグラフも表示してある。

表 2.15　力学モデル m2_4_1_heisin.wmのワールド初期設定

力学モデル・ファイル名 m2_4_1_heisin_A.wm～
m2_4_1_heisin_C.wm

目的・機能 並進座標系と静止座標系

Pause when（中断条件） Time > 10
Tracking（軌跡） Every frame　または　Off
XY Axes（XY 座標） On
Grid Lines（グリッド線）On
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(a)　水平加速度運動する座標系から見た放物運動
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(b)　水平加速度運動する座標系上の単振子

図 2.21　並進座標系と静止座標系

　加速度 0で初速度のみを与えて等速直線運動する座標系から静止座標系での放物運動を見ると，

x 方向は異なるがやはり放物運動していることがわかる。加速度を与えて，加速運動をする座標系

から静止座標系での放物運動を見ると，何らかの力を受けて運動が変化しているように見える。

　水平に加速している乗り物の中で振子を振らせた場合は，振子の振動の中立位置が鉛直下方では

なく，進行方向と反対側に偏り，振動数も変化していることがわかる。この並進座標系で見ると，

質点には糸の張力T と鉛直下方に重力mg の他に水平後方に慣性力ma が働いている。質点のつり合

い位置が鉛直方向となす角は ( )1tan a− g となる。その位置からの振れ角をθ とすれば，運動方程式

および振子の振動数は，慣性座標系での単振子の式におけるg を 2 2a+g とした式になる。

　また，上に加速している乗り物の中で振子を振らせ場合は，振動数だけが変化していることがわ

かる。この並進座標系で見ると，質点には糸の張力T と鉛直下方に重力mg および慣性力ma が働い

ている。したがって，運動方程式および振子の振動数は，慣性座標系での単振子の式におけるg を

a+g とした式になる。

2.4.2 回転座標系 (A)
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　今度は，慣性系O xyz− 系に対し回転する座標系O x y z′ ′ ′ ′− で見た質点 P の運動を考える。簡単の

ため，２つの座標系の原点は一致しており，回転軸を z 軸＝ z′軸として，O x y z′ ′ ′ ′− 系はその周りに

一定の角速度ω で回転しているとする。

　あるベクトルur の慣性系での成分を , ,x y zu u u とし，回転座標系での成分を , ,x y zu u u′ ′ ′とすると，そ

れらの間には次の関係がる。

cos sin

sin cos
x x y

y x y

z z

u u t u t

u u t u t

u u

ω ω

ω ω
′ ′

′ ′

′

= −

= +

=

(2.88)

ここで，ベクトルur として，位置ベクトルをとれば，

cos sin
sin cos

x x t y t
y x t y t
z z

ω ω
ω ω

′ ′= −
′ ′= +
′=

(2.89)

となる。これを運動方程式

, ,x y zmx F my F mz F= = =&& && && (2.90)

に代入すると

( ) ( ){ }
( ) ( ){ }

2 2

2 2

2 cos 2 sin

2 sin 2 cos

x

y

z

m x y x t y x y t F

m x y x t y x y t F

mz F

ω ω ω ω ω ω

ω ω ω ω ω ω

′ ′ ′ ′ ′ ′− − − + − =

′ ′ ′ ′ ′ ′− − + + − =

′ =

&& & && &

&& & && &

&&

(2.91)

となり，さらに，式(2.88)の関係を逆に用いると，

( )
( )

2

2

2 cos sin

2 sin cos

x y x

x y y

z z

m x y x F t F t F

m y x y F t F t F

mz F F

ω ω ω ω

ω ω ω ω

′

′

′

′ ′ ′− − = + =

′ ′ ′+ − = − + =

′ = =

&& &

&& &

&&

(2.92)

が得られる。したがって，回転座標系の運動方程式は
2

2

2

2
x

y

z

mx F m y m x

my F m x m y

mz F

ω ω

ω ω
′

′

′

′ ′ ′= + +

′ ′ ′= − +

′ =

&& &

&& &

&&
(2.93)

と表される。

　ここで，回転座標系の回転軸に沿った角速度ベクトル (0,0, )ω ω=r
を用いると，運動方程式 (2.93)

は，次のようにベクトル表記できる。

2 ( )mr F m r m rω ω ω′ ′ ′= − × − × ×
rr r r r r r&& & (2.94)

　式(2.94)の右辺第２項 2m rω ′− ×
r r& は，回転軸に垂直な面内で速度 r′r& に直角な方向の慣性力であり，

これをコリオリの力という。慣性系で見て直線運動する質点も，回転座標系から見ると座標系の回

る向きと反対の方向へ曲がって行くように見える。この軌道を曲げるような見かけの力がコリオリ

の力である。

　式(2.94)の右辺第３項 ( )m rω ω ′− × ×r r r
は，位置が r′r で表される点から回転軸へ下ろした垂線を ρ ′−

r

とすると， 2( )m r mω ω ω ρ′ ′− × × =
rr r r
と表される。したがって，この項は回転軸に垂直な面内でρ

r
の向
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きに働く慣性力であり，遠心力と呼ばれる。回転座標系で静止している質点は，慣性系からみると

円運動を行っているので，原点に向いている求心力(向心力)が働いている。回転座標系で，この求

心力と釣り合っているのが遠心力である。

　なお，角速度ω が一定でない場合には，式(2.94)にさらに m rω ′− ×
r r& の項が加わる。

　図 2.22 に示すように，ボタンにより Reference frame（基準フレーム）を静止座標系と回転座標

系に切り替えることができる。このシミュレーションでは表 2.26 のように軌跡を残す設定になっ

ており，静止座標系および回転座標系で見た質点の位置の時間変化もグラフに表示される。

演習　　　スライダーで質量m の質点の初速度を 0 とし，静止座標系の原点以外で静止している場

合， z 軸を共通に持ち，角速度ω で回転している回転座標系から見ると，この質点の軌道はどうな

るかを調べなさい。また質点が慣性系の y 軸方向に等速直線運動をしているときは，回転座標系か

ら見るとどうなるかを調べなさい。

表 2.26　力学モデル m2_4_2_kaiten.wmのワールド初期設定

力学モデル・ファイル名 m2_4_2_kaiten.wm
目的・機能 回転座標系と静止座標系

Pause when（中断条件） Time > 10
Tracking（軌跡） Every frame
XY Axes（XY 座標） On
Grid Lines（グリッド線）On
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図 2.22　回転座標系と静止座標系

a.　重力

　地球上で感じる重力は，地球から受ける万有引力と，地球の自転による遠心力との合力である。

地球の半径は 66.4 10R = × [m]，自転の角速度は 52 (24 60 60) 7.3 10ω π −= × × = × [rad/s]であるので，

地球の自転軸からの距離の大きい赤道上での遠心力の大きさは， 2 23.4 10Rω −= × [m/s2]となる。これ

は 9.8=g [m/s2]の約 300 分の 1 程度である。赤道上では，遠心力は万有引力と逆向きになるが，南

北両極および赤道以外の緯度のところでは，合力としての重力の方向は地球の中心へ向かう方向か

らずれることになる。さらに，地球が完全な球でないことや山などの地形の影響もある。

b.　フーコー振り子

　フーコーは 1851 年，大きな単振子で実験を行い，コリオリの力が働いていることを示し，地球

の自転を実証した。

　地球は自転しているので，地球上にいる観測者は角速度ω で回転する回転座標系から運動を見て

いることになる。振子の長さl は十分長いので，質点の運動は水平面(記号 ’ は取り除いて -x y 平面

とする)内に限られているとしてよい。振子と鉛直下方とのなす角を微小角θ とすると，質点を最下

点に向かわせようとする力 F
r
の大きさは sinm mθ θ≈g g となる。したがって，F

r
の ,x y 成分は次の

ようになる。
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,x y
x m y mF m x F m y
l l

θ θ
θ θ

= − = − = − = −g g
g g

l l
(2.95)

　今，簡単のため，振子は北極点で振らせたとすると，式(2.95)を式(2.94)に代入して，質点の運動

方程式は，次のようになる。

2

2

2

2

mmx x m y m x

m
my y m x m y

ω ω

ω ω

= − + +

= − − +

g
l
g

l

&& &

&& &
(2.96)

ここで， 0,x iy lζ ω= + = g (2.97)

とおくと，式(2.96)は次のように書くことができる。
2 2

02 ( ) 0iζ ωζ ω ω ζ+ + − =&& & (2.98)

したがって，ζ の一般解は，

0 0( )i t i ti te Ae Beω ωωζ −−= + (2.99)

となる。 0t = のとき， x 軸と角α をなす直線上で単振動を始めたとすると，
( )

0cos( )i tCe tα ωζ ω φ−= + (2.100)

と表せる。この式より，角振動数 0ω で振動する振子の振動面は，自転の向きと逆に自転の角速度ω

で回転することがわかる。

　Working Model 2D では３次元モデルのシミュレーションは行えないので，図 2.23 に示すよう

に，質点の運動は水平面での単振動としてシミュレーションしてみよう。

演習　　　スライダーで回転座標系の角速度を変えて，ボタンにより Reference frame（基準フレ

ーム）を静止座標系と回転座標系に切り替えて慣性座標系で単振動している質点の振動の様子を観

測しなさい。

表 2.37　力学モデル m2_4_2_foucault.wmのワールド初期設定

力学モデル・ファイル名 m2_4_2_foucault.wm
目的・機能 フーコー振子

Gravity（重力） None（無重力）

Pause when（中断条件） Time > 100
Tracking（軌跡） Every frame
XY Axes（XY 座標） On
Grid Lines（グリッド線）On
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図 2.23　フーコー振子

2.5 仕事とエネルギー

2.5.1 仕事と運動エネルギー (A)

　１つの質点に一定の力F
r
が働いていて，その力と角θ をなす直線上を質点がrr だけ動いたとする。

このとき力F
r
はこの質点に対して，

cosW F r F r θ= ⋅ =
r r

(2.101)

の仕事をしたという。すなわち，力F
r

[N]と変位rr [m]のスカラー積W [J]を仕事と呼ぶ。

質点が 1P から 2P まで動くとき，その経路が直線でない場合や力F
r
が質点の位置による場合には，力

のなす仕事W は，

2

1

d
P

P
W F r= ⋅∫

r r
(2.102)

と表される。

質点は時刻 1t t= で 1P にいて， 2t t= で 2P にいたとして，運動方程式(2.1)を用いて，式(2.102)を書き

直すと，次のようになる。ただし， d dv r t r= =
r r r& である。
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2

1

2 2

1 1

2

1

2

d
d

d
d d d

d d
d d d

d 1
d

d 2

P

P

t t

t t

t

t

v
W m r

t
v r v

m t m v t
t t t

mv t
t

= ⋅

= ⋅ = ⋅

 =   

∫

∫ ∫

∫

r
r

r r r
r

r
(2.103)

　 1P および 2P での質点の速度をそれぞれ 1vr ， 2vr とすると，式(2.103)は，

2 2
2 1

1 1
2 2

W v v= −
r r

(2.104)

と表される。右辺に現れるスカラー量

21
2

K mv=
r

(2.105)

を質点が持つ運動エネルギーと呼ぶ。

これを用いると，式(2.104)は，「質点に働く力のする仕事は，質点の運動エネルギーの増加量に等

しい」ことを表しているといえる。逆に，運動エネルギーの増加があれば，何らかの仕事がなされ

たということになる。

　単位時間内になされる仕事の量を仕事率[W]という。

d
d
WP F v
t

= = ⋅
r r

(2.106)

2.5.2 保存力とポテンシャルエネルギー (A)

　式(2.102)の右辺の積分の値が途中の経路によらず一定で，両端 1P ， 2P の位置だけによって，

2

1
1 2d ( ) ( )

P

P
F r U r U r⋅ = −∫
r r r r

(2.107)

のように，ある位置のスカラー関数 ( )U rr の両端における値の差で与えられるとき，この力を保存力

という。また， ( )U rr をその力のポテンシャルエネルギーと呼ぶ。

万有引力や静電気力は保存力である。また，保存力F
r
はポテンシャル ( )U rr から次のように導かれ

る。

gradF U F U= − =−∇
r r

または (2.108)

このような保存力を受けて運動している質点は，閉曲線に沿って一周すると，

d 0F r⋅ =∫
r r

Ñ (2.109)

が成り立つ。これを微分形で表すと

rot 0 curl 0F F F= = ∇ × =
r r r

または (2.110)

となり，渦なしであるということもできる。

2.5.3 力学的エネルギー保存則 (A)

　保存力を受けて運動している質点を考える。 1P および 2P でのポテンシャルエネルギーをそれぞれ
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1U ， 2U とすると，質点が 1P から 2P へ移動するときに力 F
r
がなす仕事W は，式(2.107)より

2

1
1 2d

P

P
W F r U U= ⋅ = −∫

r r
(2.111)

となる。また，この仕事W によって変化した運動エネルギーK の変化は，式 (2.104)および式(2.105)

より，

2 2
2 1 2 1

1 1
2 2

W v v K K= − = −
r r

(2.112)

である。したがって，式(2.111)と式(2.112)より，次の関係が得られる。

1 1 2 2K U K U+ = + (2.113)

これは，「質点が保存力を受けて運動しているとき，運動エネルギーとポテンシャルエネルギーの和

は一定である」ことを表している。運動エネルギーと一緒に考える場合に，ポテンシャルエネルギ

ーのことを位置エネルギーと呼ぶ。運動エネルギーとポテンシャルエネルギーの和 E K U= + を力

学的エネルギーといい，式(2.113)で表された関係を力学的エネルギー保存の法則という。

2.5.4 質点の運動と力学的エネルギー保存則 (A)

　2.3節でみた質点の運動のうち，いくつかを取り上げて運動と力学的エネルギー保存則の関係をみ

てみよう。

a.　自由落下

　質量m の質点を地表から高さ 0y の位置に静止させ，そこから自由落下させる。運動方程式などは

既に示した通りである。ここでは，力学的エネルギー保存則を用いて，質点が地表に落ちる瞬間で

の速度を求めてみよう。

　地表を 0y = とし，ポテンシャルエネルギーの基準を地表にとると，高さ 0y の位置にある質点の

ポテンシャルエネルギーは

1 0U m y= g (2.114)

である。地表に落ちる瞬間の速度をv とすると，このときの運動エネルギーは

2
2

1
2

K mv= (2.115)

である。高さ 0y で持っていたポテンシャルエネルギーが，地表に落ちる瞬間には全て運動エネルギ

ーに変わってしまうとすると，式(2.113)より，次の関係式が得られる。

2
0

1
2

m y mv=g (2.116)

これにより，速度v は

02v y= g (2.117)

と求められる。

b.　単振動

　2.3.4項で示した単振動の固有振動数を力学的エネルギー保存則により求めてみよう。質量-バネ
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による単振動系は，摩擦などによる抵抗がないのならば，外部に対して仕事をしないし，外部から

仕事をされることもない。したがって力学的エネルギー保存則が成り立つ。

　バネの変位，すなわち質点の位置を x ，速度をv x= & とすると，運動エネルギーは

2 21 1
2 2

K mv mx= = & (2.118)

である。この場合のポテンシャルエネルギーは，バネに蓄えられている弾性エネルギーである。こ

れは，バネを 0x = から x x= まで，引っ張るか，縮めるのに要するエネルギーであり，次のように

求められる。

2

0

1
2

x
U kxdx kx= =∫ (2.119)

質点が 0sinx a tω= で表される振動をしていたとする。振動の折り返し点では 0x =& であるので

1 0K = となり，ポテンシャルエネルギーのみになり，それは

2
1

1
2

U ka= (2.120)

となる。また，質点が 0x = の中立点を通過するときは 2 0U = となり，運動エネルギーのみとなり，

0 0cosx a tω ω=& の最大値 0aω より

22
2 0

1
2

K ma ω= (2.121)

となる。以上を式(2.113)に代入すると

22 2 2 2
0

1 1 1 1
2 2 2 2

E K U mx kx ma kaω= + = + = =& (2.122)

となる。したがって，固有振動数 0ω は次のように求まる。

0 k mω = (2.123)

これは，式(2.31)と一致している。

演習　　　図 2.24 に示すような単振動の力学モデルでシミュレーションを行い，運動エネルギー，

ポテンシャルエネルギーおよび全力学的エネルギーの時間変化を観察し，全力学的エネルギーが一

定であることを確かめなさい。

表 2.18　力学モデル m2_5_4_tansindo.wmのワールド初期設定

力学モデル・ファイル名 m2_5_4_tansindo.wm
目的・機能 単振動

Gravity（重力） None（無重力）

Pause when（中断条件） Time > 10
XY Axes（XY 座標） On
Grid Lines（グリッド線）On
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図 2.24　単振動の運動とエネルギー

c.　単振子

　図 2.25 に示すように，質量m の質点を長さl の質量の無視できる糸でつり下げて振子を作り，

鉛直と 0θ だけ傾けて初速度を与えないように静かに離す。鉛直下方と糸とのなす角θ と糸の張力T

および質点の速度v との関係を求めよう。ただし，空気の抵抗はないものとする。

　糸の張力は，質点の運動の方向と垂直なので仕事をしない。したがって，この系でも力学的エネ

ルギーは保存される。ポテンシャルエネルギーの基準は最下点にとることにする。初期条件と，力

学的エネルギー保存則より，次の関係式が得られる。

2
0

1 (1 cos ) (1 cos )
2

mv m l m lθ θ+ − = −g g (2.124)

したがって，速度は以下のようになる。

02 (cos cos )v l θ θ= −g (2.125)

　質点は半径l の円弧上を速度v lθ= &で往復運動しているが，このようなときには，質点は円の中心

に向かう 2v l の半径方向の加速度を持っている。これに対して半径方向の力は cosT m θ− g である。

したがって半径方向の運動方程式は次のようになる。
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2

cos
v

m T m
l

θ= − g (2.126)

式(2.124)と式(2.126)よりv を消去すると，糸の張力T は次のように求められる。

0(3cos 2cos )T m θ θ= −g (2.127)

演習　　　単振動と同様に，図 2.25 のような単振子のモデルでシミュレーションを行い，運動エ

ネルギー，ポテンシャルエネルギーおよび全力学的エネルギーの時間変化を観察しなさい。

表 2.19　力学モデル m2_5_4_tanfuriko.wmのワールド初期設定

力学モデル・ファイル名 m2_5_4_tanfuriko.wm
目的・機能 単振子

Pause when（中断条件） Time > 10
XY Axes（XY 座標） On
Grid Lines（グリッド線）On

図 2.25　単振子の運動とエネルギー
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「力と運動の法則」　　　　　　　　　

Coffee Break 2

　

「力を加える」「力を入れる」といった表現を日常良く使いますが，“力”の実体を考えたことは

ありますか。Coffee Break 1 で，力学は「力によって物体の位置が，時間と共にどのように変化してい

くかを理解するための学問」と説明しましたが，さて“力”とは何でしょう。ちょっと考えてみま

せんか。

ところで力学において重要な，運動に関する３つの法則は知っていますね。

第1法則：物体は力の作用を受けないかぎり，静止の状態，あるいは一直線上の一様な運動をその

ま

　　　　　ま続ける。

第 2 法則：運動量が時間によって変化する割合 mα（α：加速度）は，その物体にはたらく力 F に

比例

　　　　　し，その向きに生じる。すなわち F=mα。

第3法則：物体1が物体2に力を及ぼすときは，物体2は物体1に対し，大きさが同じで逆向きの

力

　　　　　を及ぼす。

どうも初めに“力”ありきで，明確には定義されていないようです。でもヒントは隠されています。

第1法則，第2法則によれば，まず“力”は物体にはたらくものということがわかります。しかも

質量と加速度の積で与えられる。これが一つの“力”の定義のようにも思えますが，第3法則は，

物体が2つ存在するときに，物体は“力”を及ぼすものらしいということも言っています。どうも，

まず物体が2つ存在して初めて“力”というものが現れてくるということのようですね。考えてみ

れば，物体が１つだけのときに“力”が存在するとは思えません。

そこで第3法則を起点として考えてみましょう。既知の質量 m1をもつ物体1と未知の質量 m2をも

つ物体2を考えます。第2法則を併用すると m1α1=-m2α2，さらに変形してやると m2/m1=-α1/α2と

いう関係が得られます。この関係を使えば，質量 m1 をもつ物体 1 と物体 2 を相互作用させて，加

速度の比を知ることによって質量 m2を決定することができます。こうして得られた質量 m2を第2

法則 F=mαに代入することによって，ようやく“力”を定義することができることになります。す

なわち，“力”とは「ある知られた質量 mに働き，ある加速度αを発生させるもので，F=mαで与え

られる」と考えれば良いでしょう。力学モデルでは連結した 2 つの物体（機関車と客車と思ってく

ださい）が用意されています。ある加速度で機関車が 1 両の客車を牽引しながら等加速度運動する

ときの様子とそのときの「ある知られた質量 mに働き，ある加速度αを発生させるもの」としての

“力”が mc 2 chikara1.wmで示されます。次に mc 2 chikara2.wmでは“力”をそのままに，客

車を２両に増やして運動の様子を示します。重くなれば？軽くなれば？加速度はどうなっているで

しょうか？最後の力学モデル mc 2 chikara3.wmで確認してみてください。
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第３章　質点系の力学

3.1　２体問題

3.1.1  太陽と地球

　2.3.7 節では太陽を中心にした惑星の軌道を考察したが、その際、中心に位置する太陽は固定さ

れたものとして取り扱った。しかし、太陽とて宇宙空間に固定されているわけではないので惑星の

力を受けて運動するはずである。ここで太陽と地球の運動を表すモデル m3_1_sun.wm を実行して

みよう。地球の質量に比べて太陽の質量は桁違いに大きいので太陽の運動はほとんど観測できない。

3.1.2  ２体問題

　二つの物体が宇宙空間に孤立して存在する場合を考える。２物体の物体の質量を m1 , m2、座標

を 21 , rr rr
とすると運動方程式は各々次のように書ける。

( )212
1

2

1 rrF
dt

rd
m

rrrr
−=                                  ( 3 . 1 )

( )212
2

2

2 rrF
dt

rd
m

rrrr
−−=                                 ( 3 . 2 )

( )21 rrF
rrr

− は２体間に働く力を表す。式  (3.2) で力が (3.1) のものとは逆符号になっているが、これ

は運動の第三法則（作用反作用の法則、式 (2.7) 参照）に基づいている。ここで次式の重心座標R
r

と相対座標r
r
を導入すると、

21

2211

mm
rmrm

R
+
+

=
rrr

                                  ( 3 . 3 )

21 rrr rrr
−=                                      ( 3 . 4 )

運動方程式は(3.1), (3.2)次のように変形される。

演習　　地球と月の場合はどうであろうか。これを実現するモデル m3_1_sun.wm を実行しよ
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0
2

2

=
dt

Rd
M

r

                                    ( 3 . 5 )

( )rF
dt

rd rrr
=

2

2

µ                                    ( 3 . 6 )

ここに ( )21 mmM += は全質量を表し、μは換算質量と呼ばれ次式で与えられる。

21

111
mm

+=
µ

                                  ( 3 . 7 )

式(3.5)は質量 M の物体が力の働いていない空間で行う運動を、すなわち等速直線運動である。式

(3.6)は力 ( )rF
rr
を受けている質量μの物体の運動を表している。このように２体問題は独立な２つの

１体問題に書き直される。力がポテンシャル力であれば式(3.6)の第１積分（エネルギー積分）が存

在し（2.5.1 節参照）、r
r
は閉じた積分の形で表現される。この意味で１体問題は解けるといわれる

が、同様の意味で２体問題も解ける。なお、式 (3.3), (3.4)から 1r
r
および 2rr は解かれた変数 ( ) ( )trtR

rr
, に

よって次のように求められる。

r
mm

m
Rr

rrr

21

2
1

+
+=                                  ( 3 . 8 )

r
mm

m
Rr

rrr

21

2
2

+
−=                                  ( 3 . 9 )

前節のシミュレーションでの力は式(2.59)で与えられる万有引力である。そのとき、太陽の運動を

観察できなかったのであるが、第１の物体を太陽とすると、式(3.1)によって、理屈の上で太陽は動

いているはずである。しかし、m2 ≪m1 であれば式(3.3)で 2rr は無視されて Rr
rr

=1 となる。 一定=R
r

とすると太陽は動かないことになる。実際、地球と太陽の質量比 12 mm はおよそ 6103 −× であって、

ここで行ったシミュレーションではその運動を認識するのはむずかしい（初速度は 一定=R
r

になる

ように設定されている。先の地球と月に関する演習では地球に対する月の質量比はおよそ 0.012 で

ある。この場合物体１（地球）の運動は認識できたはずである。

3.1.3  連星（２重星） (A)

  質量比が大きくなり、同等程度なら２物体の運動が同程度に観察されることが予想される。実際、

m1=m2

なら優劣がないのであるから当然同等に動くはずである。このような体系の例として連星の運動を

シミュレートしてみよう。連星は星ができるときに質量が１つにだけ集まるのでなく、複数のとこ

ろに集まり複数の星ができたものである。この場合 2321 =mm であることは先のものと同じである

が、 R
r
が零でなく先の楕円運動に並進運動が加わるので軌道は閉じない。宇宙空間を連星が運動す

ることを思い浮かべていただきたい。

演習　　惑星最大の木星の場合、太陽に対する質量比は 3101 −× である。その場合を模したモデ

ル m3_1_sun.wmでスライダーを用いて質量比を最大値 3101 −× に設定すればよい。シミュレー

ションを実行してみよう。太陽の動きを観察できるだろうか。
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　ところで実視観察できる星のうち、数十パーセントは連星である。太陽に次いで明るい星シリウ

スも連星である*) 。太陽系創成時に木星にもっと質量が分配されていたら木星も恒星になれた。も

っとも、木星も太陽のように光っていたら、いつが昼か夜か混乱も甚だしいものになるのでこれで

良かったと言えるのかもしれない。

3.1.4  バネの力 (B)

  ここまで２体問題として力が万有引力である天体の運動を論じてきたが、3.1.2 節の定式化は万有

引力に限ったことではない。ここでは力がバネのようにフックの法則に従う場合の運動をシミュレ

ートする。

　すなわち、力は式(2.65)で与えられる。モデル m3_3_bane.wm を実行してみよう。この場合、

m1=10m2 ,

初速度は大きさが 1:10 で反対方向になるように設定されている。２物体には相互にバネの力が働き

合うだけであって、全体に支えられているわけでないが、あたかも重心が支えられているかにみえ

る。物体２の初速度をわずかに変えてみよう。重心は等速直線運動をし、２物体はバネの運動を続

けながら並進も加わることがわかる。初速度を様々に変えて運動の変化を検討してみよう。

 *)  ファインマン：ファインマン物理学 I 力学（岩波書店）第７章

演習　　モデル m3_2_rensei.wm は２重星に対するもので、 0,2321 == Rmm
r

に設定されて

いる。続いて、物体２の vyを少し変えて実行してみよう。

演習　　モデル m3_3_bane.wm では質量も変化できるように設定されている。様々な質量比

に対して、運動を予想しながらシミュレーションを実行してみよう。
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3.2　帯電体

3.2.1  帯電した質点の衝

突

　電気を帯びている質点が衝

突するときどんな様相を示す

だろうか。重力を無視し電気

力のみが作用する空間におい

て、電界の大きさを 1.000

Nm2/c2 とする。その空間に固

定され、+1.000 クーロンの電

気を帯び、質量 0.503Kg の質

点 A に対して、+1.000 クーロ

ン の 電 気 を 帯 び た 質 量

0.031Kg の質点 B が、初速

1.000m/sで直衝突する場合を考                      図 3.1 帯電した質点の衝突

える。

　ここで、質点Bと同様の物理量を持つ質点を図 3.1 のように配置し、それらの軌跡を観察すれば、

ラザフォード (Rutheford) の散乱実験の軌跡が見られる。ラザフォードの実験では、ラジウムから

のα線をアルミ箔などに照射すれば、α粒子が散乱されることが示され、原子核が帯びている電気

量や原子核の大きさを定量的に測定した。

　モデル m3_4_electrostatic.wmを実行しその結果を観察すれば、図 3.1 の質点 Aを原子核、質点 B

をα粒子とし、粒子の軌跡の計算から原子核の物理量が計算されるということが容易に推察できる

であろう。

3.2.2  帯電体の二体問題

　図 3.2 のように、電界の大きさが 10.00 Nm2/c2 の空間において、電気量＋0.100 c  、質量0.126Kg

の静止している質点 A に対し、電気量‐0.100c、質量0.031Kg の質点 B が初速 1.000m/sで運動す

る場合をシミュレートしてみよう。

　両者は引力を互いに作用させており、両者の軌跡はそれらの初期条件により複雑な様子を示す。

演習　　m3_4_electrostatic.wm を実行し、メジャーウインドウを開いて質点 B のデータを取得

し、質点の斜衝突の理論から求められる軌跡の方程式が成り立つかどうか検討せよ。
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すなわち、質点 B の位置を少しずらして実行して見ると、その軌跡は大きく変化することが観察さ

れる。ただ、両者の軌跡は周期性を示していることが注目される。しかし、それらの軌跡を示す方

程式を計算することは大変難しい。

図 3.2 帯電体の二体問題

演習　　モデル m3_5_two-body problem.wmを実行してみよう。質点 B の位置に関するスラ

イダーを開き、その x‐y 座標を変えて軌跡を観察してみよう。宇宙空間で互いに作用し合いな

がら運行する天体の運動は、衝突や合体などの可能性がありながら、数億年も安定した状況を

呈しているのは奇蹟とも言える。さらに、質量、電気力、質点 B の初速度を様々に変更して軌

跡を観察すると時間の経過を忘れてしまう。
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3.2.3  帯電体の三体問題

　図 3.3 のように、電界の大きさが 10.00 Nm2/c2 の空間において、電気量＋0.500 c  、質量0.785Kg

の静止している質点 A と、電気量＋0.100 c  、質量 0.126Kg の静止している質点 B に対し、電気

量‐0.100c、質量 0.031Kg の質点 C が初速 1.000m/sで運動する場合をシミュレートしてみよう。

  前節は二体の相互運動であったが、さらに一つの質点が加わると三体問題と言われ、それらの解

析が相当難しいものであることが知られている。この節では、理論的な考察は行わずもっぱらモデ

ルの実行による運動の軌跡を観察することにする。

　ここで実行するモデル m3_6_three‐body

problem のように、三者が直線上にある場合でも、

質量比、電気量比、距離をほんの少し変化させる

だけでも、その軌跡は大きく変化することが観察

される。また、三者とも初速度が与えられた場合

では、その軌跡は予測もつかないものとなり、高

性能のパソコンであってもその軌跡を示すことは

大変である。このモデルを実行して見れば、我々

の宇宙は、ごくごくの確率でその安定が保証され

ていることを実感する。

　実際に宇宙ロケットを打ち上げる場合には、宇

宙空間に存在する星とロケットとの質量比が桁違

いであるため、ロケットの運航に神経をとがらせ

るのは、星にずいぶん近づいたときであるからあ

まり悲観することもない。

　また、逆のミクロな世界に関する粒子の研究は

さらに多くの多体問題を扱うことになり、質点系

という力学としての解明には限界があることも考

慮する必要がある。　　　　　　　　　　　　　　　　　　　図 3.3 帯電体の三体問題

演習　　三体問題に関するモデルの実行は m3_6_three‐body problem.wmであるが、電気

力は引力と斥力が関係し、宇宙空間を運動する天体よりはより複雑である。このモデルや前

節で紹介されているモデルなどを観察し、質点系の運動を総合的に考察する必要がある。

　実際の自然現象には多くの質点が関与し、個々の質点運動を解析する方法だけでは真実を

明らかにするすることは不可能である。そのため、空間に存在する粒子の数はアボガドロレ

ベルであるたことから、多くの標本を考える確率・統計学が導入されており、アバウトな考

え方も必要とされている。流体の力学や固体の変形など、多くの分野でそのような考え方が

展開されている。
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3.2.4 力学モデル「結晶場」
　実行すれば、結晶モデルの相互運動が展開する様子が観察される。対象性の破れに注目せよ。

　m3_7_crystal field1.wm「無重力、電気力場」　　m3_8_crystal field6.wm「無重力、電気力場」

　m3_9_crystal field11.wm「無重力、電気力場」　　　m3_10_crystal field16.wm「無重力、電気力場」
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「“角”振動数って？」　　　　　　　　

Coffee Break 3

　　力学を勉強していると「速度やら振動数といった言葉はなじみがあって良いけれど，なぜ角速度，角振

動数といった”角”がついたものを考える必要があるの？速度と振動数で十分じゃないの？」と思ったことは

ありませんか。私も単振動において初めて角振動数が出てきたときに奇異な印象を抱いたことを記憶して

います。単振動を説明するために良く用いられる図を思い起こしてください。まずバネの一端を固定し，他

端に物体をつけて水平な所に置きます。この物体を押したり引いたりしたときに生じるバネの力によって，

物体は振動的な運動をします。これが単振動ですね。力学は「力によって物体の位置が，時間と共にど

のように変化していくかを理解するための学問」です。単振動における物体の位置の時間変化を記

述するのに”角”をつける必要はどこにあるのでしょうか。

力学の教科書によれば，単振動における物体の位置 x と時間 t の関係について一つの解

x=asin(vk/mt)が与えられます。ここで，k はバネ定数，m は質量です。したがって物体の位置が

時間と共に変化していく様子は，簡単な正弦波で与えられるということになります。力学モデル

mc 3 kakushinndo.wmでは，横軸を時間，縦軸を位置として物体の位置の時間変化を示していま

す。まず時間と共に物体の位置が，どのように変化していくかを確認してください。物体の位置は

時間軸に沿って正弦波上を周期的に変化していくことがわかります。ただし画面上の時間軸には限

りがありますので，時間がたてばたつほど変化していく様子を表示するのが困難になっていきま

す。そこで考えられたのが，周期的な位置の変化を円周上に表すということです。こうすれば，時

間軸を延々とたどる必要がなくなります。力学モデル mc 3 kakushinndo.wmの中で物体の位置の

変化の様子を見てください。物体の位置は円周上の回転で与えられることがわかります。このよう

に単位円の円周の長さ 2πを基本に考えて，振動数を表したものが角振動数ω=vk/mで，これを用い

ると単振動における物体の位置は x=asin(ω t) という形になるというわけです。
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第４章　剛体の力学

4.1　剛体の運動

4.1.1  剛体の平面運動

                                                                

平面運動

　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　

　図 4.1 に剛体内の 2 点 A,Bの座標を( xA , yA )、( xB , yB )とすれば、

AB の長さは                                                      図 4.1 棒の平面運動

( ) ( ) constyyxxAB ABAB =−+−= 22                        (4.1)

である。

　いま、剛体が平面運動し、線分 AB が A'B'に移ったとすれば、まず、AB が A''B'に移動する並進

運動と、B'点を通り x,y平面に垂直な軸のまわりの回転運動

が生じたと考えられる。

　剛体の内外に関わらず、任意の一点を軸とする回転にお

いては、その周りのどの点においても、回転角の大きさと

方向は不変である。すなわち、軸に対する各点の角速度は

同じである。このことから、剛体の平面運動（変位、速度、

加速度）は、任意の代表点に対する並進運動と、その周り

の回転運動との合成運動となる。

　

瞬時中心
　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　図 4.2 瞬時中心

　図 4.2 のように、AA' と BB' の垂直二等分線の交点 O を軸の点にすれば、AA'を BB'に回転だけ

で移動させることが出来る。

          A''      A'

          

　A　　　　　　θ

　　　　　　　　　

                 B'

        B

    A

A'

                   B'

        B
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　実際は、このO 点自身が時間とともに運動しているから、ある瞬間における線分の移動は O 点を

瞬間における回転運動の中心として考えるということである。この意味で、O 点を瞬時中心という。

瞬時中心は、2 点の速度に垂直に引いた垂線の交点としても求められる。                                          

　図 4.3 は、車輪が速さ V でレール上を滑らずに走行し、車輪中心 O を軸とする角速度ωの回転

運動をしている。ある時刻に置いて、任意の点

P はレールの方向に速さ v、点 P の接線方向に

速度 aωで運動している。従って、P 点は 2 つ

の速さを合成した速度をVとすれば、V=2aωcos

θで、その方向は図から AP に垂直である。一

方、線分 AP は、AP=2acosθであるから、速度

V は A を中心、AP を半径、ωを角速度とする

円運動と考えることができる。従って、レール

上の A 点は瞬時中心である。

                                                 　　　　図 4.3 車輪の瞬時中心

　レールの A点における合成速度の速さ V は、V= v - aωであるが、車輪は滑らない条件だから、

V=0 より v=aωである。

4.1.2  剛体の回転運動

　P 点が xy 平面内で半径 rの円運動をすると

き、Δt 時間に動径r
r
がΔθ回転し、動径 r

r
′

になった。このとき、P の描く円弧Δsは

θ∆=∆ rs  　　　        (4.2)

である。

　ここで、r
r
を r

r
′の方向へ右ねじを回し、右

ねじの進む方向を向きとする角変位ベクトル

θ
r

∆ を考える。　　　　　　　　　　　　　　　　　　　　　　　　　　図 4.4 剛体の回転

また、図 4.4のように、ベクトル sr∆ を考えると、r
r
、 sr∆ 、 θ

r
∆ の右手系となり、(4.2) 式は

s
r∆ = θ

r
∆ ・ r

r
                                   (4.3)

となる。これを、時間微分すれば、速度vr 、角速度ω
r
、半径 r

r
の関係式

rv rrr
×= ω 　　　　　　　　　　　     (4.4)

が得られる。

　以上を一般化すると、平面運動をしている剛体の一点 P の変位 sr∆ は、任意の回転を考える代表点

の変位 0sr∆ と、角変位 θ
r

∆ から

rssss ′×∆+∆=′∆+∆=∆
rrrrr

θ00  　　　　　　　　　      (4.5)

および、速度に関して

rvv ′×+=
rrrr

ω0                                  (4.6)

となる。ここで、 0=vr となるような点 P が瞬時中心である。

O

                        P          v

                             aω  　　

                                        

                                  

                 A

ω

V
θ

       θ
r

∆

 z

                                    P'

　　　　　　　　　  Δθ　  s
r∆ 　Δs

       y　　　    r
r
　　　　　 P

                                   x
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　剛体力学モデル実習　m4_1
１　テーマ　「平面運動と瞬時中心」

２　力学モデル　m4_1_instantaneous center.wm「スライダー（速度）」

３　理論

　車輪がレール上を滑らずに走行しているとき、車輪の中心（重心）を軸とする回転も行っている。

重心の速さと、回転における車輪外周速度の大きさとの合速度は、次第に変化する。

４　操作

　図 m4.1 は、車輪の瞬時中心に関する、図 4.3 において、角速度ωを観察するものである。球体

の点 P の角変位、角速度と角加速度をグラフ出力する。球体の水平方向の速さをスライダーで適宜

設定できる。

　また、点 P をクリックし、Mesure ⇒ Velocity でグラフウインドウを示し、速さ、角速度など観

察できる。なお、点 P が描く軌跡はサイクロイド(Cycloid)という曲線である。

図 m4.1 平面運動と瞬時中心

演習　　　スライダーで球体の速さを設定し、点 P の角速度の変化を観察せよ。また、点 P

をクリックし、Mesure ⇒ Velocity でグラフウインドウを示し、速さ、角速度など観察せよ。

速さと角速度の合速度に点 P を通る垂線を引けば、図 4.3 のように瞬時中心 A が求まること
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　剛体力学モデル実習　m4_2
１　テーマ　「軸周りの回転運動」

２　力学モデル　m4_2_rotational motion.wm「無重力、スライダー（Ball の Y 方向速さ）」

３　理論

　剛体内の任意の点について、回転軸からの距離を r、速さを v、角速度をωとすれば、 ωrv = であ

る。また、外力が作用して、力のモーメントによって回転運動が起こり、外力が 0 となった後では、

その運動は安定する。その場合、剛体の慣性モーメントを I とすれば、式(4,59)より、 constI =ω で

ある。角速度が慣性モーメントに反比例することを、確かめる。

４　操作

　Ballの速さを設定するスライダーの最小値は 0.0、最大値は 10.0である。剛体内の 4 点について

角速度を示すグラフウインドウがある。Run すると各点の加速度が同じであることが観察できる。

グラフウインドウの Vｘ、Vy、V、Vo を適宜クリックし各種グラフを出力できる。

図 m4.2 軸周りの回転運動

演習　　　スライダーで Ball の速さを適宜変更し、同時に剛体をダブルクリックして

Properties の Moment を別の値に入力して Run せよ。 constI =ω をグラフの値から計算し確か

めよ。
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4.2　剛体に働く力のモーメント

4.2.1 力のモーメント

　力が作用する点を作用点という。任意の点 O に関する位置ベクトルr
r
の作用点にして、力 N

r
が作

用するとき、

FrN
rrr

×= 　　　            (4.7)

の N
r
を力 F

r
の O に関するモーメントを表わす。

　ここで、位置ベクトルr
r
と力ベクトルN

r
のベクトル積の

大きさは、その方向への基本ベクトルをnr として

θsinnrFFr
rrr

=×               (4.8)

となる。

　ここで、N
r
の方向は r

r
を F

r
と同じベクトルOA にθの回

転で右ねじを回して重ねるとき、右ねじが進む方向である。

またその大きさは、r
r
と F

r
で作成する平行四辺形の面積で

ある。　　　　　　　　　　　　　　　　　　　　　　　　　　　図 4.5 力のモーメント

4.2.2  偶力

　大きさ等しく平行で向きの反対な二つの力の組を偶力という。偶力の作用点 A,Bの位置ベクトル

を Arr 、 Brr とし、弧二つの力のモーメントの和をN
r
とすれば、

( ) ( ) FrFrrFrFrN BABABAA

rrrrrrrrrr
⋅=⋅−=−×+×=                     (4.9)

となる。このN
r
を偶力のモーメントという。ただし、このモーメントは、点 O に無関係で、考える

偶力のみで決まる。また、その方向は、偶力を作る力の平

面に垂直で、向きは Arr を Brr に右ねじを回して重ねるときの、

右ねじの進む方向である。

　偶力を構成する力F
r
と F

r
− の垂直距離を h とすれば

hFNN ==
r

となり、この h を偶力の腕の長さという。

　ここで、剛体に対する偶力の効果は、点 O に無関係であ

り、モーメントN
r
が一定であれば、F

r
や作用点が変わって

も同様である。従って、N
r
は自由ベクトルである。

　多くの偶力は、ベクトルの和の法則に従って合成することがで         図 4.6 偶力

きる。
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　剛体力学モデル実習　m4_3
１　テーマ　「力のモーメント」

２　力学モデル　m4_3_torque.wm「無重力、スライダー（なし）」

３　理論

　回転軸からの距離 rの点に外力 F を作用させるとき、力のモーメント(Torque)を Nとすれば式(4.8)

から、 θsinrFN = である。角度θは図 4.5を参照。

４　操作

　Run し、6 種類の場合を観察せよ。1 と 2 は Torque のグラフウインドウにより数値が読みとれる。

図 m4.3 力のモーメント

演習　　　1、2、3、は一外力の場合で、中心を通る 2 はＮ=0 である。4、5、6、は二外力の

場合で、4、5、は偶力を示す。力の矢の大きさと作用点を適宜変更し Run せよ。
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4.2.3  作図による平行力の合成

　剛体に作用する多くの外力の合成は、次の 1 通りであ

る。

    A　１つの合力が得られる

    B  一組の平行力が得られる

　Aの場合は図 4.7 のように、剛体に n 個の力 jF
r

 ( j =

1......n )が作用するとき、ベクトルの一般的性質である

「ベクトルは平行移動しても同じベクトルである」、「力

の効果は、力をその作用線のどこに移動しても同じであ

る」、「互いに交わる 2 力は、2 力を 2 辺とする平行四辺

形の、対角線に作られる力を合力として合成される」か

ら、2 つの力を平行四辺形の方法で次々合成し、最後の

合成が終わると 1 つの合力が得られる。　　　　　　　　　　　　　　図 4.7 力の合成

　Bの場合はさらに次の 3 通りがある。

　　1　同じ方向の平行力

　　2　逆方向で大きさが異なる平行力

　　3　逆方向で大きさが同じ平行力

　3 の場合は前節の偶力であり、これ以上合成できない。ただし、偶力のモーメントが逆の偶力で

うち消すことはできる。

　ここでは 1 の場合について、合成の方法を図形的に処理する方法を考える。

　図4.8は 1F
r
と 2F

r
を合成するためそ

れぞれの作用点A,Bに互いにうち消

し合う 2 力 F
r
と F

r
− を導入し、それ

らとの合力を平行四辺形の方法で求

め、ついで、得られた 2 つの合力を

この合力の作用線の交点Cに移動し、

さらに合成する。こうして得られた

合力は図形の計算から、次のことが

導かれる。

　同じ方向で平行な 2 つの力の合力

は、大きさが 2 力の大きさの和であ

り、方向は 2 力と同じで、その作用

点は、2 力の作用点 A,Bを結ぶ線分　　　　　　　　　図 4.8 同方向の平行力合成

AB を、AO / OB = F2 / F1 に内分する

点 O である。　方向が異なる 2 力の合成は次のようにまとめられる。

　同じ方向で平行な 2 つの力の合力は、大きさが 2 力の大きさの差であり方向は大きいほうの力と

同じでその作用点は、2 力の作用点 A,Bを結ぶ線分 AB を、AO / OB = F2 / F1 に外分する点 O である。

               

      321 FFF
rrr

++        21 FF
rr

+

              2F
r

3F
r

　　　　　　　　　　　　　　 1F
r

jF
r

                              nF
r

         

　　線分 AB の内分点 O の位置　AO / OB = F2 / F1

　　　　　　　　　　　　　　　C

　　　　　 F
r

− 　　　　　　　　　　　　　　　　F
r

                A        O                B

　　　　　　　　   21 FF
rr

+ 　　　　  2F
r

　　　　 1F
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       　　　　合力＝F1＋F2
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　剛体力学モデル実習　m4_4
１　テーマ　「平行力の合成」

２　力学モデル　m4_4_heikouryoku gousei .wm「無重力、空気抵抗（通常）、スライダー（力）」

３　理論

　図 4.8 同方向の平行力合成について、「合力は大きさが２力の大きさの和、方向は２力と同じで、

その作用点は、２力の作用点を結ぶ線分を、外力比に内分する点である。」と説明される。詳細は本

文を参照のこと。

４　操作

　Run すれば、天井からの紐の作用点と、２力の作用点に、X、Y 方向の力と合力が表示される。空

気抵抗を設定してあるため、急速に平衡状態になり、剛体が静止したとき Stop する。合力の作用点

は天井からの紐に引いた線分上にある。その大きさは２力の長さの和となり、２力の作用点を結ぶ

線分を、外力比に内分する点であることは、図の測定からも伺える。スライダーは Base point に作

用する力の大きさを変更する。

図 m4.4 平行力の合成

演習　 　スライダーで外力の大きさを設定し、Run の後、平衡状態で Stop せよ。スライダー

で外力を色々に変更して繰り返し観察せよ。このモデルは重力場ではないので注意を要する。

　このモデルを参考に、重力場における平行力の合成を検証するモデルを作成せよ。
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4.2.4  ベクトル計算による平行力の合成

　図 4.9 において、A,Bを作用点とする平行な 2 力を AF
r
、 BF

r
とし、線分 AB 上の点 P で合成すれ

ば

( ) BPBAPABAP

BPBBPAPAAPBBAA

FrFrFFr

FrFrFrFrFrFr
rrrrrrr

rrrrrrrrrrrr

×+×++×=

×+×++×=×+×
                (4.10)

となる。右辺の 2 項は P に関する AF
r
のモーメント、3 項は P に関する BF

r
のモーメントであるが、

これが 0 になる点 P は

0=×+× BPBAPA FrFr
rrrr

            (4.11)

である。ここで、A,B,P は同じ直線上にあり、 AF
r
、 BF

r
は

平行だから、

A

B

F
F

BP
AP

±=                  (4.12)

または

BA

B

FF
F

AB
AP rr

r

±
=                 (4.13)

となり、前節の結果を示す。ここで±の＋は同方向、－

は反対方向の 2 力関係である。

　式 (4.11) を (4.10) に代入すれば

( )BAPBBAA FFrFrFr
rrrrrrr

+×=×+×        (4.14)

が求まる。

　2 力が同方向の場合、力の大きさを FA、FB とすれば、

式(4.14) は

                                                                 図 4.9  平行力の合成

BA

BBAA
P FF

rFrF
r

+
+

=
rr

r
                                  (4.15)

となる。ここで、力が多く作用する場合、合力の大きさを F、その作用点を G、G の位置ベクトル

を R
r
とすれば、

FrFRFF iii

rr
∑∑ ==                               (4.16)

であり、G を平行力の中心という。

      　　2 力は同方向

　　 O

       Arr            Brr

         

         A      P      Prr       B

       AF
r

                 BF
r

              BA FF
rr

+

　　　　　力は反対方向

     O

        Arr     Brr           BF
r

         A             B      P

        AF
r
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4.3　剛体に働く力がする仕事

4.3.1  内力がする仕事

　図 4.10 において、剛体内の 2 点 A,Bに力 AF
r
と ( )AB FF

rr
−= が作用し

ている。剛体が運動するとき、点 Bは剛体の全ての点の並進運動に

よる変位 sr∆ と、点 Aを軸とする回転運動の変位 s ′∆
r
を合わせた運動

をする。

2 点を一対として、2 つの内力がする仕事を Wとすれば               図 4.10 内力がする仕事

( ) ( ) sFssFsFssFsFW AAABA
′∆×−=′∆+∆×−∆⋅=′∆+∆×+∆⋅=

rrrrrrrrrrrr
            (4.17)

となるが、 s ′∆
r
は 2 つの力の作用線 ABに対して垂直をなすので、この場合の仕事 Wは 0 である。

　剛体内の全ての点を一対にして、その仕事の総和を求めても、やはり 0 である。従って、剛体に

力が作用するときは、内力の仕事の総和は 0 となり、外力がする仕事だけを考えればよい。

4.3.2  回転における外力がする仕事

　図 4.11 は剛体内の軸 O に z軸を取り、任意の点 P に力 F
r

が作用し、P 点が z 軸の周りに θ∆ だけ回転して、変位 sr∆ を

生じたものである。

　この変位 s
r∆ に対する外力 F

r
の仕事を Wとすれば

sFW
rr

∆×=∆    　　            (4.18)

である。

　ここで、変位 sr∆ は、 θ∆ を軸性ベクトル θ
r

∆ とし、軸 O に

たいする点 P の位置ベクトルをr
r
として

rs rr
⋅∆=∆ θ        　　         (4.19)

となるから、                                                 　　図 4.11 外力の仕事

θθ
rrrrrrrr

∆××=⋅∆×=∆×=∆ FrrFsFW                          (4.20)

　これは、O 軸に対する力F
r
のモーメント FrN

rrr
×= に角変位 θ

r
∆ の大きさを乗じたものである。

ここで、 θ∆ は xy 平面、 θ
r

∆ は z方向に限られるから、 N
r
は z 成分 N だけを考える。また、 r

r
も平

面内、N の z成分を与える F
r
は点 P が描く円周方向の成分だけであるから、

θ∆= NW                                       (4.21)

　一般に、剛体内の全ての点 Pi に拡張すれば、

( ) θθ ∆=∆=∆=∆ ∑ ∑∑ iii NNWW                           (4.22)

となる。

                  sr∆
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  AF
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θ
r

∆ 　　Δθ　　　r
r

　O
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4.3.3  平面運動における外力の仕事

　図 4.11 のように、平面運動をする剛体の任意の

点 P の変位 sr∆ は、軸 A とともにする並進運動の

変位 0sr∆ と軸周りの回転による変位 s ′∆
r
に分けら

れ、

sss ′∆+∆=∆
rrr

0             (4.23)

となる。

  ここで、変位 s ′∆
r
は、 θ∆ を軸性ベクトル θ

r
∆ と

し、軸 O に対する点 P の位置ベクトルを r ′
r
として

　 rs ′⋅∆=′∆
rr

θ              (4.24)

であるから、点 P の変位に対する外力の仕事 Wは

                                                    図 4.11 並進・回転に対する仕事

θ

θθ

∆+∆×=

∆××′+∆×=′⋅∆×+∆×=∆×=∆

NsF

FrsFrFsFsFW

0

00
rr

rrrrrrrrrrr

             (4.25)

となる。第 1 項は軸にする仕事、第 2 項は軸に対する力のモーメントのする仕事である。

　剛体全体にする仕事 Wi は

( ) ( ) θdNsFsdFW iiiii 00 ∑∑∑ +∆×=×=
rrrr

                      (4.26)

である。ここで、( )0∑ iN は O 軸周りの外力のモーメントである。また、重心を軸とする場合は

( ) ( ) θdNsFsdFW
GiGiiiG ∑∑∑ +∆×=×=

rrrr
                     (4.27)

である。

4.4　剛体のエネルギー

4.4.1  軸に対して回転する剛体の運動エネルギー

　図 4.12 は剛体が軸 O の周りを角速度ωで回転するもので、

任意の点 P から軸に下ろした垂線の長さを ri、P 点の速さを vi

とすれば

ωii rv =                   (4.28)

であり、その方向は、O 軸に垂直な ri を半径とする平面内の

円の 接線方向である。

                                                            図 4.12 軸 O の周りの回転

　P 点の微小質量をΔmi、密度をρi、微小体積をΔVi とすれば、O 軸周りの P 点の回転による運動

エネルギーΔKi は

 z

                    s ′∆
r

        

       y                   P        0sr∆

               Δθ     r ′
r

           A            0sr∆

                                        

                        

  O                                   x

　　　

      ω

                             

　　　　

        O

ri

vi

P
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iiiiii VrvmK ∆=∆=∆ 222

2
1

2
1

ωρ                            (4.29)

である。

　軸 O 周りの剛体の全運動エネルギーK は

[ ] 22

2
1

ωρ∫∫ =∆= dVrKK i                              (4.30)

である。ここで、［　］内を I とし、K を I で示せば

dVrI ∫= 2ρ                                   (4.31)

2

2
1

ωIK =                                    (4.32)

となる。この I は軸周りの慣性モーメントといい、慣性の大きさを示す。

　重心の並進運動の運動エネルギーを Kt とすれば、

2

2
1

Gt MvK =                                  (4.33)

剛体の重心を通る軸の周りの慣性モーメントを IG とし、軸に対する回転運動のエネルギーを Kr とす

れば

2

2
1

ωGr IK =                                  (4.34)

平面運動を行う剛体の全エネルギーK は,K=Kt+Kr であるから

22

2
1

2
1

ωGGrt IMvKKK +=+=                        (4.35)

である。

4.4.2  剛体の運動エネルギー式

　軸周りの回転をする剛体に、外力が仕事をするときの仕事は式 (4.22) 、それにより、増加する運

動エネルギーは式 (4.32) で求められる。 従って、軸周りの剛体のエネルギー式は

( ) θω dNId i∑=





 2

2
1

                            (4.36)

である。

　平面運動のエネルギー式は式(4.35)であるが、重心の運動エネルギーと重心を軸とした回転の回転

エネルギーとの和である。

　平面運動に対する外力がする仕事は、重心にする仕事と重心周りの仕事との和である。これは、

式 (4.27)から

( ) ( ) θω dNsdFIvMd
GiGIGG ∑∑ +=






 +

rrr 22

2
1

2
1

                  (4.37)

である。
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　剛体力学モデル実習　m4_5
１　テーマ　「外力による球の平面運動」

２　力学モデル　m4_5_heimen undou.wm「無重力、中断時間 1.8秒、スライダー（力）」

３　理論

　球体に外力を加え続ける場合、その作用点の違いにより、球体の運動は並進運動と回転運動が独

立して起こる。すなわち、力の作用線が重心を通る場合は並進運動だけであり、重心をはずれる場

合は、重心を回転軸とする回転運動が、重心の並進運動と同時に起こる。

　平面運動における運動方程式は式(4.72)で示され、並進運動と回転運動は独立して起こることから、

式(4.74)の具体的な式が得られている。

４　操作

　Run すれば、中断時間 1.8 秒でストップする。３つのスライダーのうち１つだけ数値を設定し、

他は 0 として Run せよ。力が重心を通過する真ん中の場合は回転が起こらないことが観察される。

図 m4.5 外力による球の平面運動

演演習　　　スライダーで３力の組み合わせと、大きさを色々なパターンに設定し Run せよ。

このモでデルは外力が作用し続けるので、運動は等加速度運動と、等角加速度運動となる。球

体をクリックし、Measure⇒ Apperance ⇒ Velocity ⇒ All を選択し、メジャーウインドウを示

して、速さ、加速度、角速度のグラフを観察せよ。

7
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　剛体力学モデル実習　m4_6
１　テーマ　「球の衝突」

２　力学モデル　m4_6_goutai kyu syoutotu.wm「無重力、スライダー（位置、速さ）」

３　理論

　球の質量を m、速さを v、慣性モーメントを I、角速度をωとすれば、完全弾性衝突において、運

動量 mv と角運動量 Iωが保存される。式(4,91)より、 constmv = 、 constI =ω である。

　２球の衝突において保存則を適用すれば、

221122112212211 ωωωω ′+′=+′+′=+ IIIIvmvmvmvm

が成り立つことを、確かめる。

４　操作

　図 m4.6 は、球 22 が球 11 に衝突するものである。Run すれば、22 が上方へ、11 が下方へ運動す

る。スライダー左方は 22 の Y 方向の位置を、右方は X 方向の速さを設定する。左方を 1.0 に設定し

たときは２球は直衝突するので、２球ともに回転しない。スライダーの最小値と、最大値は調べてみ

ること。22 の速さに関するメジャーウインドウを 22 をクリックし、Measure ⇒ Velocity ⇒ Allとし

て開き、適宜 22 の位置と速さを設定し観察せよ。

図 m4.6 球の衝突

演習　　　両球のメジャーウインドウの数値データから、上記の二式を確認せよ。
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　剛体力学モデル実習　m4_7
１　テーマ　「球の衝突と球を突く現象」

２　力学モデル　m4_7_piston and billiards.wm「無重力、スライダー（速さ）」

３　理論

　ビリアードは、人が自球をキューで突き、力のモーメント（トルク）を衝撃力として球に作用さ

せ、運動量と角運動量を得た球が、それを保存しながら他の球と次々と衝突することで、ゲームを

構成しているスポーツである。

４　操作

　ビリアードにおいて球を突く道具をキューというが、これをバネで作成したものが、図 m4.7 の

Piston である。球 24 の y 座標はスライダーで調節できる。

　Run すれば、球 24 と 27 が、それぞれキューと球 28 によって衝撃力を受け、ともに右上方を平面

運動をする。両球の重心のプロットを描かせているので、その軌跡がほぼ平行になるように設定し

てある。

　

図 m4.7 球の衝突と球を突く現象

演習　　　両球の速さに関するメジャーウインドウを開き速さと角速度を観測し、剛体力学モ

デル実習 m4_6 の式を検証せよ。ピストンを、どの方向へでも突けるように改良し、ビリアー

ドゲームの力学モデルを作成せよ。
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　剛体力学モデル実習　m4_8
１　テーマ　「球体と壁の衝突」

２　力学モデル　m4_8_rotation and bound.wm「無重力、スライ

ダー（速さ、角速度）」

３　理論

　平面運動をする球体が壁などの障害物と衝突する場合、重心

の運動の速度 GV
r
と、重心周りの回転運動の角速度 Vr

r
=ω が関

係する。ここで、r は球の半径、V
r
は外周の速度である。

　衝突後の球体の速度は右図のように、 GeV と rV を合成した速

度となり、その速さは ( )22)( rVeVG + 　である。

４　操作

　図 m4.8 は、球 1 と 2 にスライダーで重心の X 方向の速さと、角速度を設定し、平面運動を起こ

させ、壁に衝突させるものである。衝突後の運動と、重心の軌跡を観察し、角速度の方向を逆にす

ればどうなるかも観察せよ。スライダーの角速度は－2π～2πである。球と壁の弾性係数 e を 0.5

としてあるが、スライダーを表示し、e を変化させて衝突後の並進運動を観察せよ。

図 m4.8 球体と壁の衝突

演習　　　任意の設定における、衝突前後の平面運動を、定量的に解析せよ。メジャーウイン

ドウを開き、デジタルデータを得て行え。

( )22)( rVeVG +

　　　　　　　　　　　

rV

　　　　　　　　　　　壁

　       eV
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4.5　慣性モーメント

4.5.1　回転体の慣性モーメント

　静止する回転可能な物体や、固定された軸を回転する

物体には、回転し易さを示す物理量が考えられている。

それを、慣性モーメントと言い、記号の I を用いる。I

が大きいほど回転しにくく、回転している場合はなかな

か止まらないことを示す。

　一般に、回転する物体の慣性モーメントは、質量と回

転軸からの距離の二乗との積に等しいとされている。

　図 4.13 のように、軸からの距離が R1、質量が M1 の物

体が角速度ωで回転しており、軸の周りには、合計 r 個

の物体が、同じ角速度で回転しているとする。このよう     図 4.13　回転体の慣性モーメント

な複合体の場合、慣性モーメントの定義から

∑
=

=
r

j
jj RMI

1

2                                  (4.38)

となる。

　ここで、一様な棒の慣性モーメントを考え

る。図 2-9 の A は軸と棒が垂直、Bは同方向

とする。

A の場合は

22

3
1

4
1 MLMR +            (4.39)

B の場合は

　  2

2
1 MR                (4.40)

と計算されている。このように回転軸の取り           図 4.14 円柱体の慣性モーメント

方により慣性モーメントは異なる。             　　  

4.5.2　いろいろな剛体の、回転軸と慣性モーメント

　剛体の慣性モーメントの計算は、質点の連続的集合と考え、式  (4.38) によって積分計算になる。

ここで、軸からの距離が rの一点における密度をρ、微小質量 dm、微小体積 dv とすれば、慣性モ

ーメント I は

dxdydzrdvrdmrI ∫∫∫∫∫ === 222 ρρ                         (4.41)

                           M1

  M2                      R1

            R2        M3   

                     R3

   Mr

      Mr      Rr

  

　

　　　丸棒　　　　　　　　　     R   回転

軸

　　　　　　

　　　　　　  2L　回転軸 　　　　　　　   

　                                       

2L
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で計算される。

　図 4.15 は半径 r、密度ρの球について、直径を軸とする慣性モーメントを計算するものである。

球の中心に xy 座標をとり、中心から距離 y にある厚さΔy の円盤の、y 軸周りの慣性モーメントを

ΔI とすれば、　　　　　　　　 ( ) yxxyxI ∆=∆=∆ 422

2
1

2
1

ρπρπ                             (4.42)

となり、ここで、x2+y2=r2 であるから、球の慣性モーメント I は

( ) ( )
15
8

2
2
1

2
5

0

4224
2

0

22 r
dyyyrrdyyrI

rr
υπρπρπ =+−=−×= ∫∫            (4.43)

である。ここで、球の質量を M とすれば、 ρπ 334 rM = だから、I は

2

5
2 MrI =                                   (4.44)

となる。慣性モーメントは回転半径を k として
2MkI =                                   (4.45)

とする場合がある。剛体の回転半径は式(4.41)から

M

dvr
k ∫=

2
2

ρ
                                (4.46)

　剛体の、重心を通る回転軸と、慣性モーメントの大きさを、図 4.15 に示す。

図 4.15 密度一様な剛体の慣性モーメント

　細い棒　　　　　　　球殻　　　　　　　　　　　球

        l

                                            　　r

                                         　r

           1/12Ml2

　　　　　　　　　　　　　　　　　　　　　　　　　　      2/5Mr2

                                2/3Mr2        2l

　長方形板　　　　　　　円柱     r

                                                         1/2Mr2

          2a

                                              1/4Mr2+1/3Ml2

 2b                        1/3Mb2

　　　　　　　　　　　        円輪   　　　 r

                1/3Ma2

                                                1/2Mr2
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　剛体力学モデル実習　m4_9
１　テーマ　「剛体各種の慣性モーメント」

２　力学モデル　m4_9_moment of inertia.wm「無重力、中断時間 3 秒、スライダー（質量、角速度）」

３　理論

　板状の剛体各種について、トルクＮを、その回転半径 r を同じにして、作用させるときの角速度

と角加速度を考慮する。ここで、
dt
dIN ω= である。角加速度が慣性モーメントに反比例することを、

確かめる。

４　操作

　図 m4.9 は、剛体各種の回転について、トルク（力のモーメントで、力を 7.7 ニュートン）を設

定してある。Run すれば、剛体それぞれの角速度が、メジャーウインドウのグラフとして観察でき

る。角加速度を見る場合は、メジャーウインドウを開くこと。

図 m4.9 剛体各種の慣性モーメント

演習　　　剛体それぞれについて、ダブルクリックして Properties を開き、剛体の種類を material

で選択し、慣性モーメントを moment に入力して Run せよ。ただし、剛体の質量は、慣性モー

メントを設定すれば自動的に決定される。スライダーで慣性モーメントを設定する場合は、

Properties で質量 mass と慣性モーメント moment を 0.000 と入力し、次に、剛体をクリックし

Define ⇒ New Contlol
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　剛体力学モデル実習　m4_10
１　テーマ　「転がりながら平面運動をする球体の運動エネルギー」

２　力学モデル　m4_10_kinetic energy.wm「中断時間 2.2秒、スライダー（速さ）」

３　理論

　球体の質量を M、重心周りの慣性モーメントを GI 、角速度をω、重心の X 方向の速さを GV 、と

すれば、平面運動を行う球体の全運動エネルギーは、式(4.35)から

22

2
1

2
1

ωGGrt IMVKKK +=+=

である。

４　操作

　図 m4.10 は、球体 Aと B が摩擦のある床と斜面を、転がりながら平面運動をするものである。

スライダーで、両球の X 方向の速さを 2.00m/s2 としてあり、Runすれば、運動エネルギーkinetic energy

に関するメジャーウインドウで、並進運動のエネルギーTraと回転運動のエネルギーRot および、全

運動エネルギーTot のグラフが観察される。

図 m4.10 転がりながら平面運動をする球体の運動エネルギー

演習　　　スライダーで両球の X 方向の速さを適宜設定し、メジャーウインドウのデジタル

データを用いて、上式の成立を検証せよ。
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　剛体力学モデル実習　m4_11
１　テーマ　「長方形板の物理量各種とトルクの設定」

２　力学モデル　m4_11_slider.wm「無重力、スライダー（位置、質量、慣性モーメント、長さ、力、

                                角速度、）」

３　理論

　長方形板の物理量各種とトルク（力のモーメント）の設定をスライダーで行う。長方形板では、

重心の

X、Yの位置、質量と慣性モーメント、長さと幅、外力では大きさと作用点の角速度を設定できる。

スライダー自身の設定は、スライダー本体をクリックすれば、Properties ウインドウが開かれ、最小

値 min と最大値 max を入力すればよい。

４　操作

　図 m4.11 を Run すれば、長方形板が外力によるモーメントで回転運動が起こり、回転はだんだ

ん速くなる。長方形板をクリックしメジャーウインドウを開き、Measure ⇒ Acceleration ⇒ All を

選択して、角速度、角加速度を観察する。

図 m4.11 長方形板の物理量各種とトルクの設定

演習　　　スライダーで各種物理量の最小値、最大値を確認せよ。長方形板の長さと幅を適宜

変更し、その他の量も設定して色々試してみよ。
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　剛体力学モデル実習　m4_12
１　テーマ　「円形と長方形板の慣性モーメントと角運動量」

２　力学モデル　m4_12_inertia slider.wm「無重力、スライダー（全設定、慣性モーメント、長さ幅」）

３　理論

　剛体の慣性モーメントは、その素材の違い、形の違い、面積の違い等により、さまざまな値をと

る。図 m4.12 の場合は、円形坂と長方形板について、3D/Spher、Plarar、Shell の違いによる、慣性

モーメントの値を記してある。ただし、5 と 6 の図は長さと幅を変えてある。スライダーで 4 と同

じにすれば記した値となる。

４　操作

　図 m4.12 は、この図の左上の Generic Controlがそれであり、1.000～10.000 を最小・最大値に設

定してある。例えば、Generic ControlをクリックするとPropertiesの最上段に*Input[47]-Generic Control

が示されており、次いで、剛体板のどれかをクリックし、Properties の中の V を見れば 3.140*input[47]

と入力されている。このことは、角速度の設定を Generic Controlで指定した倍率を掛けて設定する

ことを意味する。

図 m4.12 円形と長方形板の慣性モーメントと角運動量

演習　　　Generic Control の使い方に慣れよう。角運動量はどの物理量に最も関係が深いか
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4.5.3　慣性モーメントに関する定理

A　平行軸の定理

  図 4.16 のように、剛体内の任意の一点 O と、それに平

行で重心を通る軸を G とし、軸に垂直に xy 軸、x'y''軸を設

定する。

　点 P の座標を (x , y ) 、( x ' , y ' ) 、重心 G の座標を ( x G ,

y G )とし、点 O を通る y 軸周りの慣性モーメント I は、

( )22 yxmI i += ∑               (4.47)

であり、重心 G を通る y'軸周りの慣性モーメント IG は

( )22
iiiG yxmI ′+′= ∑     　      (4.48)

である。                                                   　図 4.16 平行軸の定理

　ここで、 iGiiGi yyyxxx ′+=′+= を式(4.48)に代入して

( ) ( ){ }
( ) ( )2222

22

22 GGiiiGiiGiii

iGiGi

yxmymyxmxyxm

yyxxmI

++′+′+′+′=

′++′+=

∑∑∑∑
∑    　      (4.49)

である。ここで、重心に関する各質点の位置ベクトルをr
r
とすれば、

0=∑ iirm
r

         　                       (4.50)

であり、よって

00 =′=′ ∑∑ iiii ymxm        　                   (4.51)

であるから式(4.49)は

( ) ( )∑∑ ++′+′= 2222
GGiiii yxmyxmI                      (4.52)

となり、従って
2MhII G +=                                 (4.53)

を得る。ここで、M は剛体の全質量、h は平行軸間の距離である。この関係式を平行軸の定理とい

う。

　回転半径で平行軸の定理を示せば
22

GG MkIMkI ==                             (4.54)
222 hkk G +=                                (4.55)

となる。

        y           y'

                          P

                       G    x'

                  h

        O                   x
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B　平面版の定理

　図 4.17 の薄い板状の剛体の一点 Pの質量を m i、x y座標を (x i ,

y i) 、OP 間の距離を r i とすれば、O 点における z軸周りの慣性モ

ーメントを Iz、y 軸周りの慣性モーメントを I x、x 軸周りの慣性モ

ーメントを I yとすれば、

( )
xyiiii

iiiiiz

IIymxm

yxmrmI

+=+=

+==

∑∑
∑∑

22

222

          (4.56)

となる。                                                         図 4.17 平面板の定理

　この式は平面板の慣性モーメントを求めるときに使われる。これを平面板の定理という。

4.6　固定軸周りの運動方程式

4.6.1　運動方程式と角運動量

　固定軸周りの運動エネルギー式は式 (4.46) より

( ) θω dNId i∑=





 2

2
1

であるが、微分すれば、ω＝dθ/ d t より

( ) θθ
ω dNd

dt
d

I i∑=





                                (4.57)

となり、

∑∑ ==∴ ii N
dt
d

IN
dt
d

I 2

2θω
                           (4.58)

であり、この式を固定軸周りの運動方程式という。ここで、∑ iN は軸に対する外力のモーメント

で、∑ = 0iN のとき、

constI =ω                                    (4.59)

である。

　この Iωは軸に関する剛体の角運動量という。また、この式を説明すれば「軸に関する外力のモ

ーメントの和が 0 であれば、その軸に関する剛体の角運動量は保存される」となり、これを角運動

量保存の法則という。

     z

              y

                  xi       P

                   ri          yi

         O                  x
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　剛体力学モデル実習　4_13
１　テーマ　「角運動量と力のモーメント」

２　力学モデル　m4_13_angular momentum.wm「無重力」

３　理論

　剛体の慣性モーメントを I、角速度をωとすれば、力のモーメントが 0 であれば、式(4,59)より、

constI =ω である。角速度が慣性モーメントに反比例することを確かめる。

４　操作

　図 m4.13 は、剛体の回転について、式(4.59)を検証するためのものである。球体の速さを 2m/s

で長方形板に衝突させ、力のモーメントを与えれば、長方形板は重心を軸とする回転運動を行う。

球からの力は衝撃力であるから、回転後は力が 0 となり、力のモーメントは 0 である。従って上式

が成立する。

　Run すれば、球からの力のモーメント（トルク）と、慣性モーメントが異なる長方形板 1 と 2 の

角速度のメジャーウインドウにグラフが表示される。

                                      

図 4.13 剛体の回転

演習　　　球体の速さと質量のスライダーを開き、設定を変えて Run し、デジタルデータを得て

上記の式が成立することを検証せよ。

　デジタルデータをメジャーウインドウから入手し、ワープロソフト「エクセル」に移植する方

法は、Run の終了後、目的とする測定のメジャーウインドウをクリックし、Edit ⇒ Copy Data

を選択する。データがコピーされたので、エクセルを起動し、編集 ⇒ 貼り付け、でエクセルに

移植が終了する。
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　剛体力学モデル実習　m4_14
１　テーマ　「角運動量と力のモーメント」

２　力学モデル　m4_14_angular momontum-1.wm「無重力、スライダー（角速度）」

３　理論

　剛体の慣性モーメントを I、角速度をωとすれば、力のモーメントが 0 であれば、式(4,59)より、

constI =ω である。角速度が慣性モーメントに反比例することを確かめる。

　回転（スピン）を伴う高飛び込み、鉄棒競技、フィギュアスケートなどでは、角運動量一定の状

況における回転速度を制御するため、自身の体型を変化させて慣性モーメントを変化している。す

なわち、回転軸に対する回転半径の大小が慣性モーメントを規定する。

４　操作

　図 m4.14 は、剛体の回転について、式(4.59)を検証するためのものである。角運動量は力の作用

がなければ、常に一定である。初期の角速度をスライダーで設定し、角速度のグラフをメジャーウ

インドウで観察する。スライダーによる角速度の最小値は－31.0、最大値は 31.0である。Run すれ

ば、人の腕 (Arm)が体 (Body) に近くなったとき、角速度がどう変化するか観察せよ。

図 m4.14 剛体の回転

演習　　　モーグルというスキー競技は、ジャンプ台からジャンプした後に回転やひねりで競

うものである。このモデルを作成せよ。
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4.6.2　複振子（物理振子ともいう）

　図 4.18 は複振子であるが、重心を G、G から下ろした垂線の

足を点 O とする。いま、O 点を水平な軸にすれば、剛体は G と O

を含む鉛直面内で振動する。剛体の質量を M、軸周りの慣性モー

メントを I、線分 OG の長さを h、OG が鉛直線となす角をθとす

れば、式(4.58)から

θ
θ

hsin2

2

gM
dt
d

I −=       　　　　　 (4.60)

となる。剛体に作用する外力は重力と軸からの抗力であるが、　　　　　　図 4.18 複振子

抗力は軸を通過するから、軸の周りにモーメントを持たない。

　振幅が小さく、sinθ≒θと近似できるときは、

θ
θ

I2

2 hM
dt
d g−=                                  (4.61)

である。これは、単振子の式と同型であるから、周期を T とすれば、I=Mk2 であるから

h
k

hM
I

T
gg

2

22 ππ ==                              (4.62)

となる。

　ここで、G を通り軸に平行な軸周りの回転半径を kG とすれば、I=M kG
2+Mh2 だから

h
hk

T G

g

22

2
+

= π                                (4.63)

となる。

　同じ周期を持つ単振子の長さを L とすれば、その周期 T は

g
L

T π2=

であり、この関係を式 (4.62) に代入すれば

h
k

hM
IL

ggg

2

==                               (4.64)

となる。簡単にすれば

h
k

Mh
I

L
2

==       　　　　　　　             (4.65)

となる。この長さ L をその複振子の相当長（または、相当単振り子の長さ）という。

　　　 O

        θ  h

                G
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　ここで図 4.19 のように、OG の延長線上に O から L の長さの点 O'をとり、O'を軸として振動さ

せれば、このときの周期を T'として、線分 O'Gの長さを h'、

O' 軸周りの回転半径を K' とすれば

h
2

2

′
′

=′
g
k

T π      　 　　　　　　(4.66)

である。この h' は

2
222

G
G khh
h

k
h

hkhLh =′∴=−=−=′      (4.67)

となる。この関係を使い

                                                                図 4.19 振動の中心

h
k

h
hk

h
k G

2222

=
′

′+
=

′
′                                 (4.68)

となり、T=T' であるから、点 O で振動させても、点 O' で振動させても周期は同じである。点 O' を

振動の中心という 。この結論を用いて、重力の加速度を性格に測定する装置が、Kater の可逆振子

である。

　この振子は、金属棒に二つの平行な金属刃 O , O' を固定し、棒に沿って重り M および m を、ね

じで移動調節できるようになっており、どちらの刃で支えて振動させても周期 T が、等しくなるよ

うに調節すると、2 個の刃の距離が相当長となり

g
L

T π2=                                     (4.69)

であるから

２

２４
＝

T
Lπ

g                                     (4.70)

となる。この実験では、慣性モーメントを測定する必要がなく、重心の位置を正確に知る必要がな

い。

 　　 O

           h

             G

          L      h'

                   

                     O'
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　剛体力学モデル実習　m4_15
１　テーマ　「複振子の周期」

２　力学モデル　m4_15_compound pendulum-1.wm「重力場」

３　理論

　図 m4.15 のように、点 O を回転軸とし、剛体を振動させる。重心を G とし、線分OG の長さを h

とし、

剛体の質量を M、重力加速度を g、慣性モーメントを I、角速度をωとすれば、重力のモーメントが

θhsingM− であり、式(4.59)より、 constI =ω であるから、式(4.60)より

θω sinhM
dt
dI g−=

である。重心 G の周期を T とすれば、式(4.62)から次のようになる。

hM
I

T
g

π2=

４　操作

　図 m4.15 は、Run すれば剛体の角速度がメジャーウインドウで観察できる。

図 m4.15 複振子の周期

演習　　　剛体をダブルクリックして Properties ウインドウから、重心 G の X,Y 座標と、線分

OG と鉛直線となす角度θ、のデータからｈを計算し、剛体の質量 M、慣性モーメント I のデー

タを用いて、周期 T を計算せよ。また、デジタルデータをエクセルに移植して T を求める方法
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　剛体力学モデル実習　m4_16
１　テーマ　「複振子と振動の中心」

２　力学モデル　m4_16_compound pendulum.wm「重力場」

３　理論

　複振子については、本文 13～14 頁に記しているが、図 4.19 において回転軸を O 点にする場合と、

O'点にする場合、両者の振動周期 を T , T' とすれば、両者を振動させたとき、 TT ′= であったとす

る。

ここで、重心を G とし、線分 OG = h , O'G = h' , OO' = L とすれば、L = h + h' である。このとき、L

を複振子の相当単振り子の長さといい、式 (4.62)～(4.68) の結果、周期 T と L の関係式は次のよう

になる。

g
L

T π2=

４　操作

　Run し、左右の剛体は上下転地させ、回転の中心を O と O'とした場合の振動が観察できる。メジ

ャーウインドウで、運動量と角運動量のグラフが見られる。

　左右の周期は、点 O' の位置を微小に変えて、ほぼ同じになるように設定せよ。

図 m4.16 複振子と振動の中心

演習　　　線分 O'G = h を、スライダーを開いて設定出来るように工夫し、両者の h , h' を計

算して
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　剛体力学モデル実習　m4_17
１　テーマ　「剛体の可逆振子」

２　力学モデル　m4_17_double pendulum.wm「重力場、」

３　理論

　本文 13～14 頁と剛体力学モデル実習 m4_16 compound pendulum.wm を参照。

４　操作

　図 m4.17 は、ケーター (kater) の可逆振子を、簡単な模型として作成したものである。Run すれ

ば、上部の△（回転の支点）を回転軸とする、ゆるやかな単振動が観察できる。メジャーウインド

ウで重心の速度のグラフなどが見られる。このモデルは、あくまでも説明用であるから、厳密なも

のではない。

　次に、下部の△を回転軸とする場合、△を固定するための錨マーク Anchor を取り除き、一番大き

な長方形の中点に Pin joint を取り付け、モデルの適当な箇所をクリックし、ドラッグによってモデ

ルを回転させ、適当な状況にモデルを設定する。そして、上部に位置した△に錨マークを取り付け

る。こうして、下部の△を回転軸とする単振動が観察される。実際の、重力加速度を測定する実験

に用いる装置では、それぞれの回転軸に対する支点は、ネジ機構により精密に設定できる。

図 m4.17 剛体の可逆振子

演習　　　Kater の可逆振子の精密なモデルを作成し、スライドを用いてネジ機構の代わりとな

るよう工夫せよ。Run の結果、得られたデータを検討し、どの程度の誤差を含むか検討せよ。
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4.7　平面運動の運動方程式

4.7.1　運動方程式

　図 4.20 のように、xy 軸を重心 G の平面運動内にとり、

剛体内の点 P をとって、GP が x 軸となす角をθとし、

重心の座標を( xG , yG )とする。

  剛体の質量を M、重心を通り xy 平面に垂直な軸の周り

の慣性モーメントを IG、剛体に作用する外力の合力F
r
の

x 成分を Fx、y 成分を Fy、重心周りの外力のモーメント

を Nｚとする。

  また、重心周りの回転における角速度をωとする。

　平面運動をする剛体のエネルギー式は、式(4.37)で示さ

れるが、変形して　　　　　　　　　　　　　　　　　　　　図 4.20 平面運動の運動方程式

θω dNsdFIvMd zGGG +=





 +

rrr 22

2
1

2
1

                       (4.71)

となり、ここで微分をすれば

θθω dNsdFd
dt
dI

dt
vd

M zGG
G +=+

rrr
          　           (4.72)

となる。

  剛体の平面運動は重心の並進運動と、重心周りの回転運動を考えなければならないが、上式の両

辺の同じ項から、並進運動の運動方程式と回転運動の運動方程式は

zG
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dt
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                                   (4.73)

となる。この両式からも判断できるが、両者の運動は独立しており、それぞれの初期条件や運動の

環境条件で関係づけられる。

　上式を座標成分で表せば
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となる。
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　剛体力学モデル実習　m4_18
１　テーマ　「衝撃力による平面運動」

２　力学モデル　m4_18_cycloid.wm「無重力、スライダー（速度）」

３　理論

　剛体に作用する外力 F について、衝突時間を t とすれば、F t として考え、これを力積としてい

る。この力積は通常、撃力として扱われる。衝突時間 t は相当小さく、ほとんど、瞬間と考えられ

ている。また力も 0 から最大値を経て 0 まで連続的に変化し、その大きさは時間積分により求めら

れる。従って、通常、「運動量の変化は力積に等しい」という法則により、外部からの力積（撃力）

は、剛体に力積と等しい運動量を与えると言える。

　撃力は剛体に対し、力のモーメントを作用させるから、剛体は平面運動を起こし、与えられた運

動量によって重心の並進運動を維持し、また、それとは独立に生じる、重心周りの回転運動による、

角運動量を維持しながら回転運動も続ける。

　以上をまとめれば、剛体の質量を M、重心軸周りの慣性モーメントを IG 、外力を F、重心周りの

外力のモーメントを N とすれば、式 (4.73) から

N
dt
d

IF
dt
vd

M G
G ==

2

2θrr

となる。左の式を X , Y 座標で示す式は式 (4.74) を参照のこと。

４　操作

　図 m4.18 は、球体を剛体に衝突させ、剛体の平面運動を観察するものである。重心の並進運動

と、重心周りの回転運動が観察できる。上部の点が描く軌跡は、Cycloid 曲線である。スライダーで

球速を変更して試してみよ。

図 m4.18 衝撃力による平面運動

演習　　　Cycloid 曲線であることを証明せよ。
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　剛体力学モデル実習　m4_19
１　テーマ　「平面運動のエネルギー」

２　力学モデル　m4_19_rotational energy.wm「中断時間 1 秒、スライダー（質量、速さ、角速度、  半

                                         径、動摩擦係数）」

３　理論

　剛体力学モデル実習 m4_10_kinetic energy.wm の理論を参照のこと。

４　操作

　図 m4.19 は、剛体の回転について、式 (4.35) を検証するためのものである。球体の半径、質量、

速さ、角速度、動摩擦係数を色々に設定し、理論式を検証せよ。メジャーウインドウでは、球体に

おける重心の運動エネルギー、重心周りの回転エネルギー、とそれらの合運動エネルギーが観察さ

れる。

図 m4.19 平面運動のエネルギー

演習　　　ボウリング競技の基礎理論となる運動である。他に、どんなエネルギーが考慮され

るか考え、それのモデルを作成せよ。特に、ボールとピンとの衝突現象に関するモデルを、無

重力場における平面運動としてのモデルも作成せよ。



118

　剛体力学モデル実習　m4_20
１　テーマ　「段差のある道路を走行する自動車」

２　力学モデル　m4_20_Run a car.wm「スライダー（速さ、角速度）」

３　理論

　段差がある道路を自動車が走行する場合、重心の速さ、車輪の角速度、路面の動摩擦係数、段差

部分との跳ね返りの係数の設定により、段差を乗り越えられるかどうかが問題となる。モデルのシ

ミュレーションにより、一定の理論が得られるよう検討する。

４　操作

　図 m4.20 は、Run すれば乗り越える場合である。スライダーを操作し、乗り越えられる場合はど

んな傾向があるか、色々設定を変えてみよう。

図 m4.20 段差のある道路を走行する自動車

演習　　　段差のスライダーを設定し、段差の高さは、乗り越える場合において、どの要素と

相関が大きいか検討せよ。また、乗り越える様子を見ると、前輪の角速度と摩擦が重要である

と観察できるが、この点に関しても考察せよ。
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4.7.2　斜面上の円柱の運動

　図 4.21 のように、傾角αの斜面上を質量 M、半径 r

の密度が一様な円柱が転がり落ちる運動において、円柱

に作用する外力は、重心 G への重力 M  、斜面との接触

点 O における抗力 R、斜面方向の摩擦力 F である。

A　滑らず転がり落ちる場合

　重心の座標を xG , yG 、重心に対する回転の角速度を

ω 、重心を軸とする場合の慣性モーメントを IG とすれ

ば、式 (4.74) より                                         図 4.21 斜面上の円柱の運動
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M G                                (4.75)
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M G −=                                (4.76)
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                                    (4.77)

となる。ここで、y =r = const であるから d 2 yG / d t 2 = 0 、従って θcosgMR = となる。また、円柱

が滑らない条件の意味は v = rωだから、
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である。式 (4.77) , (4.78) から
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が得られ、これを式 (4.75) に代入してF を求め

α
θ

αα sin
3
2d

sin
3
2d

 sin
3
1

2

2

2

2

rdtdt
x

MF G g
gg ===                 (4.80)

が求まる。

　従って、重心は加速度 ( ) αsin32g で等加速度運動を行い、円柱は重心の周りに角加速度

( ) αsin3r2g の等角加速度の回転運動をする。

　いま、静止摩擦係数をμとすると、 Rµ が円柱に作用する最大摩擦力だから、もし RF µ≤ であれ

ば、円柱は滑ることなく転がる。従って、その条件は

αµαµα tan
3
1cosMsin

3
1

≥∴≤ ggM                        (4.81)

となる。
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B　滑りつつ転がり落ちる場合

　この場合は、すでに摩擦力は最大値μR に達しており、滑り摩擦係数をμ'とすれば

RF µ ′=                                     (4.82)

であるから、
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                          (4.83)

となる。これを計算すれば
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となる。

　このとき、斜面との接触点の速度を V とすれば、 0=t の初期条件の

00 ==
dt
d

dt
dxG θ

         　                   (4.85)

によって計算すれば

( ) t
dt
d

r
dt

dx
V G αµα

θ
cos3-sin ′=−= g     　                (4.86)

となり、tanα/3 >μ' のときは 0=V となり、滑りながら転がり落ちる。

　剛体力学モデル実習　m4_21
１　テーマ　「斜面上を円柱体が転がり落ちる現象」

２　力学モデル　m4_21_slope and ball.wm「中断時間 2.5秒、スライダー（質量、速さ、角速度、摩

                                       擦係数）」

３　理論

　本文 15～16 頁についてのモデルである。傾角αの斜面上を質量 M、半径 rの円柱体が転がり落ち

る運動において、円柱体に作用する外力を、重心への重力 mg、円柱体と斜面の接触点への斜面から

の抗力 R、斜面上方への摩擦力 F とする。

　滑らず転がり落ちる場合、式 (4.75)～(4.79) を経て、式(4.80)により次のような物理量が得られる。
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このとき、滑らない条件は、動摩擦係数をμとすれば、次のようである。

αµ tan
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≥
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　また、滑りながら転がり落ちる場合、式 (4.82)～(4.85) を経て、式(4.86)により次のような物理量

が得られる。ここで、動摩擦係数をμ'とする。

( )αµα
θ

cos3-sin ′=−= g
dt
d

r
dt

dx
V G

このとき、滑る条件は V=0 だから、次のようである。

αµ tan
3
1

≤′

４　操作

　図 m4.21 は、スライダーを多用し、円柱体の運動を観察するものである。特に上記の滑るかど

うかの条件について、検証してみよう。

　ここで、斜面の傾角αは、スライダー である slope 22 Rotation で自由に設定できるが、注意を要

することは、ボールを斜面上にきちんと接触させることが必要である。

　　　　　　　　　　　　　　　　　　　　　　　

図 m4.21 斜面上を円柱体が転がり落ちる現象

演習　　　メジャーウインドウを各種開き、デジタルデータをエクセルに移植して、上記理論に

示された各種物理量の計算をせよ。

　また、斜面を登るモデルを作成し、滑りの問題を検討せよ。
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4.8　衝撃力による剛体の運動

4.8.1　運動量の変化

　棒などの物体をバットで打つように、剛体に衝撃力を作用させ、平面運動を起こさせる事を考え

る。式(4.74) で示される平面運動の運動方程式を運動量の変化を示す形に書き表せば、

( )
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∑
∑
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                               (4.87)

となる。

　右辺の上 2 項は任意の点に作用する力積であるが、これを、衝撃力が作用する微小な時間τの間

で積分すれば全力積Φが求まる。従って

∫

∫
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ixix
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となる。

　右辺 3 項は衝撃力のモーメントであるが、x y座標で示すと

( )∑∑ −= ixiiyiiz FyFxN                            (4.89)

となる。

　微小時間τで積分すれば全モーメントが求まるが、τの間、剛体の位置と作用点はそのままであ

る事を考慮すれば、

[ ] ( )∑∑ ∫ ∫∑ ∫ −=−= ixiiyiixiiyiiz yxdtFyFxdtN FF
τ ττ

0 00
             (4.90)

となる。ここで、右辺は力積のモーメントを示している。

　従って、衝撃力による運動量の変化は
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となる。
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4.8.2　打撃の中心

　バットの芯でボールを打てば、グリップを握る手には衝撃が加

わらないので、手がしびれないと言われる。バットという剛体の

芯とは、剛体の回転運動の中心を示している。

　図 4.22 のように、静止している質量 M の剛体の、一点 O に衝

撃力を作用させ、その運動を考える。

　点 O を通り、y 軸は重心 G を通る x y座標軸をとり、x 軸方向に

衝撃力による力積Φを与え、重心 G と点 O の距離を h とする。

　運動量の変化は、式 (4.91)において左辺 2 項は、剛体が静止して

いるから 0 とおき、右辺のΦiy も 0 とし、 hy i = と置けば              図 4.22 衝撃運動

FF v hIMvMv GGyGx === ω0                      (4.92)

となる。回転半径を kG とすれば、 2MkI = を用いて整理すれば

Gx
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GyGx v
k
h

Mk
h

v
M

v 220 ==== FF ω                  (4.93)

となる。ただし、 GyGx vv は重心 G の速度成分、ωは重心周りの回転運動の角速度である。

　ここで、点 O から重心 G を通り過ぎた延長線上に一点 O ' をとり、線分O 'G長さを h ' とする。

点 O ' の速さを V、重心の速さをvG とすれば
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となる。

　従って、V が 0 になる場合の h ' は

h
k

h G
2

=′                                       (4.95)

である。このときの点 O ' は瞬時中心となるから、この剛体は O ' を回転の中心軸として運動する。

　このことから、衝撃力を O ' に作用させた場合は O 点が瞬時中心となり、O を回転の中心軸とし

て運動する。

　また、O ' 点は瞬間的に運動しないことから、一切の力が作用しない、言い換えると力を受けな

い。従って、バットでボールを打つ場合に、点 O ' の部分を握り、点 O でボールを当てれば、手に

は衝撃が伝わらないことになる。このように、O と O ' は互いに他に対する打撃の中心を成してい

るという。

　他方、式 (4.95) は複振子における式(4.67)と同じであるから、複振子の相当長（相当単振子の長

さ）L を求める事ができる。すなわち、

hhL ′+=                                      (4.96)

である。Kater の可逆振子の二つの支点である金属刃の位置が、この 2 点 O と O 'である。
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　剛体力学モデル実習　m4_22
１　テーマ　「衝撃力と打撃の中心」

２　力学モデル　m4_22_center of percussion.wm「無重力、中断時間 5 秒、スライダー（質量、速さ）」

３　理論

　衝撃力による剛体の平面運動の理論は、剛体力学モデル実習 m4_18_cycloid.wm で示されている

から参照すること。

　打撃の中心とは、「バットでボールを打つ場合、衝撃の影響が、バットの１点だけ 0 になるところ

がある。」という常識があるが、その点のことである。従って、打撃の中心を握ってボールを打てば、

手にはなにも衝撃を受けない。また、バットのボールを打つ打点と、衝撃の中心を逆にしても、同

様のことが言える。

４　操作

　図 m4.22 は、球体を棒状剛体の点 3 にぶつけたとき、棒がどんな運動をするかを観察するもの

である。球体を点 4 にぶつけた場合は、実習 m4_18 と同様に運動する。

　ここで、ボールをぶつける点の位置を、少しずつずらして Run し、その点の加速度をメジャーウ

インドウで観察して、それが 0 であれば、その点が打撃の中心であることになる。

図 m4.22 衝撃力と打撃の中心

演習　　　打撃の中心を調べるモデルを作成せよ。また、打撃の中心は、剛体の回転運動にお

ける瞬時中心となることを証明せよ。
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4.8.3　回転体の自由軸

　図 4.23 は、実線の図のように、天井から紐でぶら下げら

れた円柱を、紐を軸とする回転を与えたものである。しばら

くすると、点線の図のように、もとの紐を軸とする回転状態

に移行し、回転は安定する。

　回転体の軸には、剛体の各部の遠心力が作用し、軸を安定

させるには適当な力で支えなければならない。ところが、重

心を通る任意な方向の軸を選択すれば、支える力が不要とな

り、安定して回転する。すなわち、剛体各部の軸周りの遠心

力が 0 で、重心の周りの遠心力のモーメントの和が 0 であれ

ば、回転は安定する。この条件を満たす軸を、回転体の自由

軸という。

　楕円体では、中心を通る 3 つの軸が自由軸であり、円柱の      図 4.23　回転体の自由軸

場合はその中心軸と、これに垂直な中心を通る任意な軸が自由軸である。

　自由軸のうちで、慣性モーメントの最大な軸の周りに回転するとき、回転は最も安定する。従っ

て、剛体を、任意の軸の周りに回転させれば、剛体は慣性モーメントが最大の自由軸の周りに、回

転するように回転自体が変化する。

4.8.4　コマの才差運動

　剛体が回転するとき、その軸に直角な線の周りに、力

のモーメントを受けるときは、角運動量の方向は変化す

るが、その大きさは変化しない。

　図 4.24 のように、コマを鉛直線から傾けて自転させ

るとき、コマに作用する力は、重心に重力、コマの心棒

に床の抗力の二力である。この二力は偶力であり、コマ

の心棒に対して力のモーメントを与える。

　偶力の効果は、コマの角運動量方向すなわち、心棒の

方向を変化させるだけで、角運動量の大きさを変化させ

ない。心棒は次第に方向を変えて、心棒と鉛直線とのな         図 4.24 コマの才差運動

す角θを半頂角とする、円錐面の外縁に沿って円運動をし、コマを倒そうとする偶力に対抗し、コ

マは倒れない。

　このように、回転軸が、それと直角に作用する力のモーメントを受けて、次第に方向を変化する

とき、この運動を才差運動という。

　回転運動に対する運動方程式をベクトルで示すと

( ) N
dt
Id rr

=ω                                     (4.97)

　　　　　　天井

点線図

安定した回転

　　　　　　  

実線図

最初の回転

  θ

              θ R

　　　　　Mg
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である。また、角運動量 ω
rI をL

r
とすれば、

N
dt
Ld r
r

=                                      (4.98)

となる。

　図 4.25 のように、角運動量L
r
は自転軸の方向に向くが、外力F

r
によるモーメントN

r
がこの軸に

垂直に作用するときは、先に記したように、大きさは変わらないで、L
r
の方向が N

r
の方に変わる。

その変化 L
r

∆ の方向は L
r
に垂直で、大きさ L

r
∆ は、 L

r
の回転角を ϕ∆ とすれば

ϕ∆=∆ LL
r

   　　　　       (4.99)

である。よって、式 (4.98) は

N
dt
dL =ϕ                  (4.100)

となる。これから、回転の軸を変えるように外力を作用させ

ると、軸は力F
r
の方向ではなく、力と軸により求められるモ

ーメントN
r
の方向を追うように、軸自身が向きを変える。こ

れが才差運動で、                                              図 4.25 軸の向きの変化

そのときの角速度の大きさは

ω
ϕ

I
N

L
N

dt
d

==                                 (4.101)

である。

4.9　剛体の静力学

4.9.1 総質量と重心

　剛体は、様々な密度を持つ小物体の集積体である。小

物体には、地球の引力が作用し、地球の中心方向へひか

れている。普通なら、バラバラになるのだが、小物体ど

うしの相互作用による引力・斥力がバランスよく対応し、

全体としての大きさや形状が維持されている。無限とも

言える、小物体の一つひとつについて、物理学を適用す

るには、不可能であり、

小物体の質量を一カ所に集めた、総質量を考え、それを

考慮の対象にする。                                               図 4.26 重心

　総質量は、図 4.26 のように、小物体の重力を合成して得た合重力の大きさを、重力加速度 g で除

して求める。合重力の作用点を、重心と呼ぶ。従って、剛体に作用する力は、重心に集積された総

N
r

                       L
r

∆
     O       ϕ∆

               L
r

                     F
r

　　　　　　　重心

              　  G

  　W1           W2

W3

       W1+W2
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質量に作用すると言える。

　重心 G には、物体全体に作用する重力 Wが働き、その点で重力と逆向きで、大きさの等しい力 T

で引けば、Wと T が釣り合う。このとき上下方向の並進運動は起こらない。また、重心 G を軸とす

る回転運動も起こらないと考える。

4.9.2 力の作用による、軸に対する回転運動と力のモーメント

　物体の回転について、重心 G を軸としたとき、各小物体 1、2、3

に作用する重力 W1、W2、W3 が、どの方向に回転させるかを決めて

おく。

　図 4.27 では、W1 と W2 が左回り（時計の針の回転と逆）、W3 は右

回り（時計の針の回転と同じ）に回転させ、前者を正方向、後者を

負方向とする。

　軸に対して回転させる強さを表す量として、力のモーメントを導

入する。記号で N を用いることにする。

                                                                図 4.27 力のモーメント

　力のモーメントは、力の大きさ×力の作用線に軸から下ろした垂線の長さで示される。ここで重

力 W1 と W3 の力のモーメントを N 1 、N 3 とすれば、

　　　　　　　　　　　　　　  111 lWN +=    　　　　　　　　　　　　　　　    (4.102)

                            333 lWN −=                 　                  (4.103)

となる。

　N 1 と N 3 は、回転させる強さと回転方向を示す物理量だから、それらの和 N を考えると、

　　　　　　 3311331131 )()( llll WWWWNNN −=−++=+=          　       (4.104)

となり、N = 0 のとき、左右両方向への回転の強さが等しくなり、回転が起こらないことになる。

従って、力のモーメントの和がゼロのとき、回転運動は起こらないと言える。

　式 (4.104) の最右辺をゼロとして、

　　　　　　　　　　　　　　 3311 ll WW =                                   (4.105)

となり、さらに、

　　　　　　　　　　　　　　　
1

3

3

1

W
W

=
l
l

                 　                 (4.106)

となる。この式は、重心 G の位置を求める式でもある。すなわち、重心は小物体の距離を、反比例

の関係で内分する、内分比で得られることを示す。

　また、式  (4.105) は一般にテコの法則として知られ、シーソーや棒はかりなどで応用されている。

　　　
1l 　G    3l

　　　　  

  W1     W2

W3

       ＋      －
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4.9.3  剛体に作用する力のモーメントの釣り合い

　一般に、力 F が回転軸 O から、距離Ｌの一点 P に作用するとき、

直線 OP と力の作用線がなす角度をθとすれば、図 4.28 のように、

力 F のモーメント N は、次のようになる。

 θsinFLN =                    (4.107)

　また、外力 F は                                               　 図 4.28 力のモーメント

θsinL
NF = 　　　　　　　　　　　　　　　　　(4.108)

となる。

4.9.4  剛体に作用する力の釣り合いと、力のモーメントの釣り合い

　図 4.29 のように、質量が M である剛体 AB の A 点

に紐をつけ天井からつるし、B 点につけた紐を引いた

ところ、剛体は静止した。

　ここで、剛体の長さを L、鉛直線に対する、紐が引

く力 T1、剛体、紐が引く力 T2 の角度を、θ1、α、θ2と

する。

　いま、剛体 ABに作用する力の釣り合いを考えると、

重力 Mg と、紐が引く力 T1 および T2 が釣り合うから、

水平方向の分力の釣り合いより、

　　　　　　 2211 sinsin θθ TT =            (4.109)

鉛直方向の分力の釣り合いより、

            2211 coscos θθ TTM +=g        (4.110)

となる。　　　　　　　　　　　　　　　　　　　　　　　　　　図 4.29 棒の釣り合い

　剛体が外力の作用を受けて、静止している場合は、剛体内のどの点を回転軸と考えてもよい。い

ま、重心 G を回転軸とし、力 T1 、T 2 の力のモーメントを N 1 、N 2 とすれば、N 1 = N 2 より、

　　　　　　　　 ( ){ }2211 180sin
2

)sin(
2

θαθα +−=−
LTLT                     (4.111)

となり、整理して、

　　　　　　　　　 ( ){ }2211 180sin)sin( θαθα +−=− TT                       (4.112)

が得られる。この式には、剛体の長さ L が含まれず、二つの力と三つの角度の相互関係となってい

る。式(4.109) , (4.110) , (4.112) に、質量 M と紐を引く力 T2 および、剛体の角度αの大きさを代入す

れば、他の量が計算される。

　　　　

　　　　   P  θ

O

　　　 F          L

　　　　　　　　天井

    T1　 θ1

        A

                     α    θ2

                G               T2

                        B

　　　　　　  

             Mg
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　剛体力学モデル実習　m4_23
１　テーマ　「棒の釣り合い」

２　力学モデル　m4_23_bou no turiai.wm「スライダー（質量）」

３　理論

　棒の両端に紐を付け、天井に紐の他端を取り付ける。紐の張力と重力の釣り合いは、紐の張力の

合力が重力と大きさが等しく、向きが反対で、作用線が一致すれば３力は釣り合い、棒は静止する。

詳細は、本文 22～23 頁を参照のこと。

４　操作

　図 m4.23 を Run すれば、空気抵抗を設定してあるので、すぐに収束し、棒は釣り合いの状態と

なり、力のベクトル図から容易に、釣り合いの条件が確認できる。スライダーで棒の質量を適宜設

定し試してみよう。

　また、棒の釣り合いは、力のモーメントの釣り合いを考えるが、剛体に付けられた紐の一点を回

転軸と見なし、外力が作用する点で力のモーメントの合成をし、それを 0 と置けばよい。

図 m4.23 棒の釣り合い

演習　　　Run 後、画面をコピーし、３力が釣り合っているか、作図で確認せよ。また、棒に

関して慣性モーメントや棒の長さを適宜設定し、様々な場合における３力の釣り合いを試して
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　剛体力学モデル実習　m4_24
１　テーマ　「連結された二本の棒における釣り合い」

２　力学モデル　m4_24_equilibrium of 2body.wm「重力場」

３　理論

　剛体力学モデル実習　m4_24_bou no turiai.wmと同様であるが、解析する場合は式の数が多くなる。

要は、外力の釣り合いを、X、Y 方向の成分の釣り合いの式で、力のモーメントの釣り合いを、多く

の力が作用する点を軸とし、他の力についての釣り合いの式を作る、という二点を考えればよい。

４　操作

　図 m4.24 は、Run すれば複雑な振動が生じ、しばらくは収束しない。そのときは、空気抵抗を設

定すれば、すぐ収束するので、結果が得やすい。それは、World ⇒Air Resistance ⇒ Standard ⇒ Ok

とすればよい。

図 m4.24 連結された二本の棒における釣り合い
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4.9.5  力のモーメントの計算例

　（1）どこまで梯子を上れるか

　図 4.30 のように、滑らかな壁と摩擦のある床に、

床となす角度がθの梯子が立てかけてある。梯子の

長さと質量を L、M とし、梯子と床との間の静止最

大摩擦係数をμ、とする。いま、梯子の下点 B から、

梯子の上方 x の距離に質量 m の人が居て、さらに上

方へ登ろうとしている。どこまで登れるだろう。

　Aと B 点に於ける抗力を FA、FB とし、B点の摩擦

力

をＦとすれば、水平方向の釣り合いから、

　　　　　　　　　 AB FF =μ              (4.113)

鉛直方向の釣り合いから、

BFMm =+ g)(           (4.114)

となる。　　　　　　　　　　　　　　　　　　　　　　　　　　図 4.30 梯子を登る

　剛体のどの点でも回転軸を考えてよいから、B 点を軸とすれば、B 点の周りの力のモーメントが

釣り合うから、

　　　　　　　　　 θθθ cos
2

cossin LMxmLFA gg +=    　　　　            (4.115)

となる。式 (4.113) , (4.114) , (4.115) から、FA、FB を消去して、x を求めると、

　　　　　　　　　　 { }
m
MmLx

2
)1tan2(tan2 −+= θμθμ      　　             (4.116)

となる。

　剛体力学モデル実習　m4_25
１　テーマ　「壁と床で支えられた梯子の運動」

２　力学モデル　m4_25_friction of ladder.wm「スライダー（摩擦係数）」

３　理論

　本文 23 頁参照のこと。梯子に作用する外力は、重力、床と壁からの垂直抗力、床と壁からの摩擦

力である。梯子を登る人があればその重力も加える。力の釣り合いと、力のモーメントの釣り合い

の方程式を作ることに帰着する。この実習では人が登らないが、本文の方程式を活用すれば、人の

重力と床から人までの距離を 0 とすればよい。

４　操作

　Run すれば、梯子がすべるのを観察できる。摩擦係数の設定をスライダーで行い、滑る場合や激

しく滑る場合など色々試して見よ。

　 　A　　抗力

　　

　　　　　　　　人

            重力     重心

　   壁   

　　　　　　　　　　　重力　　    抗力

              合力

                      床　摩擦力  Ｂ

演習　　　人が梯子をどこまで登れるかを、シミュレートするモデルを作成せよ。また、この

モデルを、等加速度運動をする列車に、乗せて見た場合のモデルも作成し、慣性系外の観測者

から見た梯子の運動を考察せよ。
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図 m4.25 壁と床で支えられた梯子の運動

　（2）　図 4.31 のように、長さ L、質量 M の棒が、壁

の一点 Aに取り付けられ、他端は紐で B点に結ばれてい

る。A点の抗力を R、紐の張力を F とし、棒と紐が、水

平となす角度をそれぞれα、θとするとき、R と F を求

める。

　三力 R、F、Mg が釣り合っているから、抗力 R の方向

と棒のなす角度をγとすれば、水平方向と鉛直方向の分

力の釣り合いにより、

　　　　 θαγ cos)cos( FR =+            (4.117)

gMFR =++ θαγ sin)sin( 　　  　  (4.118)

となり、B 点に対する周りの力のモーメントが釣り合う

から、　　　　　　　　　　　　　　　　　　　　　　　　　図 4.31 と紐による棒の釣り合い

　　　　　　　　　　　 γα sincos
2
1 LRLM =g                                 (4.119)

が得られる。

　これら三式から R、F および、γを計算すると、

Mg

F

R

紐

棒

壁

α

θ

γ

Mg
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)sin(

cos
θαγ

θ

++
= gM

R             　                (4.120)

                          
)sin(
)cos(

θαγ

αγ

++
+

= gM
F                              (4.121)

                   
)cos(coscos2

)sin(
tan

θααθ

θα
γ

+−
+

=                        (4.122)

となる。

　剛体力学モデル実習　m4_26
１　テーマ　「壁に付けられ紐で結ばれた棒の釣り合い」

２　力学モデル　m4_26_equilibrium forces.wm「スライダー（質量）」

３　理論

　本文 23～24 頁を参照のこと。

４　操作

　図 m4.26 を Run すれば、力の釣り合いの矢が示される。棒の質量をスライダーで設定し色々試

して見よ。この場合、紐をバネ (Spring) 、ダンパー (Damper)に付け替えて釣り合いを試して見よ。

図 m4.26 壁に付けられ紐で結ばれた棒の釣り合い

演習　　　スライダーでバネ定数やダンパー係数を設定し、剛体の振動の様子を観察すると同

時に、角速度に対する振幅の変化を図にプロットせよ。
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　（3）　図 4.32 のように、内面が半径 R の半円球をなす陶器の器に、長さ L で、質量 M の細い棒

を入れたところ、静止した。陶器と棒との

間には、摩擦がないとする。棒の静止した

位置と、棒が受ける抗力を求める。

　いま、棒を ABとし、半円球の中心を O、

棒が乗る陶器の端を C、棒と OC となす角

度をαとする。また、抗力を RA、RCとする。

　棒 A への抗力 RA と C 点での抗力 RC、重

心 G への重力 Mg が釣り合っているから、

水平方向と鉛直方向の釣り合いを求めると、

αα sin2cos CA RR =        (4.123)

     gMRR CA =+ αα cos2sin     (4.124)

となり、これを計算して、

                          

     　　　　　　　　　　　　　　　　　　　　　　　　図 4.32 陶器内の棒の釣り合い

　　　　　　　　　　　　　　 αtangMR A =                                   (4.125)

　　　　　　　　　　　　　　
θ

θ
cos

2cosgMRC =                                  (4.126)

が求まる。　また、C 点に対する力のモーメントの釣り合いを考えると、

                   ααα 2sin)
2

cos2(cos RRLRM A=−g                     (4.127)

となる。式 (4.125) , (4.126) , (4.127) から、

　　　　　　　　　　　 04coscos8 2 =−− RLR αα                          (4.128)

となる。この式を計算し棒の静止位置を角度αで示すことになる。

　　　　　　　　　　　　
R

RLL
16

128
cos

22 −+
=α                            (4.129)

　この棒が陶器内で静止するためには、棒の重心 G が C 点より内側に、B点は C 点より外側に、な

ければならないから、

αcos2
2
1 RL ≤ 、 LR ≤αcos2                          (4.130)

が得られ、(4.129) 式を代入して、

RLR
3
8

4 ≥≥                                (4.131)

の条件が求まる。

    

　　　　　　　　　　　　　　　　　　　　B

                             RC

　               O      G  C

             RA      α

         A             Mg
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　剛体力学モデル実習　m4_27
１　テーマ　「お椀内の箸の運動」

２　力学モデル　m4_27_friction of rigid body.wm「スライダー（摩擦係数）」

３　理論

　本文 24～25 頁を参照のこと。箸が静止する位置を求める式 (4.129)は、椀の内径を R、箸の長さ

を L とし、箸の水平となす角度をαとすれば、

R
RLL

16
128

cos
22 −+

=α

となり、箸が椀内で静止するための条件は、式 (4.131) により、次のようになる。

RLR
3
8

4 ≥≥

４　操作

　図 m4.27 を Run すれば、箸が少し振動して静止する事が観察できる。スライダーで箸の慣性モ

ーメントを変更し、また摩擦係数を変更して色々試して見よ。必要なメジャーウインドウを開き、

上式を検証して見よ。

図 m4.27 お椀内の箸の運動

演習　　　箸の運動は減衰振動であることを箸の重心の位置のプロットから説明せよ。
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　剛体力学モデル実習　m4_28
１　テーマ　「クレーン」

２　力学モデル　m4_28_crane.wm「スライダー（質量）」

３　理論

　クレーンは基本的に剛体の静力学で解析できる。これまでの実習を参照すること。

４　操作

　図 m4.28 を Run すれば各部に作用する力の矢が示される。つり下げる物体の質量をスライダー

で変更し色々試して見よ。ただし、あまり大きくすると、クレーンが右方向に倒れてしまうから注

意を要する。倒れなくするには、クレーン本体の質量を大きくすればよい。

　初期設定では、Circle 9.9 Mass のスライダーを最大にしても、クレーンは倒れないが、クレーン

の質量を 1,000 kg にすると（このとき、Circle 9.9 Mass の値が 0.53 より大きくなると）倒れる。

図 m4.28 クレーン

演習　　　クレーンを他の道具を用いて、高性能で現実のものに匹敵するモデルを作成せよ。

バネ、アクチュエーター、モーター、ダンパー、滑車、ギアなどがワーキング・モデルの中に

用意されている。
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「1 次元から3 次元へ」　　　　　　　

Coffee Break 4

　

力学の教科書をひもといていくと，最初の内は 1次元での運動；時間と共に変化していく物体の位置はx

座標だけで与えられます。もう少し進んでいくと，次は2 次元での運動；物体の位置は x 座標，y 座標で与

えられます。私たちが目にする現実の運動は 3次元；物体の位置はx 座標，y 座標，z 座標で与えられるこ

とになります。力学は「力によって物体の位置が，時間と共にどのように変化していくかを理解するた

めの学問」ですから，それぞれの場合について運動方程式を解いてやればよいのですが，1 次元での運

動はともかく，2次元，3次元の運動では考える座標が増えてきて煩雑になってきます。例えば，3次元の運

動では 3 つの方程式が必要となります。そこで，位置ベクトル   
r 
r の登場です。下式のように位置ベクトル

  
r 
r =(x, y, z)を使えば 1 つの方程式だけで運動の様子を調べることができます。

      m
d 2x
dt 2 =Fx,　　m

d 2y
dt2 =Fｙ,　m

d 2z
dt2 =Fｚ　　　→　　m

  

d 2r r 
dt2 =  

r 
F 

力学モデル mc 4 ichivector.wmでは，落下運動について 1 次元と2 次元の場合を例示しています。

2 次元での運動における物体の位置変化を見るのに，位置ベクトル  
r 
r の絶対値を考えると簡単になること

を実感してください。座標の成分表示では x 座標，y 座標という２つの値の変化を見なければいけないのに

対し，位置ベクトル表示では  
r 
r の絶対値の変化を見るだけですむので楽ですね。3 次元の場合は，シミュ

レーション画面で表示できないので省略しますが，さらにわかりやすくなるはずです。
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第５章　振動と波動#

日常生活や自然現象においては物体（質点やその集まり）に平衡状態があって，それからずれる

と復元力が働く場合が非常に多く見られる。例えば，ひもにつるした１個のおもりはひもが鉛直方

向にあるとき平衡状態となり，傾くと鉛直方向に戻そうとする復元力を受ける。また，木々が風で

少し傾いても倒れずに元に戻ったり，ゴムの塊が少し変形してももとの形に戻るのは復元力が働い

ているからである。われわれの居る建物が少し揺れたくらいで倒れないのも復元力のおかげである。

このように平衡状態と復元力はいろいろな場面で見られる。

　この章では，おもに，平衡状態からあまりずれていない範囲での物体の運動を調べることにする。

その運動は特定の振動数での振動（あるいはいくつかの特定の振動数の振動の重ね合わせ）になる

ことがわかる。そこへ周期的に変動する外力が加わると共振現象が見られる。また，非常に多くの

おもりを連結すると，そこでは波動が生じる。これらのことをシミュレーションを通じて納得して

いただきたい。振動系は原理的・基礎的な面から見ても，応用面から見ても格別に重要な系なので

ある。

5.1　単振動 (A)

　x 軸上の一つの質点（質量 m；以下「質点 m」と略記）の運動について考えよう。この場合は運

動方程式は比較的簡単になる。

質点 m には平衡点があってそれからのずれに対して復元力が働いているとする。 平衡点を原点

x = 0 に選ぶと，復元力 f は，x > 0 では f < 0，x = 0 では f = 0 ，x < 0 では f > 0 のように働い

ている。したがって復元力のグラフを描くと図 5.1（次のページ）のようになる。ここで，平衡点

からのずれ x が小さいとすると x = 0 の近くで， f (x) =? k x  (ただし，k =? f ′(x) > 0) と書き表

すことができることに注目しよう。（いま f (x)の関数形は時間とともに変化しないと考えるので k

は定数である。）

この力の表式から質点 mに対する原点 x = 0 の十分近くでの運動方程式は

m Ý Ý x = − k x  (5.1)

となることがわかるが，式を整理して x (t) に対する次の微分方程式が得られる。

                                                
#この章は前の章を読まなくても理解できるように書いてあるために，以下の§5.1? §5.3 は§2.3.4，§2.3.5 の一
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Ý Ý x = − 0
2ω  x (5.2)

ω0 =
k
m

 (5.3)

図 5.1　直線上の復元力 f のグラフの概形

その解は

x(t) = Acos(ω0t + α) (5.4)

である。A ( ≧ 0)を振幅，ω0t +αを位相，αを初期位相と呼ぶ。

詳細　　　式(5.4)の形の x(t)が方程式(5.2)を満たすことは sin の微分が cos に，cos の微分が? sinになることなど

を使って容易に確かめられる。逆に，(5.2)を満たす関数 x(t)がこれ以外にないことも大学初年級の数学の知識で証明

できる。しかし，この辺の事情は次のように考えると直感的に納得できるだろう。A とαは任意に選ぶことができ

る定数だが，運動方程式の解にこのような任意定数がちょうど二つだけ現れることは，出発時（例えば，t = 0）で

の位置 x0 と速度 v0 を自由に選ぶことができることに対応している。しかも，この対応は一対一である。他方，x0 と

v0 を与えてやれば運動方程式に従って以後の運動（つまり x (t)）は完全に定まってしまう。（このことは日常的にも

経験していることである。）もし，式(5.4)以外の解があるとなると，初期条件値 x0 と v0 だけからは運動が定まらな

いことになってしまう。

力学モデル m5_1_tansindou.wm（図 5.2）ではバネに繋がれて水平方向に運動するおもりの例を

取り上げている。バネは近似式 f (x) =? k x  の適用範囲が非常に広いという特徴を持つ。それで，

kのことを Spring Constant（バネ定数）と呼ぶことが多い。kが大きいほどバネが硬いということ

である。

                                                                                                                                                         
部と重複している。§2.3.4，§2.3.5 も参照されるとよい。

f

f = - k x
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表 5.1　m5_1_tansindou.wmのワールド初期設定

力学モデル・ファイル名 m5_1_tansindou.wm
目的・機能 単振動
スライダー
初期設定と［範囲］

mass（質量）= 1.00 [0.1? 10]
spring constant（バネ定数）= 10 [5? 500]

バネの自然長 rest length = 2.00
Air Resistance（空気抵抗） None
Gravity（重力） 9.807
XY Axes（XY 座標） On
Grid Lines（グリッド線） On

図 5.2　単振動（m5_1_tansindou.wm）
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　初期設定では， m =1 [kg]，k =10 [N/m]としてあるが，これに対応して振動数ω0と周期 T0は

ω0 = 10 = 3.2 [rad/s] ,   T0 = 2π / ω0 = 2.0 [s]となる。実際にモデルをスタートさせてこの振動数や周期の

値を確認していただきたい。モデルでは質量 mもバネ定数 kもスライダーで変化させることができ

るようにしてある（kの範囲は 5? 500[N/m]，mの範囲は 0.1 ? 10 [kg]）。mと kをいろいろに変

化させて振動数や周期の変化を観察していただきたい。mを大きくすると慣性が大きくなるので同

じ力を加えていても加速・減速がしにくくなりゆっくりとしか振動できなくなる。k を大きくする

と平衡点からのずれが同じでも復元力が大きくなり振動は速くなる。

5.2　減衰振動 (A)

　前節 5.1 での状況設定では，運動に伴う摩擦抵抗を十分に小さいとして無視した。しかし，現実

の系では摩擦が無視できない場合も多い。そこで，摩擦抵抗を取り入れた場合に運動の様子がどの

ようになるかを，まず解析的に（式でもって）調べ，次に Working Model 2D を使って確認してい

こう。

　摩擦抵抗の原因が質点の置かれた床や空気などの周囲の媒質との接触にあり，床と媒質が一様で

あるならば，摩擦力 f まさつは速度 v のみに依存し，位置 x には無関係となるだろう。そして，速度 v

が v > 0（右向き）のときは f まさつ < 0（左向き），v = 0 のときは f まさつ= 0， v < 0（左向き）のとき

は f まさつ > 0（右向き）となるはずである。すると，前節で述べた復元力の働き方と同様のパターン

になっているので，v の大きさが十分に小さいときには f まさつ　は f まさつ＝? b v（b は正の定数）の

ように近似できるだろう。（v について１次の項のみを残したがこの項がゼロになって２次の項が

重要になる場合もある。）

　復元力 ? k x と合わせると運動方程式は

m Ý Ý x = − k x − b v  (5.5)

となる。この式から x (t)に対する微分方程式

 Ý Ý x + 2 γ Ý x +ω 0
2 x = 0  (5.6)

を得る。ただし， ω
0

= k m ,  γ = b 2mである。この方程式の解は次のようになる。

1）γ<ω0のとき　減衰振動

x(t) = A0 e−γ t cos  (ω t +α )  (5.7)

ω = ω0
2 − γ 2   (5.8)

ただし，A0とαは（初期条件に応じて定まる）任意定数。

2） γ>ω0のとき　過減衰

x(t) = B1 e
− p

+
 t + B2 e

− p
−

 t  (5.9)

ただし， p± = γ ± γ 2 − ω0
2 > 0でB1, B2は任意定数。

3） γ=ω0のとき

x(t) = (C0 + C1 t ) e−γ t  (5.10)
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ただし， C0 ,C1は任意定数。

詳細　　　これらの解を，単振動の運動方程式の解を求めた場合のように目の子で見つけるのは難しい。しかし，

次のように物理的に考えて多少の計算をすれば解を求めることができる。まず， 1) のときは摩擦抵抗が小さいので

運動は徐々に減衰していく振動となることが期待される。そこで， x(t) = A(t)  cos (ω t + α)とおいてみる。　ここで，

Ａ(t)が時間とともに変化することとωがω0 とは異なることに注意しておこう。この表式を式（5.6）に代入して sin

(ωt+α)の項と cos (ωt+α)の項に分けて整理すると，方程式

Ý A + γ A =0

Ý Ý A + 2 γ Ý A  + (ω 0
2 − ω2) A =0

が得られる。これから，

A (t) = A0e − γ t

ω2 = ω0
2 −  γ 2  

でなければならないことがわかる。解の表式には初期条件と一対一に対応する独立な任意定数２個の組が含まれて

いるので，これで解をすべて求めたことになる。2) の場合には上のやり方は適用できない。なぜならω2 
 < 0 とな

ってしまうからである。このことは振動型の解がないことを予想させる。そこで， x(t ) = B e −p t  (B，p は定数)形の

解を探してみるとよい。3) の場合にはx(t ) = C(t) e− p t  (p は定数)の形の解を探してみるとよい。

　さて，上記の（5.7），（5.9），（5.10）で表される運動を力学モデル m5_2_gensui.wm（図 5.3）

で確認してみよう。このモデルでは m =1 [kg]のおもりを自然長 2 [m]，バネ定数 k = 10 [N/m]のバ

ネに結びつけている。ただし，このバネとして，摩擦抵抗を与えるダンパーの機能をあらかじめ組

み込んであるツールSpring Damper（バネ・ダンパー）を用いてある。摩擦抵抗 b v の係数 b の値

（damper constant;ダンパー係数）はスライダーで 0? 20 [Ns/m]の範囲で変化させることができる

ようにしてあるが，初期設定では b = 2 [Ns/m]とした。これに対応して，

γ =1 [Ns/m]

ω = ω0
2 − γ 2 = 99 = 9.95 [rad/s]

T = 2π / ω = 0.63 [s]

となる。

表 5.2　m5_2_gensui.wmのワールド初期設定

力学モデル・ファイル名 m5_2_gensui.wm
目的・機能 減衰振動
スライダー
初期設定と［範囲］

mass（質量）= 1.00 [0.1? 10]
spring constant（バネ定数）= 10 [5? 500]
damper constant　=　2.00 [0? 20]

バネの自然長 rest length = 2.00
Air Resistance（空気抵抗） None
Gravity（重力） 9.807
XY Axes（XY 座標） On
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図 5.3　減衰振動（m5_2_gensui.wm）

　まず，最初におもりを平衡点から 2 [m]だけ右側にずれた場所 x＝2 [m]から初速度ゼロで出発さ

せてみよう。この初期条件下では運動はx(t) = 2 e−γ t cos ω t となる。徐々に減衰する振動が観察され

るはずである。画面上方には t - x のグラフが自動的にプロットされるようにしてある。振幅が指数

関数的に減衰していくことを確認されたい。

次に，ダンパー定数 b をスライダーで少し変化させて，たとえば，b＝10 [Ns/m]程度にすると減

衰が速くなることも確かめられる。さらに，もっと b を大きくしていって，b＝20 [Ns/m]程度にま

でもっていくと，ついにはまったく振動することなく平衡点に落ち着いていく。

演習　　　以上の観察だけでも運動の定性的な様子はよくわかったと思うが，さらに，定量的な

確認も行ってみよう。振動の右端（t - x グラフでは山の頂上）から出発して平衡点を通りすぎる

までの時間T1/ 4 は T1/ 4 =π  /2ω で与えられるのでT1/ 4 を t - x グラフから読み取り，その値から

ω = π /2T1/4  の値を求めることができる。例えば，b = 2γ= 2，6，10，14 [Ns/m]の各設定でモデ

ルを走らせて，対応したωの値を上記のように「測定」し，b-ωのグラフを描くことができる。

式（5.8）に従えば，グラフは円周になるはずである。確かめられたい。
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5.3　強制振動 (B)

5. 3. 1　共振（共鳴）

 復元力の働いている系に外部から振動する力が加わった場合を考えよう。摩擦抵抗も取り入れてお

こう。このような系の中で一番簡単なものは前節 5.2 の状況設定に，さらに，振動数Ωで振動する

外力 f0 cosΩt（f0は一定）を加えた場合であろう。運動方程式は

m Ý Ý x = − k x −b v + f0 cosΩ t  (5.11)

となる。これを整理して微分方程式

Ý Ý x + 2 γ Ý x + ω0
2 x =

f0
m

cosΩ t  (5.12)

が得られる。この方程式の一般解#  x (t) は

x(t)  =     x1(t)     +       x0 (t)

　　　　　　　　　　　　　　　　特殊解　　　 (5.12)の右辺= 0 の方程式の一般解

のような形に書くことができる。そのことは，この表式を微分方程式(5.12)に代入してみればすぐ

にわかる。x0(t)は既に前節で求めてある。時間が経つとともに減衰していくのであった。x1(t)は次

のように選んでやれば方程式(5.12)を満たすことは，直接代入して計算すれば確かめられる。（計算

は少し面倒だが特別な工夫は必要ない。摩擦抵抗のないγ= 0 の場合はかなり簡単になるので，こ

の場合だけでも確かめておかれたい。）

x1(t) =
f0 m

(ω0
2 − Ω2 )2 + 4γ 2Ω2

cos(Ω t −δ ) (5.13)

ただし， tanδ =
2γΩ

ω0
2 − Ω2

である。

詳細　　　このような複雑な表式をどのように導いたのか不思議に思う人は次のように考えるとよい。まず，強制

力は振動数Ωで振動しているので，質点もそれに従って同じ振動数Ωで振動することもあるであろう。しかし，摩

擦抵抗があるので位相は少しずれる可能性がある。そこで， x1 (t) = A1 cos (Ω t −δ )のような形の特殊解を探して

みる。この表式が方程式(5.12)を満たすためには振幅と位相のずれδは上記のように選ばなければならないことがわ

かる。

　ここで，振幅

A1 =
f0 m

(ω0
2 − Ω2 )2 + 4γ 2Ω2

 (5.14)

に注目しよう。外力の振動数Ω以外は固定して，Ωを変化させてそれに応じた振幅A1の変化のグラ

                                                
#微分の階数（いまの場合２）と同じ個数の任意定数を含む解を一般解とよぶ。これに対して任意定数を特別な値に
選んだものを特殊解とよぶ。一般解は方程式と必要十分な関係にあるが，特殊解は十分条件にすぎない。
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フ描くと図 5.4 のようになる。Ω = ω 0
2 − 2γ 2 ≡ Ωm

のときに振幅が劇的に大きくなることに注意しよう。

（多くの場合には摩擦抵抗が非常に小さいのでγが小さく振幅が最大となる振動数はΩm ≈ω 0
のと

ころになる。）この現象を共振（あるいは共鳴）とよぶ。それで，このグラフを共鳴曲線と呼ぶ。

図 5.4　共鳴曲線

　バネに結びつけられたおもり自身に固有な振動に調子を合わせて（すなわちほぼ同じ振動数で）

押したり引いたりしてやれば振幅はどんどん大きくなるが，調子がはずれると（すなわち振動数が

かなり異なると）大きくはならないという経験を共鳴曲線は定量的に表したものと言える。摩擦抵

抗を取り入れているので「調子を合わせた」Ω = Ωm ≈ ω0
のときでも振幅が無限に大きくなるわけで

はない。しかし，共振点での振幅の表式を見てもわかるように摩擦抵抗が十分に小さくなったγ→

０の極限ではピークの高さは無限に大きくなる。つまり，共振は鋭くなる。反対に，γが大きくな

ると共振の山は低くすそ野が広くなる。

　さてそれでは，共振現象を力学モデル m5_3_ kyousin.wm（図 5.5）で確認していこう。このモ

デルではダンパーの機能をあらかじめ組み込んであるバネSpring Damper（バネ・ダンパー）を使

っている。

表 5.3　m5_3_kyousin.wmのワールド初期設定

力学モデル・ファイル名 m5_3_kyousin.wm
目的・機能 共振
スライダー
初期設定と［範囲］

ｍass（質量）= 100 [0.1? 100]
spring constant（バネ定数）= 1000 [100? 4000]
damper constant　=　10 [0? 50]
アクチュエータ input[18]　=　3.16 [0? 50]

バネの自然長 rest length = 7.50
Actuator（アクチュエータ） 100*cos(input[18]*time)
Air Resistance（空気抵抗） None
Gravity（重力） 9.807
XY Axes（XY 座標） On

Ω
Ωｍ

振幅Ａ
1

γ 小

γ 大
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図 5.5　共振（m5_3_ kyousin.wm）

　おもりには，Actuator（アクチュエータ）によって強制力を加える。おもりの質量は m =1 [kg]

に，バネ定数は k = 1000 [N/m]に固定した。b v の係数 b の値（ダンパー係数）はスライダーで 0

? 50 [Ns/m]の範囲で変化させることができるようにしてあるが，初期設定では b = 2 [Ns/m]とした。

Actuator（アクチュエータ）の強制力は 100 cosΩ t [N]のようにセットしてあり，角振動数Ωはス

ラ イ ダ ー で 0 ? 100 ［ rad/s ］ の 範 囲 で 変 化 さ せ る こ と が で き る 。 初 期 設 定 で は

Ω = ω 0 = 10 = 3.16 [rad/s]にしてある。

　モデルをスタートさせると平衡点 x = 0に静止していたおもりは振動を始め，振幅はだんだんと

大きくなっていく。その様子は画面上方の t - x のグラフで確認することができる。微分方程式の一

般解 x(t ) = x1 (t ) + x0 (t)  の第１項は振幅が一定の単振動であったが，第２項は減衰していく振動であ

った。したがって，十分時間が経った後には消滅してしまい第１項の振動のみが生き残る。

演習　　　共鳴曲線を確認するには，外力の角振動数Ωをスライダーで変化させ，各Ωごとに

モデルを走らせて最終振幅 A1 を画面上から読み取っていけばよい。たとえばΩ＝3，15，25，

32，35，45［rad/s］などどとって，これらの各値ごとに最終振幅 A1の測定値をΩ-A1グラフに

プロットしていけばよい。ダンパー定数 b の値を変えてみて（たとえば，b＝0.1，2，10 [Ns/m]），

同様なことを繰り返し，摩擦抵抗が大きくなるとともに共鳴のピークが低くなることを確かめ

よ。
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画面上方の t - x 曲線を何通りか見てすでに気づいたと思うが，おもりの振幅はスタート後の最初

のうちは時間 t に比例して増大していく。もちろん，その増大傾向がいつまでも続くわけではなく

振幅はいずれ頭打ちになるが，摩擦抵抗が小さいほど長時間にわたって比例関係は保たれる。そし

て摩擦抵抗ゼロの極限ではいつまでも t に比例して大きくなる。このことを計算によって簡単に確

かめることができる。すなわちx(t ) = A1  t sin  Ωt の形を仮定し（これは初期条件を満たしている）摩

擦抵抗ゼロに対応した微分方程式  Ý Ý x + ω0
2 x = ( f0 m )cosΩ  t に代入して整理すると， A1  = f0 2mΩのとき

に方程式が満たされることがわかる。（共振点で考えているのでΩ = ω 0 である。）　すなわち，t - x

曲線はじつはx(t) = ( f0 2mΩ) tsin  Ωt なのである。

5. 3. 2　チューニングの原理

　こんどは強制力が単振動ではなく２つの単振動の重ね合わせ f0 cosΩ  t + ′ f 0 cos ′ Ω  tのようになってい

る場合を考えよう。運動方程式から導かれる微分方程式は

 Ý Ý x + 2 γ Ý x +ω 0
2 x =

f0

m
cos Ω t +

′ f 0
m

cos ′ Ω  t  (5.15)

のようになる。（γは小さいとする。）この場合も前節の方程式(5.12)と同様に一般解は特殊解と強

制力= 0 とおいた方程式の一般解の和で書き表される。後者の方は時間とともに減衰するので特殊

解のみを考えよう。方程式を眺めていると，右辺の第１項のみを残した方程式の特殊解を x1(t)，第

２項のみを残した方程式の特殊解を x'1(t)とすると，x (t) = x1(t)＋x'1(t)はもとの方程式を満たすこ

とに気づく。x1(t)はω0 ≈ Ωで x'1(t)はω0 ≈ ′ Ω で共鳴のピークを持つ解であることに注意しよう。Ω

とΩ'は固定し，ω0を変化させていくことにすると，ω 0 ≈ Ωでは x1 が大きくなって振動数Ωの振

動が増幅され，ω0 ≈ ′ Ω では x'1が大きくなって振動数Ω'の振動が増幅されることがわかる。

　このような現象は，いろいろな振動数の振動の重ね合わせから特定の振動数の振動を増幅して取

り出したいときに応用される。たとえば，方々の放送局からはチャンネル毎に異なるいろいろな振

動数の電磁波が発信されて空中にはそれらが重ね合わさった電磁波がとびかっているが，そのなか

から希望のチャンネルに対応した振動数の振動を増幅して取り出したい（チューニング）ときに応

用される。その仕組みは次の通りである。まず，上記の重ね合わせの電磁波はアンテナにきわめて

微弱な振動電流を発生させる。この微弱電流は受信機の中の振動系（電気回路）に強制力（交流電

圧）として伝えられる。振動系の振動数ω0はコンデンサーなどで調整しチューニングを行う。

Working Model 2D でこの現象を確かめてみよう。

演習　　　スライダーを使ってダンパー定数をゼロにセットし，モデルをスタートさせて t - x 曲

線を描かせ，振幅の変化率を測定することによって係数A1  = f0 2mΩの値を確認されたい。
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表 5.4　m5_3_tuning.wmのワールド初期設定

力学モデル・ファイル名 m5_3_tuning.wm
目的・機能 チューニング
スライダー
初期設定と［範囲］

mass（質量）= 1 [0.1? 100]
spring constant（バネ定数）= 100 [100? 4000]
damper constant　=　2 [0? 20]

バネの自然長 rest length = 7.50
Actuator（アクチュエータ） 100*cos(30*time)+100*cos(60*time)
Air Resistance（空気抵抗） None
Gravity（重力 9.807
XY Axes（XY 座標） On

図 5.6　チューニング(m5_3_tuning.wm)

m5_4_ tuning.wm（図 5.6）では，Actuator（アクチュエータ）で強制力 100 cos 30t + 100cos 60t

[N]を加えている。おもりの質量は m =1 [kg]に，ダンパー定数は b = 2 [Ns/m]にセットしておいた。

そして，バネ定数 kのほうをスライダーで k = 100? 4000 [N/m]の範囲で変化させることができる。

それに応じて，ω0も変化する。kの値をいろいろ変化させて，たとえば，k = 100，900，2000，

3600 [N/m]と選んで，k = 900，3600 [N/m]近くで共鳴のピークがあることを確かめられたい。
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5. 3. 3　うなり　? 　共振点近くでの強制振動

　摩擦抵抗が無視できる状況下で角振動数ω0 で単振動する系に対して角振動数Ωで振動する強制

力 f0 cosΩtを加えよう。運動方程式は式(5.11)において b = 0とおいたものとなり，それを整理し

て得られる微分方程式は

Ý Ý x + ω 0
2  x =

f0

m
cosΩ t  (5.16)

となる。その一般解は

x(t) = A1 cos  Ωt + A2  cos (ω0t + α)  (5.17)

　 A1 =
f0 m

ω0
2 − Ω2

である。ただし，A1は初期条件とは無関係に定まる定数であり，A2とαは初期条件に応じて定まる

定数である。第１項は方程式(5.16)の特殊解，第２項は強制力= 0 とおいた方程式の一般解である。

　いま，出発時の位置が平衡点 x = 0で初速度がゼロの場合の運動について考えよう。このような

初期条件は A2 =? A1，α＝０に対応する。運動は

x(t) = A1 (cos  Ωt − cos ω 0t)

となる。これを三角関数についての恒等式

cosα − cos β = −2sin
α − β

2
sin

α + β
2

を使って書き換えると

x(t) = 2A1 sin
ω 0 − Ω

2
t sin

ω0 + Ω
2

t

の形になる。　ここで，Ωがω0に近くて，ε≡ω0? Ωが非常に小さいとき（もっと正確に言えば，

|ε| = |ω0? Ω|≪ω0＋Ωとき）には(ω0? Ω)/2=ε/2 は微小なので(ω0+Ω)/2=ω0とみなしてよく，

x(t) = 2A1 sin
ε
2

t sin ω0t　 (5.18)

と書くことができる。この表式の第１因子2A1 sin
ε
2

t は周期 T =2π/ω0 の間にはほとんど変化しな

いので，この時間内だけ見ていれば運動は単振動に近い。しかし，長時間かけてみると単振動の振

幅は緩やかに振動する。振動数ω0の振動の振幅が大きくなったり小さくなったりするうなり（beat）

の現象である。

　一般的な任意定数（初期条件）A2，αの場合には，結果だけ示すと，

x(t) = A(t) cosω0t  (5.19)

A(t) = [A
1

2 + A2
2 + 2 A1A2 cos(εt +α )]1 /2  (5.20)

のようになる，「振幅」A(t ) は | A1 − A2 |≤ A(t) ≤| A1 + A2 |の間を振動数ε≡ω0? Ωで振動する。

このようなうなりの現象を力学モデル m5_5_unari.wm（図 5.7）で確かめてみよう。おもりの質量

は m =1  [kg]に，バネ定数は k = 1000 [N/m] に固定してある。これに対応する振動数は

ω0 = 1000 =31.6［rad/s］である。Actuator（アクチュエータ）で与える強制力は 100cos(ω0? ε)t
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とし，εはスライダーで変化させることができる。初期設定ではε＝ω0/20 = 3.16/20=0.16［rad/s］

としてある。

表 5.5　m5_3_unari.wmのワールド初期設定

力学モデル・ファイル名 m5_3_unari.wm
目的・機能 うなり
スライダー
初期設定と［範囲］

ｍass（質量）= 100 [0.1? 100]
spring constant（バネ定数）= 1000 [100? 4000]
アクチュエータ input[16] = 0.16 [0.05? 0.5]

バネの自然長 rest length = 7.50
Actuator（アクチュエータ） 100*cos((3.16? input[16])*time)
Air Resistance（空気抵抗） None
Gravity（重力） 9.807
XY Axes（XY 座標） On

図 5.7　うなり（m5_5_unari.wm）

初期設定のままでモデルをスタートさせると，おもりは初期条件 x0 = v0 =  0 で動き出すので式

(5.18)で表される運動になる。振幅がゆっくりと変化していくこと，そして，うなりの振動数はω0

の 1/40 になることを確かめられたい。また，スライダーでεを変化させてうなりの振動数と振幅の

増減を観察されたい。

　式(5.19) ，(5.20)で表されるうなりは，初期条件を変更すれば実現される。たとえば，おもりの

出発点を平衡点からずらしてやればよい。これも試みられたい。
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5.4　　急速に振動する外力のもとでの振動(C)

　§2.3.8 の B 係数励振振動（パラメータ励振）で取り上げたような振動する支点を持つ単振子を

考えてみよう。（図 5.8）

　　　　　　　　　　　　　図 5.8　急速振動する支点を持つ振子

　このおもりには，外力として重力以外に支点の運動を通じた振動型の外力が付け加わる。§2.3.8
では，この外力の振動数Ωが振子の振動数ω = g l  と同程度の場合を想定した。ここでは，反対に，

支点が急速に振動しているΩ≫ωの場合に注目する。このとき，おもりに加わっている外力の性質

からみて，振子の運動θ(t)は，支点の振動によって引き起こされた高い振動数で振動する変位Θ(t)
と振動数ω = g l  程度で緩やかに振動する変位ε(t)の和として表すことができることは明らかだ

ろう。すなわち，

θ(t) = Θ(t) + ε(t )

　θ(t) = Θ(t) + ε (t)を高い周波数の振動の周期 2π/Ωにわたって平均すると第２項ε(t)は消えて，第

１項Θ(t )のみが生き残る。よって，Θ(t )は平均化された運動を表すと言ってよい。それでは，Θ(t )が

従う運動方程式はどのようなものだろうか。

　詳しい説明は省略するが#，上述のような時間平均をとって振動をならしてしまうと，おもりの運

動は重力から来る鉛直最下点上への復元力の他に振幅の２乗 a22 に比例する力を受けながら運動し

ていること同じになる。そのそれぞれの力のポテンシャル・エネルギーを Ugrav (Θ ) ，Uav (Θ )と書

くと全ポテンシャル・エネルギーU (Θ )は

 U (Θ ) = Ugrav (Θ ) +Uav (Θ ) (5.21)

                                                
#ランダウ＆リフシッツ 著，広重徹＆水戸巌 訳：力学（増訂第３版，東京図書 1991 年）§30

a sin Ωt
a sin Ωt

重力 重力

（ａ）支点水平振動 （ｂ）支点鉛直振動
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となる。そしてポテンシャル・エネルギーU (Θ )のグラフの概形は図 5.9 のようになる。（いずれも，

2gl < a22Ω2　と仮定した。）

    図 5.9　急速振動する支点を持つ振子が受ける平均的なポテンシャル・エネルギー

　　Ugrav は重力のポテンシャル，U av は支点の急速振動がおもりに及ぼす平均化されたポテンシャル，

　　U はこれら二つの和である

この図からわかるように，水平方向に支点が動く場合(a) では平衡点はΘ = 0ではなく，Θ = Θ0（た

だし，cosΘ 0 = 2gl
a2Ω

）となる。鉛直方向に支点が動く場合(b)では，平衡点はΘ = 0以外に，Θ = πが

ある。

以上のことをシュミレーションで確かめてみよう。力学モデル m5_6_sitensindou1.wm (図 5.10)

は場合(a)で， m5_6_sitensindou2.wm(図 5.11)は場合(b)である。

表 5.6　m5_4_sitensindou1.wmおよび m5_4_sitensindou2.wmのワールド初期設定

力学モデル・ファイル名 m5_4_sitensindou1.wm m5_4_sitensindou2.wm
目的・機能 水平振動する支点を持つ振子 鉛直振動する支点を持つ振子

Mass（質量） circle mass = 1.00 circle mass = 1.00
Actuator [length] (支点強制振
動)

0.02*cos(input[6]*3.142*tim
e)

0.1*cos(input[6]*3.142*time)

Ugrav(Θ) = −mgl cos Θ

Uav (Θ) =

m
4

a 2Ω2 cos2 Θ          (a)

m
4

a2Ω2 sin 2 Θ          (b)

 

 
 

 
 

U grav

- Θ0

U g ra
v

U av

U

π Θ-π

Θ0

U av
U

（ａ） （ｂ）
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スライダー初期設定と［範囲］ input[6] = 25 [0? 50] input[6] = 6 [0? 10]
Air Resistance（空気抵抗） None None
Gravity（重力） 0.98 0.98

図 5.10　水平方向に急速振動する支点を持つ振子(m5_6_sitensindou1.wm)
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図 5.11　鉛直方向に急速振動する支点を持つ振子（m5_6_sitensindou2.wm）［逆立ち振子］

振子の棒（質量 0）の長さは 1 [m]，重力加速度は g = 0.98 [m/s2]にした#。また，支点の振幅は

モデル m5_4_sitensindou1.wmでは a2 = 0.02 [m]に，モデル m5_4_sitensindou2.wmではa2 = 0.1

[m]に固定しておいた。支点の振動数Ωは，スライダーを使って大きさを変化させることが可能であ

る。

上記のパラメータを初期設定の通りにした状態では，モデル m5_4_sitensindou1.wmでは

2gl / a2Ω2 = 2×0.98×1/(0.02)2×(25×3.1) 2＝0.82 なので，cos? 10.82 =35°が平衡点となる。したが

って，たとえば 40°近くで初速度ゼロでスタートさせてみると 35°を中心とした振動を行うはず

である。このことを確かめられたい。他方，モデル m5_4_sitensindou2.wmでは，頂点の近くで初

速度ゼロでスタートさせてみられたい。頂点を中心とした振動をするはずである。それで，このよ

うな振動をする振子を逆立ち振子と呼ぶことがある。（いずれも初期設定のままモデルをスタート

させると上述の振動を見ることができるようにしてある。）

5.5　復元力下の平面上の運動　リサジューの図形 (B)

　１個の質点 mの平面上での運動を考える。mは保存力を受け，そのポテンシャル・エネルギーU

には最小点があるとしよう。この点を xy 座標軸の原点に選ぶと， x = y = 0 において

∂U ∂x =∂U / ∂y = 0である。したがって，原点 x = y = 0での Uのテーラー展開

  
U(x,y) = U(0,0) + (x∂ ∂x + y∂ ∂y)  U + 1

2
(x∂ ∂x + y∂ ∂y)2  U +K (5.22)

において第２項は消える。第１近似では第２項までを取ればよい。この項は，二次形式

ax 2 + 2bxy + cy2の形をしているので座標軸の適当な回転(x,y) → ( ′ x , ′ y )によって ′ a ′ x 2 + ′ c ′ y 2 のような

形に持っていくことができる。そこで，最初から座標軸の方向をこのように選んでおくことにすれ

ば，結局，原点の十分近くでは

U(x,y ) = U(0,0) + 1
2

(kxx
2 + kyy2 ) (5.23)

のように近似することができる。ただし，k x ,kyは正の定数である。

このポテンシャル・エネルギーのもとでの運動方程式は

第 2 章 質点の力学 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1

2.1 運動の法則 ...................................................................................................................... 26

2.2 力のつり合い (A) ............................................................................................................... 28

2.3 質点の運動 ...................................................................................................................... 30

2.4 座標変換.......................................................................................................................... 61

2.5 仕事とエネルギー ............................................................................................................ 69

                                                
#ｇを現実値よりも小さくとったのは平衡点の鉛直からのずれを拡大して見やすくするためである。
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xk
x
U

xm x−=−=
∂
∂

&& (5.24a)

yk
y
U

ym y−=−=
∂
∂&& (5.24b)

となる。これを整理して微分方程式

Ý Ý x = −ω x
2x (5.25a)

Ý Ý y = −ω y
2 y (5.25b)

ω x =
kx

m
,    ωy =

ky

m

を得る。その一般解は

x = Acos(ω xt + α) (5.26a)

y = Bcos(ω yt + β) (5.26b)

となる。ここで，A，B，α，βは初期条件に応じて定まる定数である。x，y 成分ともに単振動と

なっているが，一般的には成分によって角振動数が異なっていることに注意しよう。ω x, ωyの相対

的な値ω x ω y によって運動の様子は，とくに軌跡の様子はかなり異なったものになる。（軌跡をリサ

ジューの図形と呼ぶ。「リサジュー」は人名。）以下では典型的な場合をいくつか調べていこう。

5. 5. 1　ω x ωy = 1の場合

　ω x = ω y(= ω)のときはポテンシャル・エネルギーが原点の周りの回転について不変になっている。

例えば，長い紐につるしたおもりが受ける重力のポテンシャルはこのような性質を持っている。

解の形

x = Acos(ω t + α) (5.27a)

y = Bcos(ω t + β) (5.27b)

を見ればわかるように，(x,y)は tが 2π/ωだけ進んだときに元に戻るので軌跡は閉じる。その形は

初期条件に応じて異なる。例えば，α＝β＝０のときには式(5.27a)，(5.27b)からωtを消去すれば

x A = y B となるので軌跡は線分になる。また，α＝０，β＝±π/2 のときには同様にして

x
A

 
 

 
 

2

+
y
B

 
 

 
 

2

= 1 (5.28)

となるので，軌跡はx, y軸を長・短軸とする楕円となる。そして，β＝+π/2，β＝? π/2 に応じて

運動の向きは，それぞれ，時計回り，反時計回りとなっている。もっと一般の初期条件の場合でも

軌跡の方程式はあらわな形で求めることができて

x
A

 
 

 
 

2

+
y
B

 
 

 
 

2

− 2
x
A

y
B

cos(α − β) = sin 2 (α − β) (5.29)

となり，これも楕円を表している。

詳細　　　上記の軌跡の方程式（5.29）は，式(5.27a)，(5.27b)を加法定理を使って展開した式から cosωt，sinωt
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を消去することによって得られる。tan 2θ = 2AB cos(α −β)
A2 − B2

で与えられる角度θだけ座標軸を回転してやると式(5.29)

は楕円の標準的な形の方程式(5.28)と同じ形になる。

　では， Working Model 2D で 運 動 と 軌 跡 の 様 子 を 確 か め て い こ う 。 力 学 モ デ ル

m5_5_lissajous1.wm(図 5.12)では質点 m（質量は 1［kg］）を小さな丸で表示してある。復元力は

Force Field（力の場）で

 
Fx = −kxx = −4 x
Fy = −ky= −4y

 
 
 

のように設定してある。そして，始めの位置(x0, y0 )と初速度(vx0, v y0 )はスライダーで変化させること

ができる。初期設定は(x0, y0 ) = (4,0)  [m]，(vx0, v y0 ) = (0, 4)  [m/s]とした。スライダーを動かして初期

条件をさまざまに変えて運動の様子を観察されたい。一般には長・短軸が傾いた楕円となる。特別

な場合，例えば，α＝β= 0 の場合は(x0,y0 ) = (A,B)，(vx0, v y0 ) = (0, 0)に対応するので，初期条件とし

ては任意の点から初速度ゼロでスタートした運動が対応する。α＝0，β＝±π/2 の場合は

(x0,y0 ) = (A, 0)，  (vx 0,vy 0 ) = (0,mωB)に対応するので，初期条件としてはｘ軸上の一点から真上方向あ

るいは真下方向に向けて発射した運動が対応する。

5. 5. 2　ω x ω y  = 有理数（≠１）の場合

　x 座標は時間2π ω x の後には元に戻るが，y 座標は2π ω y の後に元に戻る。これら２通りの時間は

一般には異なるが，ω x ω y  = 有理数の場合には２つの時間の最小公倍数だけの時間が経てば x，y

両方の座標が元に戻る。つまり，xy 平面上で出発点に戻ってくる。これは軌跡が閉じることを意味

する。この事情は初期条件の取り方に無関係である。

　モデル m5_5_lissajous2.wmでは復元力の Force Field（力の場）は

 
Fx = −kxx = −4x

Fy = −kyy = −y     
 
 
 

    ωx ω y = 4 = 2

と設定してある。そして，初速度はゼロに固定してあるが，最初の位置はスライダーで動かすこと

ができる。

　モデル m5_5_lissajous3.wm(図 5.12)では復元力の Force Field（力の場）は

 
Fx = −kxx = −9x
Fy = −kyy = −4y  

 
 
 

    ωx ω y = 9 4 = 3 2

と設定してある。

　それぞれのモデルで運動の様子を観察されたい。

5. 5. 3　ω x ω y  = 無理数の場合

　この場合はいつまでたっても最初の点に戻ってくることがない。それで軌跡は平面上のある領域

を徐々に埋めていくことになる。モデル m5_5_lissajous4.wmでは復元力の Force Field（力の場）
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は

 
Fx = −kxx = −2x
Fy = −kyy = −y   

 
 
 

    ωx ω y = 2

と設定してある。埋め尽くす様子を観察されたい。

表 5.7　m5_5_lissajous1.wmなどのワールド初期設定

ファイル名 m5_5_lissajous1.wmmm5_5_lissajous2.wm m5_5_lissajous3.wm m5_4_sitensindou4.wm

目的・機能 リサジューの図形
スライダー
初期設定と［範
囲］

 (x , y)  =  (4 , 0)  [ (? 5? 5 , ? 5? 5) ]
(vx0 , vy0)  =   (0 , 4)  [ (? 10? 10, ? 10? 10) ]

Force field
（力の場）

x: -1*4*body[1].p.x
y: -1*4*body[1].p.x

x: 1*4*body[1].p.x
y: -1*1*body[1].p.x

x: 1*9*body[1].p.x
y: -1*4*body[1].p.x

x: 1*2*body[1].p.x
y: -1*1*body[1].p.x

Air
Resistance

None

Gravity (重力) None
図 5.12　リサジューの図形（m5_5_lissajous3.wm ）
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5.6　連成振動 (Ｂ)

5. 6. 1　強制力を加えない場合

　次ページの図 5.13 のように２個のおもり A，B（質量は簡単のためともに１とする）があって，

A が壁に取り付けたバネ(バネ定数 k）から復元力を受け，A と B は別のバネ（バネ定数 k´）で結

ばれているとしよう。

　A，B の平衡点からのずれを xA，xBとすると運動方程式は

Ý Ý x A = −k xA − ′ k (xA − xB ) (5.30a)

Ý Ý x B = ′ k  (xA − xB) (5.30b)

となる。状況設定から考えて，この方程式は振動型の解を持つと予想される。そこで，試しに

xA (t) = Acos(ωt + α),  xB (t ) = B cos(ωt + α)（A， B，ω，αは定数）の形の解がないか探してみよう。

この表式を方程式(5.30a)，(5.30b)に代入して整理すると

(ω2 − k − ′ k )A + ′ k B = 0 (5.31a)

′ k A + (ω 2 − ′ k )B = 0 (5.31b)

を得る。この方程式を A，B についての連立方程式と見たときその係数行列式がゼロでなければ A　=

B = 0 以外に解はない。しかし，この解はずっと平衡点に静止しているだけの「運動」にすぎない。

そこで，係数行列式= 0 の場合に注目する。

係数行列式= (ω2 − k − ′ k )(ω2 − ′ k ) − ′ k 2 = 0

をω2 について解いて

ω 2 = k + 2 ′ k ± k2 + 4 ′ k 2

2
(5.32)

を得る。複号の中で? をとったほうの解をω1
2 ，＋をとったほうの解をω2

2 書こう。このとき(5.31a)，

(5.31b)は

B
A

= k ± k2 + 4 ′ k 2

2 ′ k 
(5.33)

となる。＋はω1
2 に，? はω2

2 に対応する。それぞれの場合の比 B/A の値を r1 ，r2と書こう。r1 > 0，

r2 < 0 となっている。結局，

xA(t) = A1 cos(ω1t +α1)

 xB (t) = r1A1 cos(ω1t + α1)

 
 
 

        
xA(t) = A2 cos(ω2t + α2 )

 xB (t) = r2A2 cos(ω 2t +α 2 )

 
 
 

  

は方程式(5.31a)，(5.31b)を満たすことがわかった。振動数ω1，ω2 の各々の振動を基準モードある

いは単にモードと呼ぶ。モードω1では r1 > 0 なのでＡ，Ｂは同じ向きにそろって振動し，モードω2

では，r2 < 0 なのでＡ，Ｂは反対向きに振動することに注意しよう。

　これらの方程式が線形であることに注意すると上記２通りの解の和（重ね合わせ）も解となるこ

とがわかる。すなわち

xA(t) = A1 cos(ω1t + α1) + A2 cos(ω 2t + α2 )

 xB (t) = r1A1 cos(ω1t + α 1)+ r2A2 cos(ω2t + α2 )

 
 
    (5.34)

も解である。この解の表式は任意定数をA1, A2 ,α1,α2 の計４個を含んでいるが，これらは２個の質点
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の初期条件（始めの位置２個，初速度２個）に対応する。したがって，解を全て求めたことになる。

　例えば，質点Ａ，Ｂがともに初速度ゼロで，xA0，xB0から出発したとすると

xA0 = A1 + A2

 xB0 = r1A1 + r2 A2

 
 
    (5.35)

となる。したがって，

r1xA0 = xB0であればモードω1のみが生き残る（A1 ≠ 0, A2 = 0）

　 r2 xA0 = xB0であればモードω2 のみが生き残る（A1 = 0, A2 ≠ 0）

　上述のような運動の様子を Working Model 2D で確認する前に，例として， ′ k = 3kのときの計算

をしておこう。このときには式(5.32)，(5.33)より

ω1
2 = 7 − 37

2
k = 0.46k

ω2
2 = 7 + 37

2
k = 6.5k

 

 
 

 
 

  (5.36)

r1 = 1+ 37
6

= 1.2

 r2 = 1 − 37
6

= −0.85

 

 
 

 
 

  (5.37)

さて，力学モデル m5_6_coupled1.wmあるいは m5_6_coupled1.wmを開いてみよう。バネ定数は

′ k = 3k=120［N/m］に設定しておいたので振動数と周期は

ω1 = 4.3  [rad/s],     T1 = 1.47   [s] 

ω 2 = 16.2   [rad/s],   T2 = 0.39  [s]

 
 
 

  となる。

特別な初期条件で出発するのでなければ運動は一般にω1の振動とω2 の振動の重ね合わせになる。

したがって，モードω1のみを取り出すには初期条件を適当に設定しなければならない。例えば，Ａ，

Ｂともに初速度ゼロで出発することにすれば，最初の座標（平衡点からのずれ）xA0，xB0　は

r1xA0 = xB0，すなわち，1.2 xA0 = xB0 のように設定してモデルをスタートさせればよい。モードω2 の

みを取り出すには xA0，xB0　はr2xA0 = xB0 ，すなわち，−0.85 xA0 = xB0 のように設定してモデルをス

タートさせればよい。モデル m5_6_rensei1.wm とモデル m5_6_rensei2.wm では，初期設定のま

までスタートさせると，それぞれ，モード１とモード２の振動が見られるようにしてある。各モー

ドの振動の様子を確認されたい。

表 5.8　m5_6_rensei1.wmおよび m5_6_rensei2.wmのワールド初期設定

力学モデル・ファイル名 m5_6_rensei1.wm m5_6_rensei2.wm
目的・機能 連成振動モード 1 連成振動モード 2
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Spring1 constant = 40 [1? 100 ]
Spring2 constant = 120 [ 1? 200]
Square1 mass = 1 [ 0.01? 5.00 ]
Square2 mass = 1 [ 0.01? 5.00 ]

スライダー

初期設定と［範囲］

Square1 x = 1.40 [ 0.15?
15.5 ]
Square2 x = 4.50 [ 0.15?
15.5 ]

Square1 x = 3.55 [ 0.15 ?
15.5 ]
Square2 x = 6.00 [ 0.15 ?
15.5 ]

平衡点 Square1 x = 2.50
Square2 x = 5.50

Air Resistance（空気抵抗） None

図 5.13　連成振動（m5_6_rensei1.wm）

5. 6. 2　強制力を加えた場合　共振

　図 5.14（力学モデル m5_6_rensei-kyousin.wm）のように２つのおもりＡ，Ｂの一方Ｂに外部か

ら振動型の強制力 f0 cosΩt（f0は一定）を加えたとしよう。このときは，二つの基準モードω1，ω2

の両方に対して角振動数Ωの強制力が加わることになる。容易に推察できるようにΩ=ω1のときは
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モードω1の振幅が大きくなり，Ω=ω2 のときはモードω2 の振幅が大きくなる。共振点は二つ現れる

のである。

詳細　　　このことを運動方程式に基づいて確かめるには以下の筋道に従って前小節と同様の計算を行っていけば

よい。まず，運動方程式 (5.30b)の右辺には強制力 f0 cosΩt が付け加わる。そして，強制力と同じ角振動数Ωの振

動 xA (t) = Acos(ωt + α),  xB (t ) = B cos(ωt + α)の解を探す。すると，式(5.31a)，(5.31b)においてωをΩで置き換

え，(5.31b)の右辺に強制力から出てくる項 f0B を追加した方程式が得られる。この方程式をA，B について解く。

その解 A，B はΩ=ω1のときとΩ=ω2 のときに無限に大きくなる。

　シュミレーションでこの共鳴現象を確かめることは容易である。モデル m5_6_rensei-

kyousin.wmの設定は m5_6_rensei1.wmとほぼ同様であるが，　Damper spring を使って摩擦抵

抗を与えるよう修正してある。（これは共振以外の余計な振動を減衰させることによって，共振現象

と基準モードを見やすくするためである。）質点ＢにはActuator（アクチュエータ）で強制力 1 cos

Ωt  [N]を加えている。振動数Ωはスライダーを使って 1? 30 [rad/s[の間で変化させることができ

る。Ω=ω1＝4.3［rad/s］およびΩ=ω2 ＝16.2［rad/s］近辺でモードω1，ω2 が励起されることを確

かめられたい。

表 5.9　m5_6_rensei-kyousin.wmのワールド初期設定

力学モデル・ファイル名 m5_6_rensei-kyousin.wm
目的・機能 連成振動での共振

スライダー

初期設定と［範囲］

Spring1 constant = 40 [ 1? 100 ]
Spring1　Damper constant = 0.30
Spring2 constant = 120 [ 1? 200 ]
Square1 mass =  1 [ 0.01? 5.00 ]
Square2 mass =  1 [ 0.01? 5.00 ]
Square1 x = 2.5 [ 0.5? 15.5 ]
Square2 x = 5.5 [ 0.5? 15.5 ]
Square1 x = 1.40
Square2 x = 4.50
Actuator input[10] = 4.3 [ 1? 30 ]

Actuator (アクチュエータ) 1*cos(input[10]*time)

平衡点 Square1 x = 2.50，　　Square2 x = 5.50
Air Resistance（空気抵抗） None
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θ
ｙ

Ｗ
図 5.14　連成振動で の共振（m5_6_rensei-

kyousin.wm）

5.7　つり橋の振動のモデル (B)

 　つり橋の横断面を簡単化して描くと図 5.15　のようになっている。

図 5.15　つり橋の横断面の模型

 　道路部分を，変形しない一様な平板（質量 M，幅 W）とみなし，これが横方向に揺れることも

奥行き方向（道路方向）に傾くこともないとすると，平衡状態からのずれは重心の鉛直方向の変位

y と橋の面の傾きθによって指定される。橋を吊っているワイヤーが伸び縮みに対してバネのよう

に働くと考えてそのバネ定数を kとすると，橋の運動方程式は
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MÝ Ý y = −2ky  

I Ý Ý θ = −
kW2

2
θ

 
 
 

  
  (5.38)

となる。ただし，I は重心の周りの慣性モーメントでI =
MW2

12
  である。(5.37)の２番目の式の右辺

（バネが与える力のモーメント）ではθは小さいと仮定した。この方程式の形からただちに，重心

の鉛直座標 y は角振動数ω1 =
2k
M

 の単振動をし，傾きθは角振動数ω2  =
kW2

2I
 =

6k
M

の単振動を

することがわかる。

　力学モデル m5_7_bridge1.wm（図 5.16）で振動の様子を見てみよう。（m5_7_bridge1.wmでは

M =1 [kg]，k =5 [N/m]とした。対応する角振動数はω1＝3.2[rad/s]，ω2 ＝5.5[rad/s]である。バネ

は横揺れしないようにしてある。）モードω1のみの振動が起こるのは橋が水平を保ちながら上下振

動のみをする場合である。この振動をみるには初速度ゼロで両端の高さを揃えてモデルをスタート

させればよい。モードω2 のみの振動が起こるのは重心が動かない場合である。この振動をみるには

初速度ゼロで左端と右端を反対向きに水平状態から同じだけ傾けてモデルをスタートさせればよい。

表 5.10　m5_7_bridge1.wmのワールド初期設定

力学モデル・ファイル名 m5_7_bridge1.wm
目的・機能 つり橋の自由振動

Spring spring constant = 5.0
Bridge Mass = 1.0
Gravity (重力) 9.807
Air Resistance（空気抵抗） None
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図 5.16　つり橋の自由振動（m5_7_bridge1.wm）

　この橋に対して風や地震などが原因で周期的な外力が加わると運動方程式(5.38)の右辺には周期

的強制力の項が付加されることになり，§5.3 と同様にして共振を引き起こす。強制力の角振動数

をΩとすると，Ω＝ω1　のときは橋の上下振動が励起され，，Ω＝ω2 　のときは橋の捩れ回転振動

が励起される。上記のモデル（が当てはまるように設計された橋）では，ω2 ω1 = 3 =1.7となり二

つの振動数はかなり異なっているので上下振動と捩れ回転振動が同時にしかも大きく励起されるこ

とはない。しかし，ω1とω2 が接近しているように設計されている橋ではこの二つの振動が同時に励

起されて橋は大揺れに揺れることになる。このような橋は危険である。

　力学モデル m5_7_bridge2.wm（図 5.17）では橋の左端にActuator（アクチュエータ）を連結し

て，振動型の強制力 2 cosΩt [N/m]を加えている。角振動数Ωはスライダーで 1? 10[rad/s]の範囲

で変化させることができる。（共振が際限なく大きくならないように空気抵抗 f = 2v  [N]を加えてお

いた。）Ωを変化させて上下振動，捩れ回転振動の共振が起こるのを確かめられたい。

表 5.11　m5_7_bridge2.wmのワールド初期設定

力学モデル・ファイル名 m5_7_bridge2.wm
目的・機能 つり橋の共振

Spring spring constant = 5.0
Bridge Mass = 1.0
Actuator 2*cos(input[10]*time)
Gravity (重力) 9.807
Air Resistance（空気抵抗） Standard（標準）
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図 5.17　つり橋の共振（m5_7_bridge2.wm）

5.8　分子の振動のモデル (C)

　水分子は図 5.18 のような概形をしている。Ｏ-Ｈ間の伸び縮みとＨ-Ｈ間の伸び縮みに対して復元

力が働く。そこで，水分子のモデルとして，バネで結ばれた３個の質点の系を考えることができる。

Ｏ-Ｈ間バネ定数を k，Ｈ-Ｈ間バネ定数を ′ k とすると，基準モードは図 5.18　で示したように３通

りあって，振動数ω a ,ωb ,ωcは次のようになる。#

ω a
2 = k

m
(1+ 2m

M
sin 2 α) (5.39)

ω b,c
2 は二次方程式

ω4 − ω2{
k
m

(1+
2m
M

cos2 α) +
2 ′ k 
m

(1 +
2m
M

sin 2 α )}+
2µk ′ k 
Mm2 = 0 (5.40)

の２根。（ただし，µ = mM
m+ M

）

図 5.18　水分子の固有振動

　力学モデル m5_8_molecule.wmでは現実の水分子とはかなり異なるパラメータの設定をしてあ

る。Actuator（アクチュエータ）で振動数Ωの強制力を一方の水素原子に加えている。Ωをスライ

ダーで変化させていって，上記の(a)， (b)， (c)のモードが励起されることを確かめられたい。(a) は

スライダー目盛り 3.5 近辺で，(b)は スライダー目盛り 0.75 近辺で， (c)は スライダー目盛り 4.15

                                                
#ランダウ＆リフシッツ 著，広重徹＆水戸巌 訳：力学（増訂第３版，東京図書 1991 年）§24

( a ) (b ) (c)
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近辺で励起されるようになっている。電子レンジで水分を含む物質が加熱されるのは上記とまった

く同様な共振を通じてである。電磁波（マイクロ波領域）がアクチュエータの役割を果たし，共振

の振動エネルギーは，摩擦によって熱エネルギーに転化されているのである。

表 5.12　m5_8_molecule.wmのワールド初期設定

力学モデル・ファイル名 m5_8_molecule.wm
目的・機能 分子振動の模型

Mass（質量） 「酸素原子」　3.2
「水素原子」　0.2

Spring constant 水素-酸素　50
水素-水素　25

Actuator cos(input[15]*3.14*time)
Gravity (重力) None
Air Resistance（空気抵抗） Standard（標準）

図 5.19　分子振動の模型（m5_8_molecule.wm）
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5.9　波動 (A)

　§5.5 ではバネで連結した２個のおもりの系を取り上げ，一方のおもりの振動が他方のおもりへ

と伝達される現象を観察した。おもりの数を増やしてたくさんのおもりをバネで次々に連結しなが

ら並べていくと，今度は一つのおもりの振動が隣のおもりの振動を引き起こし，それが次から次へ

と伝えられていく現象が見られることになる。これが波動である。（バネを短くしておもりを小さく

軽くし，そのかわり，それらの数を大きくしていくと連続体に近づく。）この節では波動現象を

Working Model 2D で観察してみよう。

5.9.1 横波と縦波

　力学モデル m5_9_yokonami.wmでは短いバネで連結したおもりが上下方向にしか振動できない

ように設定してある。水平軸が平衡状態である。真中あたりのおもりを強制的に上下に揺すると波

が左右方向に進行するのが観察される。このような波はおもり（媒質）の振動方向が波の進行方向

に対して垂直（横方向）なので横波と呼んでいる。これに対して力学モデル m5_9_tatenami.wm

ではおもりは水平方向にしか振動できないように設定してある。左端のおもりを強制的に左右に揺

すると波（おもりの間隔が短いところや長いところ）が右方向に進行するのが観察される。このよ

うな波はおもり（媒質）の振動方向が波の進行方向に対して平行（縦方向）なので縦波と呼んでい

る。横波の典型的なものは水面を伝わる波や地震のＳ波である。縦波の典型的なものは音波や地震

のＰ波である。

表 5.13　m5_9_yokonami.wmおよび m5_9_tatenami.wmのワールド初期設定

力学モデル・ファイル名 m5_9_yokonami.wm m5_9_tatenami.wm
目的・機能 横波 縦波
スライダー
初期設定と［範囲］

Spring constant = 200 [ 0.5?
1000]
Mass（各質点）= 5.0 [ 0? 100 ]

Spring constant = 50 [ 0.5?
1000]
Mass（各質点）= 0.031 [ 0?
100 ]

Air Resistance（空気抵抗） None
Stop when（停止条件） Time < 8.00 None



169

図 5.20　横波（m5_9_yokonami.wm）

5.9.2 干渉

　力学モデル m5_9_kansho1.wm と m5_9_kansho2.wm では左端と右端でほぼ同じ形のパルス波

を発生させるように設定してある。kansho1 では山どうしがぶつかって強めあうのが，kansho2 で

は山と谷がぶつかって打ち消しあうのが観察される。このような現象を干渉と呼んでいる。

表 5.14　m5_9_kansho1.wmおよび m5_9_kansho2.wmのワールド初期設定

力学モデル・ファイル名 m5_9_kansho1.wm m5_9_kansho2.wm
目的・機能 干渉（強めあい） 干渉（打ち消しあい）
スライダー
初期設定と［範囲］

Spring constant = 200 [ 0.5? 1000]
Mass（各質点）= 5.0 [ 0? 100 ]

Actuator 左側　6*cos(1*time)
右側　6*cos(1*time)

左側　6*cos(1*time)
右側　? 6*cos(1*time)

Air Resistance（空気抵抗） None

Stop when（停止条件） Time < 9.00 Time < 8.50
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図 5.21　干渉（m5_9_kansho2.wm ）

5.9.3 反射

　力学モデル m5_9_hansha1.wm と m5_9_hansha2.wm では右側から進行してきた波が左端で反

射される様子を観察されたい。m5_9_hansha1.wmでは左端は上下方向に動くことができるように

設定してある（自由端），m5_9_hansha2.wmでは左端は固定してある（固定端）。自由端での反射

では反射波の位相は入射はと同じである。その理由は，右端でのおもりの変位y0とその左隣のおも

りの変位y1 がつねに（よい精度で）y0 − y1 = 0の関係を保っていなければならないからである。（も

し， y0 − y1 ≠ 0となったとしても右端のおもりが直ちに移動してきてy0 − y1 = 0となる。）これに対し

て固定端での反射では位相は逆転する。その理由は，右端でのおもりの変位y0 がつねにy0 = 0とな

っていなければならないからである。(入射波と反射波が逆転しているときに限りy0 = 0となる。)

表 5.15　m5_9_hansha1.wmおよび m5_9_hansha2.wmのワールド初期設定

力学モデル・ファイル名 m5_9_hansha1.wm m5_9_hansha2.wm
目的・機能 自由端での反射 固定端での反射
スライダー
初期設定と［範囲］

Spring constant = 200 [ 0.5? 1000]
Mass（各質点）= 5.0 [ 0? 100]

Air Resistance（空気抵抗） None
Stop when（停止条件） Time < 14.0
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図 5.22　反射（m5_9_hansha1.wm）

5.9.4 異なる二つの媒質の境界での波の反射と透過

 力学モデル m5_9_kyoukai1.wmと m5_9_kyoukai2.wmでは真中あたりを境として右側と左側と

でおもりの質量を異なるように設定してある。右側の質量を左側の質量の 10 倍にしたので右側で

の波の速度は左側の1 10 倍となる。m5_9_kyoukai1.wmで左側から右側へ進行するパルス波は境

界でどのように振る舞うかを観察されたい。透過波と反射波が見られるはずであるがそれらの位相

は両方とも入射波と同じである。これに対して，m5_9_kyoukai2.wmでは右側から左側へ進行する

パルス波を見ることができる。このとき透過波は入射波と同位相となるが反射波は逆位相になるこ

とを確かめられたい。

表 5.16　m5_9_kyoukai1.wmおよび m5_9_kyoukai2.wmのワールド初期設定

力学モデル・ファイル名 m5_9_kyoukai1.wm m5_9_kyoukai2.wm
目的・機能 媒質境界での反射と透過 媒質境界での反射と透過

Spring constant = 200 [ 0.5? 1000]スライダー
初期設定と［範囲］ Mass（各質点）

境界左側 = 5.0 [ 0? 100]
境界右側 = 50.0 [ 0? 100]

Mass（各質点）
境界左側 = 50.0 [ 0? 100]
境界右側 = 5.0 [ 0? 100]

Air Resistance（空気抵抗） None
Stop when（停止条件） Time < 5.0 Time < 30.0
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図 5.23　異なる媒質の境界での反射と透過(m5_9_kyoukai1.wm)

5.9.5 定在波

　境界で反射してきた波は入射波と干渉して，適当な条件を満たすとき定在波をつくる。定在波で

は，まったく振動の起こらない所（節）と振動が最大で起こるところ（腹）がある。力学モデル

m5_9_teizaiha1.wm と m5_9_teizaiha2.wm では右端のおもりに Actuator（アクチュエータ）で

強制力 6 cosΩt [N/m]を加えている。さらに， m5_9_teizaiha1.wmでは左端に同様の強制力をく

わえているが，m5_9_teizaiha2.wm では左端を固定端としている。Actuator の振動数Ωをスライ

ダーで変化させていって定在波ができるのを確認されたい。振動数を 0 から徐々に大きくしていく

と，まず最初に節が１個の定在波ができ，さらに大きくしていくと節が１個，３個，? の定在波が

できる。

表 5.17　m5_9_teizaiha1.wmおよび m5_9_teizaiha2.wmのワールド初期設定

力学モデル・ファイル名 m5_9_teizaiha1.wm m5_9_teizaiha2.wm
目的・機能 定在波

（左端：固定；右端：自由）
定在波
（左端：自由；右端：自由）

スライダー
初期設定と［範囲］

Spring constant = 200 [ 0.5? 1000]
Mass（各質点）= 5.0 [ 0? 100]
Actuator input[376] = 1 [ 0? 10]

Actuator （アクチュエータ） 6*cos(input[376]*time)
Air Resistance（空気抵抗） None
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図 5.24　定在波（m5_9_teizaiha1.wm）
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「質点から剛体へ」　　　　　　　　　

Coffee Break 6

力学の講義が進むにつれ，例として提示される運動も1次元から 3 次元へ，物体も質点から剛体

へと移行してきます。ここで，力学で取り扱われる物体について，もう一度定義しておきましょ

う。

さて，力学は「力によって物体の位置が，時間と共にどのように変化していくかを理解するため

の学問」です。質点は力学を簡単に理解するためには有用ですが，現実とは異なりますね。物体に

は大きさと形があります。より現実に近づくためには，剛体を考える必要があります。質点と剛体

の運動はどのように違うのでしょう

物体：質量 m をもちます。力学では一般に以下の３種類を考えます。

　　　質点（質量をもつが大きさ，形がないもの；現実的ではないけれど取り扱いが簡単）

　　　質点系（多くの質点が集まったもの；現実の物体を扱うための前段階）

　　　剛体（無数の質点があつまったもの；現実の物体に近い）か。

力学モデルでは，斜面を転がり降りる球の様子を示しています。mc 6 shitsuten.wmでは，球が

回転せずに斜面を滑り降りていきます。mc 6 gotai.wmでは，球が回転しながら斜面を滑り降りて

いきます。一つは質点の運動で，もう一つは剛体の運動です。どちらが質点で，どちらが剛体かわ

かりますか。剛体の運動の特徴として慣性モーメント Iがありましたね。これは，何に対応するも

のでしたでしょうか。そう回転です。これが質点と剛体の運動の差を与えます。この回転に(1/2)Iω2

（ω：角速度）のエネルギーをとられるために，物体の運動は質点の場合と比べて遅くなります。

もう一度，剛体の運動の内容を復習しながら力学モデル mc 6 shitsuten.wmと mc 6 gotai.wmのシ

ミュレーションをやってみてください。
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第６章　複合モデル

この章の構成と内容

前章までは、自然現象を、力学的に、質点・質点系、剛体・剛体系、振動系の三分野に分け、そ

れぞれシミュレーションモデルを実行し、理論的・定量的な解析を試みた。

実際の日常生活で見られる現象は、これら三分野の内容が、複雑に関係して起こり、客観的な方

程式では解析が難しい。このため、基本的モデルをいくつか組み合わせて複合モデルを作成し、そ

の実行によって、定性的な理解が深まるような内容が必要である。したがって、理論先行ではなく、

モデルの実行により現象の把握につとめ、次いで、定性的な理論解析が行えることが求められる。

この章は、解説文を割愛し、いきなり「剛体力学モデル実習」を実行するという構成にした。こ

こで、質点と質点系の分野は、剛体系を考える場合に抱合されており、剛体系と振動系の複合モデ

ルをシミュレーションすることになる。

各モデルは、目的が適切に把握できるように、初期設定されているが、スライダーや Properties な

どで設定を変更し、実行を試みることが大切である。さらに、課題によって、モデルが内包する基

本的理論を、定性的に検討し理解を深めることが求められる。モデルによっては、メジャーウイン

ドウで取得したデータを、数学的に処理する場合もある。

モデルの実行に際し、次の順序で準備作業を行う必要がある。

１、「テーマ」と「操作」でモデル内容を把握する。

２、モデル各部の初期設定を確認する。

３、World⇒Start Here を選択する。

４、World 画面を最大にする。

５、シミュレーションの状況を把握するため、予行として実行してみる。

６、予行の結果、中断条件、各種設定、スライダーの最大・最小、メジャーウインドウズ、など

を適切に設定しなおす。

７、本番の実行を行う。

モデルは、CD から自分のフォルダにダウンロードし、それを起ち上げて作業することが肝要で

ある。設定変更により、モデルが初期に戻らないことがある。
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　剛体力学モデル実習　m6_1　　テーマ　「風力の影響」

力学モデル　m6_1_wind.wm「重力場、空気抵抗なし、風力あり」

操作

　重力場で、球体が水平に投射され、風力の作用により曲線を描いて下方へ運動する。種々条件を

設定し、その軌跡を観察せよ。

初期設定

　重力：world⇒Gravity⇒Vertical 2.0

  風力：World⇒Force Field⇒Field 2.0

  速さ：D.K⇒properties⇒Vx 7.0

　表示：K⇒Define⇒VectorVelocity

  測定：K⇒measure⇒P‐V‐A

課題

　風力の加速度は左水平方向と設定して

いる。重力加速度との合成加速度を考え

ると、この運動の軌跡は「初期原点にお

ける直交 X,Y 座標軸に対して放物運動を

示す」である。このことを証明せよ。

　　　　　　　　　　　　　　　　　　　　　　　　　　　　　図 m6.1 風力の影響

　剛体力学モデル実習　m6_2　　テーマ　「ロケットの発射」

力学モデル　m6_2_rocket start.wm「重力場、中断時間 2.8秒」

操作

　ロケット二体を同時に打ち上げる。本体と動力源の質量の組み合わせにより、種々の打ち上げが

可能である。動力は、鉛直上方へ初速度を与えた正方形部分が、衝突するときの撃力による

初期設定

　重力場：Gravity Vertical=9.807m/s2

　空気抵抗：なし

  動力：左 35m/s、右 30m/s

　本体質量：左 3Kg、右 1Kg

  角度：左 0rad、右 0.453rad

　（注）画面を最大にする。速度設定を

　　　　小さくする。

課題

　右のロケットは回転しながら、放物線

の軌跡を描いて飛行する。この打ち上げ

システムの何が原因で、回転が生じるの

か、解説せよ。

　　　　　　　　　　　　　　　　　　　　　　　　　　　　図 m6.2 ロケットの発射
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　剛体力学モデル実習　m6_3　　テーマ　「地球と月の運動」

力学モデル　m6_3_earth and moon .wm「万有引力場、スライダー（速さ）」

操作

　宇宙空間において、地球の周りを、月が回転する現象を観察する。万有引力が物体に作用し合う

場合の、物体の運動は様々である。設定を変えて実行してみれば、我々の地球と月の運動は奇蹟と

も言える。

初期設定

　万有引力定数：6.672e－11 Nm2/Kg2

　質量：E  0.503Kg、M  0.126Kg

  速さ：E  Vx=0、Vy=0、

        M  Vx=10.0m/s、Vy=slider　2m/s

　軌跡：Track center of mass

課題

　モデルは模型である。実際の数値を用

いて、地球と月の相対運動を実行して見

よ。ただし、月の周期が１日であるから、

実行する場合はその周期を数秒に圧縮し

なければならない。

　　　　　　　　　　　　　　　　　　　　　　　　　　　　　図 m6.3 地球と月の運動

　剛体力学モデル実習　m6_4　　テーマ　「宇宙空間の三体」

力学モデル　m6_4_planet 3 body.wm「万有引力場、」

操作

　図 m6.3 の現象を二体問題ともいうが、これに、太陽を参加させると三体問題となる。三者が互

いにその距離と引力を変えながら運動する状況を観察しよう。

初期設定

　万有引力定数：6.672e－11 Nm2/Kg2

　質量比：S : E : M=5 : 5 : 3

　速さ：S  Vx=0、Vy=0、E　Vx=5m/s、Vy=5m/s

　      M  Vx=0、Vy=5m/s

　摩擦係数：0.3  反発係数：0.5 (S のみ 0 )

やってみよう

　地球と月の実際を再現することは大変で

ある。さらに、太陽の周りを回らせ、地球

の周期を 365 日、月の周期を１日にできる

よう、奮闘を期待する。

　　　　　　　　　　　　　　　　　　　　　　図 m6.4 宇宙空間の三体
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　剛体力学モデル実習　m6_5　　テーマ　「ボールと剛体の衝突」

力学モデル　m6_5_bound of a ball.wm「重力場」

操作

　モデルは縮小しているから、拡大してから Run すること。質点が壁と床で跳ね返る様子を観察す

る。この場合、質点の回転運動を考えないことに留意すること。

初期設定

  質点：Vx=9.5m/s、e=1.00、μs=μk=0.30

　壁・床：Rubber、e=0.95、μs =0.90、

　　　　　μk=0.80

  ベクトル表示：速さ、加速度

課題

　質点、壁、床について、各種スライダ

ーを設定し、様々な運動を試してみよう。

また、メジャーウインドウも開いてデジ

タルデータを取得し、質点の時間 t 後の

位置を求める計算式の計算と、データと

が一致するか、検証せよ。

　　　　　　　　　　　　　　　　　　　　　　　　　　　図 m6.5 ボールと剛体の衝突

　剛体力学モデル実習　m6_6　　テーマ　「小球の複雑な衝突」

力学モデル　m6_6_double collision.wm「重力場」

操作

　質点の、斜面と平面上の運動、放物運動、壁との衝突、床との衝突の繰り返しを経て、最後に、

曲面での振動で終息する運動である。モデルを拡大し、それぞれの様子を観察せよ。

初期設定

  それぞれの部分の設定を、個別に

ダブルクリックし、Properties ウイン

ドウで調べよ。複雑なモデルは、ス

ライダーを用いると、解析がスムー

ズに行える。また、メジャーウイン

ドウによるデータの取得について、

最終目的をきちんと設定して、効果

的な活用をするべきである。

課題

　剛体球を用い、スタートから、様々

な仕掛けを通過して、無事ゴールに

到達するゲームを作成せよ。

　　　　　　　　　　　　　　　　　　　　図 m6.6 小球の複雑な衝突
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　剛体力学モデル実習　m6_7　　テーマ　「静止摩擦係数と剛体の滑り」

力学モデル　m6_7_cofficient of friction.wm「重力場、スライダー（摩擦係数、速さ）」

操作

　床の上に載せられた、３直方体と１球体の相互作用を観察する。最下の直方体 3 の速さと静止摩

擦係数をスライダーで設定し、全体の運動を検討してみよう。

初期設定

　摩擦：3  S.F 0.65、K.F 0.50

        2  S.F 0.40、K.F 0.80

        1  S.F 0.50、K.F 0.40

        球 S.F 0.30、K.F 0.30

　　　　床 S.F 0.30、K.F 0.30

  速さ：3  Vx=4.00、Vy=0.00

課題

　各部分の質量を調べ、運動方程式を作

り、運動状況の条件（滑る滑らないなど）

を示す式を求め、メジャーウィンドウの

データで検証せよ。

　　　　　　　　　　　　　　　　　　　　　　　　　図 m6. 静止摩擦係数と剛体の滑り

　剛体力学モデル実習　m6_8　　テーマ　「斜面を運動する剛体と摩擦係数」

力学モデル　m6_8_friction of slope.wm「重力場、スライダー（角度、摩擦係数）」

操作

　傾角を変更できる斜面上で、正方形型剛体が運動する場合、摩擦係数の変更により運動は、どの

ように変化するか観察する。

初期設定

　質量：3　2.00Kg

　傾角：3  0.20rad

  摩擦：9  S.F 0.20、K.F0.20

  （注）傾角を変更する場合、正方形体

　　　　を斜面に接触させること。

課題

　長方形体は傾角と摩擦係数の設定によ

り、静止、滑り出す、転がる、の三つの

運動を行うが、それらを規制する条件式

を求め、ウインドウのデータから検証せ

よ。

　　　　　　　　　　　　　　　　　　　　図 m6.8 斜面を運動する剛体と摩擦係数
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　剛体力学モデル実習　m6_9　　テーマ　「乗用車の衝突」

力学モデル　m6_9_collision of car.wm「重力場、スライダー（角速度）」

操作

　走行する乗用車が壁に衝突する場合、乗用車の質量、速さと、車輪と道路との摩擦係数、壁との

反発係数の設定により、乗用車に加わる衝撃力の変化を検証する。

初期設定

　摩擦：前輪 0.10, 道路 0.10

　速さ：前輪 ‐9.49 rad/s

　反発係数：車体 0.95, 壁 0.95

　測定：車体 P‐V‐A Window

課題

  車体に作用する衝撃力は、運動量の変

化で求められる。車輪の角速度からはや

さを計算、それを車体の速さとして、方

程式を作れ。衝撃力と速さ、反発係数、

摩擦力との関係を、ウインドウデータを

得て検証せよ。

　　　　　　　　　　　　　　　　　　　　　　　　　　　　図 m6.9 乗用車の衝突

　剛体力学モデル実習　m6_10　　テーマ　「球の回転と滑り」

力学モデル　m6_10_kaiten to suberi.wm「重力場、スライダー（力）」

操作

　床の上に置かれた剛体球に小球を衝突させたとき、剛体球の運動を観察する。小球の位置と力を

いろいろ変更すれば、剛体球は、転がる、滑りながら転がる、滑るのみ、の三運動をする。

初期設定

　質量：5   1Kg、剛体球 2Kg

　撃力：5  10 N

　位置：5   (‐1.0, ‐1.0 )

  角速度：22  0 rad

  反発係数：5  0.50、22  0.95

課題

　転がる、滑りながら転がる、滑るのみ、

の運動は、どのような条件で起こるか理

論式を作り、ウインドウデータを得て、

検証せよ。

　　　　　　　　　　　　　　　　　　　　図 m6.10 球の回転と滑り
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　剛体力学モデル実習　m6_11　　テーマ　「ビリヤード」

力学モデル　m6_11_billiards.wm「無重力、スライダー（速さ）」

操作

　剛体球によるビリヤード競技は、自球をキューで打ち、他球に当てて競うものである。四つ玉、

ポケットなどの種類がある。剛体球の並進運動と回転運動および、衝突現象を観察する。

初期設定

　摩擦：壁 S.F 0.90、K.F 0.80

        球 S.F 0.90、K.F 0.80

  速さ：自球 5.50 m/s

　反発係数：壁、球とも 0.95

課題

  このモデルを参考にして、ポケット競

技のモデルを作成せよ。球に回転を考え

る場合、球どうしや球と壁の衝突は複雑

になる。第四章、剛体の平面運動の内容

を参照し、自球の時系列運動を記述する

方程式を考えよ。

　　　　　　　　　　　　　　　　　　　　　　　　　　　　図 m6.11 ビリヤード

　剛体力学モデル実習　m6_12　　テーマ　「剛体のエネルギー伝搬」

力学モデル　m6_12_ propagation of energy.wm「重力場」

操作

　剛体が境界を接して存在し、他から衝撃力を受けたときの、剛体の挙動を観察するモデルを実行

する。剛体に与えられたエネルギーが伝搬する様子を、いろいろの設定により詳しく観察する。

初期設定

　質量：振り子球 4.52Kg、静止球 1.13Kg

　反発係数：全球 1.00

課題

  実際の実験装置では、両端の球が運動

し、その他の球は静止したままである。

このモデルを実行したとき、そのように

はならないことが観察されるが、その原

因を考察せよ。また、エネルギーが剛体

内を伝搬するモデルでもあるが、エネル

ギーが減衰する理由を考えよ。

　　　　　　　　　　　　　　　　　　　　図 m6.12 剛体のエネルギー伝搬
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　剛体力学モデル実習　m6_13　　テーマ　「単振子の減衰振動」

力学モデル　m6_13_pendulum of air resistance.wm「重力場」

操作

　単純な振り子に対し、空気の抵抗を考慮すれば、その振動は規則的に減衰し、減衰振動を呈する。

この場合、振動方程式はどのようになるか、考える。

初期設定

　質量：振子の重り 0.28Kg

  空気抵抗：k=0.05 (F=kVS)

  測定：V、A

課題

  第五章、減衰振動を参照し、その方程式

か、ウインドウデータを得て振動状況を検

討せよ。　また、第四章、複振子を参照し、

質点と剛体における振の基本的な差異につ

いて考察せよ。

　小球の代わりに、長方形剛体を重りにし

た場合はどうなるか考察せよ。

　　　　　　　　　　　　　　　　　　　　　　　　　　　　図 m6.13 単振子の減衰振動

　剛体力学モデル実習　m6_14　　テーマ　「バネ振子の不規則振動」

力学モデル　m6_14_spring pendulum.wm「重力場」

操作

　このモデルは、単振子のひもをバネに取り替え、下部にバネを２本取り付けた場合で、鉛直方向

に重りを振動させるものである。鉛直、水平方向の振動を観察する。

初期設定

　質量：重り 0.78Kg

  バネ：上 k=10 N/m、L=4.5m

        左 k=40 N/m、L=2.0m

        右 k=20 N/m、L=2.0m

　測定：重り Vx、Vy、Vo ウインドウ

応用

　この重りを乗用車のタイヤと考えれば、走

行中の車輪に作用する車体の重力と、路面か

らの衝撃力の影響による、複合現象のモデル

と見られる。設定をいろいろ組み替えて実行

すれば、水平方向が不規則振動を行っている

ことが観察できる。

　　　　　　　　　　　　　　　　　　　　　　　　　　　図 m6.14 バネ振子の不規則振動
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　剛体力学モデル実習　m6_15　　テーマ　「紐による連接振り子」

力学モデル　m6_15_joint pendulum.wm「重力場、スライダー（速さ）」

操作

　重り２個を紐で結び、固定された板の上の小球を動かしたとき、下部の小球の影響による、不規

則な運動系が観察できる。また、右方の壁に衝突する事で、さらに複雑な現象となる。

初期設定

　質量：3  0.50Kg、4  0.12Kg

　摩擦係数：3　板 K.F 0.30

  反発係数：壁 0.90

　速さ：3  5.00m/s、4   0Kg

　測定：3、4  Vxウインドウ

課題

　スライダーで小球の速さを変更し、小

球 3,4 の速さのグラフを観察し、運動を

解析せよ。このモデルは、ヘリコプター

が物資をぶら下げて運ぶ場合に相当する。

小球が振動せず、安定した並進運動を起

こす条件を求めよ。

　　　　　　　　　　　　　　　　　　　　　　　　　　　図 m6.15 紐による連接振り子

　剛体力学モデル実習　m6_16　　テーマ　「バネによる連接振り子」

力学モデル　m6_16_renseisindou unari.wm「重力場、スライダー（速さ）」

操作

　重り２個をバネで結び、固定された板の上の小球を動かしたとき、下部の小球の影響による、不

規則な運動系が観察できる。下部の小球 4 の軌跡は、うなりに似たものとなる。

初期設定

　質量：3  0.12Kg、4  0.12Kg

　摩擦係数：3  K.F 0.30

　速さ：3  3.00m/s、4   0Kg

　測定：3 、4  Vxウインドウ

課題

　バネによる下部の小球 4 の運動は X、

Y 方向に成分を持ち、不規則である。し

かし、ある程度長く運動させて観察すれ

ば、その軌跡は、音波に見られる「うな

り」と似たものとなる。これを理論的に

証明せよ。

　　　　　　　　　　　　　　　　　　　　　　　　　　図 m6.16 バネによる連接振り子
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　剛体力学モデル実習　m6_17　　テーマ　「縦波の伝搬」

力学モデル　m6_17_propagation of wave.wm「重力場」

操作

　小球間をバネで結び、各小球は天井に固定されている。左方から球体を衝突させて撃力を与え、

繋がったバネ系の振動を観察する。振動が伝搬する様子がよく分かる。これは縦振動で、音波のモ

デルになる。

初期設定

　質量：小球 0.03Kg、球体 0.12Kg

　バネ：横 k 5 N/m、L 0.50 m

        縦 k 50 N/m、L 1.90 m

　速さ：球体 10m/s

課題

　右水平方向へ小球の振動が次々と起

こり、小球の疎密状況が観察できる。

剛体内部の構成粒子をモデルとした振

動系であり、剛体内をエネルギーが、

伝搬することを説明するものである。

理論的に説明せよ。また、横振動の伝

搬モデルを作成せよ。

　　　　　　　　　　　　　　　　　　　　　　　　　　　図 m6.17 縦波の伝搬

　剛体力学モデル実習　m6_18　　テーマ　「不規則振動による描画」

力学モデル　m6_18_random motion.wm「無重力」

操作

　曲線レールに沿って運動可能な係留点に、紐で剛体球を結ぶ。剛体球を右水平方向に運動させる

と、重心と外周の一点とが軌跡を描く。剛体球は並進運動と回転運動を同時に起こし、複雑な運動

となる。

初期設定

　質量：球 3.8Kg

  速さ：球 Vx 20m/s

課題

  球の速さを設定するスライダを開き、軌

跡がどのような描画をするか観察し、軌跡

線の範囲を考えよ。この範囲は、もとの曲

線レールと相似形であることが分かる。こ

のことを用いて、レールを適宜変更し、ユ

ニークな描画作品をいくつか作成せよ。

軌跡を描く点に色彩を与えると、カラフル

な絵画のような絵が描ける。　　　　　　　　　　　　図 m6.18 不規則振動による描画
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　剛体力学モデル実習　m6_19　　テーマ　「棒の回転振動」

力学モデル　m6_19_swing of stick.wm「重力場、スライダー（角速度）」

操作

　剛体棒の一端を紐で天井からぶら下げ、棒の重心周りの加速度を与えると、棒は振動を起こす。

角速度によっては、不規則で複雑な振動となる。

初期設定

　質量：棒 0.38 Kg

  角速度：棒 7.79 rad/s

  長さ：紐 2.8 m

課題

　この振動を加速度に関して解析し、

一定の規則性があるかどうか、検討せ

よ。また、紐の長さと、鉛直線との角

度を変えたら、運動の違いが起こるか

試し、どちらの影響が規則性に関係が

深いか、考察せよ。

　　　　　　　　　　　　　　　　　　　　　　　　　　　図 m6.19 棒の回転振動

　剛体力学モデル実習　m6_20　　テーマ　「ギアによる単振子の振動」

力学モデル　m6_20_gear pendulum.wm「重力場、スライダー（質量、角速度）」

操作

　ギアをいくつか組み合わせ、振り子をセットする。振り子を付けた球体に角速度を与えれば、振

り子は

振動から始まり、様々な運動をくり広げる。

初期設定

　質量：重り 0.55 Kg、球体 3.8 Kg

　角速度：球体 6.28 rad/s

　測定：重りの位置 x、y ウインドウ

課題

  不規則運動に見えるが、少し長く実

行させてみれば、長周期の規則性が観

察される可能性がある。その可能性が

あるとすれば、どんな条件が必要か考

察せよ。また、球体の角速度に関して、

同様の検討をして見よ。

　　　　　　　　　　　　　　　　　　　　　　　　図 m6.20 ギアによる単振子の振動
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　剛体力学モデル実習　m6_21　　テーマ　「分子運動による拡散」

力学モデル　m6_21_motion of molequle 2.wm「無重力」

操作

　小球（分子と考える）が互いに作用し合って、空間で混じり合い、全体が均一になる状況をモデ

ルで観察する。分子が逃げないように、反発係数の大きな枠で囲んである。

初期設定

　質量：球 1.00Kg、枠 0.81Kg

  反発係数：球 0.95、枠 0.95

　物質：球 Steel、枠 Rubber

  速さ：左１列球 20.0 m/s、他球10.0 m/s

  角速度：全球 62.8 rad/s

  摩擦係数：全球 S.F 0.40、K.F 0.30

  慣性モーメント：全球 0.02 Kgm2

実行

　実際の分子間力は、引力と斥力が距離

をパラメータとして作用するが、このモ

デルでは、衝突による撃力を作用させて

ある。設定を変えて色々試して見よ。

　　　　　　　　　　　　　　　　　　　　　　　　　　　　図 m6.21 分子運動による拡散

　剛体力学モデル実習　m6_22　　テーマ　「剛体の不規則平面運動」

力学モデル　m6_22_rotation of rectangle.wm「無重力、スライダー（質量、速さ、角速度）」

操作

　曲線レールに一点で連結された長方形剛体坂が、速さ、角速度、慣性モーメントを与えられたと

きの平面運動を観察する

初期設定

　質量：剛体 1.00 Kg

　慣性モーメント：剛体 0.27 Kgm2

　角速度：剛体 0.63 rad/s

　速さ：剛体 Vx 10.0 m/s, Vy 1.00 m/s

  摩擦係数：剛体 0.3

課題

　スライダーで色々と設定を変更し、各

種メジャーウインドウを開いて、試して

見よ。

　回転の方向が変化するときは、どんな

ときであるか調べ、その原因を解明せよ。

　　　　　　　　　　　　　　　　　　　　　　　　　　　図 m6.22 剛体の不規則平面運動



188

　剛体力学モデル実習　m6_23　　テーマ　「地面振動とビル振動」

力学モデル　m6_23_earsquake.wm「重力場」

操作

　モーターによる回転をダンパーで制御し、ビルが建つ地盤に振動を与えて、ビルを加振したとき

の、ビル各部の振動状況を観察する。

初期設定

　質量：ビル 0.84Kg、地盤 0.63Kg

　摩擦係数：ビル、地盤 S.F 0.95、

K.F 0.80

　モーター：50 rad/s

　ダンパー：ｋ 1.00 Ns/m  (F=kv)

課題

　ビルの４点における振動加速度の

メジャーウインドウを開き、観察せ

よ。このモデルを参考にして、高層

ビルのモデルを作成し、地盤振動と

ビル振動との共振現象からビルのど

の位置に最大作用が起きるか、検討せよ。

　　　　　　　　　　　　　　　　　　　　　　　　　図 m6.23 地面振動とビル振動

　剛体力学モデル実習　m6_24　　テーマ　「風力による橋梁の桁振動」

力学モデル　m6_24_wind and bridge.wm「無重力」

操作

　橋梁に左方から周期関数に従う風力を与え、橋梁の桁がどのような応答をするか観察する。図は、

橋梁を上空から見たものである。風力の

周期関数は、サイン関数とした。

初期設定

　質量：桁 0.28Kg

　摩擦係数：S.F 0.30、K.F 0.30

　桁は可動継ぎ手で連結

課題

　風力の設定を変更し、桁の質量により

応答の変化を調べよ。ウインドウデータ

から共振点を検討せよ。また、橋梁の全

長との関係も考察せよ。ただし、モデル

によるものであるから、厳密な結果が得

られないから、定性的な検討でよい。

　　　　　　　　　　　　　　　　　　　　　　　　図 m6.24 風力による橋梁の桁振動
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再び「力学って？」　　　　　　　　　

Coffee Break 7

　「力学でいろいろなことを勉強するのだけれど，モデルばかり考えていて，一体現実的な系と

の対応はどうなっているの？」とお考えのあなたに，Coffee Break 最後の話題として「力学って？」

一体どんなものを考えるときに役立つのか一例を挙げてみましょう。

さて工学の世界では最近“ナノテクノロジー”という言葉を良く聞くようになってきました。“ナ

ノ”というのはナノメートル[nm]を意味しています。すなわち，10-9 [m] という非常に小さな領域

での“テクノロジー（技術）”のことを“ナノテクノロジー”と呼びます。このような長さの領域

では，私たちが目で見ている物体はもはや一つながりの連続したもの（連続体）ではなく，不連続

に原子が並んだものとして認識されます。多数の原子が規則正しく並んで，私たちの目で見ること

ができる物体を形作っているということですね。普段私たちが接している長さの尺度から考えると，

これら多数の原子からなる系は，いわば質点系のようなものと考えても良いと思います（質点とは

「質量をもつが大きさ，形がないもの」：質点系とは「多くの質点が集まったもの」でしたね）。

　このような質点に似た原子が，規則正しく並んでいるということは，原子と原子の間にあるポテ

ンシャルが存在して，原子を等距離に保っていると考えられます。このポテンシャルのことを原子

間ポテンシャルと呼びます。そのポテンシャル曲線は原子と原子の間の距離の関数として，図 C. 1

のような形になるのが一般的です。似たような形のポテンシャル曲線を見た覚えはありませんか。

そう単振動のポテンシャル曲線と似てますね。単振動の場合には左右対称な 2 次曲線でしたが，原

子間ポテンシャルの場合には左右非対称になっているのが特徴的です。

図 C. 1　　単振動におけるポテンシャル曲線（左）と原子間ポテンシャル曲線（右）
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　温度が絶対零度であれば，原子はこのポテンシャル曲線の最小位置にとどまります。しかしなが
ら私たちは，300 [K]程度の温度の下で暮らしています。このような温度では，原子はこの最小位置
にとどまらず，温度に対応した運動エネルギーをもって振動をしています。この運動エネルギーと
ポテンシャルエネルギーの和，すなわち全エネルギーE を表す水平線を図中に引けば，これとポテ
ンシャル曲線の交点 A と B の間では，運動エネルギーは K で与えられます。A と B では K=0 とな
り  ，ここで運動は一時止まって折り返し，振動は A と B の間で行われます。温度が高くなる，す
なわち運動エネルギーが大きくなると，原子の平均位置はどうなるでしょうか。
　力学モデル mc 7 pot1.wm では単振動における原子の平均位置が，mc 7 pot2.wm では原子間ポテ
ンシャルを与えて原子の平均位置が，それぞれ温度と共に変化していく様子（矢印の位置に注目）
を調べています。原子間ポテンシャルにおいてはポテンシャル曲線の非対称性を反映して，温度と
共に原子位置の平均値は増加していくことがわかります。これが私たちが良く知っている熱膨張と
いう現象です。温度が変化すると物質が伸び縮みする理由は，こんなところにあったんですね。力
学で学ぶ内容はモデルが中心ですが，実は実際の現象に近いことを学んでいるのだということがお
わかりいただけたでしょうか。この副教材には，基礎的な問題から現実的な問題までを含んだ，さ
まざまなシミュレーションが提示されています。いろいろな問題に気軽に挑戦してみてください。
力学は決して難解なものではなく，考えることの楽しさを味わえるのではないかと思います。力学
って単に「力によって物体の位置が，時間と共にどのように変化していくかを理解するための学問」
に過ぎないのですから．．．。
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第７章　モデリング法

7.1　力学モデル創造の勧め

　本書では，単に力学モデルを動作させるだけでも読者の力学に対する理解を促進する。しかし与

えられた力学モデルを読者自ら改造したり，あるいは新しい力学モデルを創造してみることは更に

学習効果を高めるし，何よりも純粋に面白い。あるいはシミュレーションプログラムの工学への応

用では，力学モデルの作成（すなわち，モデリング）手法の修得は必須である。

　そこで，本章ではモデリングの手法について解説する。本章で使用する例題は，一部を除いて，

第 1 章で用いた力学モデル，あるいはそれらを構成する要素に関する力学モデルである。モデリン

グを初めて学ぶ人が順を追って読み進むことにより，次第に高度なモデリング手法について学習で

きるように配慮されている。しかし既に Working Model 2D のモデリングに関しある程度の知識を

持っている読者は，必要な場所を拾い読みしていただければ十分である。

7.2　Object（オブジェクト）の特性を設定・表示する３つのウィンドウ

　すべての Object（オブジェクト）の特性はオブジェクト一つずつに固有の各３つのウィンドウに

よって設定・表示される。３つのウィンドウの種類と役割を表 7.1 に載せる。

　　　　表 7.1　 Object（オブジェクト）の特性を設定・表示する３つのウィンドウ

名称 呼び出し方 機能
Properties
（属性）

・Window>Properties
　あるいは
・World(ワールド）の中で
　Object（オブジェクト）
　をダブルクリック

Object（オブジェクト）の基本的性質および，初期位
置などの設定。
Body（物体）の場合は，初期速度，材質，質量，
静・動摩擦係数，反発係数，電荷，慣性モーメント
などが設定できる。

Appearance
（外見）

・Window>Appearance Object（オブジェクト）の可視性（Show），色，パタ
ーンなどの設定。および COM（質量中心：Center Of
Mass）の可視性設定など。

Geometry
（幾何寸法）

・Window>Geometry Body（物体）の幾何学的寸法や COM（質量中心：Center
Of Mass）の位置を設定する。

　各オブジェクトは，その Properties（属性：性質や質量など），Appearance（外見：見えるか見
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えないかなど），Geometry（幾何学的寸法）を独立に設定することができる。ここでは，このよう

に Object（オブジェクト）の内容を，読者が自由に設定できることを理解していただきたい。

　本章では，モデリングの方法を解説するにあたり，各種Object（オブジェクト）を段階的に利用

していくが，まずその前にモデリングの準備から解説を始める。

7.3　モデリング開始前のワールド初期設定

　Working Model 2D は，モデリングの途中でも，シミュレーションを実行して，半完成力学モデ

ルの機能をテストすることができる。従って，実際にObject（オブジェクト）を選択してモデリン

グに入る前に，大まかな力学モデルの形態を，メニューの必要項目を設定することにより決定して

おくことが望ましい。

　メニューバーの Worldの中で設定できる主な機能を表 7.2 に示す。このメニューでは，主にWorld

（ワールド）の性質や，シミュレーション一時停止・終了の態様，計算精度などを設定する。もち

ろんこれらは，モデリング途中で設定したり変更しても構わないのであるが，これらを最初に設定

するように習慣づけておくことが好ましい。

　本章でも第１章と同様に，各力学モデルのワールド初期設定表にこれら初期設定の情報を記載す

る。本節でその主な項目を一括して解説することにより，各モデルの解説の紙数を節約し，記述の

簡素化を図ることにする。

　まず最初にしなければならないことは，1.2 節で触れた重力の設定である。Working Model 2D

を立ち上げた初期画面の重力に関するデフォルト値はVertical（鉛直方向）であるから，異なる重

力場を設定する場合は World>Gravity の内容を変更する必要がある。

　次に，そのシミュレーションをいつまで続けるかをあらかじめ設定しておくことが望ましい。つ

まりシミュレーションの一時停止・終了制御である。この設定はメニューバーの World>Pause

Control で行なうが，デフォルトではこの項目は何も設定されていない。そのまま力学モデルを作

　　　　　　　　　　　　表 7.2 　メニューWorldの主な設定項目

設定項目名 内容
Gravity 重力の設定

Air Resistance 空気抵抗の設定

Electrostatics 静電気の影響の設定

Force Field その他の力場の設定

Skip Frames 表示フレームのスキップ設定
Tracking 追跡表示設定
Auto Erase Track 追跡の自動消去
Erase Track 追跡の消去
Retain Meter Values 計測ウィンドウ値の保持

Erase Meter Values 計測ウィンドウ値の消去

Accuracy シミュレーション精度の設定

Pause Control 一時停止・終了制御
Preferences シミュレーション環境の設定

成し，実行を開始すると，ツールバーの Stop（終了）ボタンあるいは Reset（再設定）ボタンをク
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リックするまで，いつまでも実行状態が続く。しかし最近のコンピュータは実行速度が速く，予期

しない状態にまで計算が進んでしまう場合がある。従って本書では，モデリング開始前にシミュレ

ーション継続時間の限界を設定しておくことを推奨する。

　図 7.1 に，初期画面の World > Pause Control のウィンドウの様子を示す。正確に言うと，この

図は，このウィンドウが立ち上がってから New Condition（新条件）ボタンを一回だけクリックし

た直後の様子である。New Condition ボタンをクリックしなければ，一時停止・終了制御はなにも

行なわれない。

　図中の “ Pause when “，“ time > 1.0 “ とは，ワールド時間の time変数が 1.0 より大きくなった

ら実行を一時停止することを意味する。従って，このまま OK をクリックして次へ進み，最終的に

シミュレーションを実行すると，ワールド時間で 1 秒よりも多く時間が経てば（１秒を超えた時点

で），このシミュレーションは一時停止する。time 変数で表されるワールド時間は，実際に実行中

に経過する実時間とは異なる。力学モデルが複雑で計算処理に時間が掛かるときには，ワールド時

間は実時間に対してゆっくり進むかもしれないし，逆に単純な力学モデルを実行しているときには

あっという間にワールド時間が過ぎて行く。

　もしもワールド時間が 1 秒では短すぎるなどというときには，例えば 1.0 を 10.0 や 120 などに

適宜書き換えればよい。あるいはこの条件部分に，時間ではなく，Object（オブジェクト）の位置

や速度などの条件式を書くこともできる。さらに一時停止・終了制御はPause Control ウィンドウ

で New Condition ボタンを押すことにより，複数の条件を設定することができる。実行時に，各

一時停止ごとに Run（実行）ボタンを押すことにより，次の段階へ進む。一時停止ではなく，完全

に終了させるときには， “ Pause when “ の代わりに，その位置のコンボボックスから “ Stop when

“ を選べばよい。一度 Stop（停止）したモデルは，Reset ボタンで復帰する以外は元に戻らない。

　もし，ワールド時間の経過が早すぎて，シミュレーションの結果がわかりにくいときには，World

> Preferences の “ Prevent model from running faster than real-time “ のチェックボックスをチ

ェックしておけば，少なくともワールド時間が実時間より早く経過してしまうことは防げる。

　モデリングや実験には World（ワールド）の基本特性のみならず，見た目も重要である。これら

はメニューバーの Viewの中で設定する。本書では，View > Workspace > Navigation の XY Axes

（XY 座標軸）や Grid Lines（グリッド線）なども，ワールド初期設定の項目として挙げることに

する。

7.4　Body（物体）のみを用いた簡単な力学モデル

　　　図 7.1  Pause Control（一時停止制御）ウィンドウ
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　それではまず，簡単な力学モデル m7_4_1 の作成を始める。始めに表 7.3 に示したワールド初期

設定に従い，無重力を選択する。具体的には図 1.3 で示したように World > Gravity を表示し，None

（なし）のラジオボタンをオンとして OK を押す。さらに World>Pause　Control において，New

Condition ボタンを押し，一番上のコンボボックスとその右側のテキストボックスをアクティブに

する。次にそのコンボボックスから”Stop when”を選び，右側のテキストボックスの”time > 1.0”

を "time >= 10.0" に変更し，OK を押す。（ここで注意を要するのは，”>=”の前後には，スペース

が必要なことである。）これにより，ワールド時間 10 秒で力学モデルのシミュレーションがストッ

プする。

表 7.3　力学モデル m7_4_1 のワールド初期設定

力学モデル・ファイル名 m7_4_1.wm
目的・機能 Body（物体）の理解

Gravity（重力） None（なし）

Stop when（停止条件） time >= 10.0
XY Axes（XY 座標軸） On
Grid Lines（グリッド線）On

　次に，見易さのために xy 座標軸とグリッド線を設定する。具体的には初期画面から View >

Workspace ウィンドウを立ち上げ，Navigation の中で XY Axes さらに Grid Lines もチェックし，

そのウィンドウを閉じる。初期状態では，グリッド線の間隔は１[m]となっているはずである。第 1

章 1.3 節でも述べたが，xy 座標軸はWorld（ワールド）の絶対座標系（ワールド座標系）における

座標軸であるが，グリッド線は後述する Reference frame（基準フレーム）に伴って動く。しかし

初期状態では『基準フレーム』はワールド座標系に一致している。

　以下の解説では，紙数を節約するために，ここまでに述べた程度のワールド初期設定の方法は特

に記述しないので，各モデルのワールド初期設定表に従い読者自ら行なっていただきたい。

　これでモデリング前の準備が整ったので，いよいよBody（物体）を一つ造り出してみよう。まず

ツールバーにおいて，Body（物体）グループの Circle（円形）のアイコンをクリックし，World（ワ

ールド）の中の適当な位置でマウスを斜めにドラッグすると，円形の物体が作成される。この物体

の現在の状態を，7.2節の３つのウィンドウによって確認してみよう。まず，上記のCircle(円形)

が選択されている（四隅に小さい黒四角が現れている）ことを確認する。選択されていないときに

は，その Circle（円形）の上にカーソルを移動して1回だけ左クリックすればよい。次に，メニュ

ーバーの Window>Propertiesをクリックする（あるいは円形そのものをダブルクリックする）と，

Properties（属性）ウィンドウが現れる。このとき，画面は図7.2のようになっているはずである。

このウィンドウでは，最上部分のコンボボックスに，”*Body[1]-Circle”という名前が出ているが，

これは選択されているObject（オブジェクト）の名称である。World（ワールド）の中に複数の Body

（物体）がある場合，カギ括弧の中の数値が１，２，３と増える。

　その下の”x”，”y”あるいは”_”と名前が付いているテキストボックスの中の数値は，それぞれ，選

択されている Body（物体）の初期位置の（x,y）座標値と初期回転角度φ（力学モデルの中では”_”
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で表記されている）を表している。Properties（属性）ウィンドウではこれらのテキストボックス

に数値を書き込むことができる。ちなみに，ここで（x,y）＝（0,0 ）[m]，およびφ＝1 [rad]を代

入してみると，Circle（円形）の中心が（0,0）[m]に，また円形の方向を示す半径方向の直線が左

回りに1 [rad]動くことがわかる。Working Model 2D のデフォルトでは，SI単位系が採用されて

いて，長さは[m]，角度はラジアン[rad]が単位となっている。

　ここで，さらにその下の（Vx, Vy)および V_はそれぞれ Body（物体）のｘ,ｙ軸方向初期速度お

よび初期回転角速度である。ここでは，（Vx,Vy)=（1,0) [m/s]および V_= 0 [rad/s]を代入してみ

よう。もちろん，0の部分はデフォルト値が0.00であれば何もしなくてよい。（x,y）, φ,（Vx,Vy)

およびV_を設定することを，特に初期条件を設定すると言うことがある。

　またその下の material（材料）のコンボボックスにて，その Body（物体）の材料が Standard（標

準）となっていることが確認できる。

詳細　　　ここではその他の設定について解説する。まず，material（材料）のコンボボックスであるが，これは

その Body（物体）の材料を指定する。この材料を指定すると，その下のテキストボックスに現れる mass（質量），

static[friction]（静止摩擦係数），kinetic[friction]（動摩擦係数），elastic*（反発係数），charge（電荷），お

よび moment（慣性モーメント）がその物体の特性と大きさから決定される。

　その決定過程として，初めに，mass（質量）について説明する。material（材料）が決定されると（体積）密度

　　　　　図 7.2  Properties（属性）ウィンドウ
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が決定するが，mass（質量）はこの値に体積を掛けて計算される。ただしその体積は，World（ワールド）に表示さ

れている Body（物体）の平面積に１[mm]＝１×10-3[m]の厚さを掛けて計算される。従って，Body（物体）が一辺１

[m]の正方形だとすると，平面積は１[m2]であり，体積は１×10-3[m3]となる。この正方形の（体積）密度を水と同様

に１×103[kg/m3]とすると（material が standardのときはこの設定），結果的にこの正方形のmass（質量）は１[kg]

となる。

　ただし Properties（属性）ウィンドウにおいてcharge の下の density（密度）の値（この欄を変更することはで

きない）として自動的に表示される密度は，その単位を[kg/m2]としている。それはこのソフトウェアが２次元版で

あり，密度を体積密度とするのではなく，面積密度と考えているからである。この場合，実際の 3 次元物体と，力

学モデルの 2次元物体の関係は，上記のように厚さを１[mm]とすることで整合される。

　次に，static[friction]（静止摩擦係数）と kinetic[friction]（動摩擦係数）であるが，現実の世界ではこれら

の値は接触する相手が決まらないと決定しない。しかし，Working Model 2Dでは個々の Body（物体）がそれぞれ

固有の静止摩擦係数と動摩擦係数を持ち，接触する相手も別の静止摩擦係数と動摩擦係数を持つ。このような状況

で両者が接触したときには，静止摩擦係数も動摩擦係数も，それぞれ，２つの Body（物体）の間で小さい方が両者

の間の値として採用されるアルゴリズムとなっている。

　次に，elastic*（反発係数）であるが，一般的に日本語の反発係数の英語訳は restitution coefficient となるので，

本書では elastic に*を付けて注意を喚起している。いずれにしても，ここでは elastic*はその物体固有の反発係数

を意味する。しかし，これも現実の世界で衝突する相手が決まらないと決定しない。しかしWorking Model 2Dで

は，２つの Body（物体）が衝突した場合，両者の elastic*（反発係数）のうちの小さい方が両者の間の値として採

用されるアルゴリズムとなっている。

　次に，charge（電荷）は文字通り電荷[C]であるが，この項目は，静電界を考える（World>Electrostatics の中で

On がチェックされている）ときにのみ，有効な概念である。その場合この項目には，そのmaterial（材料）や mass

（質量）に応じ，その Body（物体）が動きうるに足りる電荷量があらかじめ負荷されることになる。従って数値的

に静電界の影響を考慮する場合，通常はこの部分を自分で正しい値に書き換えなければ意味がない。

　最後に，moment（慣性モーメント）であるが，これは Body（物体）の mass（質量）や２次元的な形状によって異

なってくる。Working Model 2Dでは，Properties（属性）ウィンドウの下から 2行目のコンボボックスで２次元

的な形状を選択できるようになっている。デフォルトでは Planer（平面盤）が選択されており，その下のmoment（慣

性モーメント）テキストボックスには，その条件における慣性モーメントが表示されている。コンボボックスでは

その他に Shell（殻体）や 3D/Sphere（球面体）が選べるが，それらの概念は慣性モーメントを計算するためだけに

意味があり，その World（ワールド）における Body（物体）の実質的な形状にまでさかのぼって影響することは無

い。

　なお，material（材料）のコンボボックスではデフォルトの Standard（標準）の他に，Steel（鋼），Ice（氷），

Wood（木材），Plastic（プラスチック），Clay（粘土），Rubber（ゴム），Rock（岩石）およびCustom（特別仕様）を

選択できる。いずれにしても，Properties（属性）ウィンドウの材料に関するテキストボックスの値を故意に変更

すると，material（材料）のコンボボックスは Custom（特別仕様）と表示される。

　次に，Properties（属性）ウィンドウを閉じて（実際は閉じなくてもよいが，画面が込み合って

くるのでとりあえず閉じる），Circle（円形）が選択されていることを確認した後，

Windows>Appearance を ク リ ッ ク す る と ， Appearance （ 外 見 ） ウィンドウが ， ま た

Windows>Geometryをクリックすると，Geometry（幾何寸法）ウィンドウが現れる。いずれのウイ

ンドウにも，最上部分のコンボボックスに，”*Body[1]-Circle”という名前が出ていることを確認

してほしい。

　この状態でAppearance（外見）ウィンドウのShowチェックボックスのチェックをはずすと，Circle

（円形）が見えなくなる（見えなくても，そこに Body（物体）は存在する）。このように，Appearance
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（外見）ウィンドウでは Object（オブジェクト）の外見を設定することができる。試しに，Fill

（内部）や Frame（枠）の Color（色）やPattern（パターン）を容易に変えてみることができる。

その程度の設定変更では，外見以外，力学モデルの力学的本質には何も影響を受けない。ここでは

外見は最終的に元の状態に戻しておこう。

　次に，Geometry（幾何寸法）ウィンドウでは，その Object（オブジェクト）の幾何学的寸法を設

定することができる。この例では，Radius（半径）テキストボックスに1.0と代入してみると，Circle

（円形）の半径が即座に1.0[m]に変化するのが分かる。この状態では図 7.3のようになっているは

ずである。

　また，その上のCOM（質量中心：Center Of Mass）の枠内では Auto（自動）ラジオボタンの直下

のラジオボタンをOnにすることにより，質量中心の位置を，故意に変化させることができる。しか

し通常は COM（質量中心）の枠内ではAuto（自動）としておく。

　さて，Radius（半径）テキストボックスに1.0を代入した時点で力学モデル m7_4_1 の動作部分

は完成したので試運転を行なってみる。ツールバーの Run ボタンを押すとシミュレーションが開

始する。これは単に，無重力空間の中で，半径１[m]の円盤がｘ軸に沿って１[m/s]の等速で直進す

る力学モデルである。このような実験はシンプルではあるが，地球上ではなかなか実現することが

できない。シミュレーションプログラムでは，このようにいとも簡単に実現してしまう。

　この仮想 World（ワールド）の中で，シミュレーションは 10 秒後に終了する。動作中はツールバ

ーの Stop ボタンが有効で，それを押すことにより，シミュレーションを一時停止することができ

 図 7.3  Appearance（外見）および Geometry（幾何寸法）ウィンドウ
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る。また Reset ボタンも有効で，これを押すことにより，シミュレーションを停止し，即座に初期

状態に戻すことができる。ただし，一度実行した力学モデルは，その設定を変えず，しかも

World>Start Here を押さない限り，計算結果は保存されていて，Run ボタンを押すことにより，

再び計算されることなく前と同じ動作過程を画面の上でなぞることになる（動作は素早い）。

　ここまでの力学モデルを，m7_4_1（具体的なファイル名は m7_4_1.wm）として保存しておこう。

力学モデルを名前を付けて保存するためには，メニューバーの File>Save As…により行う。あるい

は故意に保存動作を行なわなくても，力学モデルの作成を終了するときには，現在編集中の力学モ

デルに変更があった場合に限り，その変更を保存するかどうか聞いてくるので，その場合も m7_4_1

という名前で保存すればよい。

7.5　Meter（計測ウィンドウ）を用いた計測

　ここでは，前節で作成した力学モデル m7_4_1 を改造して実験を行う。このような場合，まず

Working Model 2D の画面に m7_4_1 がロードされている必要がある。まだロードされていない場

合はファイルからロードし直しておく（具体的にはメニューバーで File>Open…により力学モデル

を開く）。まず力学モデルがリセット状態であることを確認するが，もしも一時停止などの状態であ

れば，Reset ボタンによりリセットする。

　この状態から『改造して作成する新しい力学モデルの名前』を決め，現在の状態をあらかじめそ

の名前で保存しておくことが望ましい。このようにすれば，今までの力学モデル名の上に誤って新

しい力学モデルを上書きしてしまう危険性は無くなるし，その後いつ上書き保存しても，新しい力

学モデルとして保存される。

　具体的には，新しい力学モデル名を m7_5_1 とするので，メニューバーのFile>Save As…により，

m7_5_1 の名前（具体的なファイル名は m7_5_1.wm）でセーブする。この時点から，現在編集中

の力学モデルの名前も m7_5_1 に替わる。

　次に，この力学モデルの初期状態において，Circle（円形）の質量中心の位置をグラフに表示す

るための Meter（計測ウィンドウ）を追加しよう。以後，本書ではMeter は単に『計測ウィンドウ』

と訳すこととする。

　まず，画面上の Circle（円形）を左クリックし選択する。さらにメニューバーの

Measure>P_V_A>X をクリックすると，図 7.4 のような数値表示モードの計測ウィンドウが表示さ

れる。ここで，計測ウィンドウ P_V_A はそれぞれPosition（位置），Velocity（速度），Acceleration

（加速度）を全て（あるいはそのうちのいくつかを）表示するObject（オブジェクト）を意味すが，

さらにここではｘ軸方向の P_V_A を表示するメニューを選んでいる。

　この状態でツールバーの Run ボタンを押すとシミュレーションの実行が開始する。そのとき上

記の計測ウィンドウにはそれぞれ，Px（Position of x：x軸方向位置），Vx（Velocity of x：x軸

方向速度），およびAx（Acceleration of x：ｘ軸方向加速度）の数値が，それぞれ[m]，[m/s]，お

よび[m/s2]を単位として表示される。ワールド時間が 10 秒を超えるとこの力学モデルは停止するが，

その時点で，位置は 10.0[m]，速度は 1.0[m/s]，加速度は 0.0[m/s2]となっているはずである。なお，

この計測ウィンドウは，それを選択した状態でマウスでドラッグし，任意の位置へ移動させること
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ができる。以後特に断らない限り、視覚的に邪魔にならない場所へ移動するものとする。

　さらに一度 Reset ボタンを押して初期状態へ戻した後，図 7.4 左上の白い右向きの矢印を一度ク

リックすると，計測ウィンドウは図 7.5 のようにグラフ表示モードに変化するので，その四隅の黒

い点をドラッグし，適当な大きさにすることができる。またいずれの表示モードにおいても，計測

ウィンドウをダブルクリックすると，図 7.6 のようにこの計測ウィンドウの Properties（属性）ウ

ィンドウが表示され，グラフ表示のためのパラメータを表示・編集・設定することができる。この

ウィンドウの上側半分に表示されているのは，上から順に，x 軸のラベルとその式，第１ｙ軸（y1

軸）のラベルとその式，第２ｙ軸（y2 軸）のラベルとその式，第３ｙ軸（y3 軸）のラベルとその

式である。ここで式とは，その項目がどのような内容であるかを式で表したもので，この場合具体

的には，ｘ軸は time（ワールド時間），y1 軸，y2 軸および y3 軸はそれぞれ Body[1].p.x（物体１

のx 軸方向位置），Body[1].v.x（物体１のｘ軸方向速度）および Body[1].a.x（物体１のｘ軸方向

加速度）であることが示されている。Working Model 2D では，ワールド時間が time で表されるこ

とは前述したが，Body（物体）の位置，速度および加速度がこのような式で表されることも覚えて

おくと後で役に立つ。詳細は製品の User’s Manualに詳しい。

　次に図 7.6 の下側半分に表示されているのは，ｘに関しては，計測ウィンドウの左右端における

ワールドタイム timeの値，y1，y2，y3 に関しては，計測ウィンドウの下上端における各軸の値を

示す。初期状態では，これらはシステムによって自動的に設定され，Auto（自動）チェックボック

スもチェックされている。その場合，実行中に各値がその限界値を超えると計測ウィンドウの左右

あるいは下上端における各軸の値が自動的に変更される。図7.6に表示されている諸値（真中より

も下側の部分）を図 7.7 に示される値に編集し直し，（Properties（属性）ウィンドウを閉じてから）

力学モデルを Run すると，図 7.8 のような結果となる。

　図 1.5 には明示されていないが，計測ウィンドウもObject（オブジェクト）の一種である。した

がって，他に Appearance（外見）および Geometry（幾何寸法）ウィンドウも存在する。特に Appearance

（外見）ウィンドウを編集することにより，座標軸を表示することもできる。以降本章では可能な

限り計測ウィンドウにおいて座標軸を表示することとする。

　ここで，作成した力学モデルを，m7_5_1 として保存する必要があるが，この節の始めから継続

して作業している場合には，現在 m7_5_1.wmという力学モデルを編集中なので，それに上書き保

存すればよい。

　図 7.4  計測ウィンドウ

　　（数値表示モード）

　図 7.5   計測ウィンドウ

　　（グラフ表示モード）
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7.6　Constraints（拘束）グループ Actuator（アクチュエータ）を用いた力学モデル

　1.3節において，図1.5のツールバーにあるPoints（点要素），Joints（接続），および Constraints

（拘束）は，Body（物体）とBackground（バックグラウンド），あるいはBody（物体）1 とBody（物

体）2 の力学的関係を決める『規則』である，と述べた。これらのうち，まず簡単な Constraints

（拘束）グループから説明を始める。実は Working Model 2D では，Constraints は Body（物体）

図 7.7  Properties（属性）

ウィンドウの設定・編集

図 7.6 計測ウィンドウの

Properties（属性）ウィンドウ

　　　　　図 7.8  計測ウィンドウの表示結果

x

xv

xa
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に力やトルクなどを積極的に働き掛ける要素のことである。従ってそのグループの仲間として，バ

ネやダンパ，モータやアクチュエータ，および力そのものなどが挙げられる。その和訳として『拘

束』という用語は今一つなじまないが，ほかに良い訳が無いので，本書では Constraints（拘束）

とする。

　さてここでは，前節で作成した力学モデル m7_5_1 を，さらに改造して実験を行う。前節と同様

に，まず Working Model 2D の画面に m7_5_1 がロードされている必要がある。まだロードされて

いない場合はファイルからロードし直す。

　次に，力学モデルがリセット状態であることを確認するが，もしも一時停止などの状態であれば，

Reset ボタンによりリセットする。この状態から改造して作成する力学モデルの新しい名前を

m7_6_1 とするので，現状の力学モデルを m7_6_1 の名前（具体的なファイル名は m7_6_1.wm）

でセーブする。この時点から，編集中の力学モデルの名前は m7_6_1 となる。

　継続して新しい力学モデルの作成にかかる。まず，World（ワールド）中の Circle（円形）をダ

ブルクリックしてそのProperties（属性）ウィンドウを表示し，前に設定したｘ軸方向初期速度Vx

と初期角度_をそれぞれ 0.0 に戻しておく。次に，ツールバーのConstraints（拘束）グループから

Actuator（アクチュエータ）を選び（左クリックする），グリッド線を頼りに，ワールド座標（-2,0）

から Circle（円形）の中心まで右側にドラッグする。以後，ワールド座標を単に座標と呼ぶことに

する。上の結果，座標（-2, 0）からCircle（円形）の中心まで『2 段伸ばしの筒』の絵が描かれる

が，それが Actuator（アクチュエータ）である。このように，Constraints（拘束）グループの中

で，Force（力）以外の要素は，Background（バックグランド）とBody（物体），あるいはBody（物

体）1 と Body（物体）2 上の各点などと，生成時に２つの端点を要し，それらの点の間の力学的関

係を規定する。上の例では左の端点が Background（バックグランド）上にあり，右の端点が Body

（物体），具体的にはCircle（円形）の中心にある。ただし，Constraints（拘束）の２つの端点は

必ずしも座標上で離れているとは限らない。見掛け上 1 点でも，紙面の厚さ方向に２点ということ

もある（後述の Motor（モータ）など）。

　上の状態で Actuator（アクチュエータ）をダブルクリックすると，その Properties（属性）ウ

ィンドウが現れる。あるいは，目的のActuator（アクチュエータ）が選択されている状態で，メニ

ューバーの Window>Properties をクリックしても同じ結果が得られる。この状態を図 7.9 に示す。

　このように，マウスのドラッグによりObject（オブジェクト）を描くと，その幾つかのパラメー

タがドラッグした量により自動的に決定される。しかし適切な項目の選択や正確な数値入力が必要

な場合には，Properties（属性）ウィンドウから入力する。ここではTypeコンボボックスをVelocity

（速度）とし，Value（値）テキストボックスの値をそのまま 1.0 としておく。これはActuator（ア

クチュエータ）が毎秒 1 [m]の速さで伸びる設定であることを意味している。

　用意ができたら Run ボタンを押してみよう。結果は図 7.10 のようになる。描かれるグラフは，

最初の値を除いて m7_5_1（図 7.8）と同じになる。実験の内容はほぼ同じはずであるが，最初の値，

特に加速度の最初の値が異なるのは，m7_5_1 では初期速度が Vx=1.0 [m/s] であったのに比べ，

m7_6_1 では初期速度を Vx=0.0 [m/s] としてその直後に Vx=1.0 [m/s] に設定しており，理論的に

は瞬間的に加速度が無限大になるために，始めの値が不安定になることがあるからである。

　従って，今回の力学モデルのようにあらかじめ開始直後の速度が分かっているときは，厳密には，
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各初期速度を Properties（属性）ウィンドウで設定しておく方が望ましいが，ここではそのことが

結果に大きな影響を与えないし，以下の力学モデルへの変更過程を簡単にするためにも，あえて Vx

の初期値を 0.0[m/s]としたままとした。読者の力学モデルで開始直後に不安定な値が記録される場

合は，そのような事情があることを察していただき，必要に応じ初期値を設定し直してもらいたい。

　この力学モデルを Reset した状態で上書き保存し，m7_6_1 を確定する。

詳細　　　このように，力学モデルを実行した後に Reset し，ディスクに保存するとその実行過程の記録も保存さ

れる。これに対し，Reset した後に World>Start Here を左クリックしてから保存すると，記録データが保存され

ず，結果的にディスク容量を節約できる。また，力学モデルの実行途中で Stop し，この Start Here を左クリック

すると，その状態を力学モデルの新たな初期常態とする機能があり，複雑な力学モデルの作成時には非常に便利な

機能である。

　m7_6_1 を次の力学モデルに改造するために，m7_6_2 という名前で保存し，Actuator（アクチ

ュエータ）をダブルクリックしてその Properties（属性）ウィンドウを表示し，Value（値）テキ

ストボックスに式 “ 0.2*time “ を代入する。ここではさらに World（ワールド）中の Circle（円

形） を選択（クリック）しておき，メニューバーの Define>Vectors>Acceleration と

Define>Vectors>Total Force を左クリックする。これにより，選択されているObject（オブジェク

ト）すなわち Circle（円形）のCenter of Mass（COM：質量中心）の位置に Acceleration（加速度）

と Total Force（合力）が矢印で表示される。ただし，デフォルトのままでは矢印が短かすぎるの

で，Define>Vector Lengthsで Acceleration（加速度）とTotal Force（合力）のスライダーを最

大位置（値で１）に設定する。

　次に計測ウィンドウにおいて Appearance(外見)ウィンドウの Axes（座標軸）チェックボックス

　図 7.9 Actuator（アクチュエータ）の

Properties（属性）ウィンドウ初期画面

　　図 7.10  m7_6_1の実行結果（計測ウィンドウ部分）

x

xv

xa
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をチェックし，座標軸を表示する設定に変更する。このような準備のもとに Run ボタンを押すと，

図 7.11 のような結果が得られる。グラフからは，加速度は一定値  . a(t) 20=  [m/s2]，速度は直線

的に増加し t *. v(t) 20=  [m/s]，位置は放物線状に増加し 210 t *. p(t) =  [m]となることが分かる。

なお本書の式中ではワールド時間を表す time をｔと置いている。これらの式は第 1 章の(1.7)～

(1.10)式の関係を満たしていることが確認できる。

詳細　　　本力学モデルを作成するにあたり，Actuator（アクチュエータ）の Properties（属性）ウィンドウで Type

コンボボックスを Acceleration（加速度）とし，その Value（値）テキストボックスの値を 0.2 としても同じ結果

が得られる。

　同様に，Type コンボボックスを Length（長さ）とし，そのValue（値）テキストボックスの値を “ 2.0+0.1*time^2

“（式で表現すると 2.0+0.1t2）としても同じ結果が得られるはずである。しかし実際にそれを試してみると，加速

度の数値が少し異なってくる。その理由として，このようなシミュレーションプログラムでは，微分演算に誤差が

多く含まれることが挙げられる。この例では長さの値が決定しており，そこから加速度が求まるまでに 2 度微分が

行なわれるので，誤差が累積するものと考えられる。

　従って，このように長さが決まっていて加速度を求めるような力学モデルを実行する場合には，メニューバーの

World>Accuracy>Integrator Error において，積分誤差を例えば 10-５程度に指定（実際には " 1e-5 "と入力）す

る必要がある。

7.7 Constraints（拘束）グループの Force（力）を用いた力学モデル

　前節と同様の実験は，m7_5_1 から改造を始め，Actuator（アクチュエータ）ではなく同じ

　　図 7.11　m7_6_2の実行結果（計測ウィンドウ部分）

演習　　　m7_6_2 において，Actuator（アクチュエータ）をダブルクリックしてその

Properties（属性）ウィンドウを表示し，Value（値）テキストボックスに式 “ 0.1*time^2 “ を

代入してその挙動を調べよ。

Px

Vx

Ax
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Constraints（拘束）グループの Force（力）を用いることによっても実現できる。その場合は，ま

ず Circle（円形）の初期速度と初期角度をいずれも 0.0 とした後，ツールバーから Force（力）を

選択し，Circle（円形）の中心にカーソルを置いて x 軸上を左へドラッグする（図 7.12）。現れた

Force（力）の矢印をダブルクリックして，（Fx，Fy）の値を（0.628，0.0）とすればよい。この力

学モデルを m7_7_1 として保存しておこう。

　この例では Circle（円形）の質量が 3.142m =  [kg]，さらに作用する力が fx =0.628[N]で固定さ

れているため，ニュートンの第二法則により，加速度が 0.2 /mf a x == x  [m/s2]となる。

注意　　　第 1 章でも付記したが，Working Model 2Dのようなシミュレーションプログラムは，その動作原理の

中で既にニュートンの運動法則を自明の理論として用いているので，このようなソフトウェアを用いた実験結果か

らそのような法則が正しいという結論を導くことはできない。あくまでもヴィジュアルな確認実験と考えていただ

きたい。なお，Working Model 2Dにおける変数の表記は大文字が多いが，本書の式では極力小文字で表記する。

　ここで重要なのは，Constraints（拘束）グループの Force（力）の用い方である。他のConstraints

（拘束）が，2 つの端点を要するのに対し，Force（力）は Body（物体）上の一点を矢頭とする矢

印で指定し，矢頭から矢尻までの長さによりその大きさを指定する。力の大きさや方向は

Properties（属性）ウィンドウでも指定できる。

　　　　　　　　　　　　　　　図 7.12 　Force（力）の創造

7.8　Joints（接続）を用いて Body（物体）を組み合わせる

　Body（物体）と Background（バックグラウンド），あるいは Body（物体）1と Body（物体）2 を，

何らかの規則のもとに結びつけるときにはJoints（接続）を用いる。このように書くと，Constraints

（拘束）と似ていると思われるかもしれない。事実，Constraints（拘束）と Joints（接続）の成

り立ちは，ほぼ同じであると言える。

　両者の相違は，Actuator（アクチュエータ）やMotor（モータ），あるいはSpring（バネ）や Damper

（ダンパー）などの Constraints（拘束）は，Body（物体）上の一点を最低１つ含む２点間に力や

モーメントを働きかけることを目的とする。これに対し，Joints（接続）は，第一に，２点間の位
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置を制限することを目的とし，それに付随して力やトルクが発生する。具体的には Pin joint（回

転ジョイント）や Rigid joint（固定ジョイント）などは，『２点間の位置を同一と規定する』位置

の制限であり，Slot joint（溝型摺動ジョイント）類は，『動きを１次元的な動作範囲に規定する』

位置の制限である。

　ここではまず，簡単な力学モデル m7_8_1 の作成を通じ，Pin joint（回転ジョイント）とRigid

joint（固定ジョイント）の相違について説明する。始めに初期状態で新しい力学モデルを立ち上

げ，表 7.4 に示したワールド初期設定を行なう。本書では，Gravity（重力），Pause・Stop when（一

時停止・終了条件）以外，ワールド初期設定表で特に触れていない項目は，デフォルトの状態を想

定するものとする。

表 7.4　力学モデル m7_8_1 のワールド初期設定

力学モデル・ファイル名 m7_8_1.wm
目的・機能 Body（物体）の接続

Gravity（重力） Vertical（鉛直方向）

Stop when（停止条件） time >= 10.0
XY Axes（XY 座標軸） On

　ワールド初期設定がなされた後，

１）適当な位置に適当な大きさの，Rectangle（矩形）を作る。

２）上記 Rectangle（矩形）を，Pin joint（回転ジョイント）で Background（バックグランド）

に固定する。

　具体的には，ツールバーの Joints（接続）グループから Pin joint（回転ジョイント）を選び，

上記の Rectangle（矩形）の内部の，しかもその上下に引かれる中心線上にない適当な位置にカー

ソルを置いてから左クリックする。これにより，小さな○印が Rectangle（矩形）の内部に一つ置

かれる。

　この状態で Run ボタンを押すと，Rectangle（矩形）は重力によりその Pin joint（回転ジョイ

ント）を中心に振り子のように往復回転運動を始める。文字通り，回転ジョイントである。この場

図7.13  Pin joint（回転ジョイント）とRigid joint（固定ジョイント）
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合，Pin joint（回転ジョイント）は，それぞれBackground（バックグラウンド）と Rectangle（矩

形）上の各一点に point（ポイント）を設定し，『 Rectangle（矩形）は Background（バックグラ

ウンド）に対して回転はできるが各 point（ポイント）は（位置的に）分離できない』という制限

を加えたのである。

　次にこれを Reset して，m7_8_1.wmというファイル名で保存しよう。さらに，

３）始めの Rectangle（矩形）に重ならないように，少し離れたところに別の Rectangle（矩形）

を作成する。

４）その Rectangle（矩形）を，Rigid joint（固定ジョイント）で Background（バックグランド）

に固定する。

　この状態で Run ボタンを押しても，新しいRectangle（矩形）は固定されたように動かない。こ

れを再び Reset し，さらにモデリングを続ける。

５）始めの Rectangle（矩形）の，『動作時に下へ動き始める辺』に重なるように Circle（円形）

を作成する。

６）その Circle（円形）が選択されている状態で，メニューバーの Object>Send To Back をクリ

ックする。

　このコマンドにより，選択されているBody（物体）が，今まで下にあって見えなかったBody（物

体）と入れ替わって表示される。これにより見えるようになった，『始めの Rectangle（矩形）』と

『今作成した Circle（円形）』の重なっている部分に，Rigid joint（固定ジョイント）を置く。こ

の状態を，図 7.13 に示す。

　この力学モデルを Run すると，新たに Rigid joint（固定ジョイント）によってCircle（円形）

を付加された Rectangle（矩形）は，相変わらず動くことが確認できる。すなわち，新たに加えら

れた Rigid joint（固定ジョイント）は，Body（物体）をBackground（バックグラウンド）に固定

していない。このように，一般に Joints（接続）グループの Object（オブジェクト）は，Body（物

体）が一つしかない場合は，その Body（物体）をBackground（バックグラウンド）と接続するが，

重なっている２つのBody（物体）の場合は，それら 2 つのBody（物体）のみを接続する。

　このような性質を用い，Joints（接続）を用い，Body（物体）の要素を組み合わせ，複雑な構造

を組み立てることができる。

　なおこれとは別に，ツールバーのBody（物体）グループに，Anchor（アンカー）という固定具が

ある。これは Body（物体）をBackground（バックグラウンド）と固定する。上の力学モデルで，『Body

（物体）の構造物』のどの位置に Anchor（アンカー）を置いても，力学モデルの実行中，その構造

物は動かない。ただし，複数の Body（物体）を Anchor（アンカー）のみによって互いに固定する

ことはできない。シミュレーションを実行させたとたんに，重なったBody（物体）は衝突状態に陥

りエラーとなるからである。Working Model 2D では，通常，Joints（接続）で接続されない限り，

２つ以上の Body（物体）が重なることは許されない。複数の Body（物体）でも，上の例のように

Joints（接続）で接続されたものは，結果的に一つの Body（物体）のようにみなされ，その上に

Anchor（アンカー）を置いて固定することができる。Anchor（アンカー）は垂直重力場における『足

場』を固定するときなどに用いられる。
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7.9 Motor（モータ）を用いて Body（物体）を回転させる

　ここでは Constraints（拘束）グループの Motor（モータ）を利用した簡単な力学モデルを作成

してみよう。まず力学モデル m7_9_1 を，表 7.5 のワールド初期設定に沿って作成開始する。

　なお，m7_9_1 を改造した m7_10_1 は Exp1_3 と全く同じなので，図や実験の経過などは，第 1

章の 1.6 節を参考にされたい。

表 7.5　力学モデル m7_9_1 のワールド初期設定

力学モデル・ファイル名 m7_9_1.wm
目的・機能 Body（物体）の回転

Gravity（重力） None（なし）

Stop when（停止条件） time >= 10.0
XY Axes（XY 座標軸） On
Grid Lines（グリッド線）On

　表 7.5 の設定は，実は m7_4_1 の表 7.3 と全く同じである。このように，よく用いるワールド初

期設定は，例えば m7_0.wmなどとして保存しておき，必要なときにロードしすぐに新しい名前を

付けてセーブすることにより，簡単に新しい力学モデルの作成を開始することができる。

　以下，次の手順に従い，２つの Body（物体）による構造を作成する。

１）ツールバーのCircle（円形）を選択し，World（ワールド）上で（2, 1）から（4, -1）までマウ

スをドラッグすることにより，（3, 0）に半径１[m]のCircle（円形）を置く。

２）ツールバーのRectangle（矩形）を選択し，World（ワールド）上で（0, 1）から（3, -1）まで

マウスをドラッグすることにより，（1.5, 0）[m]の位置に，Height（高さ）2 [m]，Width（横幅）3

[m]の Rectangle（矩形）を置く。

　Body（物体）の位置と寸法は，その Properties（属性）ウィンドウ，および Geometry（幾何寸

法）ウィンドウによって容易に設定・変更できる。

３）上記 Rectangle（矩形）が選択されている状態でGeometry（幾何寸法）ウィンドウを開き，そ

の Height（高さ）を 0.4[m]に変更する。

４）上記の Circle（円形）の中心にRectangle（矩形）の端があることを確認した上で，ツールバ

ーの Rigid joint（固定ジョイント）を選択し，World（ワールド）上の Circle（円形）の中心を

左クリックし，両者を接続する。

５）ツールバーConstraints（拘束）グループの Motor（モータ）を選択した状態で，World（ワー

ルド）上の（0, 0）[m]を左クリックし，Motor（モータ）をRectangle（矩形）に吸着させる。

　これにより，Motor（モータ）が Background（バックグラウンド）をベースとして Rectangle（矩

形）を回転させることができるようになる。

　このように，Constraints（拘束）グループの Object（オブジェクト）を用いて Body（物体）に

力やトルクを加えようとするとき，始めに対象とするBody（物体）が存在している必要があり，『目

的とする Constraints（拘束）を選択した状態で，Body（物体）上の作用点を左クリックする』の
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が常套手段である。Actuator（アクチュエータ）のように作用点が 2 つある場合，そのConstraints

（拘束）は 2 つの Body（物体）の間に相対的な作用を及ぼすが，片側が Background（バックグラ

ウンド）となることもある。Motor（モータ）のように作用点を一つ指定する Constraints（拘束）

の場合，その点に 2 つの Body（物体）が重なっているときはその 2 つの Body（物体）間に相対的

な作用をおよぼすが，その点に 1 つの Body（物体）しか存在していないときには，他の１点として

その背後の Background（バックグラウンド）がターゲットとなる。

　さて，Motor（モータ）の特性も種々のものを選ぶことができる。具体的には，そのモータが制

御する要素として，Torque（トルク），Rotation（回転[角]），Velocity（[角]速度），Acceleration

（[角]加速度）を選択することができる。Motor（モータ）をダブルクリックするとその Properties

（属性）ウィンドウが現れるが，そのType コンボボックスで上記の要素を指定することができる。

６）Motor（モータ）のProperties（属性）ウィンドウにおいて，Type コンボボックスに Velocity

（[角]速度）が，また Value テキストボックスに 1.0 [rad/s]が表示されていることを確認すること。

さらに力学モデルの動作を Run により確認した後 Reset し，ここまでの作業を上書きセーブする。

　次に，この力学モデルの Rectangle（矩形）の回転角，角速度，角加速度の関係を調べてみよう。

７）World（ワールド）上で Rectangle（矩形）を選択し，Measure>P-V-A>Rotation を左クリッ

クして計測ウィンドウを表示し，さらに左上の矢印を左クリックしてグラフ表示モードとする。

８）計測ウィンドウを４隅のドラッグにより適当な大きさとしてからダブルクリックし，その

Properties（属性）ウィンドウの（Min, Max）の設定において，それぞれ x：（-1, 11），y1：（-10,20），

y2：（-1,2），y3：（-1,2）とする。Auto チェックボックスのチェックは全てはずしておく。ついでに

Appearance(外見)ウィンドウにより座標軸を表示するようにしておく。

　次に，Circle（円形）の質量中心の位置を計測してみよう。まず，

９）World（ワールド）上で Circle（円形）を選択してから Measure>Position>All をクリックし

て計測ウィンドウを表示し，さらに左上の矢印を左クリックしてグラフ表示モードとする。

10）計測ウィンドウを４隅のドラッグにより適当な大きさとしてからダブルクリックし，その

Properties（属性）ウィンドウの（Min, Max）の設定において，それぞれ x：（-1, 11），y1：（-5, 5），

y2：（-5, 5），y3：（-20, 20）とする。Auto チェックボックスのチェックは全てはずしておく。これ

についても Appearance(外見)ウィンドウにより座標軸を表示するようにしておく。

　さらに，Circle（円形）の質量中心の速度を求めてみよう。

11）World（ワールド）上で Circle（円形）を選択してから Measure>Velocity>All を左クリック

して計測ウィンドウを表示し，さらに左上の矢印を左クリックしてグラフ表示モードとする。

12）計測ウィンドウを４隅のドラッグにより適当な大きさとしてからダブルクリックし，その

Properties（属性）ウィンドウの（Min, Max）の設定において，それぞれ x：（-1, 11），y1：（-5, 5），

y2：（-5, 5），y3：（-5, 5），y4：（-5, 5）とする。Auto チェックボックスのチェックは全てはずして

おく。また Appearance(外見)ウィンドウにより座標軸を表示するようにしておく。

　最後に，Circle（円形）の質量中心の加速度を求めてみよう。

13）World（ワールド）上で Circle（円形）を選択してから Measure>Acceleration>All を左クリ

ックして計測ウィンドウを表示し，さらに左上の矢印を左クリックしてグラフ表示モードとする。

14）計測ウィンドウを４隅のドラッグにより適当な大きさとしてからダブルクリックし，その
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Properties（属性）ウィンドウの（Min, Max）の設定において，それぞれ x：（-1, 11），y1：（-5, 5），

y2：（-5, 5），y3：（-5, 5），y4：（-5, 5）とする。Auto チェックボックスのチェックは全てはずして

おく。上記と同じようにAppearance(外見)ウィンドウにより座標軸を表示するようにしておく。

　この時点で m7_9_1 は完成とするので，m7_9_1.wmの名前でセーブする。

　ここからの運用は 1.6 節を参照のこと。

7.10　Vector（ベクトル）を表示する

　ここでは，Body（物体）の質量中心の Velocity（速度）と Acceleration（加速度）をベクトル

表示してみる。いま，新たにm7_9_1 が立ち上がっているものとして，さっそくそれを m7_10_1.wm

の名前でセーブし，ここから作成する力学モデルの名称を m7_10_1 とする。次に，

１）World（ワールド）上で Circle（円形）と Rectangle（矩形）を同時に選択し（キーボードの

Shift を押しながら 2 つの Body（物体）を順次左クリックする），Window>Appearance を左クリ

ックして Appearance（外見）ウィンドウを表示する。

２）同ウインドウの中で，Fill（フィル）のPattern（パターン）コンボボックスの項目からno を

選ぶ。もしも no が表示されていないときには，そのコンボボックス中の選択項目の一番上にある

ので，どれか一つのパターンの上にカーソルを置いて，上のほうにドラッグし，no が出てきたらそ

こで左ボタンを離せばよい。これにより，2 つの Body（物体）の内部が透明になり，ベクトルが見

やすくなる。

３）World（ワールド）上でCircle（円形）のみを選択しなおし，Define>Vectors>Velocity を左ク

リックする。

４）同様に Circle（円形）のみを選択した状態で，Define>Vectors>Acceleration を左クリックす

る。これにより，Circle（円形）の質量中心の速度と加速度のベクトルが，図中に表示される。力

学モデルの動作を Run により確認した後 Reset し，ここまでの作業を上書きセーブする。

7.11 Reference frame（基準フレーム）を変える

　前節で，Circle（円形）の質量中心の速度と加速度をベクトル表示したが，読者は表示されたベ

クトルを見にくいと感じたであろう。このように回転したり移動している物体に張り付いたベクト

ルは，その変化の様子を注視するのは容易でない。そこで，シミュレーションの過程を見易くする

ための Reference frame（基準フレーム）（表示の基準となる座標系）を，移動する物体の質量中心

の位置に変更してみよう。前節の m7_10_1.wmを m7_11_1.wmに名前を変えてセーブし，次のよ

うな改造を加える。

１）World（ワールド）上でCircle（円形）を選択し，View>New Reference Frame において Name

が Circle になっていることを確認し，OK を押す。

　これにより，Circle（円形）の質量中心に目の形が出て（出さないようにすることもできるが）
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Reference frame（基準フレーム）がそこに移動したことが分かる。これを Run すると，今度は Circle

（円形）が動かず，ｘｙ軸のみが動く（回転する）。グリッド線も動かないが，これは Reference frame

（基準フレーム）に付随しているからである。Reference frame（基準フレーム）を World（ワー

ルド）に戻すためには，メニューバーの Viewの最後の項目に”Circle”が追加されていることを確認

した上で，その一つ前の”Home”を左クリックするだけでよい。

　なお，図に表れるグラフの位置，速度，加速度のｘｙ座標値は，すべて World（ワールド）座標

系における値であり，これは Reference frame（基準フレーム）を変えても変わらない。したがっ

て，その数値を新たな座標系の値に変換して表示するためには，各グラフの中の式に手を入れる必

要がある（次節）。

　この例は，ある物体の１点が等速円運動をする力学モデルであるが，その場合，その点の速度は

軌跡円の半径方向に垂直，すなわち軌跡円の接線（円周）方向で一定，加速度は軌跡円の中心方向

を向き，一定であることが分かる。さらにこれを改造して，不等速円運動の一例についても調べて

みよう。２）Motor（モータ）の Properties（属性）ウィンドウにおいて，Type コンボボックスが

Velocity（[角]速度）になっていることを確認し，Value テキストボックスを 0.12*time に変更す

る。その結果，回転の角速度が時間の関数，

　　　　　　　　　　                  0.12t  =ω  [ r a d / s ]                        （1.14）

となり，時間に比例して増加する。また，角加速度は 0.12 [rad/s2]で一定となる。

　作成された力学モデルを，m7_11_1.wmに上書きする。

7.12　計測ウィンドウの編集

　前節の m7_11_1 の中の計測ウィンドウにおいて，World（ワールド）座標系におけるｘ軸および

ｙ軸方向の速度および加速度の値を，Circle（円形）質量中心の円運動の接線方向（τr）成分と法

線方向（n
r
）成分の値に計算しなおして再びグラフに表示してみよう。新しい力学モデルは m7_11_1

から改造し，その名前を m7_12_1 とする。この問題の原理は，図 7.14 および式（7.1）,（7.2）に

示す座標系回転の式による。

　　　　　　　　　　　　

　　　　　　　　　　　　　図 7.14　座標の回転（回転角θ）
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　　　　　　　　　　           θθ sincos yxX += 　　                        （7.1）

　　　　　　　　　　           θθ cossin yxY +−= 　　                       （7.2）

　ここで y) (x, はある位置ベクトルの World（ワールド）座標系における yx 座標成分， Y) (X, は

World（ワールド）座標系に対しθだけ傾いた座標系に対する同位置ベクトルの XY 座標成分である。

これは，World（ワールド）座標系に対する速度や加速度（の位置ベクトル）を，別の座標系の成

分で表現しようとするものである。不等速円運動をシミュレートする力学モデル m7_12_1 は，第

１章 1.7 節の m1_7_1 と全く同じである。図や実験の経過などは，1.7 節に準ずるので，適宜参考

にされたい。

　このうち，θは ”Body[2].p.r+3.141592/2” であるが，x および y　に対応する式は，Circle（円

形） 質量中心の速度の場合は　 “Body[1].v.x” お よ び  “Body[1].v.y“，加速度の場合は 　

“Body[1].a.x” および “Body[1].a.y” である。これらの式は，m7_11_1 における計測ウィンドウを

ダブルクリックし，各項目の Equation（式）を見れば分かる。m7_11_1 において，Body[1] は Circle

（円形）を，Body[2] は Rectangle（矩形）に対応し，その次の.p は位置，.v は速度，.a は加速度

を示す。さらに最後の.r は角度，.x はx座標値，.y は y 座標値であることを意味する。なお，Object

（オブジェクト）の番号（Body[1]や Body[2]の１や２など。これらの番号はモデルを作成する順番

によって変わってくる。）は，Properties（属性）ウィンドウのトップのコンボボックスで確認す

ることができる。

　以上の知識の基に，m7_12_1 の Velocity of Circle 1（円形１質量中心の速度）の xv および

yv はそれぞれ，

　　　　　　“-Body[1].v.x*sin(Body[2].p.r)+Body[1].v.y*cos(Body[2].p.r)”

　　　　　　“-Body[1].v.x*cos(Body[2].p.r)-Body[1].v.y*sin(Body[2].p.r)”

さらに，Acceleration of Circle 1（円形１質量中心の加速度）の xa および ya はそれぞれ，

　　　　　　“-Body[1].a.x*sin(Body[2].p.r)+Body[1].a.y*cos(Body[2].p.r)”

　　　　　　“-Body[1].a.x*cos(Body[2].p.r)-Body[1].a.y*sin(Body[2].p.r)”

となる。m7_12_1 の実行結果を図 7.15 に示す。Velocity of Circle 1（円形１の速度）では xv と

｜v |が完全に重なっており，Acceleration of Circle 1（円形１質量中心の加速度）では ya と|a |

が後半でほぼ重なっている。また yv が 0 であり， xa が一定値であることも重要である。

　　　　　　　　　　　　図 7.15  m7_12_1 の実行結果

VφVx

|V|

Vy Aφ

Ax|A|

Ay
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　Working Model 2D では，このような手順により，計測ウィンドウを編集することができる。場

合によってはもっと複雑な座標変換を行なった後の位置，速度，加速度などを，自分で編集して出

力する必要が生ずるかもしれない。このような式の編集などは，Working Model 2D の User's

Manualに詳しい。

7.13　計測データの保存・Export（出力）

　図 7.15 のように，Working Model 2D だけでもある程度の計測データの編集・表示が可能である

が，得られたデータをさらに詳しく調べたり，次の加工を施す必要が出てこよう。そのような場合

は，力学モデルの実行によって計算されたデータを，File>Export により Export（出力）すること

ができる。ここでは m7_12_1 の第 4 番目の計測ウィンドウ(Acceleration of Circle 1)のデータを出

力することを考える。

１）まず，力学モデル上で第 4 番目の計測ウィンドウ Acceleration of Circle 1 を選択する。

２）File>Export において，図 7.16 のように Export to:の出力パスを適切に設定し，Export type:

が Meter Data であることを確認した上で，File Name:テキストボックスに適当な出力ファイル名

を入れる。

３）Options ボタンを押し，図 7.17 のように selected meters only ラジオボタンをチェックし，

OK を押す。

４）図 7.16 のような状況において Export を押す。

　この操作により，力学モデルが再び実行され，指定したファイル名でデータが出力される。出力

されるファイルは，『Tab 区切りテキスト形式』で，デフォルトでは.dat というエクステンション

名を持つが，これはこのままの形で Excel など外部プログラムに入力することができ，さらに外部

プログラムでグラフ化するなど，データを容易に編集・処理することができる（図 7.18）。

　　図 7.16　Export（出力）ウィンドウ 図 7.17　Export（出力）ウィンドウオプション
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7.14 Slot Joint（溝型摺動ジョイント），そして Tracking（追跡）を用いる

　Slot Joint（溝型摺動ジョイント）は２点間の位置を制限するJoints（接続）の一種で，動きを

直線的な動作範囲に制限する。対象とする 2 つの作用点は，Body（物体）１と Body（物体）２でも

よいし，１点が Background（バックグランド）でもよい。ツールバーの Joints（接続）グループ

には複数の Slot Joint（溝型摺動ジョイント）類があるが，ここでは縦型で回転を許すSlot Joint

（溝型摺動ジョイント）と，横型で回転を許さない Keyed Slot Joint（回転不能溝型摺動ジョイン

ト）を用いた力学モデル，m7_14_1 を作成する。表 7.6 にワールド初期設定を示す。この設定は，

m7_0 において Stop when（停止条件）を変化させたものである。

表 7.6　力学モデル m7_14_1 のワールド初期設定

力学モデル・ファイル名 m7_14_1.wm
目的・機能 Slot Jointを用いて，小球にリサ

ージュ図形を描かせる

Gravity（重力） None（なし）

Stop when（停止条件） time >=100.0
XY Axes（XY 座標軸） On
Grid Lines（グリッド線）On

　　　　　　　　　　図 7.18　Excel による Export（出力）データの編集
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　次に，

１）ツールバーのRectangle（矩形）を選択し，World（ワールド）上で（-1, 3）から（1, -3）まで

マウスをドラッグすることにより，（0,0）の位置に（Height, Width）が（6,2）[m]のRectangle（矩

形）を置く。

２）ツールバーのCircle（円形）を選択し，World（ワールド）上で（-1, 1）から（1, -1）までマ

ウスをドラッグすることにより，（0,0）の位置にRadius（半径）が 1 [m]の小球 Circle（円形）を

置く。さらにそのGeometry（幾何寸法）ウィンドウにより，半径を 0.1 [m]に変更する。

３）ツールバーにて縦型 Slot Joint（溝型摺動ジョイント）を選択し，World（ワールド）上の

Rectangle（矩形）質量中心（現在，Circle（円形）質量中心と重なっている）の（0,  0）[m]を左

クリックする。

　これにより，Rectangle（矩形）の上下方向に縦型 Slot Joint（溝型摺動ジョイント）が置かれ，

２つの Body（物体）が接続される。

４）ツールバーにてActuator（アクチュエータ）を選択し，World（ワールド）上で（0, -3）から

（0, 0）までマウスをドラッグする。

　ここで Run を押してみると，その挙動から，Slot Joint（溝型摺動ジョイント）が Rectangle

　　　　　図 7.19　m7_14_1 における Object（オブジェクト）の配置
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（矩形）と Circle（円形）を接続しているが，これらは Background（バックグランド）には固定

されていないことが分かる。動作確認の後は Reset すること。

５）ツールバーにて横型 Keyed Slot Joint（回転不能溝型摺動ジョイント）を選択し，World（ワ

ールド）上（0.5, 2）の付近で Rectangle（矩形）の上を左クリックする。

　これにより，横型 Keyed Slot Joint（回転不能溝型摺動ジョイント）が Background（バックグ

ラウンド）の水平方向にRectangle（矩形）と接続し，Rectangle（矩形）は回転しないように水平

にのみ動きうる構造となる。

６）ツールバーにてActuator（アクチュエータ）を選択し，World（ワールド）上で（-3, 0）から

（-1, 0）までマウスをドラッグする。

　この時点で Run を押し，Circle（円形）が結果的に斜め上方へ移動することを確認する。次に，

７）横の Actuator（アクチュエータ）のProperties（属性）ウィンドウの Type コンボボックスに

おいて，Length（長さ）を選び，Value テキストボックスに，

　　　　　　　　　　　　　　　“3.000+sin(3.14159*time)”

を代入する。

８）縦の Actuator（アクチュエータ）のProperties（属性）ウィンドウの Type コンボボックスに

おいて，Length（長さ）を選び，Value テキストボックスに，

　　　　　　　　“3.000+sin(3.14159*time+3.14159/2)-sin(3.14159/2)”

を代入する。この段階で，図 7.19 のようになる。

９）Edit>Select All に引き続き，Window>Appearance により Appearance（外見）ウィンドウを

表示し，Show のチェックをはずす。

　これにより，全てのObject（オブジェクト）は不可視となる。これに引き続き，

10）Appearance（外見）ウィンドウトップのコンボボックスから Circle[2]を選択し，Show チェッ

クボックス，およびTrack center of mass（質量中心の追跡）チェックボックスをチェックし，Track

outline（外形の追跡）チェックボックスのチェックをはずす。

11）World>Tracking が off になっているのを確認した後，Every frame をチェックする。

図 7.20　m7_14_1 の実行結果

Track center of mass（質量中

心の追跡）と Tracking>Every

frame

図 7.21　m7_14_1Tの実行結果

Track outline（外形の追跡）

と Tracking>Every 4 frames
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　この状態で Run を押すと，図 7.20 のように円の軌跡が描ける。これを上書きでm7_14_1.wmと

してセーブする。実際はこの小球にリサージュ図形を描かせるような式の設定を行ないたいのであ

るが，パラメータが６つ存在するので，次節のような方法で行なう。

12）現在のモデルを m7_14_1T.wmの名前で再びセーブし，Tracking（追跡）の練習をして見よう。

上の 10）で Appearance(外見)ウィンドウには Track center of mass（質量中心の追跡）以外に，

Track connect（線による追跡）と Track outline（外形の追跡）があり，いずれも独立に作用する。

従って，Track center of mass（質量中心の追跡）のチェックをはずし，Track outline（外形の

追跡）のチェックボックスをチェックする。

13）軌跡が密になりすぎるので，メニューの World>Tracking>Every 4 frames を選択する。

m7_14_1T.wmの実行結果を図 7.21 に示す。

7.15　Slider（スライダー）によりパラメータを変化させる

　前節で Actuator（アクチュエータ）の長さの式の設定にかかわる７）と８）において，

横（ｘ軸）方向：　3.0+sin(3.14159*time)

縦（ｙ軸）方向：　3.0+sin(3.14159*time+3.14159/2)-sin(3.14159/2)

と，少し持って回った書き方になったが，これは今後それぞれのパラメータを積極的に制御しよう

としたためである。ここではm7_14_1.wm（m7_14_1T.wmではない）を m7_15_1.wmという名前でコピ

ーして，新しい力学モデル m7_15_1を作成した上で，後にActuator（アクチュエータ）の長さの式

を下のように書きかえる。

横（ｘ軸）方向：　3.000+a*(sin(b*3.14159*time+c*3.14159)-sin(c*3.14159))  　       (7 .3 )

縦（ｙ軸）方向：　3.000+d*(sin(e*3.14159*time+f*3.14159)-sin(f*3.14159))            ( 7 . 4 )

　ただし， edcba ,,,, および f は実際には以下で述べる文字を書き込むので，この時点では実際に

書き込まない。

　これらの式は，横も縦も同じ形式で，それぞれ基本的な１次元の正弦波振動を表す式である。例

えば横（ｘ軸）方向でいえば，始めの 3.0 は，Actuator（アクチュエータ）の長さを負としないた

めに必要なオフセットである。次のa は振幅である。ここでは 11 ≤≤− a の範囲の値を取るものと

する。次にb は角速度ω[rad/s]に対し πω /=b の意味を持つ数値で， 10 ≤< b の範囲の値を取るも

のとする。最後にcは，位相φ[rad]に対し πφ /=c の意味を持つ数値で， 11 ≤≤− c の範囲の数値

を取る。なお，式の最後の-sin(c*3.14159)は，時間 time=0 のときに，振動がいつも原点から始ま

るようにするために付加してある。

　同様に，縦（ｙ軸）方向のパラメータ fed ,, は，それぞれ横（ｘ軸）方向の cba ,, に対応す

る。これらのパラメータをいろいろに設定することにより，あらゆる正弦波振動を，ｘ,y 軸の２次

元平面で小球に与えることができる。

　さて，このような数値パラメータを自由に設定するために，Slider（スライダー）を用いること

ができる。Slider（スライダー）を表示するために，まず，

１）World（ワールド）上で（不可視になっているが）横（ｘ軸）方向の Actuator（アクチュエー
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タ）を選択する。

２）Define>New Control>Length を左クリックする。

　これにより，Length という名前を持つSlider（スライダー）が新たに一つ生成される。次に，

３）上記スライダーを選択し，その Properties（属性）ウィンドウと Appearance（外見）ウィン

ドウを開く。

４）上記 Appearance（外見）ウィンドウにて，トップのコンボボックスが Input[15] など（番号

は場合によって異なる）となっていることを確認し，番号を控えておく。

５）その下のテキストボックスにて，その Slider（スライダー）の名称を，Length から X-Amp

に変更する。

６）上記２）～５）を，更に２回繰り返す。はじめのSlider（スライダー）の名称は Length から

X-Omega に，次のSlider（スライダー）の名称は X-Phase に変更する。以上により計３個のSlider

（スライダー）が生成される。

７）World（ワールド）上で（不可視になっているが）縦（ｙ軸）方向の Actuator（アクチュエー

タ）を選択する。

８）上記２）～５）をもう一度繰り返す（新たに３つのスライダーを作る）。はじめの Slider（ス

ライダー）の名称は Length から Y-Ampに，次の Slider（スライダー）の名称は Y-Omega に，最

　　　　　　　　図 7.22　m7_15_1 の実行結果（リサージュ図形を描く）
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後の Slider（スライダー）の名称は Y-Phaseに変更する。以上により，始めから合計 6 個の Slider

（スライダー）が生成されたことになる。

　上の手順に沿って作成した力学モデルであれば，手元に控えられている各スライダーの名称は恐

らくX-Ampは Input[15]，X-Omegaは Input[16]，X-PhaseはInput[17]に，またY-AmpはInput[18]，

Y-Omega は Input[19]，Y-Phase は Input[20]となっているはずである。実際にはカギ括弧の中の

数値は実際の値を確認してそれに合わせなければならない。仮に，上記のような対応になっている

ときには，

９）式(7.3)および(7.4)の両式の edcba ,,,, および f に，それぞれ Input[15], Input[16], Input[17],

Input[18], Input[19]および Input[20]を代入した式を，それぞれ横（x 軸）方向および縦（ｙ軸）

方向の Actuator（アクチュエータ）のProperties（属性）ウィンドウにおけるValue（値）テキス

トボックスに書き込む。これにより，6 個の Slider（スライダー）が，それぞれ２つの Actuator

（アクチュエータ）の各パラメータに直結することになる。これを実行させてみると，軌跡がなか

なか消えないことがわかる。そこで，

10）Define>New Button>Menu Button を左クリックし，コンボボックスからErase Track（軌跡

の消去）を選択する。これにより，Erase Track ボタンが出現するので，使いやすいところへその

ボタンをドラッグして移動すれば力学モデルが完成する。これを m7_15_1.wm として上書き保存

する（図 7.22）。６つのパラメータを適宜変更し，種々のリサージュ図形を描くこと。

　なお，手順の最後で示した New Button（新規ボタン作成機能）は，メニューのWorldや View な

どにある機能をボタン化して World（ワールド）中に配置するものである。その他にも有用なもの

があるので，適宜これを試すこと。また，この力学モデルは，第 5 章 5.5 節とは全く異なる方法で

リサージュ図形を描く。その違いについて考えること。

7.16　Slot Joint（溝型摺動ジョイント）の垂直反力を表示する（力のつり合い）

　斜面を Rectangle（矩形）が滑り落ちるような場合，斜面と Rectangle（矩形）の間には不静定

の関係が生じて斜面の垂直反力が Rectangle（矩形）のどこに作用するのか（正確には，反力がど

表 7.7　力学モデル m7_16_1 のワールド初期設定

力学モデル・ファイル名 m7_16_1.wm
目的・機能 力ベクトルのつり合い

Gravity（重力） Vertical（鉛直方向）

Air Resistant（空気抵抗）Standard
Stop when（停止条件） time >=100.0
Prevent model from
running faster than
real-time（リアルタイム
より速く動作することの
防止）

On

XY Axes（XY 座標軸） On
Grid Lines（グリッド線）On
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のような分布をするのか）一意的に決定することはできない。これはシミュレーションプログラム

が悪いのではなく，4 本足の机の座りが悪いのと同じように，力学の原理的な問題なのである。

　ここでは上記の問題を避け，斜面の垂直反力が一点で作用するように，Slot Joint（溝型摺動ジ

ョイント）によりBody（物体）を摺動させ，重力と，斜面（実際は溝型摺動ジョイント）の垂直反

力，およびそれを静止させる支持力のつり合いについてシミュレートする力学モデル，m7_16_1 を

作成する。表 7.7 にそのワールド初期設定を示す。

　なお，このモデルは，第 1 章の 1.8 節の m1_8_1 と同じであるので，図は 1.8 節を参照されたい。

１）ツールバーのRectangle（矩形）を選択し，World（ワールド）上で（-3, 1）から（11, -1）ま

でマウスをドラッグし，（4,  0）の位置に幅 14，高さ 2（単位は全て[ｍ]）のRectangle（矩形）を

置く。

２）Appearance（外見）ウィンドウにより 上記 Rectangle（矩形）の内部を透明にする。

３）ツールバーのCircle（円形）を選択し，World（ワールド）上で（-3, 1）から（2, -1）までマ

ウスをドラッグし，（-2, 0）の位置に半径 1 の Circle（円形）を置く。

４）上記 Circle（円形）が World（ワールド）上で選択された状態で，Measure>Velocity>All をク

リックし，計測ウィンドウを出現させ，グラフ表示モードとした後，Vx, Vy, Vφと記述された窓を

クリックして不活性とし，|V|のみを残す。

５）Appearance（外見）ウィンドウによりCircle（円形）の Show circle orientation（円形の方

向の表示）のチェックをはずす。

６）World（ワールド）上で（-2, 0）の位置にJoints（ジョイント）グループの Keyed Slot joint

（回転不能溝型摺動ジョイント）を設置。

７）上記 Keyed Slot joint（回転不能溝型摺動ジョイント）が World（ワールド）上で選択された

状態で Define>Vectors>Total Force を左クリックし，垂直反力ベクトルが表示されるようにする。

８）透明な Rectangle（矩形）のほぼ中央部（4, 0）まで，Circle（円形）をドラッグして移動する。

９）上記Circle（円形）が World（ワールド）上で選択された状態で，Define>Vectors>Gravitational

Force（重力のベクトル表示）と Define>Vectors>Air Force（空気抵抗のベクトル表示）を左クリ

ックする。

10）ツールバーのRectangle（矩形）を選択し，World（ワールド）上で（-3, 1）から（-2, -1）ま

でマウスをドラッグしてRectangle（矩形）を作る。

11）ツールバーのConstraints（拘束）グループのRigid Joint（固定ジョイント）を選択し，World

（ワールド）上で（-2.5, -0.75）の周辺にそれを置き，今作成したRectangle（矩形）と透明なRectangle

（矩形）を接続する。

12）ツールバーのRectangle（矩形）を選択し，World（ワールド）上で（10, 1）から（11, -1）ま

でマウスをドラッグしてRectangle（矩形）を作る。

13）ツールバーのRigid Joint（固定ジョイント）を選択し，World（ワールド）上で（10.5, -0.75）

の周辺にそれを置き，今作成した Rectangle（矩形）と透明な Rectangle（矩形）を接続する。

14）ツールバーにて Constraints（拘束）グループの Pin joint（回転ジョイント）を選択し，World

（ワールド）上で（0, 0）にそれを置き，透明なRectangle（矩形）と Background（バックグラウ
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ンド）を接続する。

15）ツールバーの Anchor（アンカー）を選択し，World（ワールド）上でおよそ（8.5, -0.5）の付

近に置く。

16）ツールバーの Force（力）を選択し，Circle（円形）の中心からおよそ 3 [m]の長さだけ右へ

ドラッグする。

17）上記 Force（力）が World（ワールド）上で選択された状態で，Properties（属性）ウィンド

ウを開き，Rotate with body チェックボックスをチェックする。

18）上記 Force（力）が World（ワールド）上で選択された状態で，Define>Vectors>Total Force

をクリックする。

19）上記Force（力）がWorld（ワールド）上で選択された状態で，Define>New Control>Magnitude

and Direction をクリックする。現れたスライダーのうち，Direction（方向）を選択した後，キー

ボードの Del キーにより消去し，Magnitude（大きさ）のみを残す。

20）Magnitude（大きさ）のスライダーをダブルクリックし，その Properties（属性）ウィンドウ

を開き，min（最小）テキストボックスに０，max（最大）テキストボックスに 40 を代入し，更に

Number of snaps（スナップの数）テキストボックスに 100 を代入して分解能を向上させる。

21）透明なRectangle（矩形）の（9, -0.5）の辺りを下の方へドラッグし，その物体に適当な角度

を付ける。

22）Run の直後から，スライダーを用いて力の大きさを制御し，速度|V|が０となるように制御す

る。ここから先の運用は，第 1 章 1.8 節を参照のこと。

7.17　Damper（ダンパー）によりエネルギーを消費する（ベクトルのスカラー積）

　Constraints（拘束）グループの Damper（ダンパー）を用いて，Force（力）が発生したエネルギ

ーを消費する力学モデル，m7_17_1（表 7.8）を作成する。力学や工学では，通常Damper（ダンパ

ー）はその伸縮速度に比例する反力を発生する。あるいは力を加えると，その力に比例した速度で

伸縮する。Working Model 2D では Damper（ダンパー）の特性として，力が速度に比例するものの

ほか，速度の二乗や三乗に比例する特性を持たせることもできる。しかしここでは，デフォルトの

『力が速度に比例する』特性とする。

　なお，このモデルは1.9節の m1_9_1と同じである。図は1.9節を参照されたい。

表 7.8　力学モデル m7_17_1 のワールド初期設定

力学モデル・ファイル名 m7_17_1.wm
目的・機能 エネルギーの消費，およびベク

トルのスカラー積の実験

Gravity（重力） None（なし）
Pause when（一時停止条件） time >= 7.0
Stop when（停止条件） time >= 8.0
XY Axes（XY 座標軸） On
Grid Lines（グリッド線） On
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１）ツールバーのCircle（円形）を選択し，World（ワールド）上で（-1,1）の位置から（1,-1）ま

でマウスをドラッグし，（0,0）を中心とする半径１[m]の円を描く。

２）慣性力を微小なものとするために，上記 Circle（円形）の Properties（属性）ウィンドウを

開いて，mass（質量）を 1[kg]とする。

３）上記 Circle（円形）が World（ワールド）上で選択されている状態で，メニューバーの

Define>Vectors>Velocity を左クリックすることにより，Circle（円形）の速度ベクトルを表示で

きるようにする。

４）デフォルトの速度ベクトルは短くて見にくいので，メニューバーの Define>Vector Length に

おいて，Velocity（速度）のスライダーを調整して数値を 1.0 とする。

５）後々の見易さのため，Appearance（外見）ウィンドウにより，Circle（円形）の内部のパター

ンに no（透明）を選択する。更に，同ウインドウ中のShow circle orientation（円形の方向の表

示）のチェックをはずす。

６）ツールバーにて水平方向の Keyed Slot joint（回転不能溝型摺動ジョイント）を選択し，World

（ワールド）上のおよそ（0, 0.5）のあたりでマウスを左クリックする。その結果，上記Circle（円

形）の動きは水平方向に規制される。

７）ツールバーのForce（力）を選択し，World（ワールド）上で（0, 0）から（-1, -1）までマウス

をドラッグする。

８）上記 Force（力）が World（ワールド）上で選択されている状態で，メニューバーのDefine>New

Control>Magnitude and Direction を左クリックすると，Force６Magnitude（力６の大きさ）と

Force６Direction（力６の方向）を制御するスライダーが現れるので，その２つを邪魔にならない

場所へマウスでドラッグする。

９）上記 Force（力）が World（ワールド）上で選択されている状態で，メニューバーの

Define>Vectors>Total Force を左クリックして，Force（力）のベクトルが表示できるようにする。

10）ツールバーのDamper（ダンパー）を選択し，World（ワールド）上で（10, 0）から（1, 0）ま

でマウスでドラッグする。これにより，Background（バックグラウンド）の点（10, 0）とCircle

（円形）上の点（1, 0）が，Damper（ダンパー）により接続される。

11）上記 Damper（ダンパー）が World（ワールド）上で選択されている状態で Properties（属性）

ウィンドウを開き，ダンパー係数を 10 [N-s/m]に書き換える。そのとき，Force のタイプが Kv（速

度に比例）であることを確認する。

12）Circle（円形）を World（ワールド）上で選択し，メニューバーのMeasure>Velocity>X Graph

を左クリックすることにより，Circle（円形）のｘ軸方向速度をグラフ表示する。グラフをダブル

クリックすることにより，その Properties（属性）ウィンドウを開き，表示のための各種パラメー

タを適宜見やすいものに設定する（図 1.13 参照）。更にこの計測ウィンドウのAppearance(外見)ウ

ィンドウを開き，座標軸も表示するようにする。

13）Damper（ダンパー）を World（ワールド）上で選択し，メニューバーの Measure>Power をク

リックすることにより，ダンパーのなす１秒あたりの仕事（仕事率）[W]を算出するウィンドウを

表示する。グラフははじめ数値を表示するモードであるが，矢印の部分を左クリックすることによ

り，グラフ表示モードとなる。このウィンドウをダブルクリックしてProperties（属性）ウィンド



223

ウを開き，表示のための各種パラメータを適宜見やすいものに設定する。更にこの計測ウィンドウ

の Appearance(外見)ウィンドウを開き，座標軸も表示するようにする。

14）まず，上記のように設定された条件で実験を行なう。はじめの Run により，システムはWorld

Time で７秒間動作し一時停止する。ここで設定した７秒間は，Circle（円形）の速度が安定する

までの助走期間である。（この期間内に定常状態にならない力学モデルの設定では，数値を変更する

必要がある。）７秒で一時停止したとき，Circle（円形）の速度ベクトルが矢印で示されているが，

これは４）の設定により，長さ[ｍ]がそのまま速度[ｍ/ｓ]と対応している。したがってそのベクト

ルの矢頭は，次に Run を押してから１秒後（はじめから８秒後）に Circle（円形）が停止する位

置を示しているはずである。このことを実験により確認すること。

15）Force６Magnitude や Force６Direction を適宜設定し直し，種々の状況を試すこができる。こ

こから先の運用は，第 1 章 1.9 節を参照のこと。

7.18　Rotational Damper（回転ダンパー）により回転エネルギーを消費する（ベクト

ル積）

　Constraints（拘束）グループの Rotational Damper（回転ダンパー）に，Force（力）によるモ

ーメントが発生した回転エネルギーを消費させる力学モデル，m7_18_1（表 7.9）を作成する。

　通常 Rotational Damper（回転ダンパー）はその角速度に比例する反力モーメントを発生する。

あるいはモーメントを加えると，そのモーメントに比例した角速度で回転する。Working Model 2D

では Rotational Damper（回転ダンパー）の特性として，モーメントが角速度に比例するもののほ

か，角速度の二乗や三乗に比例する特性を持たせることもできる。しかしここでは，デフォルトの

『モーメントが角速度に比例する』特性とする。

　なお，このモデルは第1章の1.10節と同じである。図は1.10節を参照されたい。

表 7.9　力学モデル m7_18_1 のワールド初期設定

力学モデル・ファイル名 m7_18_1.wm
目的・機能 回転エネルギーの消費，および

ベクトル積の実験

Gravity（重力） None（なし）
Stop when（停止条件） time >= 20.0
XY Axes（XY 座標軸） On
Grid Lines（グリッド線）On

１）ツールバーの Rectangle（矩形）を選択し，World（ワールド）上で（-2,1）から（2,-1）まで

マウスをドラッグし，（0,0）を中心とする幅４[m]，高さ２[m]の長方形を描く。

２）慣性モーメントを微小なものとするために，上記Rectangle（矩形）の Properties（属性）ウ

ィンドウを開いて，mass（質量）を 1[kg]とする。

３）後々の見易さのため，Appearance（外見）ウィンドウにより，Rectangle（矩形）の内部のパ

ターンに no（透明）を選択する
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４）ツールバーのRotational Damper（回転ダンパー）を選択し，World（ワールド）上で（0, 0）

に置き，Background（バックグラウンド）とRectangle（矩形）を接続する。

５）上記 Rotational Damper（回転ダンパー）が World（ワールド）上で選択されている状態で

Properties（属性）ウィンドウを開き，ダンパー係数を 10[N-m-s/rad]に書き換える。そのとき，

Torque（モーメント）のタイプが Ks（角速度に比例）であることを確認する。

６）ツールバーのForce（力）を選択し，World（ワールド）上で（1, 0）から（0, -1）までマウス

をドラッグする。

７）上記 Force（力）が World（ワールド）上で選択されている状態で，メニューバーの

Define>Vectors>Total Force を左クリックし，Force（力）のベクトルが表示できるようにする。

８）上記 Force（力）が World（ワールド）上で選択されている状態で Properties（属性）ウィン

ドウを開き，Rotate with body（ボディといっしょに回転）チェックボックスをチェックして，一

実験中 Force（力）の向きがRectangle（矩形）の回転に従って変化するように設定する。

　このとき更に，Polar（極座標形式）のチェックボックスをチェックし，そのときの力の絶対値

が 10.879[N]，方向が 0.785[rad]であることを確認し，ノートに控えておく。

９）Rectangle（矩形）をWorld（ワールド）上で選択し，メニューバーの Measure>Velocity>Rotation

Graph を左クリックすることにより，Rectangle（矩形）の角速度をグラフ表示する。グラフをダ

ブルクリックすることにより，そのProperties（属性）ウィンドウを開き，表示のための各種パラ

メータを適宜見やすいものに設定する。

10）Rotational Damper（回転ダンパー）がWorld（ワールド）上で選択された状態で，メニューバ

ーの Measure>Torque Transmitted を左クリックすることにより，Rotational Damper（回転ダン

パー）に伝達されるモーメント[Nm]を算出するウィンドウを表示する。グラフははじめ数値を表示

するモードであるが，矢印の部分を左クリックすることにより，グラフ表示モードとなる。このウ

ィンドウをダブルクリックして Properties（属性）ウィンドウを開き，表示のための各種パラメー

タを適宜見やすいものに設定する（図 1.14 参照）。

11）Rotational Damper（回転ダンパー）を World（ワールド）上で選択し，メニューバーの

Measure>Power をクリックすることにより，Rotational Damper（回転ダンパー）のなす１秒あた

りの仕事（仕事率）[W]を算出するウィンドウを表示する。グラフははじめ数値を表示するモード

であるが，矢印の部分を適宜左クリックすることにより，グラフ表示モードとなる。このウィンド

ウをダブルクリックしてProperties（属性）ウィンドウを開き，表示のための各種パラメータを適

宜見やすいものに設定する。

12）まず，上記のように設定された条件で実験を行なう。Run により，システムは World Time で

20 秒間動作した後一時停止する。ここで設定した 20 秒間には，Rectangle（矩形）の回転角速度が

十分安定するまでの時間的余裕を見込んである。（この期間内に定常状態にならない力学モデルの

設定では，数値を変更する必要がある。）

13）World（ワールド）上で Force（力）をダブルクリックし，力の絶対値と方向を適宜設定し直す

ことができる。ここから先の運用は，第 1 章 1.10 節を参照のこと。
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7.19　Points（点要素）の使い方（運動エネルギーとポテンシャルエネルギーの和）

　Points（点要素）グループの Closed Curved slot element（閉曲線溝型摺動要素）と Point element

（回転点要素）を用いたジョイントの作成法を説明する。

表 7.10　力学モデル m7_19_1 のワールド初期設定

力学モデル・ファイル名 m7_19_1.wm
目的・機能 運動エネルギーとポテンシャル

エネルギーの和をシミュレート
する実験

Gravity（重力） Vertical（鉛直方向）

Stop when（停止条件） time >= 50.0
Prevent model from
running faster than
real-time（リアルタイム
より速く動作することの
防止）

On

XY Axes（XY 座標軸） On
Grid Lines（グリッド線）On

表 7.11　Closed Curved slot

element（閉曲線溝型摺動要

素）の極座標

番号 ｒ φ
1 4.000 3.142
2 3.000 1.571
3 3.64 1.292
4 4.031 1.052
5 4.460 0.833
6 4.472 0.464
7 4.800 0.000
8 6.600 0.000
9 7.566 0.133
10 7.338 0.305
11 6.042 0.427
12 4.713 0.302
13 4.518 0.089
14 5.511 6.082
15 8.246 6.038
16 9.108 5.948
17 8.944 5.820
18 8.215 5.732
19 5.946 5.450
20 4.206 4.398
21 4.031 3.661

　　      図 7.23　 Closed Curved slot element

　　　     （閉曲線溝型摺動要素）の入力開始画面
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　ここでは，重力場において 2 次元的に摺動する物体の運動エネルギーとポテンシャルエネルギー

をシミュレートする力学モデル，m7_19_1（表 7.10）を作成する。

　　一般に，Joints（ジョイント）グループの Slot joint（溝型摺動ジョイント）類は，Points

（点要素）グループのSlot element（溝型摺動要素）類とPoint element（回転点要素）類の組み

合わせと考えることができる。

　Working Model 2D では通常，曲線をなす図形を要素として持つBody（物体）やPoints（点要素）

は，マウスクリックによって入力することができるが，ここでは再現性を確かなものとするために，

表 7.11 に示す極座標の組みを幾何学的要素として持つ Closed Curved slot element（閉曲線溝型

摺動要素）をキーボードから入力する。

１）ツールバーの Closed Curved slot element（閉曲線溝型摺動要素）を選択し，World（ワール

ド）上で（-4, 0），（0, 3）を順次左クリックし，最後に（2, 4）においてダブルクリックする。間違

えて Closed Curved slot joint（閉曲線溝型摺動ジョイント）を選択しないこと。

２）得られた Closed Curved slot element（閉曲線溝型摺動要素）が選択されている状態で

Window>Geometry により，Geometry（幾何寸法）ウィンドウを表示する。この時点で図 7.23 の

ように表示される。ここで Slot is のラジオボタンが” Closed “，および Display in のラジオボタン

が ” Polar coordinates “ にチェックされていることを確認する。

３）最終的な Closed Curved slot element（閉曲線溝型摺動要素）の座標を表 7.11 に示すが，図

7.23 の Geometry（幾何寸法）ウィンドウの下段の座標値と比較して，第３行目が異なっている。そ

こで，まず同ウィンドウ下段の数値入力テキストボックスにて，第 3 行目の左列にマウスでカーソ

ルを移した後，すぐ上の Insert ボタンを 18 回押して 21 行目までの欄を作る。

４）次に，表 7.11 に従って第 3 行目に” 3.64 ”と入力し，更にカーソルをマウスで右の列に移し，”

1.292 ”と入力する。

５）以下，第４行目から第 21 行目まで，表 7.11 に従って，正確に数値を入力する。最後は変形し

た 8 の字が描かれているはずである。

６）ツールバーのRectangle（矩形）を選択し，World（ワールド）上で（1, 5）から（3, 4）まで

マウスをドラッグし，（2, 4.5）を中心に幅２[m]，高さ１[m]の長方形を描く。

７）後々の見易さのため，Appearance（外見）ウィンドウにより，Rectangle（矩形）の内部のパ

ターンに no（透明）を選択する

８）ツールバーのPoint element（回転点要素）を選択し，これをWorld（ワールド）上で（1.5, 4.5）

に置き，Rectangle（矩形）の左半分の中心に吸着させる。

９）上記 Point element（回転点要素）が World（ワールド）上で選択されている状態で，キーボ

ードの Shift を押しながら，上記の Closed Curved slot element（閉曲線溝型摺動要素）をマウス

の左クリックで追加選択する（現在２つのオブジェクトが選択されている）。

10）この状態でツールバーのJoint（結合）ボタンがアクティブになっていることを確認し，Joint

（結合）ボタンを押す。これにより，Rectangle（矩形）が全体的に少し下に下がり，Closed Curved

slot element（閉曲線溝型摺動要素）と結合する。

11）一度何も無いところをマウスで左クリックしてから，Rectangle（矩形）を選択し，メニュー
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の Measure>Kinetic Energy>Total（計測ウィンドウ１），Measure>Gravity Potential（計測ウィ

ンドウ２），さらに再び Measure>Kinetic Energy>Total（計測ウィンドウ３）をマウスで左クリッ

クして三つの計測ウィンドウを出現させ，適当な位置にマウスでドラッグする。

12）各計測ウィンドウの左上の矢印を一度左クリックし，それぞれをグラフ表示モードとする。

　また全ての計測ウィンドウの Appearance（外見）ウィンドウにおいて，Axes（軸）チェックボッ

クスをチェックする。

13）計測ウィンドウ１，計測ウィンドウ２，計測ウィンドウ３をそれぞれのProperties（属性）ウ

ィンドウを開いて編集する。詳細はそれぞれ図 7.24，7.25，7.26 に従うこと。このうち，図 7.26

の計測ウィンドウ３における KE+GP の Equation（式）は，計測ウィンドウ１の KE（運動エネ

ルギー）および計測ウィンドウ２の Trans（重力ポテンシャル）の Equation（式）を " + " 記号

　　　　　図 7.24　計測ウィンドウ１の Properties（属性）ウィンドウ設定

図 7.25　計測ウィンドウ２の Properties（属性）ウィンドウ設定
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　　　　　　　図 7.26　計測ウィンドウ３の Properties（属性）ウィンドウ設定

　　　　　　　　　　　

　　　　　　　　　　　　　図 7.27　 Points（点要素）の使い方
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で足したものである。

　結果的に，計測ウィンドウ１は Rectangle（矩形）のトータルの運動エネルギーを，また計測ウ

ィンドウ２は Rectangle（矩形）の重力ポテンシャルを，さらに計測ウィンドウ３はRectangle（矩

形）の運動エネルギーと重力ポテンシャルの和を表示する。

14）Run によりこの力学モデルを実行すると，Rectangle（矩形）は Point element（回転点要素）

の回りで回転が許されているので，不規則に回転しながら，Closed Curved slot element（閉曲線

溝型摺動要素）の上を摺動し始める。計測ウィンドウ３を見ると，Rectangle（矩形）の回転のエ

ネルギーを含む運動エネルギーとポテンシャルエネルギーの和は保存されていることが確認される。

　力学モデルが 50 秒後に停止した直後の様子を図 7.27 に示す。15）これを Reset し，m7_19_1.wm

としてセーブする。

7.20　２つの Point element（回転点要素）によって物体の回転を規制する

　m7_19_1 では，Rectangle（矩形）が Point element（回転点要素）の回りを自由に回ってしま

った。Rectangle（矩形）の向きを，Closed Curved slot element（閉曲線溝型摺動要素）の向き

に一致させて動かしたいとき，Rectangle（矩形）の別の位置（例えば右半分の中心）にもう一つ

別の Point element（回転点要素）を設置し，回転を規制すればよい。

　しかし，一つのClosed Curved slot element（閉曲線溝型摺動要素）に対しては，一つのPoint

element（回転点要素）しかジョイントさせられない。そこで，ここではコピーによって全く同じ

Closed Curved slot element（閉曲線溝型摺動要素）をもう一つ作り，Rectangle（矩形）の右半

分の中心の Point element（回転点要素）をこちらとジョイントさせる。

１）m7_19_1.wm をロードし，m7_20_1.wm というファイル名でセーブする。力学モデルの名称

は m7_20_1 とする。

２）Reset の状態から，さらにモデリング作業を続ける。

３）ツールバーのForce（力）を選択し，World（ワールド）上でおよそ（2, 4.5）から（0, 4.5）に

向けてドラッグし，結果的に Rectangle（矩形）の中心に矢頭を吸着させる。

４）上記 Force（力）の Properties（属性）ウィンドウにおいて，Fx および Fy を共に０[N]とし，

さらに Rotate with body チェックボックスを On とする（この力は次節で試用する）。

５）Closed Curved slot element（閉曲線溝型摺動要素）をマウスの左クリックで選択し，Edit>Copy

および Edit>Paste をマウスで順次左クリックし，新しい Closed Curved slot element（閉曲線溝

型摺動要素）をコピーする。新しいClosed Curved slot element（閉曲線溝型摺動要素）は元のそ

れに対し，少しずれた位置に置かれる。

６）新しい Closed Curved slot element（閉曲線溝型摺動要素）には，元のそれと相対的に同じ位

置に一つの Point element（回転点要素）が付属しているはずである。一度，何も無いところをマ

ウスで左クリックしてからこの新たな Point element（回転点要素）のみを選択し，これをキーボ

ードの Del キーにより削除する。
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７）ツールバーの Point element（回転点要素）を選択し，これを World（ワールド）上でおよそ

（2.5, 4.5）に置き，結果的にRectangle（矩形）の右半分の中心に吸着させる。

８）新しい Closed Curved slot element（閉曲線溝型摺動要素）をマウスでドラッグしながら元の

Closed Curved slot element（閉曲線溝型摺動要素）に完全に一致させる。すなわちClosed Curved

slot element（閉曲線溝型摺動要素）は２つが重なって１つに見えるようになるのだが，この状態

で継続して選択されているのは，新しくコピーされたClosed Curved slot element（閉曲線溝型摺

動要素）である。

９）上記の新しいClosed Curved slot element（閉曲線溝型摺動要素）が選択された状態で，キー

ボードの Shift を押しながら，新しくRectangle（矩形）の右半分の中心に置かれた Point element

（回転点要素）も選択する（現在２つのオブジェクトが選択されている）。

10）この状態でツールバーのJoint（結合）ボタンがアクティブとなっていることを確認し，Joint

（結合）ボタンを押す。これにより，上記で選択されていた２つのオブジェクトが結合し，結果的

に Rectangle（矩形）が少し右下がりに傾く。

11）ここで Run によりこの力学モデルを実行すると，Rectangle（矩形）は２つの Point element

（回転点要素）で回転が規制されているので，Closed Curved slot element（閉曲線溝型摺動要素）

の上を，回転せずに摺動し始める。前節のモデルと同様に，計測ウィンドウ３を見ると，Rectangle

（矩形）の回転のエネルギーを含む運動エネルギーとポテンシャルエネルギーの和が保存されてい

ることが確認される。

12）Reset して m7_20_1.wmに上書き保存する。

7.21　Slot joint（溝型摺動ジョイント）類に粘性抵抗や摩擦抵抗を与える

　第 7 章，7.17 節の『Damper（ダンパー）によりエネルギーを消費する』では，力によってKeyed

Slot joint（回転不能溝型摺動ジョイント）上を摺動するBody（物体）に与えられる運動エネルギ

ーを消費するために，上記 Slot joint（溝型摺動ジョイント）類に Damper（ダンパー）を接続し

た。しかし実際はSlot joint（溝型摺動ジョイント）類を選択しておいて，メニューの Script>Slot

Damper を左クリックすることによって同じ機能を利用できる。同様に摩擦抵抗を与えるには，メ

ニューの Script>Slot Friction を用いればよい。

　ここでは，前節で作成した力学モデルを更に改造して，新しい力学モデルを作る。

１）m7_20_1.wm をロードし，m7_21_1.wm というファイル名でセーブする。力学モデルの名称

は m7_21_1 とする。

２）Reset の状態から，さらにモデリング作業を続ける。

３）Closed Curved slot element（閉曲線溝型摺動要素）をマウスの左クリックで選択し，メニュ

ーの Script>Slot Damper を左クリックする。これにより，Slot[13] Damping Coefficient と標記

されるスライダーが現れるので，そのテキストボックスの数値を 0.2 と変更する。

４）Rectangle（矩形）の中心の Force（力）をダブルクリックしてその Properties（属性）ウィ

ンドウを表示する。しかし前節で力の大きさを０としているので，選択が難しいかもしれない。
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　その場合は，その代わりに開いた別の Object（オブジェクト）に対する Properties（属性）ウ

ィンドウのトップのコンボボックスを探し，"Constraint[10]-Force" を選択すれば，そのウィンド

ウは Force（力）のものとなる。

　　　　　　　　　　　　図 7.28　m7_21_1 の実行結果

５）上記 Properties（属性）ウィンドウにおいて，Fx のテキストボックスを 12 [N]とし，さらに

最下段のAlwaysチェックボックスをOffとする。そのときアクティブとなるテキストボックスには，

　　　　　　　　　　　And(body[4].p.x < 0, body[4].p.y > 0)

と入力する。これは，body[4]（実際に Rectangle（矩形）が対応しているオブジェクト番号である

必要がある）の x 位置が負，かつ，同 y 位置が正のときのみに力を作用させるという意味である。

６）力の作用を明白にするために，Force（力）が World（ワールド）上で選択されている状態で，

Define>Vectors>Total force を左クリックする。

７）ここで Run によりこの力学モデルを実行すると，前モデル同様に，Rectangle（矩形）は Closed

Curved slot element（閉曲線溝型摺動要素）の上を摺動し始める。計測ウィンドウ３を見ると，

Rectangle（矩形）の全運動エネルギーとポテンシャルエネルギーの和は，Slot Damper（スロット
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ダンパー）のために減少ぎみであるが，World（ワールド）の第 2 象現にて，力が発生してRectangle

（矩形）を押し上げるため，運動エネルギーが補われ，摺動を継続することができる。

　力学モデルが 50 秒後に停止した直後の様子を図 7.28 に示す。

８）これを Reset し，m7_21_1.wmに上書き保存する。


